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Chapter 1

Welcome to Live

1.1 The Ableton Team Says: Thank You

Live is the result of musicians wanting a better way to create, produce and perform music
using a computer. A great deal of effort has been put into making Live easy and fun to
use, yet at the same time capable of helping you create music with unlimited depth and
sophistication. This effort continues even as you read these lines... in fact, a new, improved
Live version might already be available for download! Please check on our website now!,

or choose the Check for Updates command from the Help menu.

We hope you enjoy using Live and that it enhances your creative process. Should you have
suggestions about how we can improve Live, please let us know?.

Your Ableton Team.

Thttp://www.ableton.com/downloads
2contact@ableton.com
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1.2 What's New in Live 8?

1.2.1 New Warping Engine

e Live's warping engine has been dramatically overhauled, with more accurate transient
detection and a redesigned interface that allows you to drag the waveform along a
fixed timeline.

e New transient loop and envelope controls in Beats Mode allow for higher quality
warping, especially at slower tempos.

e New Complex Pro Mode for even higher quality warping.

e You can now quantize audio clips using the Edit menu’s Quantize command.

1.2.2 New Groove Functionality

e Groove patterns can now modify the timing and volume of audio and MIDI clips in
real-time. A large library of grooves is provided, and grooves can be extracted from
clips and then reapplied to other clips.

1.2.3 Workflow Enhancements

e Crossfades are now available for adjacent clips in Arrangement View.

e The MIDI Editor has been reworked, and editing MIDI is now similar to editing in
the Arrangement. An insert mark sets the precise location for clipboard operations,
allowing notes or time to be copied, pasted, inserted and deleted anywhere in the
clip. Enhanced keyboard commands also improve the editing workflow.

e As a result of the new navigation possibilities in the MIDI Editor, it is now possible to
step record MIDI notes.

¢ Audio and MIDI tracks can be grouped into a summing Group Track. Group Tracks can
be folded or unfolded to help organize your workflow in both Session and Arrangement
View.
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e Live's interface can be magnified to maximize visibility via the Zoom Display slider.

e APreview Tab in the Browser provides a visual overview of the previewed file's contents,
and allows you to scrub in the waveform or MIDI display.

e When multiple tracks are selected, adjusting one of their mixer or routing parameters
will adjust the same parameter in the other selected tracks.

1.2.4 Ableton Effects and Instruments

e Operator has been dramatically overhauled with a variety of new filter types, an ex-
panded set of modulation routings and additive wavetable synthesis with drawable
partials.

e Collision optional add-on instrument
e Corpus optional add-on effect
e Latin Percussion optional add-on sample library

e Looper provides classic tape-loop style overdubbing, with drag-and-drop export to
clips, MIDI-mappable controls optimized for use with foot pedals and more.

e Vocoder combines the best of classic analog vocoders with powerful new features.
e Limiter provides a true “brickwall” limiter, ideal for mastering applications.

e The Multiband Dynamics device allows for upward or downward compression or ex-
pansion of up to three separate frequency bands.

e Overdrive is a powerful addition to Live's arsenal of distortion tools.

e Frequency Shifter combines frequency shifting and ring modulation effects in a single
device.

1.2.5 New Library

e Live's Library is now stocked with a large collection of new creative tools including
numerous device presets, loops and samples, construction kits and template Sets.
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1.2.6 Online Collaboration Tools

e Share Live Sets with other users via a shared web area at ableton.com.

1.2.7 Controllers

e Support for the APC40 (Ableton Performance Controller), a dedicated controller for
Ableton Live.

1.2.8 More Improvements
e Macro Controls now automatically show the name and units of their mapped parameter
whenever possible.
e a High-Quality mode has been added to the Flanger effect.

e Third-party plug-in support has been improved to allow access to an arbitrary number
of parameters.

e it is now possible to slice based on the transients of the audio file.

e the Ping Pong Delay and Simple Delay effects now have three user-selectable delay
transition modes.

e Sampler's waveshaper now offers a fourth curve type: “4bit.”

e Multiple Live Packs can be uninstalled simultaneously, and the Browser can now sort
content by the Live Pack that installed it.



Chapter 2

First Steps

When you install Live and run it for the first time, you will be presented with an authorization
dialog. Please see the chapter on authorizing Live should you have questions or concerns
during the authorization process.

If you do not (yet) own Live, you can still try out all of Live's features, but you will not be able
to save or export your work.

2.1 Learn About Live

Live comes with a set of interactive lessons to take you step by step through the key features
of the program. The lessons are organized in a table of contents, which can be opened
directly in the program via the Help menu. We highly recommend following the lessons.
Many users have told us that the lessons helped them become familiar with the program
very quickly.

We also recommend that you read the Live Concepts chapter, which encapsulates every-
thing that Live is and can do, and is therefore a worthwhile read for both beginners and
experienced users. The remaining chapters of this manual serve as in-depth reference for
the material introduced in Live Concepts.
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2.1.1 Using the Info View and Index

Live's Info View tells you the name and function of whatever you place the mouse over. For
certain items, you can create your own text and it will appear in this window.

L]

[ Spectrum ] II 5 :

o [ wtility = 2 *
Info View Dynamic Tube Ll |

The Info View provides a brief
description of the user interface
alameant that the mouse is currently
over. For some elements, you can n
creata your own text and it will appear
in this window.

To save screen space, feld in the Info
View by clicking the triangle-shaped
button near the lowar left corner.

[?] ShowiHide Info View

If you require more information on a specific user interface element or topic, please consult
this reference manual. The index, found at the end of the manual, contains the names of all
user interface elements and will lead you to the relevant section.

2.2 Setting up Preferences

Live's Preferences window is where you can find various settings that determine how Live
looks, behaves and interfaces with the outside world. This window is accessed from the
Preferences command, which in Windows is available in the Options menu and in OS X
is available in the Live menu. Preferences can also be accessed with the (Cul ](, ) (PC) /

@ B[ ) (Mac) shortcut.
Live's Preferences are distributed over several tabs:

e In the Look/Feel tab, you can modify various settings, including the language used for

The Info View and its
Show/Hide Button.
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text display and the color scheme, or “skin,” for the Live user interface. This is also
where you can adjust the size of objects displayed on the screen: the Zoom Display
slider allows you to zoom Live's screen to any percentage between 50% and 200% of
the standard interface size.

e The Audio Preferences are used to set up Live’s audio connections with the outside
world via an audio interface. Please take the time to follow the program’s built-in
"Setting up Audio I/0” lesson, which will walk you through all the steps required to
set up and optimize the settings for any given system. To access the lesson, use the
Lessons Table of Contents command from the Help menu.

e The MIDI/Sync Preferences are used to help Live recognize MIDI devices for three
separate and distinct purposes:

- Playing MIDI notes. To learn how to route an external device into Live for MIDI
input, or how to send MIDI to an external device, please see the Routing and 1/O
chapter.

- Controlling parts of the interface remotely. This subject is covered in detail in the
MIDI and Key Remote Control chapter.

- Syncing the program with an external sequencer or drum machine, either as a
master or a slave. Please see the Synchronizing via MIDI chapter for details.

e The File/Folder Preferences pertain to Live's file management and the location of
plug-in devices.

e The Record/Warp/Launch Preferences allow customizing the default state for new Live
Sets and their components, as well as selecting options for new recordings.

e The CPU Preferences include options for managing the processing load, including
multicore/multiprocessor support.

e The User Account/Licenses Preferences are used to manage licensing and installation
of the Live platform, and add-on components like the Operator instrument.

e The Library Preferences allow you to specify the location of Live's Library and manage
currently installed Live Packs.
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2.3 The Main Live Screen

Most of your work in Live happens in the main Live screen. This screen consists of a number
of views, and each view manages a specific aspect of your Live Set, which is the type of
document that you create and work on in Live. Since screen space is usually limited, the
Live views can't all be displayed at the same time.

Each one of the selector buttons at the screen borders calls up a specific view; clicking this
one, for instance, opens Live’s Device Browser:

Live Devices

Mams
Instruments

[l orum Rack
[l instrument Rack

To hide one of Live's views and free up screen space, click on the triangle-shaped button
next to it. To restore the view, click the button again.

G Live Devices
Name

Instrumiants
B Orum Rack
[ instrument Rack

You can run Live in Full Screen Mode by selecting the Full Screen command from the View
menu. To leave Full Screen Mode, click the button that appears in the lower right corner of
the screen. Full Screen Mode can also be toggled by pressing [F11 ]. (Note: On Mac OS
X, this key is assigned by default to Exposé, and will not toggle Full Screen Mode unless
Exposé has been deactivated or assigned to a different key in OS X's System Preferences.)

If one of the browser views is open, you can adjust the main window’s horizontal split by
dragging.

The Device Browser
Selector.

A View Show/Hide
Button.
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Live Devices

v [P} instruments
I> [l Drum Rack
1> [@ll Instrument Rack
> [l Analog
> [l Electric
= [l External Instrument
= [l Impulse
I+ gl Operator

Adjusting the Main
Window Split.
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Chapter 3

Authorizing Live

Live is protected against illegal use by a copy protection scheme. This scheme has been
designed to meet the highest security standards while avoiding hassles for our customers. If
you find this procedure to be an inconvenience, please understand that the copy protection
secures your investment: It allows Ableton to provide you with support and to continue
developing Live.

Please be aware that the standard Live license grants you the right to use Live on only one
computer at a time. You can, however, authorize Live more than once under the legal and
technical conditions described later.

The first time you run Live, you will be prompted to complete the authorization process.
The software will walk you through the steps.

If the computer that you wish to authorize is connected to the internet, you can authorize
immediately by pressing the appropriate button in the dialog box. If you do not have
an internet connection, press the “No internet on this computer” button and follow the
instructions.
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3.1 Copy Protection FAQs

3.1.1 Can | Use Live or Other Ableton Products Without a Serial
Number?

If you do not (yet) own Live or its add-on products, you can still try them out, but saving and
exporting will be disabled.

If trying Live or another product raises your interest in purchasing it, please visit the Ableton
webshop!. This site contains information about Ableton’s distributor and dealer network. It
also offers you the opportunity to buy Ableton products online.

3.1.2 What if | Change My Computer’s Components?

If you change your computer components for some reason, Live may indeed ask you to
authorize the software another time. Live does not need to be reauthorized when computer
peripherals are replaced (audio or MIDI hardware, printers, modems). But you may need
to authorize again if the motherboard, processor or network card is replaced. On some
computers, reformatting a hard drive will require a new authorization.

3.1.3 Can | Authorize Live More than Once?

The standard Live license allows you to use Live on only one computer at a time. However,
the Ableton server will provide you with two authorizations in good faith that you will use
Live on only one machine at a time.

You can therefore run Live on both a studio desktop computer and a tour laptop, but not at
the same time.

Should the Ableton server reject your demand for another authorization, please contact
Ableton’s technical support?.

Thttp://www.ableton.com/shop
2http://www.able'con.com/suppor‘c
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To use Live on more than one computer at a time, you may require a secondary license or a
site license. Ableton offers these licenses at special rates.

3.1.4 Can | Play my Set from a Computer That Is Not Authorized?

Even if Live is not authorized, you can still load and perform a Live Set with no time limitation.
You cannot, however, save or export your work. When you go on tour, consider taking along
your Live program CD and a CD with the last state of your Live Set(s). In case of an
emergency, you can install and run Live on any computer available and play your backup
Live Set(s).

3.1.5 What Do | Do About Problems or Questions Regarding Copy
Protection?

Please visit Ableton’s technical support page®.

3http://www.able'con.com/suppor‘c
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Chapter 4

Live Concepts

This chapter introduces the essential concepts of Live. We advise you to read this chapter
early in your Live career, as a solid understanding of the program'’s basic principles will help
you fully exploit Live's potential for your music-making.

4.1 Live Sets

The type of document that you create and work on in Live is called a Live Set. Live Sets
reside in a Live Project — a folder that collects related materials — and can be opened either
through the File menu’s Open command or via the built-in File Browsers.

Library ~

MHame Typa
D Designar Drums
= B A Series of Tubes-160bpm.als Live Set
can - LR Ve o
D Bouncing in a Room-168bpm.als Live Set
D Breakbeat-150bpm.als Live Set

L)

A Live Set in the File
Browser.
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Selecting the Library bookmark in Live's File Browser will take you to the Live Library of
creative tools. Depending on what content you have installed, there may be a number of
demo Sets here, and double-clicking a Live Set's name in the Browser will open that Live
Set. You can also find Live Sets made by others at the Ableton website, as well as upload
your own. This makes it easy to collaborate with other Live users.

4.2 Arrangement and Session

The basic musical building blocks of Live are called clips. A clip is a piece of musical material:
a melody, a drum pattern, a bassline or a complete song. Live allows you to record and alter
clips, and to create larger musical structures from them: songs, scores, remixes, DJ sets or
stage shows.

A Live Set consists of two environments that can hold clips: The Arrangement is a layout of
clips along a musical timeline; the Session is a real-time-oriented “launching base” for clips.
Every Session clip has its own play button that allows launching the clip at any time and in
any order. Each clip’s behavior upon launch can be precisely specified through a number of
settings.

[roies—] I [ o | [ e B 5
[Jmosees ] | i [ oumse | - e [aes roed
[ rmoses | s [ arowom |
[moses ] [Pome ] -

The Arrangement is accessed via the Arrangement View and the Session via the Session
View; you can toggle between the two views using the computer’s Tab key or their respective
selectors. Because the two views have distinct applications, they each hold individual
collections of clips. However, it is important to understand that flipping the views simply
changes the appearance of the Live Set and does not switch modes, alter what you hear or
change what is stored.

Clips in the Session View
(Left) and in the
Arrangement View
(Right).
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Wi KEY MIDI 2% 8]
Master @

Intro

Verse?

The Arrangement View and the Session View interact in useful (though potentially confusing)
ways. One can, for instance, improvise with Session clips and record a log of the improvi-
sation into the Arrangement for further refinement. This works because Arrangement and
Session are connected via tracks.

4.3 Tracks

Tracks host clips and also manage the flow of signals, as well as the creation of new clips
through recording, sound synthesis, effects processing and mixing.

(_Clear Envelope }

The Session and Arrangement share the same set of tracks. In the Session View, the tracks
are laid out vertically from left to right, while in the Arrangement View they are horizontal
from top to bottom. A simple rule governs the cohabitation of clips in a track:

A track can only play one clip at a time.

Therefore, one usually puts clips that should play alternatively in the same Session View
column, and spreads out clips that should play together across tracks in rows, or what we
call scenes.

The Arrangement and
Session View Selectors.

A Track in the
Arrangement View.
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1 Bass 2 Chords 4 Rhodes 4 Perc's & Beats & Crash Master
synth 1 rhodes [groovy Intro
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The exclusivity of clips in a track also implies that, at any one time, a track will either play
a Session clip or an Arrangement clip, but never both. So, who wins? When a Session clip
is launched, the respective track stops whatever it is doing to play that clip. In particular, if
the track was playing an Arrangement clip, it will stop it in favor of the Session clip — even
as the other tracks continue to play what is in the Arrangement. The track will not resume
Arrangement playback until explicitly told to do so.

b i i il H|® :.\".'H.'H:-- a

This is what the Back to Arrangement button, found in the Control Bar at the top of the
Live screen, is for. This button lights up to indicate that one or more tracks are currently not
playing the Arrangement, but are playing a clip from the Session instead.

We can click this button to make all tracks go back to the Arrangement. Or, if we like what
we hear, we can capture the current state into the Arrangement by activating the Record
button. Disengaging Record Mode or stopping Live using the Stop button leaves us with
an altered Arrangement.

4.4 Audio and MIDI

Clips represent recorded signals. Live deals with two types of signals: audio and MIDI. In the
digital world, an audio signal is a series of numbers that approximates a continuous signal
as generated by a microphone or delivered to a loudspeaker. A MIDI signal is a sequence
of commands, such as “now play a C4 at mezzo piano.” MIDI is a symbolic representation
of musical material, one that is closer to a written score than to an audio recording. MIDI

A Scene in the Session
View.

The Back to
Arrangement Button.
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signals are generated by input devices such as MIDI or USB keyboards'.

It takes an instrument to convert MIDI signals into audio signals that can actually be heard.
Some instruments, such as Live's Simpler, are for chromatic playing of one sound via the
keyboard. Other instruments, such as Live's Impulse, have a different percussion sound
assigned to each keyboard key.

Audio signals are recorded and played back using audio tracks, and MIDI signals are
recorded and played back using MIDI tracks. The two track types have their own corre-
sponding clip types. Audio clips cannot live on MIDI tracks and vice versa.

Information about inserting, reordering and deleting audio and MIDI tracks is found here.

4.5 Audio Clips and Samples

An audio clip contains a reference to a sample (also known as a “sound file” or “audio file")
or a compressed sample (such as an MP3 file). The clip tells Live where on the computer’s
drives to find the sample, what part of the sample to play and how to play it.

When a sample is dragged in from one of Live’s built-in File Browsers, Live automatically
creates a clip to play that sample. Prior to dragging in a sample, one can audition or
preview it directly in the Browser; the switch in the Browser with the headphone icon
activates previewing.

'For an introduction to digital audio and MIDI, please see http://img.uoregon.edu/emi/emi.php and
http://www.midi.org/
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Current Project (Live 7 Library) ~ =1l
e T
feel 0001 T-Audio-1.wav Wave I
e} 0001 T-Audio-Zwav Wave
e 0001 T-Audio.wav Wave
5} 0001 8-Audio.wav Wave
el 0001 Bass.wav Wave
e 0002 6-Audio-1.wav Wave
F] 0002 6-Audio-2.wav Wave
[erl 0002 6-Audio.wav Wave
Fed 0002 T-Audio.wav Wave
@ [Raw]

Live offers many options for playing samples in exciting new ways, allowing you to create an
abundance of new sounds without actually changing the original sample — all the changes
are computed in real time, while the sample is played. The respective settings are made in
the Clip View, which appears on screen when a clip is double-clicked.

) clip Launch Sample @® Envelopes @ (1.2 (1.3 14
Launch Mode | 0001 5-Augiowav | [JNGIRE] | Start Start = <
[ =| | [Trigger || 44.1kHz 16Bit2Ch 10 i 0 [ ] 9]
signawre | [[legate | (EdiD) a8 @ReV) | seg. spm | End (Transpose)  End
[4 41} quantization = [HiG] [Fage| [RAM] I [ o ]
croove @ | [G0B9_5] | Transpose @
vel[00% | (T) Gaen | I T
Follow Acticn em—— Position (S8} | Region/Loop | Position
[droa) o == |
EED (<[ 7| oewne o " Lengih
oo [l 0.00 dB T [ o o] 1/8

Many powerful manipulations arise from Live's warping capabilities. Warping means chang-
ing the speed of sample playback independently from the pitch so as to match the song
tempo. The tempo can be adjusted on the fly in the Control Bar's Tempo field.

TAP129.00( 11| 4 1 4 jO®

The most elementary use of this technique, and one that usually requires no manual setup,
is synchronizing sample loops to the chosen tempo. Live's Auto-Warp algorithm actually
makes it easy to line up any sample with the song tempo, such as a recording of a drunken
jazz band’s performance. It is also possible to radically change the sonic signature of a

Samples Are Dragged in
from Live’s File Browsers.

An Audio Clip’s
Properties as Displayed
in the Clip View.

The Control Bar’s Tempo
Field.
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sound using extreme warp settings.

4.6 MIDI Clips and MIDI Files

A MIDI clip contains musical material in the form of MIDI notes and controller envelopes.
When MIDI is imported from a MIDI file, the data gets incorporated into the Live Set, and
the original file is not referenced thereafter. In the Live File Browsers, a MIDI file appears
as a folder that can be opened to reveal its individual component tracks, which can be
selectively dragged into the Live Set.

Library ]
Nama

v [1] Blotto.mid

II‘ Bass

[3] piano-z

[2] mute Guitar

[1] overdrive

in from Live’s File
Browsers.

F BadPioneerz.mp3

As you'd expect, a MIDI clip’s contents can be accessed and edited via the Clip View, for
instance to change a melody or “paint” a drum pattern.

e - 1 J o = oz 2 (13 (14
Launch Mode || Orig. BPM | Start (S8 Start B
| ] I | (-] -5

(PichBend) s ot . .

[4 2 1} quantization [ ] o P
Groave Global |
vel[ 00% | I | o B B =

Follow Action
[ Lol
GRS

006 ([ 1[o]

@

[ o [ 127
Length 4 ] I l ] I I l as Displayed in the Clip
00 e s A8 view,

MIDI Files Are Dragged

A MIDI Clip’s Properties
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4.7 Devices and the Mixer

A track can have not only clips but also a chain of devices for processing signals. Double-
clicking a track’s title bar brings up the Track View, which shows the track’s device chain.

ey = =

v [ oynamic Tube Ableton Devic II II II 07 II @
EQ Eight Ableton Devic

- Ed L <« mm> ©

LFO
EEeI Il ©
66.55

Filter

Freq Res
[Band 2408 5]
[l [Band 24cB <] Q“m Qm

— PilghEnv  Spread  Transpose

Q.G% G\D% Qsl

Time Tone Valume

‘G:“' e‘”‘ @s'gﬁ The Track View
Displaying a MIDI Track’s
Device Chain.

Live's built-in audio effects, MIDI effects and instruments are available from the Device
Browser and can be added to tracks by dragging them from there into the Track View, or
into a Session or Arrangement track.
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1> [l Electric Ableton Device
> [ External Instrument Ableton Device
> [ Impulse Ableton Device
I [l Operator Ableton Devica
I~ [l Sampler Ablaton Devica
I~ [l Simpler Ablaton Devica
I [l Tension Ablaton Devica

= 7] MIDI Effects
w =y Audio Effects

> [l Audio Effect Rack Ableton Device
¥ [l Auto Filter Ableton Device
 Eowomewn  Aw  mrmenie Live’s Built-in Devices
= cut-0-Move L Adv 26.11.2007, 12:04 Are Available from the

= | Device Browser.

You can also use plug-in devices in Live. VST and Audio Units (Mac OS X only) Plug-ins are
available from the Plug-In Device Browser.

= [ Apple
= P73 Bram @ Smarteloctronix
I+ [ s(Mjexoscope Audio Unit

= [ GMadia
v :i‘ Novation

1= [ BassStation

] D Sonic Charge
v Poyvst Plug-In Devices Are

[ +dacimate-x Available from the
Plug-In Device Browser.

Consider an audio clip playing in an audio track. The audio signal from the clip reaches the
leftmost device in the chain. This device processes (changes) the signal and feeds the result
into the next device, and so on. The number of devices per track is theoretically unlimited.
In practice, the computer’s processor speed does impose a limit on the number of devices
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you can use at the same time, a topic that deserves separate discussion. Note that the
signal connections between audio devices are always stereo, but the software’s inputs and
outputs can be configured to be mono in the Audio Preferences.

When the signal has passed through the device chain, it ends up in Live's mixer. As the
Session and Arrangement share the same set of tracks, they also share the mixer. The mixer
can be shown in both views for convenience. To optimize the screen layout, the individual
mixer sections can be shown or hidden using the View menu’s entries.
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The mixer has controls for volume, pan position and sends, which adjust the contribution
each track makes to the input of any return tracks. Return tracks only host effects, and not
clips. Via their sends, all tracks can feed a part of their signal into a return track and share
its effects.

The mixer also includes a crossfader, which can create smooth transitions between clips
playing on different tracks. Live’s crossfader works like a typical DJ mixer crossfader, except
that it allows crossfading not only two but any number of tracks - including the returns.
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Devices that receive and deliver audio signals are called audio effects. Audio effects are the
only type of device that fit in an audio track or a return track. However, two more types of
devices are available for use in MIDI tracks: MIDI effects and instruments.

The Live Mixer in the
Arrangement View (Left)
and Session View (Right).

Live's Crossfader.
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Considera MIDI track playing a clip. The MIDI signal from the clip is fed into the track’s device
chain. There, it is first processed by any number of MIDI effects. A MIDI effect receives
and delivers MIDI signals. One example is the Scale effect, which maps the incoming
notes onto a user-defined musical scale. The last MIDI effect in the chain is followed by an
instrument. Instruments, for instance Live's Simpler and Impulse, receive MIDI and deliver
audio. Following the instrument, there can be any number of audio effects — as in an audio
track.
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If a MIDI track has no instrument (and no audio effects), then the track’s output is a plain
MIDI signal, which has to be sent somewhere else to be converted into audio. In this case,
the track’s mix and Send controls disappear from the mixer.

1 Audio 2 Mioi 3 MIDy 4 mipi

The Mixer for a MIDI
Track without an
Instrument.
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4.8 Presets and Racks

Every Live device can store and retrieve particular sets of parameter values as presets. As
presets are stored independently from Live Sets, new presets become part of a library that
any project can draw from.

Live's Instrument, Drum and Effect Racks allow saving combinations of devices and their
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settings as a single preset. This feature allows for the creation of powerful multi-device
creations and effectively adds all the capabilities of Live’'s MIDI and audio effects to the
built-in instruments.

4.9 Routing

As we have seen, all tracks deliver signals, either audio or MIDI. Where do these signals
go? This is set up in the mixer's In/Out section, which offers, for every track, choosers to
select a signal source and destination. The In/Out section, accessible through the View
menu’s In/Out option, is Live's “patchbay.” Its routing options enable valuable creative and
technical methods such as resampling, submixing, layering of synths, complex effects setups

and more.
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Signals from the tracks can be sent to the outside world via the computer’s audio and MIDI
interfaces, to other programs that are connected to Live via ReWire or to other tracks or
devices within Live. Tracks can also be combined into a Group Track which serves as a
submixer for the selected tracks.

Likewise, a track can be set up to receive an input signal to be played through the track’s
devices. Again, tracks can receive their input from the outside, from a ReWire program or
from another track or device in Live. The Monitor controls regulate the conditions under
which the input signal is heard through the track.

It is also possible to route signals to external hardware devices from within a track’s device
chain, by using the External Audio Effect and External Instrument devices.

Track Routing Is Set up
Using the In/Out Section
in the Arrangement (Left)
or Session View (Right).
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4.10 Recording New Clips

Audio tracks and MIDI tracks can record their input signal and thereby create new clips.
Recording is enabled on a track by pressing its Arm button. With multiple tracks selected,
pressing any of their Arm buttons will arm all of them. You can also hold down the
(PC)/ (Mac) modifier when clicking the Arm buttons to arm several tracks at once. If
the Exclusive Arm option is enabled in the Record Preferences, inserting an instrument into
a new or empty MIDI track will automatically arm the track. When the Control Bar's Record
button is on, every armed track records its input signal into the Arrangement. Every take
yields a new clip per track.
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It is also possible to record into Session View slots on the fly. This technique is very
useful for the jamming musician, as Session recording does not require stopping the music.
When a track is armed, its Session slots exhibit Clip Record buttons, and clicking one of
these commences recording. Clicking the Clip Record button again defines the end of

the recording and launches the new clip. As these actions are subject to real-time launch
quantization, the resulting clips can be automatically cut to the beat.

> 1 1B @ OVR | =+ .&

Session recording in conjunction with the Overdub option and Record Quantization is the
method of choice for creating drum patterns, which are built up by successively adding
notes to the pattern while it plays in a loop. It only takes a MIDI keyboard (or the computer
keyboard) and a MIDI track with Live’s Impulse percussion instrument to do this.

Track Arm Buttons, as
They Appear in the
Session View.

The Control Bar’s
Quantization Chooser.
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4.11 Automation Envelopes

Often, when working with Live's mixer and effects, you will want the controls’ movements
to become part of the Arrangement. The movement of a control across the Arrangement
timeline is called automation; a control whose value changes in the course of this timeline is
automated. Automation is represented in the Arrangement View by breakpoint envelopes,
which can be edited and drawn.

L) el (e | &

synth 1 2

m Track Panning +

( Clear Envelope

Practically all mixer and effect controls in Live can be automated, even the song tempo.
Creating automation is straightforward: All changes of a control that occur while the Control
Bar's Record switch is on become automation.

Changing an automated control’s value while not in Record Mode is similar to launching a
Session clip while the Arrangement is playing: It deactivates the control’s automation (in
favor of the new control setting). The control will stop tracking its automation and rest
with the new value until the Back to Arrangement button is pressed, which will resume
Arrangement playback.

4.12 Clip Envelopes

Envelopes are found not only in tracks but also in clips. Clip envelopes are used to modulate
device and mixer controls. Audio clips have, in addition, clip envelopes to influence the
clip’s pitch, volume and more; these can be used to change the melody and rhythm of
recorded audio. MIDI clips have additional clip envelopes to represent MIDI controller
data. Clip envelopes can be unlinked from the clip to give them independent loop settings,
so that larger movements (like fade-outs) or smaller gestures (like an arpeggio) can be
superimposed onto the clip’s material.

The Automated Pan
Control and its
Envelope.
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An Envelope for Clip
Transposition.

4.13 MIDI and Key Remote

To liberate the musician from the mouse, most of Live's controls can be “remote-controlled”
via an external MIDI controller. Remote mappings are established in MIDI Map Mode, which
is engaged by pressing the MIDI switch in the Control Bar.

In this mode, you can click on any mixer or effect control, and then assign it to a controller
simply by sending the desired MIDI message (for example, by turning a knob on your MIDI
control box). Your assignments take effect immediately after you leave MIDI Map Mode.
Session clips can be mapped to a MIDI key or even a keyboard range for chromatic playing.

MIDI keys and controllers that have been mapped to Live's controls are not available for
recording via MIDI tracks. These messages are filtered out before the incoming MIDI is
passed on to the MIDI tracks.

) =m 3% (5} The Key/I\/IIDI I\/Iap
Controls.

Session clips, switches, buttons and radio buttons can be mapped to computer keyboard
keys as well. This happens in Key Map Mode, which works just like MIDI Map Mode.

Live offers, in addition to this general purpose mapping technique, dedicated support for
the Akai APC40, which allows for mouse-free operation of the program.
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4.14 Saving and Exporting

Saving a Live Set saves everything it contains, including all clips, their positions and settings,
and settings for devices and controls. An audio clip can, however, lose the reference to its
corresponding sample if it is moved or deleted from disk. The links between samples and
their clips can be preserved with a special command, Collect and Save, which makes a copy
of each sample and stores it in a project folder along with the Live Set.

A separate Save button in the Clip View saves a set of default clip settings along with the
sample, so that each time the sample is dragged into the program, it will automatically
appear with these settings. This is especially useful if you have made warp settings for a clip
and want to use it in multiple Live Sets.

Exporting audio from Live can be done from both the Session and Arrangement Views.
Live will export the audio coming through on the Master output as an audio file of your
specifications via Export Audio/Video.

Live can also export individual MIDI clips as MIDI files.

Exporting and saving material for later use in Live can be done very conveniently with the
Live Clip format. Session View clips can be dragged back out of a Live Set to the File
Browsers, and thereby exported to disk as Live Clips.

Library *
Name
P ciips
= Bass
= Fingered Bass
[P Fingered Bass-Bass 1.alc
[*% Fingered Bass-Bass 2.alc
npeored Bass-oass 1.aic A Live Cllp in the File
D Industrial Bass Browser.

Live Clips are a very powerful way of storing ideas, as they save not only the clip’s Clip View
settings, but also the corresponding track’s instruments and effects chain. Live Clips in the
Browser can be previewed and added to any open Live Set just like sample files. In the Live
Set, they restore the original clip’s creative options.

Using Live Clips, you can build your own personalized library of:
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¢ MIDI sequences with matching instruments and effects, e.g., a MIDI drum pattern with
the associated Impulse and effects settings;

e Different regions or loops referencing the same source file;

e Variations of a sample loop created by applying Warp Markers, clip envelopes and
effects;

e |deas that may not fit your current project but could be useful in the future.

4.15 The Library

The Live Library acts as a repository of sounds that are available to all projects. In Live's
File Browsers, the Library is accessible through a bookmark. Bookmarks can be selected by
clicking the Browser's title bar to open the Bookmark menu:

Library = @
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Desklop
‘Workspace

My Documents
CiMultisamples\
E\Musik!
EN\Samplest
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The first time you run Live, it will automatically install its Library to your standard user folder.
You can, of course, move it to a new location. After installation the Library will already
contain a few sound ideas, courtesy of Ableton. We encourage you to experiment with this
material to get a sense of what the program can do, but we do not recommend removing
or changing the contents of the factory Library.

Ableton provides additional Library content in the form of Live Packs which are available
from installation CDs, DVDs or the Ableton website?. Owners of a boxed version of Live can

2h'c'cp://www.able‘con.com/downloads

Choosing the Library
Bookmark.


http://www.ableton.com/downloads
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enjoy the Essential Instrument Collection, a multi-gigabyte library of meticulously sampled
and selected instruments.
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Chapter 5

Managing Files and Sets

Various types of files are used in making music with Live, from those containing MIDI and
audio, to more program-specific files such as Live Clips and Live Sets. This chapter will
explain everything you need to know about working with each of these file types in Live.

However, we should first take a look at Live's File Browsers, through which most files arrive
in the program.

5.1 Working with the File Browsers

Live offers three File Browsers which can be accessed via their selector buttons.
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The File Browser
Selector Buttons.

Each Browser can point to a different disk location, which Live will remember across sessions.
The Browser display is divided into columns corresponding to “Name”, “Date,” “Live Pack,”
etc., which you can show and hide using the @ (PC)/ © (Mac) context menu options.

[ synth Rhythmic Today, 15:34
:." Synth Poly Today, 15:34
[ synth-Module-Poly Operator Adv 26.01.2009, 03:59 Showmg/Hldmg Browser
[ synth-Module-Mono Operator Adv 26.01.2009, 03:59 Columns
Columns can be reordered by drag and drop. To resize the columns, drag their divider lines
horizontally.
Live Devices o
Name Pack ‘]m- ':Emllndm-d Resizing Browser
|22] Synth-Hollow Ringer perator Adv 6.01.2009, 03:59 Columns

5.1.1 Browsing the Folder Hierarchy

Each of the three File Browsers has its own root directory, shown at the top of the Browser,
the contents of which are available for browsing below.
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The Browser root can easily be changed: The topmost Browser item, called “Parent Folder,”
will move the Browser root up one step up in the disk hierarchy when double-clicked.

(4] Livrary @

e Name
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& 7] Ssamples

You can also set the Browser root to any folder in the Browser via the & (PC) / 9
(Mac) context menu, by double-clicking the folder, or by selecting it and pressing .

() Library ~ [
@ Nama

[E] (Parent Folder)
Sl
QO =T
. = 7] Samples.

Moving through the files in Live’s Browser can be done with either the mouse or the computer
keyboard:

e Scroll up and down in the Browser with (#] and (¥, the mousewheel, or by clicking
and dragging while holding the (Ctd J(Alt (PC)/ [& WAL~ (Mac) modifier.

e Close and open folders with and PJ.

e Jump to the parent folder of any closed folder using [«. (Hint: If executed on a
top-level folder, this is an alternative to selecting the “Parent Folder” item, and will
move the Browser root up one level.)

To clean up the Browser, use @ (PC)/ [Ctl & (Mac) to access the context menu, and
then select the Close All Folders option to show only top-level folders. Double-clicking a

“Library” Is this
Browser's Root.

The File Browser’s
“Parent Folder” Item.

A Folder in the Browser.
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File Browser's selector button will do the same.

5.1.2 Browser Bookmarks

Using bookmarks, you can quickly save and recall frequently used folder locations in the
Browser. Clicking in the Browser’s title bar will open the Bookmark menu.

¥ Library
Current Project
Desktop
Workspace

My Documents

rEser
Samples

Sets

The Bookmark Menu.

The Bookmark menu lists a number of preset bookmarks such as Desktop and Library.
Selecting the latter will bring you to the Live Library. To bookmark the current Browser root,
choose the Bookmark menu’s topmost item, the Bookmark Current Folder command. Note
that if the current Browser root is already bookmarked, the topmost option in the Bookmark
menu will remove the bookmark. All File Browsers share the same set of bookmarks; a
bookmark stored in one Browser can be accessed from another.

5.1.3 Searching for Files

Live's File Browsers are equipped with a search function for finding files. Clicking the

Search button in the upper right corner of the Browser or using the (PC)/
(Mac) shortcut will open the Browser’s Search Mode.
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After entering your search terms, begin the search by clicking the Go button or pressing
on your computer keyboard.

Live will search the entire Browser root for your search terms. The results will include files
that match all search terms, as opposed to any. For example, if you search for “acoustic
bass,” the search will yield all acoustic bass sounds — not all acoustic sounds and all bass
sounds.

The search function matches the entered criteria not only to any part of a file’s name and
suffix (e.g., “.wav"”) but also to any part of its file path. This means that a search for “bass,”
for example, will yield not only files with names containing the word “bass” but also those
located in folders with names containing the word “bass.” Compressed sample metadata
tags are also included in the search, making it possible to search for songs from a specific
album or artist, for example. The names of MIDI tracks within multitrack MIDI files are also
included in searches.

Live maintains an index of the hard disk so that it can deliver search results instantly. The
index is kept up to date as you create, install, delete, rename and move files within Live
- it has no way of knowing, however, what you are doing outside of Live. If you have
subsequently moved files using programs other than Live, the initial results of a search
might be incomplete. The Go button’s label will change to “Rescan.” If you can't find a file
in the search results, or need to be sure that the results are comprehensive, click the Rescan
button (or Return] once more), and Live will rebuild its index for the current Browser root.

(4] cibrary~ ®

=) loa::) i(ﬂﬂﬂn)

- =] E Bass Detector - Part 1.alc

Activating Browser
Search Mode.

The Search Field and Go
Button.

The Rescan Button.
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Automatic rescanning for new searches can be activated and deactivated in the File/Folder

Preferences.

While a search/rescan is going on, the adjacent search button is labeled “Stop.” Rescanning
happens in the background, and you can keep making music while Live does its work, but
you can also abort the search with this button if the disk traffic is bothering you.

You can go back to the Browser's folder view at any time by closing the search field.

=) II;T' I

] E Bass Detector - Part J.alc
1> [} Bass Detactor - Synth Variation.alc
] E Fingered Bass - Bass 1.alc

If you select a file from the search results and then close the search field, Live makes sure
that file remains selected in the folder view, opening folders as required:

Library v @
Name

[E (Parent Folden)
v Py clips

v Py Bass

[*F% Bass Detector - Part 1.alc

[*F+ Bass Detector - Part 3.alc

[CTE Bame Pntmrtnr  Euambb Warietine

If a search is in progress, closing the field immediately stops the search, although navigating
to other Browsers does not. In fact, while you're waiting for a search to finish in one Browser,
you can initiate separate searches in the others. A Browser that is in an active search will
indicate this via a small rotating ring on the Browser button.

Closing the Search
Field...

... Locates the File Last
Selected Among the
Search Results.
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For mouse-free searching, we suggest the following sequence of shortcuts:
1) ([Cwl )& JF) (PC)/ (G #(&  JF] (Mac) to open the search field;
2) Type your search terms;

3) to "Go";

4)
5)
6)

to jump to the search results;
and to scroll the search results;
(PC) / (Mac) to close the search field and go

back to the folder view.

5.1.4 Previewing Files

Live allows you to preview samples and clips in the File Browser before they are imported
into the program. To enable previewing, activate the Preview switch next to the Preview Tab
at the bottom of the Browser.

The Rotating Ring
Means That a Search is
in Progress.



CHAPTER 5. MANAGING FILES AND SETS 38

Library « o
Nama Type
o
= Brass Attack
[} Brass Attack-A#2.ait Alff
Brass Attack-B3.aif Aiff
[} Brass Attack-Ce.aif Alff
Brass Attack-C#2.aif Adif
[} Brass Attack-D1.aif Aff
Brass Attack-ES.aif Aff

Hint: You can preview files even when the Preview switch is not activated by pressing
or .

Click on a sample file (or use and (%)) to select it. Click in the Tab's scrub area to make
playback jump to that point. (Note that it is not possible to scrub clips that have been saved
with Warp turned off.)

You can also select Live Clips in the Browser to load them into the Preview Tab, but they will
not play automatically. You can click on the tab or press ) to preview them.

With the Raw button enabled, files will preview at their original tempo and will not loop.
With Raw disabled, Live will try to preview files in sync with the current Set, so that you can
better judge which samples will work for you. Please note that scrubbing is not possible
when Raw is enabled.

The previewing volume can be adjusted using the mixer’s Preview Volume knob.

i
(T) ﬂEB
[Sala]

If your audio hardware offers multiple audio outs, you can privately audition, or cue, files
via headphones connected to a separate pair of outs — while the music continues to play.

e «

peoe

The Preview Switch.

The Preview Volume
Knob.
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To learn how to set up Live for cueing, please refer to the relevant section of the Mixing
chapter.

5.1.5 Adding Clips from the Browser

There are several ways to add clips to a Live Set:

e Files can be dragged and dropped from the File Browsers into tracks in the Session or
Arrangement View. Dragging and dropping material from the Browser into the space
to the right of Session View tracks or below Arrangement View tracks will create a new
track and place the new clip(s) there.

1 Guitar 2 Accordion | 3 Pilano Master e
= O = = 3 @
[ = . A
= B Fa_ O
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— e = Drop Files and e 4
(1> [utaea T = = S [ ST
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e In the Session View, double-clicking or pressing on a file in the Browser will
automatically create a new track to the right of the other tracks and load it with the
clip.

e Files can be dropped directly into Live from the Explorer (Windows)/Finder (Mac).

5.1.6 File Maintenance in the Browser

You can use Live's File Browsers for all of the file maintenance activities that you are familiar
with on your operating system.

* Move files and folders by dragging and dropping, or by copying/cutting and pasting.
Copying, cutting and pasting can be done with either Edit menu commands or key-
board shortcuts. A file can be moved from one File Browser to another by dragging it

over the target Browser's (&) button.

Dropping a Clip to
Create a New Track.
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¢ Rename files and folders using the Edit menu’s Rename command or the (Ctl ][R]
(PC)/ (& $R) (Mac) shortcut. Cancel renaming with the ([Esc ] key.

¢ Create folders by opening the context menu with &3 (PC)/ ® (Mac), and then
selecting the Create Folder command.

e Delete files and folders using the Edit menu’s Delete command or your computer’s
or [Delete] key. Deleting items within Live moves them to the system trash; if
necessary, you can recover items from the system trash via your computer’s operating
system.

5.1.7 Hot-Swap Mode

In addition to the drag-and-drop method of loading files from the Browser, Live offers a
Hot-Swap Mode to save you mouse travel. Hot-Swap Mode establishes a temporary link
between the Browser and, for example, a virtual instrument. While in Hot-Swap Mode,
you can step through samples or presets to audition them “in place,” that is, within the
instrument. Hot-swapping for presets is covered in the Live Device Presets section. Let's go
through an example of hot-swapping samples:

Live's built-in Impulse instrument features eight sample-player slots that can be filled by
dropping samples into them. Alternatively, we can click the Hot-Swap button that appears

as we move the mouse over a slot.

Clicking the Hot-Swap button engages Hot-Swap Mode: Live’s Hot-Swap Browser opens,
and the Hot-Swap icon appears next to one of the files shown.

Impulse

The Hot-Swap Button in
an Impulse Slot.
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While in Hot-Swap Mode, pressing the key loads that file into the Impulse slot
(presumably while Impulse is playing incoming MIDI notes); pressing [v], then Return] loads
the next sample, and so on. Instead of using the keys, we can also click on the file’s Hot-
Swap icon to load it. The link between the Browser and the instrument will be broken if a
different view is selected, or if the Hot-Swap button is pressed again. Hot-swapping can
also be cancelled with a press of the key or by pressing the close button in the
Hot-Swap bar at the top of the Browser.

When Hot-Swap Mode is re-entered, the Hot-Swap Browser will try to reconstruct what you
saw when you loaded the current file into the Impulse slot. If, for instance, the current
file was found by searching for “gretsch kick,” the Hot-Swap Browser will come up with
that search string in the search field. In our example, we were hot-swapping for an empty
Impulse slot, so Live came up with something appropriate: a search for “Drum Kick” in
Library/Samples/Waveforms.

The Hot-Swap Browser.
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5.2 Sample Files

A sample is a file that contains audio data. Live can play both uncompressed file formats
(WAV, AIF, REX and Sound Designer Il for Mac) and compressed file formats (MP3, AAC,
Ogg Vorbis, Ogg FLAC and FLAC).

A note on using Variable Bit Rate (VBR) files: Please install QuickTime for decoding purposes
if you do not already have it on your system. It can be downloaded from the Apple website!.

As Live plays the samples directly from disk, you can work with a large number of (large)
samples without running into RAM memory limitations. Please note, however, that you may
run into disk throughput problems if your disk is nearly full, and/or (on Windows systems)
highly fragmented. Hard drive rotation speed can also affect disk performance. Refer to
the section on managing the disk load for more information.

Live can combine uncompressed mono or stereo samples of any length, sample rate or bit
depth without prior conversion. To play a compressed sample, Live decodes the sample and
writes the result to a temporary, uncompressed sample file. This usually happens quickly
enough that you will be able to play the sample right away, without waiting for the decoding
process to finish.

Note: When adding a long sample to a project, Live might tell you that it cannot play the
sample before it has been analyzed. Please see the section on analysis for an explanation.

5.2.1 The Decoding and Web Cache

To save computational resources, Live keeps downloaded Sets and the decoded sample files
of compressed samples in the cache. Maintenance of the cache is normally not required, as
Live automatically deletes older files to make room for those that are new. You can, however,
impose limits on the cache size using the File/Folder Preferences’ Decoding & Web Cache
section. The cache will not grow larger than the Maximum Cache Size setting, and it will
always leave the Minimum Free Space on the hard disk. Pressing the nearby Cleanup button
will delete all files not being used by the current Live Set.

1http://Www.app|e.com/<:|uicktime/downIoad


http://www.apple.com/quicktime/download
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File Documents and Settings\dds\Apg

Folder Decoding & Web Cache
Record Minimum Free Space 500.00 MB
W
) o Maximum Cache Size of 10.00 GB | (Cleanup)
aunch
Cache Folder
CPU CDocuments and Settings\dds\Appiication Data\AbletonCache\Cache
User Account Plug-In Sources

Licenses

Rescan Plug-ins Resca

5.2.2 Analysis Files (.asd)

An analysis file is a little file that Live creates when a sample file is brought into the program
for the first time. The analysis file contains data gathered by Live to help optimize the
stretching quality, speed up the waveform display and automatically detect the tempo of
long samples.

When adding a long sample to a project, Live might tell you that it cannot play the sample
before it has been analyzed. This will not happen if the sample has already been analyzed
(i.e., Live finds an analysis file for this sample), or if the Record/Warp/Launch Preferences’
Auto-Warp Long Samples preference has been deactivated. To prevent waiting for analysis
of longer samples, you can pre-analyze them via the Browser, as we will see in a moment.

An analysis file can also store default clip settings for the sample:

Clicking the Clip View's Save button will store the current clip’s settings with the sample’s
analysis file. The next time the sample is dragged into Live, it will appear with all its clip
settings intact. This is particularly useful for retaining Warp Marker settings with the sample.
Storing default clip settings with the analysis file is different from saving the clip as a Live
Clip.

While analysis files are a handy way to store default information about a particular sample’s
settings, keep in mind that you can use different settings for each clip within a Live Set —
even if those clips refer to the same sample on disk. But if you drag a new version of the
sample into a Live Set, Live will use the settings stored in the analysis file for the newly
created clip.

Preferences for the
Decoding and Web
Cache.
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The analysis file’s name is the same as that of the associated sample, with an added “.asd”
extension. Live puts this analysis file in the same folder as the sample.

Begh Samples that have an .asd file are displayed like this in the Browser.

] Samples without an .asd file look like this.
The analysis files themselves do not appear in Live's Browsers.

Note that you can suppress the creation of .asd files by turning off the Create Analysis Files
option in the File/Folder Preferences. All data (except for the default clip settings) can be
recreated by Live if the .asd file is missing, however this will take some time for longer
samples.

5.2.3 File Pre-Analysis

To avoid waiting for longer samples to be analyzed the first time they are imported into Live,
you may want to pre-analyze them.

To pre-analyze all the files contained in any folder in the Browser, use the & (PC)/ o
(Mac) context menu’s Analyze Audio command. This process can also be cancelled via the
context menu.

5.2.4 Exporting Audio and Video

The File menu’s Export Audio/Video command allows you to export Live's audio output as
new samples. The resulting files can be used to burn an audio CD for listening purposes or
a data CD, which could serve as a backup of your work or be used with other digital audio
applications. If your set includes video, you can also use the Export Audio/Video command
to export this to a new video file, which will be created in the same directory as the rendered
audio files.
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Which Signal Will Be Rendered?

Data

Rendared Track 1!
Master

Al Tracks
Wik

Simpler Bass
3-Impulse
A-Returmn
B-Relum

Normalize:

Render as Loap:

Audio

File Type:

Convert to Mono

The Export dialog’s Rendered Track chooser offers several options for which audio signal to
render:

e Master — the post-fader signal at Live’s Master output. If you are monitoring the Master
output, you can be sure that the rendered file will contain exactly what you hear.

o All tracks — the post-fader signal at the output of each individual track, including return
tracks and MIDI tracks with instruments. Live will create a separate sample for each
track. All samples will have the same length, making it easy to align them in other
multitrack programs.

e Individual tracks — the post-fader signal at the output of the selected track.

When Export Audio/Video is invoked while the Arrangement View is up, Live will render the
selected time range.

If you would like to render the current Arrangement loop, choose the Select Loop command
from the Edit menu prior to choosing Export Audio/Video. If you choose Export Audio/
Video while the Session View is up, Live will ask you to specify the length of the sample
to be rendered. The Export Audio/Video dialog will come up with a bars-beats-sixteenths
field where you can type in the desired length. Live will capture audio starting at the current
play start position for whichever duration you have specified.

Remember — a rendered audio file contains only what you heard prior to rendering. So, for
example, if you're playing back some combination of Session View clips and Arrangement
material, then that is what will be captured in your rendered file — regardless of which view
is active when you render.

The Rendered Track
Chooser.
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Audio Rendering Options

Data

Renderad Track: Masie

Normalize: [on |
Render as Loop: IIl
Audio

File Type:
Convert to Mono: -
Sample Rate:
Bit Depth:
Dither Options:
Create Analysis File: =

Video

Create Video File:
Video Encoder: JUickTime Mowie
Edit Video Encoder Settings:

Live will rendar the output of the chosen track

owar the selected time range [1.1.1 - 1.1.2]

OK__) ( Cance Audio Rendering
Options.

The Export dialog offers several audio rendering options:

e Normalize - If this is activated, the sample resulting from the render process will be
normalized (i.e., the file will be amplified so that the highest peak attains the maximum
available headroom).

e Render as Loop - If this is activated, Live will create a sample that can be used as a
loop. For example, suppose your Live Set uses a delay effect. If Render as Loop is on,
Live will go through the rendering process twice: The first pass will not actually write
samples to disk, but add the specified delay effect. As the second pass starts writing
audio to disk, it will include the delay “tail” resulting from the first pass.

o File Type, Bit Depth, Sample Rate — These options specify the type of sample to be
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created.

e Convert to Mono - If this is activated, Live will create a mono file instead of a stereo
file.

e Dither Options — If you are rendering at a bit depth lower than 32-bit, choose one
of the dither modes. Dithering adds a small amount of noise to rendered audio, but
minimizes artifacts when reducing the bit depth. By default, Triangular is selected,
which is the “safest” mode to use if there is any possibility of doing additional pro-
cessing on your file. Rectangular mode introduces an even smaller amount of dither
noise, but at the expense of additional quantization error. The three Pow-r modes
offer successively higher amounts of dithering, but with the noise pushed above the
audible range. Note that dithering is a procedure that should only be applied once
to any given audio file. If you plan to do further processing on your rendered file, it's
best to render to 32-bit to avoid the need for dithering at this stage. In particular, the
Pow-r modes should never be used for any material that will be sent on to a further
mastering stage — these are for final output only.

e Create Analysis File — If this is activated, Live will create an .asd file that contains
analysis information about the rendered sample. If you intend to use the new sample
in Live, check this option.

Real-Time Rendering

Normally, rendering happens as an offline process. But if your set contains an External
Audio Effect or External Instrument that routes to a hardware effects device or synthesizer,
the rendering process is a bit different. In this case, rendering the master output happens
in real time. If you render individual tracks, all tracks that don’t route to an external device
anywhere in their signal paths will be rendered offline. Then, any tracks that do access these
devices will be rendered in real time. Live will automatically trace each track’s signal flow
and detect if real-time rendering is necessary. You'll then be presented with several options
when you start to render:
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Waiting for external instruments & affects to becoma silent...
& of seconds remaining. SIP

@I Auto-Restart on drop-outs Waiting fOf' External

Reslar ) | Cancel ) Devices to Become
Silent.

e Skip — By default, Live will wait for ten seconds before starting a real-time render. This
should allow any sound from external devices to fade out, but if you need more time
(for example, if you're waiting for a long reverb tail), you can increase the wait time
by typing a new number in the number box. On the other hand, if you're sure that
your external devices aren’t making any sound, you can speed the process along by
pressing “Skip,” which will start the render immediately.

After the render has begun, the dialog changes to show a recording progress bar:

Rendering Audio to Disk (in real-tima)...

@ Auto-Rastart on drop-outs (Attempts: 2)

Reslar ) § Cancel ) Real-Time Rendering in

Progress.

e Auto-Restart on drop-outs — Rendering in real-time requires somewhat more CPU
power than non-real-time rendering, and in some cases drop-outs (small gaps or
glitches in the audio) can occur. Live detects when drop-outs happen, and rendering
will start again from the beginning if the Auto-Restart option is enabled.

e Restart — manually restarts the rendering process.
e Cancel - stops the rendering process and deletes the partially rendered file.

The number of rendering attempts (if there has been more than one) will also be listed in
the dialog box. If you find that dropouts and restarts keep happening, you should close
other running applications to allow more processing power for rendering. Please see the
chapter on computer audio resources for more tips on improving performance.
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Rendering Video

Video
Create Video File: [on |
Video Encoder: QuickTime Movie =
Edit Video Encoder Sattings: (_Edn )
Live will render the output of the chosan track
ovar the salected time range [8.1.1 - 12.1.1)

he rendered audio file is then used to create a
video, which will be saved in the same

directory as the audio file

In addition to settings for audio rendering, the Export dialog provides additional options
for rendering video:

e Create Video File - If this is activated, a video file will be created in the same directory
as your rendered audio. Note that this option is only enabled if you have video clips
in the Arrangement View. Also, it is not possible to only render a video file — enabling
video rendering will always produce a video in addition to rendered audio.

e Video Encoder - This chooser allows you to select the encoder to use for the video
rendering. The choices you have here depend on the encoders you have installed.

e Edit Video Encoder Settings — This button opens the settings window for the selected
encoder. Note that the settings options will vary depending on the encoder you have
chosen. Certain encoders have no user-configurable options. In this case, the Edit
button will be disabled.

Once you've made your selections and clicked OK to begin the rendering process, audio
rendering will begin. After the audio rendering is complete, the video will be rendered.
Note that, depending on the encoder used, video rendering may occur in more than one
pass. Live will display a progress bar that will indicate the status of the process.

Unless you've specified a special window size or aspect ratio in the encoder settings, the
rendered video file will play back exactly as it appeared during real time playback in Live.
The video file will also contain the rendered audio.

Video Rendering
Options.
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For more information about working with video in Live, see the chapter on video.

5.3 MIDI Files

A MIDI file contains commands that prompt MIDI compatible synthesizers or instruments,
such as Live's Simpler, to create specific musical output. MIDI files are exported by hardware
and software MIDI sequencers. Importing MIDI files into Live works differently than with
samples: MIDI file data is incorporated into the Live Set, and the resulting MIDI clips lose all
reference to the original file. MIDI files appear as folders in the File Browser; opening the
folders gives you access to the file's individual tracks (also called “voices” or “instruments”).

Desktop~ ®
Name
[E) (Parent Foider)

[ Tango Project

v [4] bach_g47.mid
[2] Piano right
[2] Piano left
m Fuga 1
II‘ Fuga 2

200000

Ty @.,‘

Iz‘ Fuga 3

Note that while you can rename or delete entire MIDI files via the Browser, this is not
possible with the individual MIDI tracks contained within them. This is also the case with the
individual components of Live Sets.

5.3.1 Exporting MIDI Files

Live MIDI clips can be exported as Standard MIDI files. To export a MIDI clip, use the File
menu’s Export Selected MIDI Clip command. This command will open a file-save dialog,
allowing you to choose the location for your new MIDI file.

Exporting a MIDI file is different from saving the clip as a Live Clip.

A MIDI File and its
Tracks in the Browser.
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5.4 Live Clips

Individual clips can be exported to disk in the Live Clip format for easy retrieval and reuse in
any project. Because they only contain references to samples on disk (rather than the audio
data itself), Live Clips are very small, which makes it easy to develop and maintain your own
collection.

To save a clip from the open Live Set to disk, simply drag it to the File Browser and drop
it into any folder. Live will manage the copying of the clip’s sample into this new location
based on the selection in the Collect Samples on Export chooser. You can then type in a
new name for the clip or confirm the one suggested by Live with [Return].

Library v

Name

I} Fingered Bass
Fingered Bass-Bass 1.alc

[*F% Fingered Bass-Bass 2.alc

ngere S55-035% J.3C

| Industrial Bass

Live Clips are a great way of storing your ideas for later use or development, as they save
not only the original clip, including all its clip and envelope settings, but also the original
track’s devices. In order to recreate a Live Clip’s device chain, either import it into a track
containing no clips or devices, or drag it into the space in the Session or Arrangement View
containing no tracks. Note that Live Clips that are imported into tracks already containing
devices or clips will appear with their clip settings but not their devices. You could, for
instance, drop a bassline Live Clip on an existing track that drives a bass instrument, rather
than creating a new track.

Clips belonging to any Live Sets already on disk are also Live Clips. Please see the section
on merging Sets for more on this topic.

Note that storing default clip settings with a sample’s analysis file is different from saving a
Live Clip. The default clip in the .asd file annotates the sample with sensible default values
(warp, gain and pitch settings) so that it will play in a defined way when it is added to a Set.
Live Clips, on the other hand, are stored on disk as separate musical ideas. For example, you

A Live Clip in the
Browser.
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could create a number of variations from the same audio clip by using different warp, pitch,
envelope and effect settings, and store them all as separate Live Clips. In the Browser, you
could then independently sort and preview these clips, even though they are all referring to
the same source sample.

5.5 Live Sets

The type of document that you create and work on in Live is called a Live Set. Think of
this as a single “song.” Sets must be saved inside projects, so that Live can keep track of
and manage all of the various components of the Live Set: Live Clips, device presets, any
samples used, etc.

5.5.1 Creating, Opening and Saving Sets

Use the File menu’s New Live Set command to create new Live Sets, and the Open or Open
Recent command to open existing ones. In the File Browser, you can double-click or press
on a Live Set to open it.

The File menu’s Save command saves the current Live Set exactly as it is, including all clips
and settings.

You can use the Save As command to save the current Live Set under a different name
and/or in a different directory location, or the Save a Copy command to create a copy of
the current Live Set with a new name and/or new directory location. Live Sets can also be
saved to the Ableton server via the Share Live Set command. Uploaded Sets can then be
shared with other Live users.

5.5.2 Merging Sets

Live makes it easy to merge Sets, which can come in handy when combining work from
different versions or pieces. To add all tracks (except the return tracks) from one Live Set
into another, drag the Set from the File Browser into the current Set, and drop it onto any
track title bar or into the drop area next to or below the tracks. The tracks from the dropped
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Set will be completely reconstructed, including their clips in the Session and Arrangement
View, their devices, and their automation.

impuiseor 2 Simpier e 3 Opsass | [mesier

Session View Drop Area
for Importing Live Sets.

Arrangement View Drop
Area for Importing Live

Sets.
If you prefer to import individual tracks from a Set, you can unfold the Live Set in the File
Browser just as if it were a folder.
o Desktop ¥ @
Name Type Date Modified
Dﬁol: Remix 18.08.2008, 16:2
o AOC Remix Project 24.04.2008, 13:1
@ [ samples 23.04.2008, 13:1
AOC Remix.als Live Set 24.04.2008, 09:4
Live Set 24.04.2008, 13:1
. MIDI Track
@ MIDI Track
@ MIDI Track
MIDI Track
- MIDI Track
I Sroons Unfolding a Set to
Wave Lo LoLLE Reveal its Contents.

You can now drag the individual tracks and drop them as described at the beginning of this
section. Any grooves that were saved with your Set are also available as a folder within the
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unfolded Set.

Of the three tracks contained in the Set shown in the following figure, two contain Session
View clips. These can be accessed by unfolding the tracks:
) o e
v E Tango.als
v Eﬁuhn
[ metody
[FF= variation

You can browse, preview and import Session View clips from the Set as if they had been
stored as individual Live Clips. This, basically, means that any Live Set can serve as a pool
of sounds for any other, suggesting creative reuse and crossover.

5.5.3 Exporting Session Clips as New Sets

You can export a selection of Session View clips as a new Live Set by dragging them to the
File Browser. To export a Set, first click and drag, or use the or ([Cul ) (PC)/
(Mac) modifiers, to select more than one Session View clip. Then, simply drag the clips to
a folder in the File Browser, where you can either confirm Live's suggested name or type in
one of your own.

5.5.4 Template Sets

Use the File/Folder Preferences’ Save Current Set as Default button to save the current Live
Set as the default template. Live will use these settings as the initialized, default state for
new Live Sets. You can use this to pre-configure:

e Your multichannel input/output setup.
e Preset devices, like EQs and Compressors, in every track.

e Computer key mappings.

Revealing the Session
View Clips Contained in
a Set.
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e MIDI mappings.

The template Live Set, “Template.als,” is located in Live's Preferences folder and can be
copied or deleted from there. The easiest way to locate this folder is to search your disk for
“Template.als.”

In addition to the template Set that loads by default, the Live Library contains a folder
called “Templates.” This is a collection of Sets with pre-configured tracks and routing
configurations for a variety of common recording scenarios.

5.5.5 Viewing and Changing a Live Set's Sample References

To view a list of the samples referenced by the current Live Set, choose the Manage Files
command from the File menu, click the Manage Set button, and then click the View Samples
button. Live will display one line for each sample used by the Live Set. To list all clips or
instruments in the Live Set where the sample is actually used, click the triangle to expand
the line. Here is what you can do:

¢ Replace a sample - Dragging a sample from the File Browser and dropping it on an
entry in the list makes the Live Set reference the new sample instead of the old one.
For samples used in audio clips, Live retains the clip properties; the Warp Markers
are kept if the new sample has the same or a greater length as the old sample and
discarded otherwise. Please note that replacing a sample will change all clips in your
set that reference this sample.

¥ Replace Files it
List of referencad files all mé more
Name Location Candidates
i3 Edit Drumiloop.wav External
@ = Drumloop.wav Project Drumicop-1

TUITOO . Wa OB e rary

e Hot-swap samples — Using the Hot-Swap button at the left-hand side of each entry,
you can quickly browse through alternatives for the sample that is currently being
referenced. This is like dragging samples here, only quicker.

Every Entry in the
Sample Reference List is
a Drop Target for
Samples.
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& [Edn Drumiloop.waw Extarna
Edit Drumiloop.wanw Project Drumlocop-1
(7 Edit Drumloop.wav Project Live T Library

¢ Edit a referenced sample - using an external application (which can be chosen in the
Preferences’ File/Folder tab). Clicking the Edit button will open the referenced sample
in the external application. The sample will remain offline as long as the Edit switch is
engaged. For samples used in audio clips, the current set of Warp Markers is retained
only if the sample length remains the same as before.

Edit Drumloop. wav Externa
.. Drumloop. wanv Project Drumiloop-1
Edit Drumloop.wav Project Live T Library

e View a sample’s location — The Location column states if a sample is missing, or if it
resides in the Live Library, a Project or somewhere else (“external”). When unfolded,
the entry shows the specific places in the Set where the sample is used.

Edit Drumloop.wav Extarnal
Edit Drumloop. way Project Drumioop-1
chorus loop [FF 2-Audio

Eait Drumiloop.wav Library

5.6 Live Projects

A Live Project is a folder containing Live-related files that belong together. Consider, for
example, work on a piece of music: You start out with an empty Live Set; you record audio
and thereby create new sample files; you drag in samples from collections; you save different
versions of the Live Set along the way so that you can go back and compare. Perhaps you
also save Live Clips or device presets that “belong” to this particular musical piece. The
project folder for this Live Project will maintain all the files related to this piece of music —
and Live's File Manager will provide the tools you need to manage them.

The Sample Reference
List's Hot-Swap Button.

The Sample Reference
List's Edit Switch.

The Sample Reference
List’s Location Column.
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5.6.1 Projects and Live Sets

You can manually create a Project by clicking & (PC)/ ® (Mac) in the Browser and
selecting Create Project from the context menu. Usually, Live takes care of this automatically.
When you save a Live Set under a new name or in a new folder location, Live will create a
new project folder and store the Live Set there — unless you are saving the Live Set into an
existing Live Project. Let's look at an example to illustrate this process:

We have recorded some audio into a new Live Set. We now save the Live Set under the
name “Tango” on the Desktop. Here is the result as displayed by the Live Browser:

|
Desktop ™ @
Nama
(Parent Folder)
v [&7 Tango Project
v D‘ Samples
= [P Recordad
el 0001 1-Guitar.wav
[ 0001 2-Accordion.wav

= Tango.als

The project folder (“Tango Project”) contains the Live Set (“Tango.als") and a Samples folder,
which in turn contains a Recorded folder with two samples in it. Note that the current Project
is also indicated in the title bar of Live's application window.

Next, we record another track into our Project. We save the modified version of the Live
Set under a new name so that we do not lose the previous version. Accepting the Save As
command’s default suggestion, we store the new version of the song in the Tango Project

folder.

A Live Set and its
Recordings in a Live
Project Folder.
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Desktop~ @
Name
[ (Parent Foidar)
w [&7 Tango Project
v :i‘ Samples
7 P77 Recorded
Frg 0001 1-Guitar.wav
el 0001 2-Accordion.wav
e 0001 3-Piano.wav
= B Tango with Piano.als
] Tango.als

LA ®O06000

The Tango Project now contains two Live Sets, and its Samples/Recorded folder contains
the samples used by both of them.

And now for something completely different: We choose the File menu’s New command
and record a samba tune. As this has nothing to do with our tango dabblings, we decide
to save it outside the Tango Project folder, say on the Desktop. Live creates a new project
folder named Samba Project next to Tango Project.

el 0001 1-Guitar.wav
[Fegh 0001 2-Accordion.wav
[ 0001 3-Pianc.wav

> [ Tango with Pianc.als

So far we have seen how to create Live Projects and save versions of Live Sets into them.
How do we open a Project? Simply by opening any of its contained Live Sets. Double-
clicking “Tango with Piano.als” opens that Set and the associated Project — as displayed in
Live's title bar.

Let's suppose that, in the course of our work on “Tango with Piano.als,” we get sidetracked:

A Second Version of the
Live Set Has Been
Added to the Project.

A New Project Was
Added Next to Tango
Project.
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The piece evolves towards something entirely different, and we feel that it should live in a
Project of its own. So, we “Save As...” under a new name and in some location outside the
current Project, say the Desktop:

=

[E3 (Parant Foider)
0 7 [&7 Electro with Piano Project

el 0001 1-Guitar.wav
e 0001 2-Accordion.wav
5} 0001 3-Piano.wav

= [ Tango with Piano.als

= Ml Tannaals

Note that the new project folder has no Samples folder (yet). “Electro with Piano.als” is
still referencing the piano sample from the original Tango Project. There is nothing wrong
with this except for when the Tango Project is moved away or deleted; then “Tango with
Piano.als” will be missing samples. You can prevent this by collecting samples. Even after
the fact, Live's tools for searching missing samples can help solve this problem.

There is actually no need to keep a Project’s Live Set exactly one level below the Project
itself. Within a project folder, you can create any number of sub-folders and move files
around to organize them as desired, although you many need to use the File Manager to
“teach” the Project about the changes you've made.

In general, Live will do what it can to prevent situations such as orphaned (Project-less) Live
Sets (and Live Clips and presets), which have the potential of confusing both the user and
Live's file management tools. It cannot, however, control situations in which Sets or files are
moved out of order and become disorganized via the Explorer (Windows)/Finder (Mac).

A note for users of older Live versions: Live 8 does not allow overwriting Live Sets that were
created by older versions to prevent compatibility problems. Instead, you will be requested
to “Save As...". Doing this will insure that the newly saved Live Sets reside in project folders.

A New Project Was
Added by Saving a Live
Set Outside its Original
Project.
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5.6.2 Projects and Presets

By default, new instrument and effect presets are stored in the Live Library, making them
available to any project. At times however, it may make more sense to save a preset with
the current Project. You might, for example, want to keep a number of alternative master
EQ settings for a given piece. These EQ presets are specific to the piece and of little use
to other Projects. For this reason, every device in the Device Browser has a Current Project
sub-folder. You can drag a preset to this folder after saving it, or simply drag the title bar of
the device and drop it there directly.

Live Devices (&)

MName

D Compressor

[ oynamic Tube

[l EQ Eight
[ Eright Acoustic Guitar
[l center Kiil
[ cheesy Speaker

[ Clear Acoustic Guitar
7 [a ] Current Project (Electro with Piano)
[ Hi Boost
[ Treble Boost

[l Ercsion

When saving presets that contain samples to a new location, Live may copy the samples
depending on the settings in the Collect Samples on Export chooser in the File/Folder
Preferences. You can then type in a new name for the device or confirm the one suggested

by Live with Return].
Project-Specific Presets Appear Under “Current Project” in the Device Browser.
5.6.3 Managing Files in a Project

Live's File Manager offers several convenient tools for managing Projects. Once you've
opened a Live Set that is part of the Project you wish to manage, choose the Manage Files
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command from the File menu, and then click the Manage Project button. The File Manager
will present you with an overview of the Project’s contents and tools for:

e locating samples that the Project is missing;

collecting external samples into the Project;

listing unused samples in the Project;

packing a Project in Live Pack format;

exporting the Project’s contents to the Library.

5.7 The Live Library

The Live Library acts as a repository of commonly used files, such as samples, clips and Live
Device Presets, that are available to all Live Projects. In Live's File Browsers, the Library is
accessible through a bookmark:

Library »

Naf
H’
Deskiop
‘Workspace

My Documents
CMultisamplest
EMusikh
E\Samples\

vy| v\ v|\vwv

a

Clips can be conveniently saved in Live Clip format for later reuse by dragging them from
the open Live Set into the desired folder in the Library. Device presets are saved in the
Library by default (but you can also save them with a Project).

Ableton delivers Library content that can serve as a starting point for creative exploration.
Content is shipped in the form of Factory Live Packs. Factory Live Packs are available from
installation CDs, DVDs or the Ableton website?. To install a Factory Live Pack in the Library,

2http://www.ableton.com/down loads

Choosing the Library
Bookmark.


http://www.ableton.com/downloads
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double-click the Live Pack file (.alp), drag it into the Live main window, or locate it via the
File menu's Install Live Pack command.

A list of the currently installed Factory Live Packs is available from the Preferences’ Library
tab. Here you can select Live Packs from the list and click the Uninstall button to remove
them. Multiple Live Packs can be selected and uninstalled at once.

By default, the Live 8 Library contains the following sub-folders:

Ableton Project Info — contains files that Live uses to identify the Library and keep track
of what Live Packs have been installed. You should not use or modify this folder or its
contents.

Clips — contains Live Clips, example Sets, construction kits (Session View-based song
ideas), loops and other related items. The actual contents of this folder will vary,
depending on what products and Live Packs you have installed. You can use this
material in your own musical productions, or to get hints about ways to use Live. The
construction kits, in particular, can be used in a variety of ways. Loading an entire
construction kit loads a new Live Set. You can also unfold the Set in the Browser and
import individual tracks or clips into a Set that's already in progress.

Defaults — presets placed into the default device folders will load in place of Live's
generic device settings. Additionally, the Defaults folder contains several special
folders corresponding to user actions such as slicing and sample dropping. Presets
placed in these folders define what Live will do when you perform the action.

Grooves — all of Live's factory groove files.

Lessons — all of Live's built-in lessons, as well as any additional images and Live Sets
that the lessons refer to. You should not change anything in this sub-folder.

Presets — contains all of the factory presets for Live’s devices.
Samples - contains all of the samples that are used by Live's presets.

Templates — contains a collection of template Sets with pre-configured tracks and
routing configurations for a variety of common recording scenarios.

After you've been using Live for a while, you'll probably find that there are additional
folders in your Library. This is normal. Installing Live Packs, recording your own samples, or
performing other common procedures will change the folder structure over time.
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5.7.1 Changing the Library Location, Upgrading an Old Library

The Library can reside in the hard drive location of your choice. In the Preferences’ Library
tab, you will find the Library Location chooser, which contains a list of Library locations that
you've used in the past:

Library Location
|C'tD0¢umel'\lS- and Setlings\dds'\My DQCumeI’ILS\-ﬂNeICIﬁ\BeE?Libl-clvl (_Browse |

If any of these previous Library locations are now unavailable (perhaps because of an
unattached external drive, a moved or renamed folder, or an angry roommate) these will
appear greyed-out in the list. If you know that these unavailable locations are gone for
good, you can remove them by using the Clear Unavailable Locations option at the bottom
of the chooser:

Library Location

C \doppelkeks) (Unavailable) w| |

ChDocuments and Settings\Dennis DeSantis\My Documentsiakielon
C\Documents and Settings\Dennis DeSantis\My Documentsimanypies -
Clear Unavailable Locations

You can also use the Browse button next to this chooser to create a new Library by pointing
to an empty folder or creating a new one. Once you've selected a Library path, one of
several possibilities will occur, depending on the new location:

o If the target location is an empty folder on a different hard drive, you will be given the
option to copy your current Library to this new location. Live will then offer to open a
Explorer (Windows)/Finder (Mac) window so that you can delete the Library from the
old location.

o If the target location is an empty folder on the same hard drive, you will be given the
option to move your current Library to this new location.

o If the target location is not empty but does not contain a Library, Live will create a
subfolder called “Library” at this location, and then offer to copy/move the old Library
contents.

In all three of these cases, you may also choose to create a new Library, without copying

The Library Location
Chooser.

Unavailable Library
Locations can be
Cleared from the List.
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or moving any content from the previous location. Live will then offer to install any default
packages to the new location.

e If the target location is a Library that was made with an older version of Live, you will
be warned about possible compatibility issues. It is generally not a good idea to try
to share a single Library between two different versions of Live.

Note: Live will not allow you to create a Library inside an existing Project.

5.7.2 Importing Projects into the Library

You can merge the contents of a Live Project into the Library to make them available to any
Project. To do this, & (PC)/ (Ctl ] (Mac) on a Project folder in the File Browser and
select the Manage Project command.

5.8 Locating Missing Samples

If you load a Live Set, Live Clip or preset that references samples which are missing from their
referenced locations, Live's Status Bar (located at the bottom of the main screen) will display
a warning message. Clips and instrument sample slots that reference missing samples will
appear marked “Offline,” and Live will play silence instead of the missing samples.

Live's File Manager offers tools for repairing these missing links. Click on the Status Bar
message to access these. (This is actually a shortcut for choosing the Manage Files command
from the File menu, clicking the Manage Set button, and then clicking the Locate button
found in the Missing Files section.) The File Manager will present you with a list of the
missing files and associated controls.
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@ Missing Files @0@®
3 of the refarenced samples are missing.
= Automatic Search (Go )
| Meme  Loostion Caedih
@  Bass Detector.wav Missing nia
@  Bass Detector.wav Missing  nia The File Manager's List
@  Bass Detector.wav Missing  nfa

of Missing Samples.

5.8.1 Manual Repair

To manually fix a broken sample reference, locate the missing sample in the File Browser,
drag it over to the File Manager and drop it on the respective line in the list of missing files.
Note that Live will not care if the sample you offer is really the sample that was missing.

5.8.2 Automatic Repair

Live offers a convenient automatic search function for repairing sample references. To send
Live on a search, click the Automatic Search section’s Go button. To reveal detailed options
for guiding the automatic search function, click the neighboring triangular-shaped button.
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Manager.

e Search Folder —includes a user-defined folder, as well as any sub-folders, in the search.
To select the folder, click the associated Set Folder button.

e Search Project — includes this Set’s project folder in the search.
e Search Library — includes the Live Library in the search.

For each missing sample, the automatic search function may find any number of candidates.
Let's consider the following cases:

e No candidate found - you can choose another folder and try again, or locate the
sample manually.

¢ One candidate found — Live accepts the candidate and considers the problem solved.

e Several candidates found — Live requires your assistance: Click the Hot-Swap button
(i.e., the leftmost item in every line of the list of missing samples) to have the File
Browser present the candidates in Hot-Swap Mode. You can now double-click the
candidates in the File Browser to load them, as the music plays if you like.
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5.9 Collecting External Samples

To prevent a Live Set from containing broken sample references, Live provides the option

of collecting (i.e., copying) them into the Set's project folder. This is accomplished via the
File Manager:

e Choose the Manage Files command from the File menu

e Click the Manage Set button
¢ Unfold the triangular-shaped fold button in the External Samples section.

¥) Current Live Set + o

View and Replace Samples

Click below to view all samples used by

the current Live Set
View Samples
Missing Samples

There are no missing samples

T External Samples
This Live Set uses external samples. Live
can collect them for you and copy them
into the current Project folder. Taell me
more.
1 samplo from the Library
(458 Bytos)
Gollect Into Project [ e

& factory samples from the (____Show
Library (3.1 MB)

Gollect Into Project W ]

4 pla from [ Show ]
Projact (4.6 MB)

Collect Into Project [ |

1 sample from elsewhere
(754 KB)

Collect Into Project |

Options for Collecting
External Samples.
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Separated by location (the Library, installed by factory Live Packs, other Projects and else-
where — sample collections from external drives, for example), the File Manager provides:

¢ A sample count and the associated disk space used;
¢ A Show button that will list the samples in the File Browser;
e A Yes/No toggle for engaging or disengaging collection.

Note: Make sure to confirm your choices by clicking the File Manager's Collect and Save
button!

it Collect and Save |

The File menu’s Collect All and Save command is a shortcut that collects and saves all
external samples referenced by the current Set, including those from the Library. Note that
this can cause a lot of copying, especially if your Live Set uses large multisample collections!

5.9.1 Collect Samples on Export

When you save Live Clips, device presets or tracks by dragging them into the Browser,
Live manages the copying of associated samples based on the selection made in the Col-
lect Samples on Export chooser in the File/Folder Preferences. This chooser provides the
following options:

o Always, the default setting, will copy files into the same folder as the clip, preset, or
track without notification.

e When Ask is selected, Live provides a dialog box with options for copying files.

o Never means that samples will not be copied when saving.

5.10 Aggregated Locating and Collecting

Instead of having to deal with problems while you are in a creative mode, you might prefer
putting aside some dedicated housekeeping time to solve all the problems in one go. Using

The File Manager's
Collect and Save Button.
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Live's File Manager, you can find missing samples and collect external samples not only for
the current Live Set but also for:

e The Library — choose the Manage Files command from the File menu; then click the
Manage Library button.

e The current Live Project — choose the Manage Files command from the File menu;
then click the Manage Project button.

e Any Live Project — (PC) / (cul )8 (Mac) on a Project in the Live Browser, and
choose the Manage PrOJect option.
e All Projects found in a specific folder (and its sub-folders) - (PC)/ (Cul 18 (Mac)

on a folder in the File Browser, and choose the Manage Projects command.

e Any selection of Live Sets, Live Clips, Live Presets — (PC)/ (Cul 8 (Mac) on the
respective items in the File Browser, and choose the Manage Files command.

Remember to click the Collect and Save button at the bottom of the File Manager when
you are finished. Otherwise your changes will be discarded.

5.11 Finding Unused Samples

Live's File Manager can find the unused samples in a Project for you. You can then review
them and decide to delete them individually or collectively. When searching for “unused”
samples, Live will inspect each sample in a project folder, checking if it is referenced by any
of the Live Sets, Live Clips or device presets in the Project. If not, the sample is regarded as
unused — even if other Projects or programs still use it.

To find the unused samples for the currently open Project, choose the Manage Files com-
mand from the File menu, click the Manage Project button, and then click on the triangular-
shaped fold button next to “Unused Samples” to access a summary and the Show button.
Clicking the Show button makes the File Browser list the unused samples; there, you can
preview the samples and delete them if you like.

Note you can also find the unused samples from the Library: choose the Manage Files
command from the File menu, then click the Manage Library button, and then see the
Unused Samples section.



CHAPTER 5. MANAGING FILES AND SETS 70

Last but not least, you can find the unused samples for all Projects found in a specific folder
(and its sub-folders): @ (PC)/ ® (Mac) on a folder in the File Browser and choose
the Manage Projects command, then see the Unused Samples section. Live inspects each
Project individually and labels a sample unused even if another Projects in the same folder
does use that sample. To prevent losses, you may want to first collect the samples into their
respective Projects and then purge the Projects of unused samples.

5.12 Packing Projects into Live Packs

Live's File Manager provides the option of packing a Live Project in Live Pack format for
convenient archiving and transfer. To do this, choose the Manage Files command from the
File menu, click the Manage Project button, and then click on the triangular-shaped fold
button next to “Packing.” Click the Create Live Pack button to bring up a file-select dialog
where you can specify the name and location of a new Live Pack file. Creating a new Live
Pack from a Project does not affect the Project. If you want the Project deleted, you can
delete it using the File Browser.

Live employs lossless compression techniques to minimize the file size of Live Packs. De-
pending on the audio materials in a Project, this saves up to 50 percent in file size.

To unpack a Live Pack (i.e., to restore the original Live Project), double-click the Live Pack
file (.alp), drag it into the Live main window, or locate it via the File menu’s Install Live Pack
command. Live will then request that you choose a location for the new Project. Note:
Factory Live Packs (those provided by Ableton) will automatically be installed in the Live
Library.

5.13 File Management FAQs

5.13.1 How Do | Create a Project?

A Project is automatically created whenever you save a Live Set, except when you save it into
the Library or a preexisting Project. You can also manually create a Project by clicking 0
(PC)/ [crl |8 (Mac) in the Browser and selecting Create Project from the context menu.
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5.13.2 How Can | Save Presets Into My Current Project?

As long as you're working in a Project (meaning that you've saved your current Live Set),
every device in the Device Browser will show a Current Project sub-folder. You can copy
presets from other Browser locations to the current project by (PC) / (Mac)-
dragging them. You can also save presets directly to the current project by dragging from
the device’s title bar and dropping into the Current Project. You can then use the File
Management tools, collect any referenced samples, etc.

5.13.3 Can | Work On Multiple Versions of a Set?

If you'd like to work on different versions of the same Live Set, save them into the same
Project. This will usually be the Project that was created when you saved the first version
of the Live Set. If a Project contains multiple Live Sets it will only collect one copy of any
samples used by the various versions, which can save disk space and help with organization.

5.13.4 Where Should | Save My Live Sets?

You can save Live Sets anywhere you want, but saving to the Library or pre-existing Project
folders can cause problems, and should be reserved for special cases. You should only save
Live Sets in the Library if you intend to use them as templates for other Live Sets. Likewise,
you should only save a Live Set to an existing Project if it is somehow related to the Project
— for example, an alternate version of a song that’s already in the Project.

5.13.5 Where Should | Save My Live Clips?

If you'd like to have your Live Clips available in all of your Projects, create a Library sub-folder
and save your clips there. You can also save clips anywhere else on your computer.



CHAPTER 5. MANAGING FILES AND SETS 72

5.13.6 Can | Use My Own Folder Structure Within a Project Folder?

You can organize your files any way you want within a Project, but you'll need to use the File
Manager to relink the files that you've moved around:

1) In Live's Browser or via your operating system, reorganize the files and folders
within your Project folder.

2) Navigate to the Project folder in the Browser and choose Manage Project via the

™ (PC)/ (Cul ]® (Mac) context menu.

3) If you've changed the original location of any samples used in the Project, the
Missing Samples section of the File Manager will indicate this. Click the Locate
button to search for the samples.

4) Since you know that your samples are all in the Project folder, unfold Automatic
Search. Then enable the Search Project and Fully Rescan Folders options. Finally,
click Go to initiate the search.

5) When searching is complete, click Collect and Save at the bottom of the File
Manager to update the Project.

5.13.7 How Do | Export A Project to the Library and Maintain My Own
Folder Structure?

If you export a Project to the Library, Live will look in the Library to see if the folder names
there match those in your Project, and will create any missing folders as necessary. For
example, if your Project folder contains samples in “Samples/My Samples,” Live will look in
the Library for a “Samples” folder (which it will find, because it's part of the standard Library)
and then for a “My Samples” sub-folder (which it will not find, but will then create).
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Chapter 6

Arrangement View

The Arrangement View displays the Arrangement, which contains music laid out along a
song timeline, like a multitrack tape.
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|madesz | |modes

lgoo loao °

—2/1

[CUCCRIC
W 1Bass

W 2 Chords
¥ 3 Rhodes
W) 4 Percs

@ 5 Beats

W 6Crash

W Master

000 60 «mmmmr[=Y]

A Piece of Music in the
Arrangement View.

The Arrangement View is a powerful editing tool that easily lets you combine and arrange

MIDI, loops, sound effects, video and complete pieces of music.
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6.1

Navigation

Live offers several fast methods for zooming and scrolling the Arrangement display:
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. To smoothly change the zoom level, click and drag vertically in the beat-time

ruler at the top of the Arrangement View (you can also drag horizontally to scroll
the display).

. To zoom in and out around the current selection, use the computer keyboard’s +

and - keys. To “pan” the display, click and drag while holding the [Ctrl
(PC) / (Mac) modifier. Double-clicking in the beat-time ruler also
zooms to the current selection. If nothing is selected, double-clicking the beat-
time ruler zooms out to show the entire Arrangement.

The Arrangement Overview is like a “bird’s-eye view” of your music. It always
shows the complete piece, from start to end. The black rectangular outline repre-
sents the part of the Arrangement that is currently displayed in the Arrangement
display below. To scroll the display, click within the outline and drag left or right;
to zoom out and in, drag up and down.

To change the displayed part of the Arrangement, drag the outline’s left and
right edges.

To see a specific part of the Arrangement in more detail, click on itin the Overview

Navigating the
Arrangement View.
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and drag downwards to zoom in around that part. Note that you can also drag
horizontally to scroll the display. Using this method, you can zoom and scroll to
focus around any part of the Arrangement with just one mouse motion.

6. To have the Arrangement display follow the song position and scroll automati-
cally, turn on the Follow switch, or use the Follow command from the Options
menu.

6.2 Transport

There are a number of ways to control Live's transport with the computer keyboard and
mouse:

1. You can start Arrangement playback by clicking the Control Bar's Play button,
and stop playback by clicking the Stop button. Arrangement playback can also

be toggled on and off by pressing the keyboard’s space bar. The Play and Stop

: — @. B =« [10ar o | Buttons in the Control
Bar.

2. You can set the Arrangement playback position by clicking anywhere along the
Arrangement to place the flashing insert marker. Double-clicking the Stop button
will return the Arrangement play position to 1.1.1.

Arrangement Playback
Begins from the Insert
Marker.

To continue playback from the position where it last stopped, rather than from
the insert marker, hold down the modifier while pressing the space bar.

3. When Permanent Scrub Areas is enabled in Live's Look/Feel Preferences, clicking
in the scrub area above the tracks will make playback jump to that point. The
size of these jumps is quantized according to the Control Bar's Quantization
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menu setting. While the mouse is held down over the scrub area, a portion of
the Arrangement the size of the chosen quantization setting will be repeatedly
played. With small quantization settings, or a setting of “None,” this allows you
to scrub through the music.

When the Permanent Scrub Areas preference is off, you can still scrub by -
clicking anywhere in the scrub area or in the beat time ruler.
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4. The song position can be adjusted numerically using the Control Bar's Arrange-
ment Position fields.

b, 17. 1. 1|0 & | ovR | =+ | 41Bar &

The Arrangement Position fields show the song position in bars-beats-sixteenths.
To change the values:

e Click and drag up or down in any of these fields.
e Click and type a number, then hit Return].
e Click and decrement or increment the value with and .

5. Arrangement playback can be started at a particular point in one of your clips
using the scrub area in the Clip View.

6. Several Arrangement playback positions can be set using launchable locators.

Note that any computer keyboard key or MIDI message can be mapped to the transport
controls, as described in the respective chapter.

Scrubbing Arrangement
Playback.

Setting the Play Position
in the Arrangement
Position Fields.
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6.3 Launching the Arrangement with Locators
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Locators can be set at any point in the Arrangement. This can be done in real time during
playback or recording with the Set Locator button, and will be quantized according to the
global quantization value set in the Control Bar. Clicking the Set Locator button when the
Arrangement is not playing will create a locator at the insert marker or selection start. You
can also create a locator using the context menu in the scrub area above the tracks or via
the Create menu. Note that the position of a new locator is quantized according to the
Control Bar's Quantization menu setting.

w 1 Bass

[HE‘SS |.Hc'|55 lHass

You can recall (jump to) locators by clicking on them, or with the Previous and Next Locator
buttons on either side of the Set button. Locators can also be recalled using MIDI/key
mapping. Note that locator recall is subject to quantization. Double-clicking a locator will
select it and start Arrangement playback from that point.

After jumping to the first or last locator in the Arrangement, the Previous and Next Locator
buttons will jump to the Arrangement start or end, respectively.

Locators can be moved by clicking and dragging, or with the arrow keys on your computer
keyboard.

To name a locator, select it by clicking its triangular marker, and choose the Rename Edit

Using Locators to
Launch Play in the
Arrangement.

The Locator Controls.
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menu command (or use the (Ctl R} (PC)/ (& $(R) (Mac) shortcut). You can also enter
your own info text for a locator via the Edit Info Text command in the Edit menu or in
the locator's O (PC)/ (Ctl__ £ (Mac) context menu. Locators can be removed with your
computer’s or (Delete] key, the Create menu, or the Delete Locator button.

Note that the locator & (PC)/ [Ctrl | & (Mac) context menu offers a quick way of looping
playback between two locators with its Loop To Next Locator command.

The locator @ (PC)/ (Ctrl ] ® (Mac) context menu'’s Set Song Start Time Here command
can be used to overrule the default “play starts at selection” rule: when this command is
checked, play starts at the locator.

6.4 Time Signature Changes

I||llr| L.IIIIr|n-.||||r|n-.||||r|n-.||||l ims LR |||l ims LR
o ._A_L_L.L ._A_L_LA. ._A_L_L.L ._A_L_L_... ._I_L_LH_..LLL_LLL..LJ.L_A_H_._-_LL.-_L.._._LL_LH_..

Live's time signature can be changed at any point in the Arrangement by using time signature
markers. These can be added at the insert marker position via the Create menu, or anywhere
below the beat-time ruler usingthe O (PC)/ [Ctrl | & (Mac) context menu. Time signature
markers appear just below the beat time ruler, but this marker area is hidden if a set contains
no meter changes, freeing up additional space at the top of the Arrangement.

In many ways, time signature markers look and function like locators; they can be moved with
the mouse or with your computer keyboard’s arrow keys, and their value can be changed
using the Edit menu’s Edit Value command (or with the (Cti J[R] (PC)/ (& _$R) (Mac)
shortcut). They can be also be deleted using the (4= ] or [Delete] key, or via delete
commands in the Edit and Create menus.

The time signature marker & (PC) / (Ctrl ] (Mac) context menu offers a number of
features, including a Delete All Time Signature Changes command and options to loop or
select the area up to the next time signature marker.

Time Signature
Changes.
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Any time signature with a one- or two-digit numerator and a denominator of 1, 2, 4, 8 or
16 can be used as a time signature marker value. The numbers must be separated by a
delimiter such as a slash, comma, period, or any number of spaces. These marker values
can also be set by adjusting the time signature fields in the Control Bar, either by typing
in values or dragging the numerator and denominator sliders. This will change the time
signature marker value at the current play location, and works either with the transport
stopped or during playback. When the Arrangement contains time signature changes, the
time signature editor displays an automation LED in the upper left corner.

Tap | 120.00 | 0 |ow

Time signature markers are not quantized; they may be placed anywhere in the timeline,
and their positioning is only constrained by the editing grid. This means that it is possible
to place meter changes in “impossible” places - such as before the end of the previous
measure. This creates a fragmentary bar, which is represented in the scrub area by a
crosshatched region. Live is happy to leave these incomplete measures as they are, but if
you'd like your Set to conform to the rules of music theory, you can use the two & (PC)/
B (Mac) context menu options to “correct” incomplete bars.

Delete Fragmeniary Bar Time

Complete Fragmentary Bar (Insert Time)

e Delete Fragmentary Bar Time deletes the duration of the fragmentary bar from the
Arrangement, thereby moving any audio or MIDI on either side of the deleted area
closer together in the timeline. The next time signature marker will now fall on a
“legal” barline.

o Complete Fragmentary Bar inserts time at the beginning of the fragmentary bar, so
that it becomes complete. The next time signature marker will now fall on a “legal”
barline.

Please note that these resolution options affect all tracks - deleting and inserting time

The Time Signature
Editor Can Change Time
Signature Marker Values,
and Shows an
Automation LED.

A Fragmentary Bar and
its Resolution Options.
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changes the length of the entire Arrangement.

If you import a MIDI file into the Arrangement, you'll be given an option to import any
time signature information that was saved with the file. If you choose to do this, Live will
automatically create time signature markers in the correct places. This makes it very easy to
work with complex music created in other sequencer or notation software.

6.5 The Arrangement Loop

_L_/— 32. 0. 0

For Live to repeatedly play a section of the Arrangement, activate the Arrangement loop by
clicking on the Control Bar's Loop switch.

[

You can set loop length numerically using the Control Bar fields: The left-hand set of fields
determines the loop start position, while the right-hand set determines loop length.

The Edit menu’s Loop Selection command accomplishes all of the above at once: It turns
the Arrangement loop on and sets the Arrangement loop brace to whatever timespan is
selected in the Arrangement.

33 41 40 57 a5 -3 31 -
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The loop brace can be selected with the mouse and manipulated with commands from the
computer keyboard:

. and nudge the loop brace to the left/right by the current grid setting.

The Control Bar’s Loop
Switch.

The Loop Start Fields
(Left) and the Loop
Length Fields (Right).

The Arrangement’s Loop
Brace.
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. and shift the loop brace left/right in steps the size of its length.

e The (PC)/ (Mac) modifier used with the arrow left and right keys shortens
or lengthens the loop by the current grid setting.

e The [Ctl ) (PC)/ (Mac) modifier with the arrow up and down keys doubles or
halves the loop length.

You can also drag the Arrangement’s loop brace: Dragging the left and right ends sets the
loop start and end points; dragging between the ends moves the loop without changing its
length.

The loop's B (PC) / ® (Mac) context menu’s Set Song Start Time Here command
can be used to overrule the default “play starts at selection” rule: when this command is
checked, play starts at the loop start.

6.6 Moving and Resizing Clips

A piece of audio or MIDI is represented in the Arrangement View by a clip sitting at some
song position in one of Live's tracks.

Ir'\..-\-r: a5 |

5=

4 o A «
B
-
W

Dragging a clip moves it to another song position or track.
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¥ 1 Bass
guitarchord v 2 Chords

¥ 3 Rhodes
shaker ¥ 4 Perc's

Dragging a clip’s left or right edge changes the clip’s length.

Clips snap to the editing grid, as well as various objects in the Arrangement including the
edges of other clips, locators and time signature changes.

Moving a Clip.

Changing a Clip’s
Length.
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6.7 Audio Clip Fades and Crossfades

The beginning and end of audio clips in the Arrangement View have adjustable volume
fades. Additionally, adjacent clips on the same audio track can be crossfaded.

To access the fades for an audio track’s clips:
1. “Unfold” the track by clicking the @ button next to the track name.
2. Select "Fades” in the Fades/Device chooser.
3. Click and drag the fade handle to change the length of the fade.
4. Click and drag the slope handle to change the shape of the fade’s curve.

You can also set the length of a fade by selecting a range of time within the clip that includes
the clip’s beginning or end and executing the Create Fade command in the clip’s & (PC)/
Ctl )& (Mac) context menu.

Fades in the
Arrangement View.

Adjacent audio clips can be crossfaded. Creating and editing crossfades is similar to creating
and editing start and end fades:

e click and drag a fade handle over the opposite clip’s edge to create a crossfade
e click and drag the slope handle to adjust the shape of the crossfade’s curve

e select a range of time that includes the boundary between the adjacent clips and
execute the Create Crossfade command from the (@ (PC)/ [Cel )& (Mac) context
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Selecting a fade handle and pressing the key deletes the fade, unless the Create
Fades on Clip Edges option is enabled in the Record/Warp/Launch Preferences. In this
case, pressing returns the fade handle to a default length of 4 ms. With this option
enabled, new clips in the Arrangement View will have these short “declicking” fades by
default.

v unwm

WarpiFades
Record
Warp LoopWarp Short Samplas Ao
Launch Auto-Warp Long Samplas on
cCPU Default Warp Mode Beatls
Create Fades on Clip Edges
User Account _—ﬁl
Licenses Launch

Another result of enabling the Create Fades on Clip Edges option is that adjacent audio
clips will get automatic 4 ms crossfades. These can then be edited just like manually-created
crossfades.

There are some limits to the length of fades and crossfades:
e Fades cannot cross a clip’s loop boundaries.
e Aclip’s start and end fades cannot overlap each other.

When a fade handle is selected, a dotted red line will appear on the relevant clip to indicate
the limit for that fade handle. This is especially helpful when editing crossfades, because
one clip’s loop boundary may be “hidden” under the other clip.

Note that fades are a property of clips rather than the tracks that contain them, and are
independent of automation envelopes.

Crossfaded Clips.

Automatically Create
Short Fades At Clip
Edges.
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6.8 Selecting Clips and Time

With the exception of moving and resizing clips, Arrangement editing in Live is selection-
based: You select something using the mouse, then execute a menu command (e.g., Cut,
Copy, Paste, Duplicate) on the selection. This editing method lends itself to an efficient
division of labor between the two hands: One hand operates the mouse or trackpad, while
the other hand issues the keyboard shortcuts for the menu commands. The menu eventually
is only used as a reference for looking up the keyboard shortcuts.

Here is how selection works:

Clicking a clip selects the clip.

Clicking into the Arrangement background selects a point in time, represented by a
flashing insert mark. The insert mark can then be moved in time with the and =
keys, or between tracks via and (#]. Holding (Cul ] (PC)/ (Mac) while
pressing the and keys snaps the insert mark to locators and the edges of clips
in the selected track or tracks.

Clicking and dragging selects a timespan.

To access the time within a clip for editing, “unfold” its track by clicking the @ button
next to the track name.

melody var A 1 Audic

A 7 Auddie

Clicking and dragging in the waveform display below the clip’s horizontal strip allows
you to select time within the clip. Notice that you can adjust the height of the
unfolded track by dragging the split line below the Unfold Track button. Note that
you can actually unfold all of your tracks at once by holding down the (PC) /
(Mac) modifier when clicking the @ button.

Clicking on the loop brace is a shortcut for executing the Edit menu’s Select Loop
command, which selects all material included within the loop.

MUSIMbeat]

Adjusting an Unfolded
Track’s Height.
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¢ Holding while clicking extends an existing selection in the same track or across
tracks. You can also hold and use the arrow keys to manipulate the selection.

Clicking the Loop Brace
to Select the Loop for
Editing.

6.9 Using the Editing Grid

To ease editing, the cursor will snap to grid lines that represent the meter subdivisions of
the song tempo. The grid can be set to be either zoom-adaptive or fixed.

You can set the width of both zoom-adaptive and fixed grid lines using the 3 (PC) /
(€l )8 (Mac) context menu available in either the Arrangement View track area or the
Clip View display.

The following shortcuts to Options menu commands allow quickly working with the grid:

o Use (PC) / (Mac) to narrow the grid, doubling the density of the
grid lines (e.g., from eighth notes to sixteenth notes).

o Use (PC)/ (Mac) to widen the grid, halving the density of the grid

lines (e.g., from eighth notes to quarter notes).

e Use ([Cl 3] (PC)/ (Mac) to toggle triplets mode; this would, for instance,
change the grid from eighth notes to eighth note triplets.

e Use (Cul 4] (PC)/ (Mac) to turn grid snapping on or off. When the grid is

off, the cursor does not snap to meter subdivisions.

e Use (PC)/ (Mac) to toggle fixed and adaptive grid modes.
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The current spacing between adjacent grid lines is displayed in the lower right corner of the
Arrangement View or Clip View.

You can hold down the (PC) / (Mac) modifier while performing an action to
bypass grid snapping. If the grid is already disabled, this modifier will temporarily enable it.

6.10 Using the ...Time Commands

Whereas the standard commands like Cut, Copy and Paste only affect the current selection,
their “... Time"” counterparts act upon all tracks by inserting and deleting time. Any time
signature markers within the selected region will also be affected.

e Cut Time cuts a selection of time from the Arrangement, thereby moving any audio
or MIDI on either side of the cut area closer together in the timeline. This command
reduces the length of your Arrangement by whatever amount of time you have cut.
Note that the Cut Time command affects all tracks, not only the selected ones.

e m ;25 T I N
— Cra—— =

e Paste Time places copied time into the Arrangement, thereby increasing its overall
duration by the length of time you have copied.

e Duplicate Time places a copy of the selected timespan into the Arrangement, thereby
increasing its overall duration by the length of the selection.

e Delete Time deletes a selection of time from the Arrangement, thereby moving any
audio or MIDI on either side of the deleted area closer together in the timeline. This
command reduces the length of your Arrangement by the amount of time you have
deleted. Note that the Delete Time command affects all tracks, not only the selected
ones.

A Gap Between Clips
Has Been Cut by First
Selecting It, Then
Executing the Cut Time
Command.
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e Insert Silence inserts as much empty time as is currently selected into the Arrangement,
before the selection.

6.11 Splitting Clips

The Split command can divide a clip or isolate part of it.
To split a clip in two halves, do the following:
1. Unfold the track;

2. In the waveform or MIDI display, click at the position where you want the clip to
be split;

3. Execute the Split command.
To isolate a part of a clip, do the following:
1. Unfold the track;

2. In the waveform or MIDI display, drag a selection over the part of the clip you
want to isolate;

3. Execute the Split command to divide the original clip into three pieces.

Drumloop Drumloop

The Result of Splitting a
Clip.

6.12 Consolidating Clips

The Consolidate command replaces the material in the Arrangement View selection with
one new clip per track. This is very useful for creating structure.
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Suppose you have, by editing or improvising, come up with a layout of clips that sound
good in Arrangement Loop mode. Selecting that part of the Arrangement, for instance by
using the Edit menu'’s Select Loop command, and then executing the Consolidate command
creates a new clip that can be treated as a loop. You can now, for instance, drag the clip
edges to create more repetitions. You might also want to drag the new loop via the Session
View selector into a Session View slot for real-time arrangement purposes.

When operating on audio clips, Consolidate actually creates a new sample for every track
in the selection. The new samples are essentially recordings of the time-warping engine’s
audio output, prior to processing in the track’s effects chain and mixer. Hence, the new
sample incorporates the effects of in-clip attenuation, time-warping and pitch shifting, and
of the respective clip envelopes; however, it does not incorporate the effects. To create a
new sample from the post-effects signal, please use the Export Audio/Video command.

The new samples can be found in the current Set’s Project folder, under Samples/Processed/
Consolidate. Until the Set is saved, they remain at the location specified by the Temporary
Folder.

Consolidating Several
Clips Into a New Clip.
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Chapter 7

Session View

In Live's Arrangement View, as in all traditional sequencing programs, everything happens
along a fixed song timeline. For a number of applications, this is a limiting paradigm:

e When playing live, or when DJing, the order of pieces, the length of each piece and
the order of parts within each piece is generally not known in advance.

e In the theatre, sound has to react to what happens on stage.

e When working along with a piece of music or a film score, it can be more efficient and
inspirational to start with an improvisation, which is later refined into the final product.

This is exactly what Live's unique Session View is for.
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7.1 Session View Clips
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1. Each clip in the Session View has a triangular button at the left edge. Click the
button with the mouse to “launch” clip playback at any time, or pre-select a
clip by clicking on its name, and launch it using the computer’s Return] key. You
can then move on to the neighboring clips using the arrow keys. Please refer
the manual section on clip launch settings for details on how to customize this
behavior.

2. Click on a square Clip Stop button to stop a running clip, either in one of the
track’s slots, or in the Track Status field below the Session grid.

Clips can be controlled remotely with the computer keyboard or a MIDI controller. They can
even be mapped to MIDI note ranges so that they play chromatically.

Clips can be played at any time and in any order. The layout of clips does not predetermine
their temporal succession; the Session grid offers random access to the clips it contains.

Notice that, even if you stop playback for a Session View clip, the Play button in the Control
Bar will remain highlighted, and the Arrangement Position fields will continue running.
These fields keep a continuous flow of musical time going, so that you can always know your
position in song time during a live performance or while recording into the Arrangement,
regardless of what your individual Session clips are doing.

You can always return the Arrangement Position fields to 1.1.1 and stop playback for the
entire Live Set by pressing the Control Bar’s Stop button twice.

The Controls for a
Session View Clip.
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Slots in Group Tracks show a shaded area to indicate that at least one of the contained
tracks contains a clip at that location. The color of the shading is the color of the left-most
clip in the group. These group slots also contain launch buttons which will launch all of
the respective clips. Group slots which have no corresponding clips contain stop buttons.
Clicking in any group slot selects all of the clips it refers to.
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7.2 Tracks and Scenes

Each vertical column, or track, can play only one clip at a time. It therefore makes sense to
put a set of clips that are supposed to be played alternatively in the same columns: parts of
a song, variations of a drum loop, etc.
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For convenient access to more clips at once, you can resize Session View tracks by clicking

and dragging at the edges of their title bars. Tracks can be narrowed this way so that only
Clip Launch buttons and essential track controls are visibile.

The Arrangement
Position Fields and the
Stop Button.

Group Slots and Group
Launch Buttons.

Resized Session View
Tracks.
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The horizontal rows are called scenes. The Scene Launch buttons are located in the rightmost
column, which represents the Master track. To launch every clip in a row simultaneously,
click on the associated Scene Launch button. This can be very useful in organizing the live
performance of a song with multiple parts.

The scene below a launched scene will automatically be selected as the next to be launched
unless the Select Next Scene on Launch option in the Launch Preferences is set to “Off.”
This allows you to trigger scenes from top to bottom without having to select them first.
Computer keys or a MIDI controller can be used to launch scenes and scroll between them.

Scenes can be renamed using the Rename command in the Edit menu or the & (PC) /
(Ctl )& (Mac) context menu. One can quickly rename several scenes by executing the
Rename command and using the computer’s Tab key to move from one scene to the next.
You can also enter your own info text for a scene via the Edit Info Text command in the Edit
menu or in the scene’s B (PC)/ (Cul ] (Mac) context menu. The context menu also
contains a color palette where you can choose a custom scene color.

Scenes can be reordered by drag-and-drop. Multiple adjacent or nonadjacent scenes can be
selected at once by ~clicking or -clicking, respectively. If you drag a selection of
nonadjacent scenes, they will be collapsed together when dropped. To move nonadjacent
scenes without collapsing, use + (#)/ (¥ instead of the mouse.

Scene names can be both descriptive and functional; if Live detects a viable tempo and/
or time signature as part of a scene name, the project will automatically adjust to these
parameters when the scene is launched. To assign a tempo to a scene, select the scene
and rename it with a viable tempo (e.g., “96 BPM"). Any tempo can be used, as long as it is
within the range allowed by Live's Tempo control (20-999 BPM). To assign a time signature
to a scene, rename the scene with a meter in the form of “x/y” (e.g., “4/4"). Any time
signature can be used, provided it has a numerator between 1 and 99 and a denominator
with a beat value of 1, 2, 4, 8 or 16.

A Scene in the Session
View.
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Tempo and time signature changes can coexist within a single scene name, and can appear
in any position as long as they are separated from each other by at least one character. For
example, “2/4+108 BPM", 72 BPM;7/8"” and "“60 BPM Chorus 3/4" are all scene names
that will cause simultaneous meter and tempo changes.
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7.3 The Track Status Fields

You can tell a track’s status by looking at the Track Status field just above the active track’s
mixer controls:

I

MMl
The pie-chart icon in a clip track represents a looping Session clip. The number to the right
of the circle is the loop length in beats, and the number at the left represents how many

times the loop has been played since its launch. A pie-chart without numbers appears in
the Track Status field for a Group Track if at least one clip in a contained track is currently

playing.

Audio Fram Audio F

The progress-bar icon represents a one-shot (non-looping) Session clip. The value displays
the remaining play time in minutes:seconds.

These Scenes Will
Change the Tempo and
Time Signature.

A Track Playing a
Looping Session Clip...

... A One-shot Session
Clip...
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|
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A microphone icon appears in an audio track that is set to monitor its input. A keyboard
icon appears in a MIDI track under these same circumstances.

|

Audio From Audio F

If the track is playing clips from the Arrangement, a miniature display representing the
Arrangement clips being played appears.

7.4 Setting Up the Session View Grid

Clips arrive in the Session View by being imported from the File Browsers or through
recording.
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If you are dragging multiple clips into the Session View, Live defaults to arrange them
vertically, in one track. Hold down (PC)/ (Mac) prior to dropping them so as
to lay the clips out in one scene.

Clips can be moved around the Session grid by drag-and-drop. To move several clips
at once, select them by using the (¢ -or [cul ] (PC)/ (Mac)-modifier before
dragging. You can also click into an empty slot and “rubber-band” select from there.

... Monitoring the
Input...

... Playing the
Arrangement.

Dropping Multiple Clips
Into the Session View.
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7.4.1 Select on Launch

By default, clicking a Session View clip’s Launch button also selects the clip, since you will
typically want the Clip View to show the newly launched clip. However, some power-users
don’t want the current focus (e.g., a return track’s devices) to disappear just because a clip
has been launched, especially when starting a clip in order to try it with the return track
device settings. Turn off the Select on Launch option from the Launch Preferences if you
prefer the view to remain as is when you launch clips or scenes.

7.4.2 Removing Clip Stop Buttons

1 Audio 2 Audio 3 Audio 4 MIDJ

EE
| i

V— Slots Without Clip Stop
Buttons.

You can add and remove Clip Stop buttons from the grid using the Edit menu’s Add/Remove
Stop Button command. This is useful for pre-configuring the scene launch behavior: If, for
instance, you don’t want scene 3 to affect track 4, remove the scene 3/track 4 Stop button.

7.4.3 Editing Scenes

In addition to the standard Edit menu commands such as cut, copy, paste and duplicate,
there are two useful commands in the Create menu that apply specifically to scenes:

e Insert Scene inserts an empty scene below the current selection.

e Capture and Insert Scene inserts a new scene below the current selection, places
copies of the clips that are currently running in the new scene and launches the new
scene immediately with no audible interruption. This command is very helpful when
developing materials in the Session View. You can capture an interesting moment as
a new scene and move on, changing clip properties and trying clip combinations.
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7.5 Recording Sessions into the Arrangement

Your Session View playing can be recorded into the Arrangement, allowing for an improvi-
sational approach to composing songs and scores.

, 1. 1. 1|p .E ovR|| =+ |1Bar o | # The Control Bar's Record
Button.

When the Record button is on, Live logs all of your actions into the Arrangement:
e the clips launched;
e changes of those clips” properties;
e changes of the mixer and the devices' controls, also known as automation;

e tempos and time signature changes, if they are included in the names of launched
scenes.

To finish recording, press the Record button again, or stop playback.
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To view the results of your recording, bring up the Arrangement View. As you can see, Live
has copied the clips you launched during recording into the Arrangement, in the appropriate
tracks and the correct song positions. Notice that your recording has not created new audio
data, only clips.

The Arrangement
Selector.

The Session clips and the Arrangement clips in one track are mutually exclusive: Only one
can play at a time. When a Session clip is launched, Live stops playing back the Arrangement
in favor of the Session clip. Clicking a Clip Stop button causes the Arrangement playback
to stop, which produces silence.

The Back
* 1 1 1| 0|® ::-".-H 1 Bar ra e Back to

Arrangement Button.
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Arrangement playback does not resume until you explicitly tell Live to resume by clicking
the Back to Arrangement button, which lights up to remind you that what you hear differs
from the Arrangement.
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To disable all Arrangement clips simultaneously, click on the Stop All Clips button in the
Master Track Status field. The clips in the Arrangement and in the Session View exist

independently from one another, which makes it easy to improvise into the Arrangement
over and over again until it's right.
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Furthermore, you can move clips not only within the Session grid, but also from the Session
View to the Arrangement and vice versa by using Copy and Paste, or by dragging clips over

the 9 or @ selectors.

When pasting material from the Arrangement into the Session View, Live attempts to pre-
serve the temporal structure of the clips by laying them out in a matching top-to-bottom
order. Moving through the scenes from the top down, you can reconstruct the original ar-
rangement. This is useful for taking a composed piece of music back to the improvisational
stage.

The Stop All Clips
Button.
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Clip View

The Clip View is where clip properties can be set and adjusted.
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The Clip View is opened by clicking on the Clip Overview or double-clicking a clip in the

Session or Arrangement View.
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The Clip View.
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In the Session View, clicking on a Track Status Field opens the Clip View for editing the clip
that is currently running in the track.

|
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The properties of more than one clip can be edited collectively in the Clip View as a multi-

selection. To create a multi-selection, click and drag from an empty clip slot to highlight the

clips, or select one clip and use the (PC)/ (Mac) or modifiers to add

to your selection. The properties available in the Clip View for a multi-selection depend

on the contents of the clips; generally only properties which the clips have in common are
shown.
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Controls such as sliders and knobs behave slightly differently when they are part of a multi-
selection. If the clips in a multi-selection have differing values for any particular knob or
slider parameter (clip transposition, for example), the range of these values will be displayed
and can be adjusted with the control. Dragging the knob or slider to its absolute maximum
or minimum value will make the clips’ settings thereafter identical, adjustable as a single
value.

MIDI clips and audio clips in Live have different sets of properties and, consequently, do
not share the same set of Clip View controls. The two types of clips do have the following

Clicking the Clip
Overview Opens the
Clip View.

Clicking a Session View
Track Status Field Opens
the Clip View.

Creating a Clip
Multi-Selection.
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in common:

e The Clip box contains basic clip settings.

e The Envelopes box and the Envelope Editor manage the clip’s envelopes, which are
used to modulate the effects, mixer, and clip or MIDI controls. Clip envelopes and
their associated Clip View components are covered in detail in a separate manual
chapter.

e The Launch box controls clip launch behavior and, as such, only appears for Session
View clips. Setting Session View clip launch properties is covered in detail in a separate
manual chapter.

Audio clips have these additional Clip View controls:

e The Sample Display toggles with the Envelope Editor on the right-hand side of the
Clip View, and controls Live's sample-warping capabilities and clip playback settings.

e The Sample box contains settings pertaining to how the clip plays its sample and
displays it in the Sample Display.
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MIDI clips have these additional Clip View controls:
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e The MIDI Editor toggles with the Envelope Editor on the right-hand side of the Clip
View, and allows editing and creating MIDI notes and velocities.

e The Notes box contains settings pertaining to how Live plays a MIDI clip and what it

displays in the MIDI Editor.
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To make best use of the screen real estate, you can show or hide the Launch, Envelopes,
and Sample or MIDI boxes using the Clip View Box selector in the Clips box. You can also
toggle between the Sample Display/MIDI Editor and the Envelope Editor by clicking in the
title bars of the Sample/Notes box and the Envelopes box, respectively.
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8.1 The Clip Box
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8.1.1 Clip Activator Switch

Using this switch, you can deactivate a clip so that it does not play when launched in the
Session View or during Arrangement playback. Clips can also be activated/deactivated
directly from the Session or Arrangement View with their & (PC)/ ® (Mac) context
menus.

8.1.2 Clip Name and Color

The Clip Name field allows naming the clip. By default, a clip’s name matches the name of
the file it references but, in general, the clip name is independent from the file name.

You can also rename a clip by selecting it in the Session grid or Arrangement View and
using the Rename command in the Edit menu or the clip’s & (PC)/ ® (Mac) context
menu. This method also allows you to create your own info text for the clip via the Edit Info
Text command.

Renaming an audio clip does not rename the referenced sample file. To rename a file, select
it in Live's File Browsers, and then choose the Edit menu’s Rename command.

The Clip Color chooser allows choosing a clip color.

The Clip Box.
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8.1.3 Clip Signature

Using the Clip Signature fields, you can specify the time signature of a MIDI or audio
clip. This setting is relevant only for display; it does not affect playback. Please note that
Clip Signature is completely separate from the project’s time signature, and can be set
independently for each clip. This makes it easy to create complex polymetric textures by
simultaneously triggering clips with different meters and/or loop lengths.

8.1.4 Clip Groove Chooser

The Clip Groove chooser selects the groove used for the clip from the grooves available in
the Groove Pool.

Clip

The "Open Groove Pool” entry in this chooser can be used to open the Groove Pool if it
is closed. If you want to quickly try out a variety of grooves, you can enable the Hot-Swap
button above the chooser and then step through the grooves in the Browser while the clip
plays.

The Commit button under the chooser “writes” the current groove settings to the clip and
disables the assigned groove. If the groove uses the Velocity parameter, committing on
an audio clip will create a volume Clip Envelope in order to convert the groove’s velocity
information into audio volume changes. Note that this will overwrite any volume Clip
Envelope that was already in the clip.

The Clip Groove
Chooser.
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8.1.5 Clip Offset and Nudging

To jump within a playing clip in increments the size of the global quantization period, you
can use the Nudge buttons in the Clip box.

Clip
— Using the Nudge
s Buttons to Jump

— Through a Clip.

These buttons can also be mapped to keys or MIDI controllers. In MIDI Map Mode, a scrub
control will appear between the Nudge buttons and can be assigned to a rotary encoder
wheel for continuous scrubbing.

Clip

Commil The Scrub Control in
o MIDI Map Mode.

With quantization set to values less than one bar, it is easy to offset clip playback from Live’s
master clock by launching clips, using the Nudge buttons or scrubbing within the clip.
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8.2 The Sample Box

8.2.1 Warp Controls

Loop

|u

When the Warp switch is off, Live plays the sample at its original, “normal” tempo, irrespec-
tive of the current Live Set tempo. This is useful for samples that have no inherent rhythmic
structure: percussion hits, atmospheres, sound effects, spoken word and the like. Turn
the Warp switch on to play rhythmically structured samples (such as sample loops, music
recordings, complete music pieces, etc.) in sync with the current song tempo.

TAPG129.00(11|111| 4 / 4 |[O®

To verify this, note that a warped sample’s speed follows the tempo as you change the
Control Bar's Tempo control.

Live offers a number of controls to adjust the time-warping engine for optimal stretching
quality. For accurate warping, Live needs to know the sample’s metrical structure. For
properly prepared loops, tempo and duration are calculated automatically; most of the time
this is accurate enough that the sample is immediately ready for use in Live. For other
samples, you may have to provide some hints. We will examine these topics thoroughly in
the Tempo Control and Warping chapter.

The Sample Box Warp
Controls.

The Control Bar’s Tempo
Field.
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8.2.2 Sample Loop/Region and Display

Zooming and Scrolling

0:05 Q10 015

Zooming and scrolling in the Sample Display work much like they do in the Arrangement
View. When Warp is disabled, zooming and scrolling can be done anywhere in the Sample
Display. When Warp is enabled, however, scrolling only happens in the beat-time ruler and
the bottom half of the waveform.

Click and drag vertically in these areas to smoothly change the zoom level, and horizontally
to scroll the display.

PRI TR

The Clip Overview provides additional zoom/scrolling functionality. It always shows the
complete clip, from start to end. The black rectangular outline represents the part of the
clip that is currently displayed. You can click within the outline and drag horizontally or
vertically to scroll or zoom.

The Clip Zoom/Scroll
Area.

The Clip Overview.



CHAPTER 8. CLIP VIEW 107

To have the Sample Display follow the play position and scroll automatically, turn on the
Follow switch, or use the Follow command from the Options menu.

ﬁ 1. 1. 1|p|m|@|ovwr|[E€|18ar |
The Follow Switch.

Playing and Scrubbing Clips

The section of the sample that plays when a clip is launched is set with the clip’s region and
loop controls. An unlooped clip will play from its start marker to its end marker or until it is
stopped.

H“ f The Clip Start and End

000 005 010 015 Markers

These markers can be clicked and dragged to new positions in the Sample Display, or they
can be moved with the and keys. To move the entire clip region (i.e., both the start
and end markers), select the start marker, hold down (£ ], and use the arrow keys.

Sample +
Bass B2 ail Warp g Stant

44.1 kHz 16 Bil 2 Ch

Edil) (Save (Rev) | seq. BP
Hi-Q| [Fade| [RAM 88.00

Transpose 2) ("2
Tones Loop
~ - Pasition
aram size . .
0st i Using Clip Start and End
Detune S | Lenstn Controls to Change Clip
0ct 0.00 dB 4 O o

Length.
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You can also adjust the clip start and end numerically using the respective value fields to
the left of the Sample Display. For warped clips, these fields display values as bars-beats-
sixteenths; for unwarped clips, the display is in minutes-seconds-milliseconds. Notice that
you can use the Set buttons here to place the markers during playback. Setting markers this
way is quantized according to global quantization.

When Permanent Scrub Areas is enabled in Live's Look/Feel Preferences, clicking in the
lower half of the waveform or in the beat-time ruler will make clip playback jump to that
point.

The size of this jump is quantized by the global quantization setting, which can be quickly
changed using the (Cl_J{6) (PC)/ (& ¥6) (Mac), (7), B), ©) and [0) shortcuts. While

the mouse is held down over the scrub area, a portion of the clip the size of the chosen
quantization setting will be repeatedly played. With small quantization settings, or a setting
of “None,” this allows you to scrub through the music.

When the Permanent Scrub Areas preference is off, you can still scrub by (& J-clicking
anywhere in the scrub area or in the beat time ruler.

Looping Clips

To have the clip play as a (potentially infinite) loop, turn on the Loop switch. Note that
the Warp switch must be activated before the Loop switch is accessible, as unwarped clips

The Clip Scrub Area.
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cannot be looped.

You can click and drag to change the position and length of the loop brace in the Sample
Display, or you can type exact values into the Loop Length and Position fields to the left of
the display.

Sample +
Bass B2 aif Warp Start

44.1 kHz 16 Bit 2 Ch

Edit ) (Save (Rev Seg. BPM | End

Hi-Q | [Fade| | RAM 98 Bl 1] 1

The Clip Loop Controls.

The loop brace can be selected with the mouse and its position changed with commands
from the computer keyboard:

) and nudge the loop brace to the left/right by the current grid setting.

. and (4] shift the loop brace left/right in steps the size of its length.

. (PC) / (Mac) shortens or lengthens the loop brace by the

current grid setting.

. (PC)/ (Mac) doubles or halves the loop length.

Regardless of the position of the loop brace, clip play will begin at the position marked by
the start marker, which means you can set up the clip to run into a loop.
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The Loop Length and Position fields are equipped with Set buttons, which can be used to
create loops spontaneously during playback:

e Playing the clip and then clicking the Set Loop Position button moves the beginning
of loop to the current playback position (rounded to the global quantization setting)
and engages the loop. Then, clicking the Set Loop Length button moves the end of
the loop to the current playback position. This lets you capture the music in a loop on
the fly.

e While the loop is still off, you can click the Set Loop Length button to set the loop
to end at the current playback position without changing its preset length. This
simultaneously activates looping.

The Set buttons, the Loop switch, the loop brace and the start/end markers can all be
mapped to MIDI controls. You could, for example, use a rotary encoder to move the loop
through a sample in increments the size of the chosen quantization interval.

Setting the Clip to Run
Into a Loop.
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8.2.3 Clip Pitch and Gain

Sample -+

The Clip Pitch and Gain

Controls.
The Transpose control shifts the clip pitch in semitones.
The Detune field fine-tunes the clip in cents (100 cents = one semitone).
The Clip Gain slider, calibrated in dB, changes the clip gain.
8.2.4 Destructive Sample Editing
Sample
— The Launch Sample
S Editor Button.

The Edit button opens the sample in an external sample editing application, which you can
specify in the File/Folder Preferences. To process a sample in an external program, you have
to stop Live’s playback. When you return to Live, the edited version of the sample will be
played back. The current set of Warp Markers is retained only if the sample length remains
the same as it did prior to editing. Remember that changes made to one sample may affect
other clips that play the same sample.
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8.2.5 Saving Default Clip Settings with the Sample

Sampile

The Save Default Clip button saves the current clip’s settings with the sample. Once saved,
Live will restore the current clip settings whenever you drop the sample into a Live Set. This
is especially useful with regards to the Warp Markers, which have to be set correctly for

Live to play long files in sync. Note that you can use the Save button without affecting any
existing clips; Save just saves default settings for future clips using this sample.

The clip data becomes part of the analysis file that accompanies the sample.

Note that storing default clip settings with the sample is different from saving the clip as a
Live Clip, which also saves devices and device settings.

8.2.6 High Quality Interpolation

Sample

Fade| [FAM

If the High Quality switch is on, Live uses an advanced sample-rate conversion algorithm
that provides better sound quality at the expense of a higher CPU load. Samples processed
with the Hi-Q algorithm generate less distortion, particularly at high frequencies, when
transposing a sample and/or matching an imported sample’s sampling rate to the system’s

sampling rate. With this mode enabled, samples can be transposed roughly 19 semitones
in either direction before aliasing is likely to be audible.

Note: As of Live 7, the Hi-Q mode uses an algorithm that produces even smaller audible
artifacts than in previous versions. Although we think this has greatly improved sound
quality, any Sets made in older versions that used Hi-Q mode may now sound different. For
this reason, we have provided a Legacy Hi-Q Mode option, which is enabled by default in

The Save Default Clip
Button.

The High Quality Switch.
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the Options menu whenever you load an old Set that has Hi-Q enabled for any clips. Simply
disable this option if you wish to use the new mode.

8.2.7 Clip Start and End Fades

Sample

b ) 2 The Clip Fade Switch.

The Clip Fade switch, when enabled, applies a short fade to the clip start and end to avoid
clicks at the clip edges. The length of the fade is signal-dependent and ranges from 0-4
milliseconds.

This switch is only available for clips in Session View. In Arrangement View, clip fades are
adjusted via envelopes.

The Clip Fade switch is on by default for all new clips when the Create Fades on Clip Edges
option is enabled in the Record/Warp/Launch Preferences.

v unwm

Warp/iFades

Record

Warp LoopWarp Short Samplas

Launch Auto-Warp Long Samples On

CPU Default Warp Moda Baals A . H C
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Create Fades on Clip Edges - Y .

User Account _——l Short Fades At Cllp

Licenses Launch

Edges.

8.2.8 Clip RAM Mode

Sample

i .|-:|,' The RAM Mode SWltCh
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If the RAM Mode switch is on, Live is loading the audio referenced by the clip into the
computer’s memory rather than reading it from disk in real time. RAM Mode can help with
these problems:

e Your computer’s hard disk is too slow to deliver audio for as many tracks as desired in
real time. For more information on disk-related problems, please refer to Managing
the Disk Load .

e You are experiencing audio dropouts when playing clips in Legato Mode.

Use RAM Mode with care, as RAM is usually a scarce resource. Your computer is using the
hard disk for swapping out RAM contents that have not been used in a while. The more
clips you are running in RAM Mode, the higher the likelihood for them to be swapped
out. Live can handle disk overloads more gracefully than swapped-out audio arriving late:
Disk overloads result in unwanted mutes, whereas RAM overload results in both mutes and
rhythmical “hiccups.”

8.2.9 Reversing Samples

Sample

This function creates a new sample by reversing the sample referenced by the current clip.
It then reapplies the old clip's settings (according to some rules that we will explain in a
moment), and replaces the original sample with the reversal in the Clip View. The new
sample can be found, after saving the Live Set, in the Set's Project folder, under Samples/
Processed/Reverse. Until the Set is saved, new samples remain at the location specified by
the Temporary Folder.

There are a few rules for the reversing process. First, any Warp Markers will remain fixed
to their positions in the sample. This means that a Warp Marker on the downbeat of the
second bar of a clip will end up on the downbeat of the second-to-last bar after reversal.
Clip loop/region settings are similarly flipped. Second, clip envelopes remain fixed to their
position in time. Therefore, a mixer volume envelope that lowers the volume of the first half
of a clip will continue to do exactly that after reversal.

The Reverse Button.



CHAPTER 8. CLIP VIEW 115

The reversal process is quite fast (about as fast as copying), but for very long samples it might
take a little time. When this is the case, the Status Bar in the lower portion of the Live screen
will give you a progress display, and further actions in the program will be temporarily locked
(though running clips will continue to play). You can play the reversed clip and perform other
actions in the program as soon as Live begins to draw the new waveform into the Sample
Display. Once a sample is reversed, a link to the reversed sample will be maintained until
you quit the program, and reversing the same clip again (or a copy) will be instantaneous.

It is not recommended that you reverse clips in a live performance situation, as a slight glitch
can sometimes occur while Live reapplies the warp and loop settings.

8.2.10 Cropping Audio Clips

The Sample Display’s & (PC) / ® (Mac) context menu includes the Crop Sample
command. This function creates, similarly to the Reverse function, a new sample by copying
the one currently in use - but only the excerpt that is actually used plus a 50 millisecond
safety margin on both ends. The new sample can be found, after saving the Live Set, in the
Set's Project folder, under Samples/Processed/Crop. Until the Set is saved, the new sample
remains at the location specified by the Temporary Folder.

8.2.11 Replacing and Editing the Sample

To replace the sample referenced by the clip with a different one, drop the new sample
directly from the File Browser into the Clip View. Clip settings like pitch and volume will
be retained. The Warp Markers will be retained only if the new sample has the exact same
length as the old sample.

The Sample Display’s @ (PC)/ (Ctl_ & (Mac) context menu includes the Manage Sample
File command. This opens the File Manager for the current Set with the sample referenced
by the clip selected. From there, you can replace and destructively edit the sample, in such
a way that all clips and instruments referencing the sample will be affected. You can also
use the Show in Browser command inthe & (PC)/ ® (Mac) context menu to reveal
the file in the Browser.
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8.3 The Notes Box
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8.3.1 Tempo Controls

The Orig. BPM field displays Live's interpretation of the tempo at which the clip’s MIDI
was recorded. When dragging up or down in the Original BPM field, or clicking the :2 and
*2 buttons, you will see that the notes in the MIDI Editor are correspondingly stretched
or compressed. This is useful for aligning notes that you have recorded without a tempo
reference, like Live's metronome.

8.3.2 Bank and Program Change

Live can send MIDI bank/program change messages to external devices and plug-ins that
support MIDI program change messages. According to the settings in these controls,
launching a clip also sends its bank/program change message. If you are using Live to send
MIDI to your synth, this means that each MIDI clip in your Live Set can play a different sound
on your synth. Live offers messages for 128 banks with 128 sub-banks, each of which has
128 programs. Please see the documentation that came with your synthesizer to determine
how many of these messages it can use. If you do not want your clip to send program or
bank change messages, simply set the bank/program choosers to “None.”

The Notes Box.
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8.3.3 MIDI Loop/Region

These controls manage how the contents of a MIDI clip are played and shown in the MIDI
Editor. They work the same way as those for audio clips.

In the MIDI Editor, the zoom/scroll area is located above the beat-time ruler, the scrub area
just below.

8.4 Clip Defaults and Update Rate

You can change the rate at which Live applies your Clip View settings to a running clip. Clip
View changes will be quantized by the rate selected from the Clip Update Rate chooser in
the Record/Warp/Launch Preferences. Certain clip settings, such as Launch Mode and Warp
Mode, can be set up as defaults for all new clips. This is also done in the Record/Warp/
Launch Preferences.
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Chapter 9

Tempo Control and Warping

Unlike music stored on tape or in a traditional digital audio workstation, the music in Live
remains “elastic” at all times. Live is capable of time-warping samples while streaming them
from disk so as to synchronize them to the current Live Set's tempo. This happens without
affecting the pitch, which can be changed independently. Mixing and matching audio from
different origins is therefore extremely easy.

9.1 Tempo

9.1.1 Setting the Tempo

The Control Bar's Tempo field allows you to change the playback tempo of your Live Set
at any time, in real time. You can even automate the tempo to create smooth or sudden
tempo changes along the song timeline. For maximum tempo control during performance,
you can MIDI map separate controllers to the Tempo field on both sides of the decimal
point. Setting one knob to control coarse tempo in BPM and another to control fine tempo

The Control Bar’s Tempo
Field.
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in hundredths of a BPM allows for enough precision to adjust to live performers or other
unsynchronized sources.

You can have an external sequencer (or drum machine) play along with Live or have Live play
along with the sequencer. The respective settings are made in the MIDI/Sync Preferences,
and the EXT switch next to the tempo control is activated to have Live follow an external
MIDI clock source. Please refer to the section on synchronization for details.

9.1.2 Tapping the Tempo

14 41 4 |oce

You can use Live’s Tap Tempo function to set the tempo at any time. As you click the Control
Bar's Tap Tempo button once every beat, the tempo of the Live Set will follow your tapping.

I MID 4 % o

Audic 11 Masier

It is better to assign the Tap button to a computer key than using the mouse. Click on the
Control Bar's KEY switch to enter Key Map Mode; then select the Tap button; press the key
you would like to use for tapping; click the KEY switch again to leave Key Map Mode. The
assignment will take effect immediately. The Tap button can also be assigned to a MIDI
note or controller, like a foot switch, in a similar fashion. Although Live responds to your
tapping immediately, it does apply some degree of inertia to prevent sluggish behavior in
the software. The more taps Live receives in a row, the more precisely it will be able to
conclude the desired tempo.

You can also use tapping to count in: If you are working in a 4:4 signature, it takes four taps
to start song playback at the tapped tempo.

9.1.3 Nudging the Tempo

The Tap Button.

The Key Map Mode
Switch.

The Nudge Buttons.
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Although Live can be easily synchronized to external MIDI devices, you may find yourself in
situations in which you need to adjust to sources that aren’t locked to one tempo, such as
live musicians or turntables. As long as your Set's tempo is basically the same as that of the
unsynchronized material, you can use the Nudge buttons to temporarily speed up or slow
down Live's playback to match what you hear. As with the Tap button, these buttons are
much easier to use when mapped to MIDI controllers.

9.2 Time-Warping Samples

Live's ability to play any sample in sync with a chosen tempo is a unique and important
feature. In addition, you can “warp” the rhythmic flow of a piece, changing its “feel,” or
even move notes to other meter positions.

A clip’s warping properties are set in the Sample box, which is a sub-section of the Clip View.

Sample -+

The most significant control here is the Warp switch, which toggles a clip’s warping on or
off. The Warp section of Live’s Preferences will determine the default warp settings for new
clips, but they can always be overridden here on a per-clip basis.

When the Warp switch is off, Live plays the sample at its original, “normal” tempo, irre-
spective of the current Live Set's tempo. This is useful for samples that have no inherent
rhythmic structure: percussion hits, atmospheres, sound effects, spoken word and the like.
Turn the Warp switch on to play rhythmically structured samples (such as sample loops,
music recordings, complete music pieces, etc.) in sync with the current song tempo.

To direct Live's assumptions about new samples, use the Record/Warp/Launch tab of Live’s

The Sample Box's
Warping Controls.
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Preferences. If the Auto-Warp Long Samples preference is on, Live assumes that long
samples contain music that should be played in sync with the Live Set’s tempo. If you would
rather have Live default to playing long samples as they are, disengage this preference.

9.2.1 Tempo Master/Slave

All warped clips in the Arrangement View have one further option: They can be defined as
tempo masters by toggling their Master/Slave switches. Any number of clips can be set as
tempo masters, but only one clip at a time can actually be the tempo master. This distinction
is always granted to the bottom-most, currently playing clip in the Arrangement View.

The clip that is the current tempo master will play as if warping was off, but with one
important difference — the rest of the Live Set will be warped so that it plays in sync with the
current tempo master.

This is achieved by adding tempo automation to the Master track for the duration of the
tempo master clip. You will notice that the Tempo field in Live’s Control Bar becomes
disabled in this state; this is because all tempo control is handed over to the tempo master
clip.

When toggling a clip’s Master/Slave switch, or when deleting a clip that was set as tempo
master, the Master track tempo automation is removed again, restoring the proper tempo
to the region. If you wish instead to keep the generated tempo automation to continue
working with it, then & (PC)/ & (Mac) on the Control Bar's Tempo field, and choose
the Unslave Tempo Automation command. All clips will then be set to Slave, but the tempo
automation will remain in place.

Note that when Live's EXT switch is enabled, the Master/Slave switch has no effect and
appears disabled.

9.2.2 Warp Markers

Think of a sample as a rubber-band that you want to pin to a (musical time) ruler. In Live,
the pins are called Warp Markers. A Warp Marker locks a specific point in the sample to
a specific place in the measure. You can use any number of Warp Markers to create an
arbitrary mapping of the piece’s inherent rhythm to a musical meter.
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Warp Markers are set in the Clip View's Sample Display by double-clicking within the sam-
ple. They can then be dragged or moved with the arrow keys to different points in time.
Warp Markers can also be deleted by double-clicking them, or by pressing the computer
keyboard’s or key after selecting them.
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When working with your sample, you can have Live scroll the Sample Display to follow
playback. Use the Control Bar's Follow switch to activate this feature. It also might be
helpful to vertically resize the Sample Display by dragging on the split line between the Clip
View and the Session View track area.
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Transients and Pseudo Warp Markers

When you first load a sample into Live, Live automatically analyzes the audio and finds its
transients. These are the points in the audio where notes or events begin, and are usually
good places to put Warp Markers. Transients appear as small markers at the top of the
sample display after zooming in.

Double-Clicking In the
Sample Creates a Warp
Marker.

The Follow Switch in the
Control Bar.
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As you mouse over transients, temporary “pseudo” Warp Markers appear. These have
the same shape as regular Warp Markers, but they're grey. Double-clicking or dragging a
pseudo Warp Marker creates an actual Warp Marker or, if there are no Warp Markers later
in the clip, changes the tempo for the clip segment. Holding the (PC) /
(Mac) modifier while creating a Warp Marker on a transient also creates Warp Markers at the
adjacent transients. Holding the modifier while clicking on a pseudo Warp Marker
allows you to drag the transient to a new position.

You can also select a range of time and create Warp Markers at all of the transients within
the range via the Create menu’s “Insert Warp Markers” command. If there are no transients
within your time selection, a Warp Marker will be created at the end of the selection.

Although Live usually does a good job of placing transients in the right places, you can
delete and create transients as well, via the corresponding commands in the Create menu.

Saving Warp Markers

Your Warp Markers will automatically be saved with the Live Set, but you may also want to
save them with the sample file itself, so that they are reconstructed anytime you drag the
file into Live. To do this, click the Clip View's Save button.

Note that if a sample has a saved set of Warp Markers, Auto-Warp will have no effect. When
this is the case, you can use any of the O (PC)/ ® (Mac) context menu commands
described in this section to initiate auto-warping.

Transient Markers.
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9.2.3 Using Warp Markers

In the following sections, we will look at a couple of applications for time-warping samples.
Warping is, of course, an optional property of clips.

Syncing Straight Loops

When you import a sample that represents a well-cut musical loop of 1,2,4 or 8 bars in
length, Live usually makes the correct assumptions to play the loop in sync with the chosen
tempo. It creates two Warp Markers, one at the sample’s beginning and one at the end.

& 1 1.2 1.3 1.4 2 2.2 (2.3 2.4
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The Seg. BPM field displays Live's guess of the loop’s tempo; if you happen to know the
tempo of the loop, you can type it in here. Sometimes Live's guess of the original tempo
is wrong by half or double. If so, correct this by clicking on the buttons labeled *2 and
:2, respectively. The sample plays at double speed when you press :2 because you are
changing Live’s interpretation of the sample’s tempo, which serves as a point of reference
for determining the required time-stretch factor.

Syncing Uncut Loops

When importing a loop that has not been edited into a well-cut loop, Live will play it out
of sync. Suppose there is a portion of silence at the sample beginning, prior to the first
beat. You can easily correct this by placing a Warp Marker at the beginning of the audio
and dragging it so that it lines up with the beginning of bar one in the timeline. Likewise,

A Two-Bar Loop as It
Appears in the Clip
View, by Default.
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you can eliminate silence after the actual loop end by placing a Warp Marker at the sample’s
right edge.

Syncing Odd-Length Loops

If you import a sample that contains a seven-bar loop, Live initially assumes the loop is eight
bars long (or four, depending on its length) and plays it out of sync. For correct playback,
the marker at the end of the sample needs to be at the beginning of bar eight, not bar nine.
To fix this, simply drag the ending marker to the correct position.

If Live's initial guess had been a four-bar loop, the eighth bar may not initially be visible. In
that case, you can drag the Warp Marker at the end toward the right until the eight becomes
visible.

Manipulating Grooves

You can now create any number of Warp Markers by double-clicking within the sample or
on transient locations. Drag in a “straight” looped sample, set a few Warp Markers, and
move them around to see what happens. Warp Markers really serve two purposes:

1. to provide a “correct” interpretation of the flow of musical time in the sample;

2. to mess up the flow of time in the sample.

Setting the Warp
Markers for a Poorly Cut
Loop.
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If a single event in a percussion loop comes late, just pin a Warp Marker to it and drag the
marker to the correct beat position. You may want to pin the adjacent events as well, to
avoid affecting neighboring regions in the sample.
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“Removing” a sample’s natural groove by applying Warp Markers is an interesting creative
method, particularly in conjunction with Live's ability to impose an artificial groove onto clips
in real-time.

Syncing Longer Pieces

Live's Auto-Warp algorithm makes longer samples and entire songs readily available for
integration into your project. You can use the Browser to import long samples or MP3, AAC,
Ogg Vorbis, Ogg FLAC and FLAC files.

When you drag a file into Live that is too long to justify the assumption that it is a loop
or a one-shot, Live will auto-warp the clip by default (though this can be changed in the
Record/Warp/Launch Preferences).

Note that, for the auto-warp mechanism to work, files which are being imported into the
program for the first time will need to undergo a first-time analysis process and will not be
immediately available for playing or editing. As explained in the section in this manual on
analysis files, analysis can be batch-processed with the @ (PC) / [Ctrl ]® (Mac) context
menu’s Analyze Audio command. Once analysis is finished, you can view the results of
Auto-Warp's assumptions about the file.

Using Warp Markers to
Manipulate the Groove.
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Auto-Warp’s Results in
the Clip View.

As long as Auto-Warp made the correct set of informed guesses, the clip will be ready to
play in perfect sync with the Live Set’s tempo. However, if Auto-Warp does not quite do
what you want, you can control its results. The remainder of this section will focus on various
ways of guiding Live’s auto-warping. Remember that the metronome in the Control Bar will
probably come in handy as you warp longer pieces.

[t might happen that Auto-Warp guesses the tempo correctly but gets the downbeat wrong.
To remedy this, you can do the following:

The Metronome Switch.

e Zoom in and create a Warp Marker on the downbeat. Then drag it to the beginning
of bar 1 in the timeline;

e Use the start marker's @ (PC)/ (Ctl | & (Mac) context menu to select the Set 1.1.1
Here command.
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Set 1.1.1 Here

Warp From Here

Warp From Here (Starl at 98.00 BPM)
Warp From Here (Straight)

Warp 58.00 BPM From Here

Warp as 8-Bar Loop

+

Directing Auto-Warp is also relatively simple when you have imported a perfectly cut loop.
You can tell Auto-Warp to work accordingly using the Warp As ...-Bar Loop command. Live
will propose a loop length that makes the most sense given the current Live Set's tempo.
Decreasing the Live Set's tempo can, for instance, lead Live to assume the loop is 8 bars at
90 BPM instead of 16 bars at 180 BPM.

Sometimes more accurate control of Auto-Warp is necessary. The best way to go about
warping a clip that requires more detailed attention is in sections, working gradually from
left to right. You can set a Warp Marker by double-clicking in the sample to the right of
each correctly warped section, “pinning” it into place. The shortcuts for working with the
clip loop brace and start/end markers can speed up this process considerably.

You might also find it helpful to select multiple Warp Markers for moving by selecting them
with the or (PC)/ (Mac) modifiers held down.

Using the Context Menu
to Direct Auto-Warp.
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The four Warp From Here commands provide various ways of resetting Warp Markers to
the right of the selected grid marker or Warp Marker, leaving Warp Markers to the left
untouched. These commands are also available from the start marker.

e Warp From Here runs the Auto-Warp algorithm on the material to the right of the
selected marker.

e Warp From Here (Start At ...) directs Auto-Warp to use the current Live Set's tempo as
a starting point for tempo tracking. The strategy here is as follows:

1. Deactivate the Warp switch for the clip so that it plays unwarped;

2. Use the Control Bar's Tap Tempo button to tap along, thereby setting the
Live Set's tempo to match that of the clip;

3. Turn warping on again and use the Warp From Here (Start At ...) command
to tell Auto-Warp to use your tapped tempo as a reference.

e Warp From Here (Straight) tells Auto-Warp that this is a clip with no tempo variations
(common in electronically produced works). Auto-Warp will then set a single Warp
Marker derived from its guess of the file's original tempo.

e Warp ... BPM From Here will also set a single Warp Marker, but in this case, Auto-Warp
is forced to interpret the clip as exactly matching the Live Set's tempo. This is useful
in cases when you happen to know the exact BPM value of an electronically-produced
work and can type it into the Control Bar before warping.

Multi-Clip Warping

When clips of equal length are multi-selected, adding or changing Warp Markers for one
clip will apply identical Warp Markers to all. This is convenient in any situation where several
tracks have the same rhythm, and you wish to alter the timing of each recording in the same
way. A common scenario would be when multi-tracking a band’s performance, where the
musicians all play in time with each other, yet the timing itself is in some way flawed.
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9.2.4 AQuantizing Audio

In the previous section, you learned how to adjust the timing of events in audio files by
manually dragging Warp Markers along the timeline. But it is also possible to automatically
snap the entire sample to the grid at once by using the Quantize command. To do this, click
in the background of the sample editor and choose the Quantize command from the Edit
menu, or use the (PC)/ (& U] (Mac) hotkey. This will quantize using default
settings, or the settings that you previously applied.

To adjust your quantization parameters, open the Quantization Settings dialog from the Edit
menu.

Quantize To: Current Grid =/
Amount 1

ok ) (_Cancel )

Using the options presented here, you can select either the current grid size or a specific me-
ter value for quantization. You can also quantize without that “quantized” feel by adjusting
the Amount control, which will move Warp Markers by a percentage of the set quantization
value.

9.3 Adjusting for Good Stretching Quality

Live offers a number of time-stretching modes to accommodate all sorts of audio material.
Each clip’s time-stretching mode and associated parameters are set in the Clip View's Sample
Box.

Quantizing Audio
Samples.
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The warp modes are different varieties of granular resynthesis techniques. Granular resyn-
thesis achieves time compression and expansion by repeating and skipping over parts of
the sample (the “grains”). The warp modes differ in the selection of grains, as well as in the
details of overlapping and crossfading between grains.

Let's investigate which warp modes work best for different types of signals and how to
adjust the warping controls for “clean” stretching. It's also fun to “misuse” these controls
to achieve interesting artifacts instead of accurate stretching.

9.3.1 Beats Mode

Beats Mode works best for material where rhythm is dominant (e.g., drum loops as well as
most pieces of electronic dance music). The granulation process is optimized to preserve
transients in the audio material.

Use the Preserve control to preserve divisions in the sample as boundaries when warping.
For the most accurate results, particularly with percussive material, choose Transients. This
setting uses the positions of the analyzed (or user-created) transients to determine warping
behavior. To preserve specific beat divisions regardless of the sample’s contents, choose
one of the fixed note values. For some interesting rhythmic artifacts, choose large note
values in conjunction with pitch transposition.

The Transient Loop Mode chooser sets the looping properties for the clip’s transients:

Loop Off — Each segment of audio between transients plays to its end and then stops.
Any remaining time between the end of a segment and the next transient will be silent.

Loop Forward — Each segment of audio between transients plays to its end. Playback
then jumps back to a zero-crossing near the middle of the segment and continues looping
until the time when the next transient occurs.

Loop Back-and-Forth — Each segment of audio between transients plays to its end.
Playback then reverses until it reaches a zero-crossing near the middle of the segment, and
then proceeds again towards the end of the segment. This pattern continues until the time
when the next transient occurs. This mode, in conjunction with the Preserve Transients
selection, can often result in very good quality at slower tempos.



CHAPTER 9. TEMPO CONTROL AND WARPING 132

The Transient Envelope slider applies a volume fade to each segment of audio. At 100,
there is no fade. At O, each segment decays very quickly. Long envelope times can help
to smooth clicks at the end of segments, while short times can be used to apply rhythmic
gating effects.

9.3.2 Tones Mode

Tones Mode serves well for stretching material with a more or less clear pitch structure, such
as vocals, monophonic instruments and basslines.

Grain Size provides rough control over the average grain size used. The actual grain size is
determined in a signal-dependent manner. For signals with a clear sense of pitch contour,
a small grain size works best. Larger grain sizes help avoid artifacts that can occur when the
pitch contour is unclear, but the tradeoff can be audible repetitions.

9.3.3 Texture Mode

Texture Mode works well for sound textures with an ambiguous pitch contour (e.g., poly-
phonic orchestral music, noise, atmospheric pads, etc.). It also offers rich potential for
manipulating all kinds of sounds in a creative way.

The Grain Size control determines the grain size used, but unlike in Tones Mode, this is a
setting that Live will use unaltered, without considering the signal’s characteristics.

Fluctuation introduces randomness into the process. Larger values give more randomness.

9.3.4 Re-Pitch Mode

In Re-Pitch Mode, Live doesn't really time-stretch or compress the music; instead, it adjusts
the playback rate to create the desired amount of stretching. In other words, to speed
up playback by a factor of 2, it's transposed up an octave. This is like the “DJ stretching
method” of using variable-speed turntables to sync two records, or what happens to samples
in samplers when they're transposed.

The Transpose and Detune controls have no effect in Re-Pitch Mode.
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9.3.5 Complex Mode

Complex Mode is a warping method specifically designed to accommodate composite
signals that combine the characteristics covered by other Warp Modes; it works well for
warping entire songs, which usually contain beats, tones and textures.

Complex Mode is a rather CPU-intensive function, using approximately ten times the CPU
resources required by the other Warp Modes. As such, you may want to freeze tracks where
Complex Mode is used or record the results as a new clip to use as a substitute.

9.3.6 Complex Pro Mode

Complex Pro Mode uses a variation of the algorithm found in Complex mode, and may offer
even better results (although with an increase in CPU usage.) Like Complex Mode, Complex
Pro works especially well with polyphonic textures or whole songs.

The Formants slider adjusts the extent to which the formants of the sample are compensated
when transposing. At 100%, the original formants will be preserved, which allows for large
changes in transposition while maintaining the sample’s original tonal quality. Note that this
slider has no effect if the sample is played back untransposed.

The Envelope slider also influences the spectral characteristics of the material. The default
setting of 128 should work well for most audio. For very high-pitched samples, you may
have better results with lower Envelope values. Likewise, low-pitched material may sound
better with higher values.

9.3.7 REX Mode

REX Mode differs from the other Warp modes in several ways. Most notably, it is not available
as an option in the Clip View's Sample Box, but is instead enabled automatically when
loading a file in REX format. REXfiles, associated with the program ReCycle by Propellerhead
Software, contain embedded tempo and timing information and will synchronize to your Set’s
tempo just like any other audio file.
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Although REX files are audio files, they can quickly be transformed into playable instruments
via the Slice to New MIDI Track command, which is available in the Create Menu or the
(PC) / ® (Mac) context menu for the Clip.

Warp Markers/parameters, Clip Envelopes that affect warping properties, and the Clip
Nudge controls are not available for REX files.
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Chapter 10

Editing MIDI Notes and Velocities

A MIDI clip in Live contains notes and controller data for playing a MIDI instrument. This
instrument can be a virtual instrument in a MIDI track’s device chain or an external synth
fed via the track’s output routing. The MIDI clip provides the device with a musical score
to play, specifying note pitch, length, position and dynamics (referred to as velocity in the
MIDI lexicon). MIDI is composed and edited in Live’s MIDI Editor.

10.1 Creating an Empty MIDI Clip

MIDI clips are created
e by means of recording;
e or by double-clicking an empty Session slot in a MIDI track;

e or by selecting an empty Session slot in a MIDI track and choosing the Create menu’s
Insert MIDI Clip command;

e or, in the Arrangement View, by selecting a timespan in a MIDI track and choosing the
Create menu’s Insert MIDI Clip command.
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10.2 The MIDI Editor

To bring up the MIDI Editor, double-click a MIDI clip to open the Clip View. You can use the
Clip View Box selector to make sure the Notes box is showing, then click in the title bar of
the Notes box to bring up the MIDI Editor on the right-hand side of the screen.

@ . o
Kick+ &3 Orig. BPM Start

— ()

Signature @ @ |ena

[Ca a1 gank I I

Groove (@& e
[ toop |

Pasition (S&l)

ook

Sub-Bank
[None | Lenglh
000 (_A(o[o

The MIDI Editor.

The MIDI Editor is divided into two editing windows: the upper Note Editor and the lower
Velocity Editor. You can resize the Velocity Editor by dragging on the split line that runs
between it and the Note Editor. You can also show and hide the Velocity Editor using the
triangular button on the left-hand side of the split line.

s S : = The Control Bar's Draw
b > B | ® ovR| =+ | 1Bar .§
, Mode Switch.

Switch to Draw Mode by activating the Control Bar's Draw Mode switch. You can now draw
MIDI notes into the Note Editor with the mouse. Deactivating Draw Mode allows notes to
be selected and moved around via clipboard operations or by clicking and dragging, either
vertically to change their transposition, or horizontally to change their position in time. MIDI
notes can also be added and deleted by double-clicking when Draw Mode is inactive.
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Previewing MIDI Notes.
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Provided your MIDI track’s device chain contains an instrument, activating the Preview switch
in the MIDI Editor allows you to hear notes as you select and move them. If the MIDI track
is armed, activating Preview also allows you to step record new notes into the clip.

Note velocity is adjusted in the Velocity Editor, by clicking and dragging on the associated
markers. You can also use Draw Mode in the Velocity Editor: It will draw identical velocities

for all notes within a grid “tile.”

After drawing a few notes and moving them around, you will probably want to know how to
get around in the Note Editor. So, before we get into detailed editing information, we will
first explain MIDI Editor navigation.

10.3 MIDI Editor Navigation and Transport

Note Scale Position Is
} Shown Vertically and
— Beat-Time Horizontally.
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The MIDI Editor has both vertical and horizontal navigation. Along the horizontal axis lies
a time ruler, which shows note position along a musical timeline. The vertical axis contains
the note ruler, displaying octaves CO-C10, and a representation of a piano keyboard (the
piano roll). Note that if the Preview switch at the top of the piano roll is activated, you can

listen to the results of your piano roll playing.

2 1 3 5 6

1.

To smoothly change the time-zoom level, click and drag vertically in the time
ruler. Drag horizontally in the time ruler to scroll from left to right.

Click and drag vertically in the note ruler to change which octaves are shown,
or drag horizontally to change the vertical zoom size of MIDI notes and the
keyboard.

Click and drag over one or more notes to select them, or over a portion of the
editor’s background to select a range of time. Then, double-click on the note
or time ruler to automatically zoom in on your selection. If nothing is selected,
double-clicking the note ruler will zoom in on the area from the lowest to the
highest note in the clip, while double-clicking the time ruler will zoom out to
show the time between the first and last note.

To zoom in and out around the current selection, use the computer keyboard’s
+ and - keys.

. The Clip Overview just beneath the MIDI Editor can also be used for navigation.

MIDI Editor Navigation.
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It always shows the complete contents of the selected MIDI clip. The black
rectangular outline represents the part of the clip that is currently displayed in
the Editor above. To scroll, click within the outline and drag left or right; to zoom
in and out, drag up and down.

6. Change the length of what is shown in the Editor by dragging the left or right
edges of the outline in the Clip Overview.

7. To quickly change what is shown in the Editor, click on a section that you want
to examine in the Clip Overview, then drag downwards to zoom in, or scroll by
dragging left and right.

1 1 (0| ®|OVR | =+ |1Bar &

The area displayed in the Note Editor can be set to scroll with playback using the Follow
switch from the Control Bar.

When Permanent Scrub Areas is enabled in Live's Look/Feel Preferences, clicking in the
scrub area below the beat-time ruler starts playback from that point, rounded by the global
quantization setting. When the Permanent Scrub Areas preference is off, you can still scrub
by (& ]-clicking anywhere in the scrub area or in the beat-time ruler. Learning about the
loop/region controls and associated shortcuts can also be helpful in getting around in the
MIDI Editor and playing selections quickly and easily.

As you work with MIDI, you may find yourself needing extra screen space. You can click and
drag vertically on the window split between the Session or Arrangement View and the Clip
View to enlarge the MIDI Editor.
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The Control Bar's Follow
Switch.

Enlarge the MIDI Editor
by Dragging the
Window Split Between
Session and Clip Views.
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10.4 Editing MIDI

10.4.1 Non-Destructive Editing

You can always return your MIDI clip to its previous state by using the Edit menu’s Undo
command. Furthermore, if the MIDI clip being edited originated in a MIDI file on your hard
drive, none of your editing will alter the original MIDI file, as Live incorporates its contents
into your Live Set when importing.

10.4.2 Folding and Looping

An important feature of the MIDI Editor is the Fold button, located in the upper left corner.
Activating this button will immediately hide all rows, or key tracks, that do not contain MIDI
notes in any clips in the track. This is very useful when working with percussion kits, for
example, which are oftentimes mapped out along a keyboard in sections corresponding
to percussion type (e.g., snares grouped together two octaves down from hi-hat cymbals,
etc.). When working with a MIDI file created by such a mapping, sometimes only one or two
of each type of percussion sound is used, and it becomes unnecessary to view the entire
keyboard range.

When editing MIDI, you might find that you want to change which part of the clip you are
listening to, or loop the clip in order to listen to it repeatedly. You can use the loop/region
markers for this.

The Fold Button Extracts
Key Tracks Containing
Notes.
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10.4.3 Grid Snapping

Most functions in the MIDI Editor are subject to grid snapping. You can hold down the
(PC) / (Mac) modifier while performing an action to bypass grid snapping.

Note movements will also snap to an “offset,” which is based on the original placement of
the note relative to the grid. This is useful for preserving a groove or loose playing style that
you do not necessarily want to “set straight.”

10.4.4 Editing Notes

Editing in the MIDI Editor is similar to editing in the Arrangement. In both cases, your
actions are selection-based: you select something using the mouse, then execute a menu
command (e.g., Cut, Copy, Paste, Duplicate) on the selection.

Here is how selection works:

e Clicking a note selects the note. Multiple notes can be selected in unison: “rubber-
band” select more than one note with one mouse motion by clicking in empty space,
then dragging to enclose the notes in the dotted line that appears. (Esc | deselects
all selected notes.;

e Clicking into the background of the MIDI Editor selects a point in time, represented
by a flashing insert mark.

Use the Loop/Region
Markers to Select a
Specific Region of the
Clip to Play.
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e Clicking and dragging in the background selects a timespan. To select all of the notes
that begin during the timespan, press [Return].

After placing the insert mark, you can manipulate it using your computer keyboard.

e Press or = to move the insert mark to the left or right, according to the grid

settings. (PC)/ (Mac) or moves the insert mark to the next note
boundary.

e Hold down while pressing the arrow keys to extend or retract the selected
timespan by moving the insert mark. (Alt (PC)/ (At ~] (Mac)+ (& while pressing

the arrow keys extends or retracts from the opposite side of the selection.

e The insert mark can be moved to the beginning or end of a MIDI clip by pressing the
Home or End key, respectively.

As we have seen, notes in the MIDI Editor can be moved both horizontally (changing their
position in time) and vertically (changing their transposition). They can be moved either by
clicking and dragging, or with the arrow keys on your computer keyboard; in either case,
they are subject to grid and offset snapping. If you are playing the clip while you edit notes,
you can listen to them play in their new assignments as you change them.

Several key modifiers also apply to note editing:
e To transpose selected notes by octave, hold down while pressing (4] or (¥].

. or ) extends or retracts the duration of selected notes, according to the
grid settings.

e To change the selection to the next note in the same key track, hold the (PC)/
(Mac) while pressing [« or BJ. (PC) / (Mac) (%] or moves

the selection to the next note in time.

e You canusethe modifier to click and add individual notes or additional “rubber-
band” selections to your current selection. You can also remove a single note from
your selection by holding down ({& ] and clicking on it. Holding ({& ] and clicking
on the piano roll adds all notes in a single key track to the current selection, or removes
them if they were already selected.

Selecting a note (or notes) makes it subject to commands from the Edit menu, such as Copy
and Paste. Notes in the clipboard will be pasted starting at the location of the insert mark.
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You can also use the (PC) / (Mac) modifier to click and drag copies of notes
to a new location. If you click and drag to move notes but then decide that you would like
to copy them instead, you can press the (PC) / (Mac) modifier even after
starting the drag.

When editing or drawing, you may sometimes place a new note on top of one that already
exists. If the new note overlaps with the beginning of the original note, the original note
will vanish. If the new note overlaps with the “tail” of the original, the original note’s length
will change so that it lasts just until the new note’s beginning.

10.4.5 Changing Note Length

Clicking and dragging on a note’s left or right edges changes its length. Note length can
only be changed when Draw Mode is inactive, and will be quantized unless the (PC)
/ (Mac) modifier is held down while dragging.

(16 (162

Tip: To set a group of notes to the same length, select them all, grab the end of the longest
one, drag them all down to zero length and then extend them.

10.4.6 The ...Time Commands in the MIDI Editor

The standard clipboard commands like Cut, Copy and Paste only affect the currently selected
notes (or the notes within a time selection). But, as in Arrangement editing, there are “...
Time"” commands that act upon the entire MIDI clip by inserting and deleting time.

Note that these operations do not change the clip start/end position or the loop brace
settings.

Changing Note Length.
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e Cut Time cuts a selection of time from the MIDI clip, thereby moving any notes on
either side of the cut area closer together in the timeline.
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¢ Paste Time places copied time into the MIDI clip, along with any notes that were in

the copied time.

e Duplicate Time places a copy of the selected timespan into the clip, along with any

contained notes.

¢ Delete Time deletes a selection of time from the MIDI clip, thereby moving any notes
on either side of the deleted area closer together in the timeline.

e Insert Silence inserts as much empty time as is currently selected into the clip, before
the selection.

10.4.7 Quantizing Notes

There are three options for quantizing MIDI notes in Live. First, you can quantize MIDI
notes as you record them. Secondly, as previously mentioned, you can move notes so that
they snap to the visible grid lines. Finally, you can select a note or notes and choose the
Quantize command from the Edit menu, or use the (Ctl (U] (PC)/ (& $)(U] (Mac) hotkey.
The first time you do this, you will see a dialog box with several quantization options. This

will quantize using default settings, or the settings that you previously applied.

To adjust your quantization parameters, open the Quantization Settings dialog from the Edit

menu.

A Gap Between MIDI
Notes Has Been Cut by
First Selecting It, Then
Executing the Cut Time
Command.
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Using the options presented here, you can select either the current grid size or a specific
meter value for quantization and set either the note start or end (or both) to be quantized.
Quantizing the note end will stretch the note so that it ends at the chosen meter subdivision.
You can also quantize notes without giving them that “quantized” feel using the Amount
control, which will move notes only by a percentage of the set quantization value.

10.4.8 Editing Velocities

To change velocity for a MIDI note, click and drag on the associated marker in the Velocity
Editor. (To help you locate the velocity marker belonging to a MIDI note that may be stacked
vertically with others, Live highlights the velocity marker for whichever note your mouse is
hovering over.) Velocity changes will be shown numerically in a small display in the time
ruler.

/| =3 3 =

Changing Note Velocity.
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As in the Note Editor, you can select multiple velocity markers to change by clicking with
the modifier held down.

Tip: To set a group of notes so that they all have the same velocity, select their markers
in the Velocity Editor, drag them up or down to either maximum or minimum velocity, and
then adjust velocity to the desired value.

As we saw earlier, Draw Mode allows drawing identical velocities for all notes within a grid
tile. While in Draw Mode, velocity drawing is limited to only those notes that are currently
selected. To draw markers individually (as you would want to with a crescendo, for instance)
deactivate grid snapping with the (Ctl J[4] (PC)/ (& 84| (Mac) shortcut, or simply hold
down the (PC) / (Mac) modifier.
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Tip: To draw a velocity ramp with notes that are all in the same key track, press ({ | and
click on the piano roll to select all notes within the desired key track, make sure Draw Mode
is activated and draw the ramp into the Velocity Editor while holding the modifier,
so that you affect only the selected notes.

Tip #2: To draw a linear velocity ramp across a selection of notes, first select the notes that
should be affected (using the [{& ] modifier to select non-adjacent notes if necessary).
Make sure Draw Mode is not activated and draw the line into the Velocity Editor while

holding the (PC)/ (& 88 (Mac) modifier.

Notes in the Note Editor display their velocity in their coloring — light notes play softly,
and vice versa. To change the velocity of notes without the Velocity Editor open, click any
selected note and drag vertically while pressing the (Alt (PC)/ (& % (Mac) modifier.

Vertical movements in Draw Mode correspond to velocity changes. This means that, with
one horizontal motion and one vertical motion, you can draw multiple notes and their
velocities without releasing the mouse button. If you change velocity with this vertical

Drawing Identical
Velocities (Left) and a
Crescendo (Right).
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movement, Live will remember the change and use your new velocity on any notes that you
draw afterward.

Note-Off Velocity

By default, the Velocity Editor allows you to adjust note-on velocities. But you can toggle
the editor to show note-off velocities via options in the editor's & (PC)/ [Ctl & (Mac)
context menu.

= =
— =
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I 00

The Velocity Editor

qvatmumalwm[ Showing Note-Off

— LA At Velocities.

»

Please note that note-off (or “release”) velocity is a somewhat esoteric parameter, and is
only supported by certain devices. Ableton’s Sampler instrument, for example, provides
note-off velocity as a controller for a variety of parameters.

10.4.9 MIDI Note Stretch
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When multiple notes are selected in the Note Editor, the Stretch Notes command becomes
available from the context menu, if you invoke itwith @& (PC)/ (Ctul_ )& (Mac). Note Stretch
markers will then appear in the Note Editor, allowing notes to be scaled proportionally in
time. The markers are a pair of downward-pointing indicators that snap to the beginning of
the first and last notes in the selection.

By clicking and dragging one of the markers horizontally, the selected notes will move and
stretch so that they continue to occupy the same proportion of time that they did when they
were initially selected. The Note Stretch markers will always snap to the Note Editor's grid
lines unless the grid is not shown, or the (PC) / (Mac) modifier is held while
dragging.

If one marker is dragged beyond the boundary of the other, then the order of the stretched
notes will be “reflected” in relation to their initial sequence; this is sometimes referred to as
"“retrograde” behavior.

Any changes occurring to the notes included in the Note Stretch before the mouse button
is released will cancel the stretch operation. This can occur, for example, if the MIDI clip is
simultaneously being overdubbed with new notes.

10.4.10 Cropping MIDI Clips

Unused MIDI data can be deleted by means of the Crop Clip command. Simply & (PC)/
® (Mac) on a MIDI clip in the Session or Arrangement View and select this option.
Unlike cropping audio clips, cropping a MIDI clip does not create a new file on disk.

10.4.11 Deactivating Notes

To deactivate, or mute, a note (or notes) in the MIDI Editor, selectitand & (PC)/ ©
(Mac) to access the context menu. The Deactivate Note(s) command will mute the note,
making it appear gray in the display. To reactivate notes, use the context menu’s Activate
Note(s) command. You can de- or reactivate all of the notes in a single key track at once by

™ (PC)/ © (Mac) on a key in the piano roll.
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Chapter 11

Using Grooves

The timing and “feel” of each clip in your Set can be modified through the use of grooves.
Live's Library includes a large selection of grooves, which appear as .agr files in the Browser.

Library~

(&)
Date Modified

07.10.2008, 17:01

MHama Type
= Grooves
[=5] 2nd Line.agr Groove
[=] Edgy.agr Groove

[=] Heavy Backbeats.agr Groove
[=] Rock Push.agr Groove
[=] slightly Behind.agr Groove
[=] Slow Texas Shuffle.agr Groove
[=] Swing 8.agr Groova
[55] swing 16.agr Groove
[=] Swing 32.agr

07.10.2008, 17:00
07.10.2008, 17:00
07.10.2008, 17:00
07.10.2008, 17:00
07.10.2008, 17:00
07.10.2008, 17:00
07.10.2008, 17:00
07.10.2008, 17:01
07.10.2008, 17:01

The easiest way to work with Library grooves is to drag and drop them from the Browser
directly onto clips in your Set. This immediately applies the timing characteristics of the
groove file to the clip. If you want to quickly try out a variety of grooves, you can enable the
Hot-Swap button above a clip’s Clip Groove chooser and then step through the grooves in

Groove Files in the
Browser.
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the Browser while the clip plays.

Clip

Grooves can be applied to both audio and MIDI clips. In audio clips, grooves work by
adjusting the clip’s warping behavior, and thus only works on clips with Warp enabled.

11.1 Groove Pool

Once you've applied a groove file, you can modify its behavior by adjusting its parameters
in the Groove Pool, which can be opened or closed via its selector button at the bottom of
Browser.

[ Grain Delay 34.04.2008, 15:54
= Limiter 21.04.2008, 12:12
[ Looper 19.09.2008, 16:00
[ muitiband Dynamics 07.05.2008, 15:18
[T overdrive 21.04.2008, 12:12
[T Phaser 31.01.2008, 15:51

(2

You can also double-click grooves in the Browser to load them directly to the Groove Pool
before applying them to a clip. The Groove Pool contains all grooves that have been loaded
in this way or that are being used in clips. “Inactive” grooves (those that are not being used
by a clip) appear with their parameters greyed out.

The Hot-Swap Groove
Button.

The Groove Pool
Selector Button.



CHAPTER 11. USING GROOVES 151

r N |
A Currant Song's Groove Pool — Amount El

8th triplets @ @ 17 | I S 0% [ 0% 4
Laid Back @@[ne o[ 6% M [ 8% |[ 0% 4
Floating 16ths (B @ 1716 <|[ 0% | 100% |[ 0% |[ 0% |
adtne @@ [116T <[ 5% |NEE 11 |[23% 4

1716T | 0 % 0 %

w HeavyBackbeat @ @ [18 |l 1z% [MEEE [ 0% 0%

=

11.1.1 Adjusting Groove Parameters

Grooves in the Groove Pool appear in a list, and offer a variety of parameters that can be
modified in real time to adjust the behavior of any clips that are using them. You can also
save and hot-swap grooves via the buttons next to the Groove's name.

The Groove Pool’s controls work as follows:

e Base — The Base chooser determines the timing resolution against which the notes in
the groove will be measured. A 1/4 Base, for example, means that the positions of
the notes in the groove file are compared to the nearest quarter note, and all notes
in any clips that are assigned to that groove will be moved proportionally towards the
positions of the groove notes. At a base of 1/8th, the groove's notes are measured
from their nearest eighth note. Notes in the groove that fall exactly on the grid aren’t
moved at all, so the corresponding notes in your clips will also not be moved.

e Quantize — adjusts the amount of “straight” quantization that is applied before the
groove is applied. At 100%, the notes in your clips will be snapped to the nearest note
values, as selected in the Base chooser. At 0%, the notes in clips will not be moved
from their original positions before the groove is applied.

¢ Timing - adjusts how much the groove pattern will affect any clips which are using it.

e Random - adjusts how much random timing fluctuation will be applied to clips using the
selected groove. At low levels, this can be useful for adding subtle “humanization” to
highly quantized, electronic loops. Note that Random applies differing randomization

The Groove Pool.
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to every voice in your clip, so notes that originally occurred together will now be
randomly offset both from the grid and from each other.

¢ Velocity — adjusts how much the velocity of the notes in clips will be affected by the
velocity information stored in the groove file. Note that this slider goes from -100 to
+100. At negative values, the effect of the groove’s velocity will be reversed; loud
notes will play quietly and vice versa.

e Amount —this is a global parameter, and scales the overall intensity of Timing, Random
and Velocity for all of the available groove files. At 100%, the parameters will be
applied at their assigned values. Note that the Amount slider goes up to 130%, which
allows for even more exaggerated groove effects.

11.1.2 Committing Grooves

Clip

The Commit Groove
Button.

Pressing the Commit button below the Clip Groove chooser “writes” your groove parame-
ters to the clip. For MIDI clips, this moves the notes accordingly. For audio clips, this creates
Warp Markers at the appropriate positions in the clip.

After pressing Commit, the clip’s Groove chooser selection is automatically set to None.

11.2 Editing Grooves

The effect that groove files have on your clips is a combination of two factors: the parameter
settings made in the Groove Pool and the positions of the notes in the groove files them-
selves. To edit the contents of groove files directly, drag and drop them from the Browser
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or Groove Pool into a MIDI track. This will create a new MIDI clip, which you can then edit,
as you would with any other MIDI clip. You can then convert the edited clip back into a
groove, via the process below.

11.2.1 Extracting Grooves

The timing and volume information from any audio or MIDI clip can be extracted to create
a new groove. You can do this by dragging the clip to the Groove Pool or via the Extract
Groove command in the clip’s & (PC)/ [Ctrl ] (Mac) context menu.

W

e

Extract Groove(s)

Grooves created by extracting will only consider the material in the playing portion of the
clip.

11.3 Groove Tips

This section presents some tips for getting the most out of grooves.

11.3.1 Grooving a Single Voice

Drummers will often use variations in the timing of particular instruments in order to create a
convincing beat. For example, playing hi-hats in time but placing snare hits slightly behind
the beat is a good way of creating a laid-back feel. But because groove files apply to an
entire clip at once, this kind of subtlety can be difficult to achieve with a single clip. Provided
your clip uses a Drum or Instrument Rack, one solution can be to extract the chain containing

Extract Grooves From
Audio or MIDI Clips.
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the voice that you want to independently groove. In this example, we'd extract the snare
chain, creating a new clip and track that contained only the snare notes. Then we could
apply a different groove to this new clip.

11.3.2 Non-Destructive Quantization

Grooves can be used to apply real-time, non-destructive quantization to clips. To do this,
simply set the groove’s Timing, Random and Velocity amounts to 0% and adjust its Quantize
and Base parameters to taste. With only Quantize applied, the actual content of the groove
is ignored, so this technique works the same regardless of which Groove file you use.

11.3.3 Creating Texture With Randomization

You can use a groove's Random parameter to create realistic doublings. This can be partic-
ularly useful when creating string textures from single voices. To do this, first duplicate the
track containing the clip that you want to “thicken.” Then apply a groove to one of the clips
and turn up its Random parameter. When you play the two clips together, each note will be
slightly (and randomly) out of sync with its counterpart on the other track.
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Chapter 12
Launching Clips

The Live Session View is set apart by the fact that it gives you, the musician, a spontaneous
environment that encourages performance and improvisation. An important part of how
you take advantage of the Session View lies within how you configure your various Session
View clips. This chapter explains the group of settings used to define how each Session
View clip behaves when triggered, or “launched.”

12.1 The Launch Box

Remember that clips in the Session View are launched by their Clip Launch buttons or remote
control. Clip launch settings are made in the Launch box. The Launch box only applies to
Session View clips, as Arrangement View clips are not launched but played according to
their positions in the Arrangement.

To view the Launch box, open the Clip View of a Session View clip by double-clicking the
clip, then activating the leftmost Clip View Box selector panel.
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Clip Launch

Il 9l o Use the Clip View Box
Selector to Bring up the

— Launch Box.

Note that you can edit the launch settings of more than one clip at the same time by first
selecting the clips and then opening the Clip View.

12.2 Launch Modes

Clip Launch
Launch Mode

The Clip Launch Mode
B = Chooser.

The Launch Mode chooser offers a number of options for how clips behave with respect to
mouse clicks, computer keyboard actions or MIDI notes:

e Trigger: down starts the clip; up is ignored.
e Gate: down starts the clip; up stops the clip.
¢ Toggle: down starts the clip; up is ignored. The clip will stop on the next down.

e Repeat: As long as the mouse switch/key is held, the clip is triggered repeatedly at
the clip quantization rate.
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12.3 Clip-Level Quantization

Clip Launch Sample -+

E s B2 Launch Mode = Bass B2.wav Warp Stan
Trigge 44 .1 ki ¥ 1 1| 1

Sgnatung Legalo Editl | (Save | Rev Seg, BPM End
4 |f 4 Cuantization Hi-Q | | Fade| | RAM Of.00 5 | 1

Vsl L§ 4

Detur h\_) Eang! The Clip Quantization
1 dE 4 0f O
Chooser.
The Clip Quantization chooser lets you adjust an onset timing correction for clip triggering.
To disable clip quantization, choose “None.”
To use the Control Bar’s Global Quantization setting, choose “Global.” Global quantization
can be quickly changed using the (Ctl J[6] (PC)/ (& &6 (Mac), 7], B, (9] and 0]
shortcuts.
Note that any setting other than “None” will quantize the clip’s launch when it is triggered
by Follow Actions.
12.4 Velocity
Clip Launch Sample -+
Bass B2 Launch Mode | Bass B2.wav Warp Start
T rigycpe 44 .1 kk I [ 1| 1
Signalure Legalo Edil ) (Save (Rev Seg. BPM | End
4 (1 4 Cuantization Hi-Q | |Fade |RAM 08,00 8| 1| 1
Non M . Loop
Ay P Pasilian
1 WIRL i 1 1 1
£ | et The Velocity Amount
1 dE 4 0f O

Field.
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The Velocity Amount control allows you to adjust the effect of MIDI note velocity on the
clip’s volume: If set to zero, there is no influence; at 100 percent, the softest notes play the
clip silently. For more on playing clips via MIDI, see the respective section.

12.5 Legato Mode

Clip Launch Sample

Suppose you have gathered, in one track, a number of looping clips, and you now want to
toggle among them without losing the sync. For this you could use a large quantization
setting (one bar or greater), however, this might limit your musical expression.

Another option, which works even with quantization turned off, is to engage Legato Mode
for the respective clips. When a clip in Legato Mode is launched, it takes over the play
position from whatever clip was played in that track before. Hence, you can toggle clips at
any moment and rate without ever losing the sync.

Legato Mode is very useful for creating breaks, as you can momentarily play alternative
loops and jump back to what was playing in the track before.

Unless all the clips involved play the same sample (differing by clip settings only), you
might hear dropouts when launching clips in Legato Mode. This happens because you are
unexpectedly jumping to a point in the sample that Live has had no chance to pre-load from
disk in advance. You can remedy this situation by engaging Clip RAM Mode for the clips in
question.

12.6 Follow Actions

Follow Actions allow creating chains of clips that can trigger each other in an orderly or
random way (or both). A clip’s Follow Action defines what happens to other clips in the

The Legato Mode
Switch.
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same group after the clip plays. A group is defined by clips arranged in successive slots of
the same track. Tracks can have an unlimited number of groups, separated by empty slots.

Follow Aclian
= ldld
2 (= <
— 1[0 ]

The Follow Action
Controls.

1. The Follow Action Time control defines when the Follow Action takes place in
bars-beats-sixteenths from the point in the clip where play starts. The default for
this setting is one bar.

2. The Follow Action choosers allow selecting two different Follow Actions, A and
B.

3. The Chance A and Chance B controls set the likelihood of each of the two
Follow Actions occurring. If a clip has Chance A set to 1 and Chance B set to
0, Follow Action A will occur every time the clip is launched. As we can see
from this example, a Chance setting of 0 means that an action will never happen.
Changing Chance B to 10 in this scenario makes Follow Action A occur much
less often — approximately once out of every ten clip launches.

There are eight Follow Actions available:

m “Stop” simply stops the clip after it has played for the chosen Follow Action Time. Note
that this overrides clip loop/region settings.

# “Play Clip Again” restarts the clip.
+ “Play Previous Clip” triggers the previous clip (the one above the current one).

#+ "Play Next Clip” triggers the next clip down in the group. If a clip with this setting is last
in a group, this Follow Action triggers the first clip.
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= "Play First Clip” launches the first (top) clip in a group.
= "Play Last Clip” launches the last (bottom) clip in a group.
# "Play Any Clip” plays any clip in the group.

4= “Play Other Clip” is similar to “Play Any Clip,” but as long as the current clip is not alone
in the group, no clip will play consecutively.

There is also the possibility to have no Follow Action by selecting “No Action,” or leaving
the chooser blank.

Note that a Follow Action happens exactly after the duration that is specified by the Follow
Action Time controls unless clip quantization is set to a value other than “None"” or “Global.”
Follow Actions circumvent global quantization but not clip quantization.

So why do you need these things? Music is repetition and change. Music based on loops or
short melodic fragments has a tendency to sound static. Follow Actions allow you to create
structures that will repeat but can also be surprising. Remember that you can always record
the results of your experiments, so this can provide a good source for new material.

In the following sections we will look at some practical examples and ideas for Follow
Actions.

12.6.1 Looping Parts of a Clip

Let's say that you want to play a longer clip, but then you want only the last eight bars to
loop. You can set this up using Follow Actions:

1. Drag the clip into the Arrangement View and make sure that the Clip View's
Loop switch is not activated. Use the Edit menu’s Split command to split the clip
between the non-looping and looping parts.

2. Click and drag the resulting two clips into the Session View by letting the mouse
cursor hover over the Session View selector. Drop the two clips into a track. They
now form a Follow Action group.
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3. Set up Follow Actions for the first clip. You will want to make Follow Action Time
equal to the clip’s length. Set the Follow Action A chooser to “Play Next Clip,”
with a Chance setting of 1, leaving Follow Action B alone. Now this clip is set
up to advance to the looping clip after it plays.

4. Activate the Loop switch for the second clip.

The first clip will now proceed to the second after it has played in its entirety; the second
clip will simply play in a loop until it is stopped.

12.6.2 Creating Cycles

One of the most obvious possibilities that Follow Actions open up is using a group of
samples to form a musical cycle. If we organize several clips as a group and use the “Play
Next Clip” Follow Action with each clip, they will play one after the other ad infinitum, or
until we tell them to stop.

Cycles can be peppered with occasional rearrangements through the addition of other
Follow Actions, such as “Play Any Clip,” with smaller relative Chance settings.

12.6.3 Temporarily Looping Clips

There are some interesting applications of Follow Actions when it comes to creating tem-
porary musical loops.

Creating a Group With
the Two Clips.
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The default setting for Follow Action is actually a 1:0 chance that “Nothing” happens after
the Follow Action Time, which means that there is effectively no Follow Action. But now,
imagine a group consisting of one single clip. Follow Action A is set to “Play Clip Again,”
with a Chance of 8. Follow Action B is set to “None,” with a Chance of 1. The clip uses
a long sample, and Follow Time is set to one bar. Clicking on the clip will play the first
bar, after which it will be very likely that it will play the first bar again. However, after a few
repetitions, it will eventually come to Action B — “Nothing” — and continue playing the rest
of the sample.

Or, a clip can be played from its start to a specific point, when its Follow Action tells it to
“Play Next Clip.” The same file can be used in the next clip in the group, but this one can
be set to loop. This second clip can have any manner of Follow Action settings, so that it
might then play forever, for a specified time or until random chance leads to the next clip in
the group.

12.6.4 Adding Variations in Sync

Paired with clip envelopes and warping, Follow Actions can be used to create all sorts of
interesting variations within a group of similar clips. You could, for example, use Follow
Actions to randomly trigger clips with different MIDI controller clip envelopes, so that fine
variations in pitch bend or modulation of an instrument or synth could occur as the clips in
a group interacted. Audio clips could morph between different effect or clip transposition
settings.

Using Follow Actions and Legato Mode together provides a powerful way of gradually
changing a melody or beat. Imagine that you have several identical clips of a melody that
form a group, and they are set up to play in Legato Mode. Whenever their Follow Actions
tell them to move on to another clip in the group, the melody will not change, as Legato
Mode will sync the new play position with the old one in beat-time. The settings and clip
envelopes of each clip (or even the actual notes contained in a MIDI clip) can then be slowly
adjusted, so that the melody goes through a gradual metamorphosis.
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12.6.5 Mixing up Melodies and Beats

You can let Follow Actions perform unpredictable remixes and solos for you: Use a clip
containing a beat or melody, and copy it so that there are several instances of it forming a
group. Alternatively, you can use several different beats or melodies that you want to mix
together. The start and end for each clip can be set differently, as can clip envelopes and
other clip settings. As long as Follow Action Time in each clip is equal to the length of the
clip that you want to play, you can set up two Follow Actions with different Chance values
in each clip, launch a clip, and surprise yourself.

12.6.6 Creating Nonrepetitive Structures

Follow Actions are great when it comes to sound installations, as they allow you to create
structures that play for weeks or months and never exactly repeat. You can set the Follow
Action Time controls in a series of clips to odd intervals, and the clips will interact with each
other so that they never quite play in the same order or musical position. Remember that
each clip can have two different Follow Actions with corresponding Chance settings... have
fun!
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Chapter 13

Routing and I/O

In the context of Live, “routing” is the setup of the tracks’ signal sources and destinations
(i.e., their inputs and outputs). Most routing happens in the mixer’s track In/Out section,
which offers, for every track, choosers to select a signal source and destination. The mixer's
In/Out section is Live's “patchbay.”

The In/Out section can be independently shown or hidden from the Session and Arrange-
ment Views. Toggle its visibility using the I/O Mixer Section selector, or via the View menu'’s
In/Out option.

1 Audio 2 Audio 3 Audio 4 Audio 5 MIDi & MIDJ Master

8 8 | | | | Stop Clips

Audio From Audio From Audio From Audio From MIDI From MIDI From

[Ext. I || [Ext. In =| [NoInpul =]/ [A-Retum =]/ [Computer Ke=| [5-MIDI | ®
[ =||m2 =||] | [ F'ost FX_ | || All Channevl || Post Mixer |

Manitor Monitor GB
RN [Auito] [Off] iR [Auito] [Orf] IEI-IEI IEI-- IEI-IEI 6"90"1 o
Audio Te Audio To Audio To Audio To MIDI To WDl To itz <]
[Master || [Master _]|[Sends Only || [Master | [No Oulpul =] [No Oulbul ] | praster Gut (-]

1] I Il il Il | fii 172

The Mixer's In/Out
Section and Mixer
Section Selectors.
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For every track that can play clips, the In/Out section has the same layout:

e The upper chooser pair (“Audio/MIDI From”) selects the track’s input. Audio tracks
have an audio input, and MIDI tracks have a MIDI input. Return tracks receive their
input from the respective sends.

e The Monitor radio button selects the monitor mode: the conditions under which the
track’s input is heard through the track.

e The lower chooser pair (“Audio/MIDI To") selects the track’s output. All tracks have
audio outputs, except for MIDI tracks without instruments. Remember that instruments
convert MIDI to audio.

Within a chooser pair, the upper chooser selects the signal category (“Ext.,” for instance,
for external connections via an audio or MIDl interface), and is called the Input/Output Type
chooser. If this signal type offers sub-selections or channels, they are available from the
lower chooser, or the Input/Output Channel chooser. In our “Ext.” example, these would
be the individual audio/MIDI inputs and outputs.

13.1 Monitoring

1

“Monitoring,” in the context of Live, means passing a track’s input signal on to the track’s
output. Suppose you have set up an audio track to receive its input signal from a guitar.
Monitoring then means that the signal from your live guitar playing actually reaches the
track’s output, via the track’s device chain. If the track’s output is set to “Master,” you can
hear the guitar signal, processed by whatever effects are used (and delayed by whatever
latency the audio hardware interface incurs), over your speakers.

The In/Out section offers, for every audio track and MIDI track, a Monitor radio button with
the following three options:

e The default Auto-monitoring setting does the right thing for most straightforward
recording applications: Monitoring is on when the track is armed (record-enabled),
but monitoring is inhibited as long as the track is playing clips.
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To permanently monitor the track’s input, regardless of whether the track is armed or
clips are playing, choose In. This setting effectively turns the track into what is called
an "Aux” on some systems: the track is not used for recording but for bringing in a
signal from elsewhere (for instance, a ReWire slave program). With this setting, output
from the clips is suppressed. An “In” monitoring setting can be easily recognized even
when the In/Out section is hidden by the orange color of the track’s Activator switch.

Monitoring can be turned off altogether by choosing the Off option. This is useful
when recording acoustic instruments which are monitored “through the air,” when
using an external mixing console for monitoring or when using an audio hardware
interface with a “direct monitoring” option that bypasses the computer so as to avoid
latency. Generally, it is preferable to work with an audio interface that allows for
negligible latencies (a few milliseconds). If you are recording into Live with monitoring
setto "Off,” you may want to make the Audio Preferences’ Overall Latency adjustment,
which is described in the built-in program tutorial on setting up the Audio Preferences.

If multiple tracks are selected, pressing one of the Monitor buttons applies this selection to
all of the selected tracks.

13.2 External Audio In/Out

An audio interface’s inputs are selected by choosing “Ext. In” from the Input Type chooser of
an audio track. The Input Channel chooser then offers the individual input channels. Entries
in this chooser each have meters next to their names to help you identify signal presence
and overload (when the meter flashes red). Setting up the audio interface’s outputs works
the same way via the output chooser pair. If multiple tracks are selected, any changes you
make to these choosers will be applied to all selected tracks.

The list of available inputs and outputs depends on the Audio Preferences, which can be

Audio and MIDI Track
Arm Buttons.
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i

reached via the Input and Output Channel choosers’ “Configure...” option. Note that
the Audio Preferences also provide access to the Channel Configuration dialogs, which
determine which inputs and outputs are used, and whether they are available to Live as
mono or stereo pairs. Essentially, the Channel Configuration dialog tells Live what it needs
to know about how the computer is connected to the other audio components in your
studio.

13.2.1 Mono/Stereo Conversions

When a mono signal is chosen as an audio track’s input, the track will record mono samples;
otherwise it will record stereo samples. Signals in the track’s device chain are always stereo,
even when the track’s input is mono or when the track plays mono samples.

Mono is turned into stereo simply by using the identical signal for left and right channels.
When a track is routed into a mono output, the left and right signals are added together
and attenuated by 6 dB to avoid clipping.

13.3 External MIDI In/Out

MIDI from the outside world is routed into Live just like audio. From the Input Type chooser
of a MIDI track, you can either select a specific MIDI input port or “All Ins,” which is the
merged input of all external MIDI ports. The Input Channel chooser offers the individual
input channels of the selected MIDI port and the merged signal of all channels, “All.” As is
the case with audio inputs, the Input Channel chooser also has meters next to every entry
to represent activity on the respective input channel. If multiple MIDI tracks are selected,
any changes you make to these choosers will be applied to all selected tracks.

13.3.1 The MIDI Ports List in the Preferences

MIDI Ports Track Sync  Remaote
. Inpul:  ReMOTE LE [fon][ on [[fon]
. Qulput: ReMOTE LE Ten| [ of |[fon]

The MIDI Ports List in
the Preferences.
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You can configure which MIDI ports are made available to Live using the MIDI Ports section
of the MIDI/Sync Preferences. All available input and output ports are listed here. For Live's
tracks to receive/send MIDI from/to a specific MIDI port, the corresponding switch in the
Track column must be set to On. You can use any number of MIDI ports for track input and
output; the mixer’s In/Out choosers allow them to be addressed individually.

13.3.2 Playing MIDI With the Computer Keyboard

The computer keyboard can be used for generating MIDI notes from computer keyboard
strokes. To turn the computer MIDI keyboard on, use the Control Bar's Computer MIDI Key-
board button, or the (PC) / (Mac) shortcut to the Options

menu entry.

KEY MID 3% (8]

The center row of letter keys on the keyboard will play notes corresponding to the white keys
on a piano, beginning on the left with the note C3. The black keys on a piano correspond to
the upper row of computer keys. The five leftmost letters on the lower row of the keyboard
(Z,X,C,V, and B on a U.S.-English keyboard) are used to transpose the note range and to set
velocity, as follows:

e The leftmost keys (Z and X) adjust the keyboard's octave range.

e The next two keys (C and V) adjust incoming note velocity by intervals of twenty (20,
40, 60, and so on).

e The fifth key from the bottom left (B) places an “accent” on incoming MIDI notes. This
key boosts note velocity by 20 as long as it is held down. Once it is released, however,
velocity will drop back to its original value. If your keyboard is already set to input
notes at 120, holding this key will raise note velocity to 127.

As it happens, when the computer keyboard is set to send notes between C3 and C4, the
keys are mapped to MIDI notes such that the center row of the keyboard (ASDF...) addresses
the Impulse percussion sampler's sample slots. This means that you can play and record
drum patterns right off the computer keyboard.

| “steal”

Note that when the computer MIDI keyboard is activated, it wil keys that may have

Activating the Computer
MIDI Keyboard.
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otherwise been assigned to remote-control elements of the Live interface. To prevent this,
you can turn the computer MIDI keyboard off when it is not needed.

13.3.3 Connecting External Synthesizers

Routing MIDI to an external synthesizer is straightforward: The Output Type chooser is set
to whatever MIDI port the synthesizer is connected to; the Output Channel chooser is used
to select which MIDI channel to send on.

In addition to routing via a track’s In/Out section, it is also possible to route from within a
track’s device chain by using the External Instrument device. In this case, you can send MIDI
out to the external synthesizer and return its audio - all within a single track.

Important: If you are using a keyboard synthesizer both as a master keyboard to play into
Live and as a sound generator, then please make sure to check the synthesizer's “Local
Off” function. Every synthesizer has this function, which effectively separates the keyboard
from the sound generator, allowing you to treat both components as if they were separate
devices. This allows you to use Live as the hub of your MIDI studio, which receives MIDI
from the keyboard and dispatches the incoming MIDI, as well as the MIDI from the clips, as
appropriate.

13.3.4 MIDI In/Out Indicators

Live's Control Bar contains three pairs of indicator LEDs that tell you about incoming and
outgoing MIDI. These indicators tell you not only about the presence of signals, but also
about their use. In every pair, the upper indicator flashes when a MIDI message is received,
and the lower indicator flashes when a MIDI message is sent.

extgl] Tar 41 4|08 » p|mle|ovr| =+ |18ar = | & ~ [ " m.rHH MID 1% =B
. .

The three indicator pairs represent, from left to right:

1. MIDI Clock and Timecode signals that are used for synchronizing Live with other
sequencers. Note that this set of indicators is only visible when an external sync
source has been enabled in the MIDI Ports List in the Preferences;

The Control Bar's MIDI
Indicators.
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2. MIDI messages that are used for remote-controlling Live's user-interface ele-
ments;

3. MIDI messages coming from and going to Live's MIDI tracks.

MIDI messages that are mapped to remote-control Live’s user-interface elements are “eaten
up” by the remote control assignment and will not be passed on to the MIDI tracks. This is
a common cause of confusion that can be easily resolved by looking at the indicators.

13.4 ReWire Slave Routing

Live can operate as a ReWire master or slave in cooperation with another ReWire application.
As a ReWire master, Live can send MIDI to, and receive audio from, any ReWire slave
application installed on the same computer.

I | g |
MIDI From MiDi From Audio From Audio From
All In (A ing || [Reason || [Ext. Ir
[E A Channe || Il 1/2: Mix L <||jn 17
Monitor Monitor Monitor
In | [Alte [O E@@ --@ In | [Auta| [Of
MIDI To Audio To
F das
.
: OO Of
o .
. .
& -
1 - 2 : 3 4
o -
E - 5 H E 5
o i R % s C
. .

The following example shows how to send MIDI from one of Live's MIDI tracks into an
instrument within Propellerhead’s Reason, and then route the audio result back into an
audio track:

1. First, start Live.
2. Then, start Reason and set up the Reason rack as desired.

3. Select "Reason” from the MIDI track’s Output Type chooser.

An Audio Track
Receiving Audio From
and a MIDI Track
Sending MIDI to Reason.
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4. The Output Channel chooser presents you with a list of the instruments that you
currently have in your Reason rack; select the instrument you want to address.

5. Select “Reason” from the audio track’s Input Type chooser.

6. From the audio track’s Input Channel chooser, select the audio channel that
corresponds to the instrument to which you are sending MIDI.

7. Set the audio track’s Monitor radio button to “In.”
8. Select “All Ins” from the MIDI track’s Input Type chooser.
9. Arm the MIDI track.

Now, any MIDI that you are playing into Live will arrive in Reason, which will generate the
corresponding audio back into the audio track, ready for further processing in Live's mixer
and effects. If you want to continue work on the project without reopening Reason, simply
record Reason'’s audio by arming the audio track and engaging Record Mode.

A similar procedure is possible with the External Instrument device. The following example
shows how to send MIDI from within a track’s device chain and return the audio to the same
track:

1. First, start Live.
. Then, start Reason and set up the Reason rack as desired.

2

3. Insert an External Instrument device into a MIDI track.

4. Select "Reason” from the External Instrument’s first MIDI To chooser.
5

. The second chooser presents you with a list of the instruments that you currently
have in your Reason rack; select the instrument you want to address.

6. From the External Instrument’s Audio From chooser, select the audio channel
that corresponds to the instrument to which you are sending MIDI.

7. Arm the MIDI track.

8. Adjust the External Instrument’s Gain knob as necessary.
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13.5 Resampling

Live's Master output can be routed into an individual audio track and recorded, or resampled.
Resampling can be a fun and useful tool, as it lets you create samples from what is currently
happening in a Live Set that can then be immediately integrated. It can be used to record
tracks that include processor-intensive devices, so as to delete the devices, or for quickly
previewing before rendering to disk.

The “Resampling” option in any audio track’s Input Type chooser will route the Master
output to that track. You can then decide on what exactly you will be resampling and mute,
solo or otherwise adjust the tracks that are feeding the Master output. You will probably
want to use the Master Volume meter to make sure that your level is as high as possible
without clipping (indicated by red in the meter). Then you can arm the track and record into
any of its empty clip slots. Note that the recording track’s own output will be suppressed
while resampling is taking place, and will not be included in the recording.

Samples created by resampling will be stored in with the current Set’s Project folder, under
Samples/Recorded. Until the Set is saved, they remain at the location specified by the
Temporary Folder.

13.6 Internal Routings

Live's mixer and external routing devices allow for inter-track routings. These routings, albeit
potentially confusing, enable many valuable creative and technical options. Via the mixer,
inter-track routing can work two ways:

1. Track A is set up to send its output signal to Track B. This is possible because
every track that can receive an output signal of the appropriate type from Track
A shows up in its Output Type chooser.

2. Track B is set up to receive its input signal from Track A. This works because every
track that delivers a signal of the appropriate type appears in Track B's Input Type
chooser.
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Both approaches result in Track A's output being fed into Track B. Approach 1 leaves Track
B's in/out settings alone, and we can, at any time, add more tracks that feed their output
into Track B. This is the method of choice for “many-to-one” routings such as submixes or
several MIDI tracks playing the same instrument. In this scenario, soloing Track B will still
allow you to hear the output of the tracks that are feeding it. Also, you can still solo Track A
and hear its output signal. In this case, all other tracks are muted, including those that might
also feed into Track B. Technically, what you hear is the output of Track B, with everything
except Track A's signal removed.

Approach 2, on the other hand, leaves Track A unaffected except for Track B tapping its
output. We can easily add more tracks like Track B that all tap Track A's output. Instrument
layering is a good example of such a “one-to-many” routing setup.

13.6.1 Internal Routing Points
Signals travel from Live’s tracks into their respective device chains and then into the track
mixer, where they might become panned or have their levels altered by the tracks’ faders.

Whenever a track’s Audio From input chooser is set to another track (as described in the
previous section’s Approach 2), the signal received can be tapped from one of three different
points chosen from the Input Channel chooser: Pre FX, Post FX or Post Mixer.

Two Ways to Route Track
A into Track B.
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1 Track A Z2Track B 4 Audio

3 From Audio From Audio From

1-Track A w=|||Mo Input

Boudio To

Pre FX taps the signal that is coming directly from a track, before it has been passed
on to the track’s device chains (FX) or mixer. Therefore, changes that are made to the
tapped track’s devices or mixer have no effect on the tapped signal. Soloing a track
that taps another track Pre FX will allow you to hear the tapped track.

Post FX taps the signal at the output of a track’s device chains (FX), but before it
has been passed back to the track mixer. Changes to the tapped track’s devices will
therefore alter the tapped signal, but changes to its mixer settings will not. Soloing a
track that taps another track Post FX will allow you to hear the tapped track.

Post Mixer taps the final output of a track, after it has passed through its device chains
and mixer. Soloing a track that taps another track Post Mixer will not allow you to hear

the tapped track.

Tap Points for Track
Routing.
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Routing Points in Racks

1 Track A 2 Track B 3 Audio 4 Guitar 5 Audio

Audio From Audio From Audio From Audio From Audio From
Ext 1-Track A =|||No Input Ext ;
I 1z il ([l ([l
Monitor = Monitor
A i M Wi
In | | Aaata] (O i Post Fx
Audio To

M i
1
S
L]
If a track has one or more Instrument or Effect Racks in its device chain, internal routing
points (Pre FX, Post FX and Post Mixer) will also be available for every chain within the Rack.

If a track contains one or more Drum Racks, internal routing points will be available for any
of the Rack’s return chains. Each Rack will also be listed in the Input Channel chooser:

i 1989 Multi FX | Delay Chain | Pre FX
ii 1989 Multi FX | Delay Chain | Post FX
ii 1289 Multi FX | Delay Chain | Post Mixer

i 1985 Multi FX | Phaser Chain | Pre FX [ m

i 1989 Multi FX | Phaser Chain | Post FX 5
5
.

i 1989 Mulli FX | Phaser Chain | Posl Mixer

o (Rack Name) | (Chain Name) | Pre FX — The signal will be tapped from the point that it
enters the Rack, before it reaches the chain’s devices.

e (Rack Name) | (Chain Name) | Post FX — The signal will be tapped from the end of the
chain, but before it passes to the chain’s mixer.

o (Rack Name) | (Chain Name) | Post Mixer — The signal will be tapped from the output of

the chain’s mixer, just before the point where all of the chains in the Rack are summed
together to create the Rack’s output.

Soloing a track that taps a Chain at any of these points will still allow you to hear the output
at that point.

Tap Points for Every
Chain in a Track.
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13.6.2 Making Use of Internal Routing

This section presents several internal routing examples in more detail.

Post-Effects Recording

Let's say that you are feeding a guitar into Live, building up a song track by track, overlaying
take onto take. It is certainly powerful to have a separate effects chain per track for applying
different effects to different takes — after the fact. You might, however, want to run the guitar
signal through effects (a noise gate or an amp model, for instance) before the recording
stage, and record the post-effects signal.

3 Audic 4 Guitar 3 Audio 6 Audic 7 Pad

g | I I
Audio From Audio From Audio From
[Ext.In | [4-Guitar <] [4-Guitar ]|~
Wiz = [ii Post FX__ ] [ii Post Mixer || /F »
Monitor Monitaor Monitor

il [#uto] [Of] [[in | [Auto] [OMf] [In] [Auto] [Off

Audio From MIDI From

Monitor
Aulo

Audio To MIDI To

This is easily accomplished by devoting a special audio track for processing and monitoring
the incoming guitar signal. We call this track “Guitar” and drag the desired effects into its
device chain. We do not record directly into the Guitar track; instead we create a couple
more tracks to use for recording. Those tracks are all set up to receive their input Post FX
from the Guitar track. Note that we could also tap the Guitar track Post Mixer if we wished
to record any level or panning from it.

As for monitoring, we set the Guitar track’s Monitor radio button to In, because we always
want to listen to our guitar through this track, no matter what else is going on in Live. The
other tracks’ Monitor radio buttons are set to Off.

An Example Setup for
Post-Effects Recording.
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Recording MIDI as Audio

When working with MIDI and complex software instruments, it is sometimes more useful
to record the resulting audio than the incoming MIDI. A single MIDI note can prompt, for
example, Native Instruments’ Absynth to produce something that sounds more like a piece
of music than a single tone. This output lends itself more to representation as an audio
waveform than a single note in a MIDI clip, particularly when comparing the editing options.

1 Piano

2 Strings 3 Absynth 4 MIDI

[ [rake 1 Strin] [
E ¢ (@ mm |0

Audio From MIDI From MIDI From
[3-Absynih =] | [Computer Kew| |41 Ins

[ii Post Mixer =||[f Al Channew||[§ Al Channe
Monitor Maonitor Monitor

I [ (O [N [ [0 | 1+ i O
Audio To Audio To MIDI To
[Master || [Master || [No Cutput

Audio From
xl. In

1z

Monitor

I | | At O

Audio To

Recording the Output of
a Complex Instrument in
Audio Tracks.

|| ==
w L5
w w
w||
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A setup similar to the one described above accomplishes the task. We have one MIDI track
hosting the virtual instrument, and we use additional audio tracks to record the audio result
of playing the instrument.
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Creating Submixes

2 Snare 3 Bass 4 Hi-Hats 5 Submix

= m
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Monitor Monitor Monitor
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Audio To Audio To Audio To Audio To
[5-Submix  =||[5-Submix | [5-Submix | [Master |
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Suppose we have the individual drums of a drum kit coming in on separate tracks for
multitrack recording. In the mix, we can easily change the volumes of the individual drums,
but adjusting the volume of the entire drum kit against the rest of the music is less convenient.
Therefore, we add a new audio track to submix the individual drums. The drum tracks are
all set to output to the submix track, which outputs to the Master. The submix track gives
us a handy volume control for the entire drum kit.

Alternatively, you could combine the separate drum tracks into a Group Track for even more
flexibility. This automatically creates the necessary output routings and also allows you to
hide or show the component tracks.

Several MIDI Tracks Playing the Same Instrument

Consider a MIDI track containing a virtual instrument — a Simpler playing a pad sound, for
example. We have already recorded MIDI clips into this track when we realize that we would
like to add an independent, parallel take for the same instrument. So we add another MIDI
track. We could now drag another Simpler into the new track, but we would really like to
reuse the Simpler from the pad track, so that changing the pad’s sound affects the notes
from both tracks.

Submixing the Individual
Drums of a Drum Kit.
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This is accomplished by setting the new MIDI track’s Output Type chooser to “Pad.” Note
that the Output Channel chooser now offers a selection of destinations: We can either feed
the new track’s output into the input of the pad track, or we can directly address the Simpler.
The “Track In” option in the Output Channel represents the pad track’s input signal (the
signal to be recorded), which is not what we want. We instead select “Simpler Ch. 1" to
send the new track’s MIDI directly to the Simpler, bypassing the recording and monitoring
stage. With this setup, we can choose to record new takes on either track and they will all
play the same pad sound.

7 Audio 8 Pad 3 9 Pad 10 Pad 2 Master

2

| | Stop Clips
Audio From MIDI From MIDI From MIDI From
Ext. In [0 Ins =||[Moinput =] [N Ing |
TRIE [§ AnChannes| || | [1 A0 Channe=|
Monitor Monitor Monitor
In | [Auto] Ol [in'] [FiGia] [ [ [Pt [Goff] | e Out
Audio To MIDI To Audio Te MIDI To il 112
Masler [9-Pad =| [Master =||[8-Pad = Master Out
[1-Simpler ]| ||[1-Simpler ]| i 1/2 The Instrument Has
(r) || . m . (T) [ Been Isolated in a
. . .
] . il . [ Dedicated Track.

We might be bothered by the fact that muting the pad track (by turning off its Activator
switch) also mutes the other MIDI track. To be precise, the other track keeps playing, but its
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MIDl is played by an instrument that is out of the mix. This can be easily remedied by cutting
the clips from the pad track and pasting them into a third track that can be independently
muted (and that can hold its own MIDI effects). The original pad track now acts as a mere
instrument container. As we are not recording new clips into this track, we can set its Input
Type chooser to “No Input,” which makes its Arm button disappear and helps to avoid
confusion when the mixer’s In/Out section is hidden.

Tapping Individual Outs From an Instrument

Some software instruments, like Live's Impulse percussion sampler, offer multiple audio
outputs for the signals they produce. By default, Impulse mixes the output of its eight
sample slots internally and delivers the mix at the instrument’s audio out. Any audio effects
following Impulse in the same track process the composite signal. Sometimes it is desirable
to take an individual drum sound out of the mix for individual effects processing and mixing.
This is possible because Impulse offers its sample slots as audio sources to other tracks.

1 Audic 2 Snare 3 My 4 Bass
Audio From Audio From MIDI From Audio From
1 [3-MIDI || [Al Ins = |[Ext
TRE i Post Mixer || [§ Al Channe=| |[Il 1/:
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We simply create an audio track and select from its Input Type chooser the track with the
Impulse. The Input Channel chooser now offers, in addition to Pre FX, Post FX and Post
Mixer, Impulse’s eight individual outputs, labeled according to the sample used in each slot.

Notice that routing an individual output from Impulse into another track automatically takes
this signal out of Impulse’s own internal mix. This convenience is not standard behavior of

Using Impulse’s
Individual Outs to
Separately Process
Sample Slots.
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most plug-in instruments, however. Soloing a track that taps one of Impulse’s sample slots
will still allow you to hear the output of that slot.

Using Multi-Timbral Plug-In Instruments

Many plug-in instruments support multi-timbral operation. A multi-timbral instrument is like
several instruments in one, with each component “part” (or whatever term the manufacturer
uses) receiving MIDI on a separate MIDI channel. Usually, the multi-timbral instrument
offers individual outputs so that the parts can be separately routed into the mixer. Or, the
instrument might offer a submixer of its own.
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Sending MIDI from the mixer to a multi-timbral instrument is a variation of a case described
above. One MIDI track hosts the multi-timbral instrument, and additional MIDI tracks are
used to feed its individual parts. Each additional MIDI track has its Output Type chooser
pointed to the track that contains the instrument, and its Output Channel chooser referenc-
ing the target MIDI channel. Additional audio tracks can then be used to tap the instrument’s
individual outputs, as described earlier.

L1 1]

It is also possible to use the External Instrument device to route MIDI to (and audio from)
the secondary outputs on multi-timbral plug-ins. This scenario eliminates the need to create
an additional audio track for each tapped output:

1. Insert the multi-timbral instrument on a MIDI track.

Tracks Feeding MIDI to
and Tapping Audio
From the Parts of a
Multi-Timbral
Instrument.
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2. Insert an External Instrument device on another MIDI track.

3. Select the track that contains the instrument in the first MIDI To chooser on the
External Instrument device.

4. Select the MIDI channel to route to in the second chooser on the External
Instrument device.

5. From the External Instrument’s Audio From chooser, select a secondary output
on the instrument to which you are sending MIDI.

Repeat steps 2-5 to feed and tap additional components of your multi-timbral instrument.
You could also put the entire system of External Instrument devices into a single track, by
placing each one in a Rack’s device chain.

Note that the main outputs of the multi-timbral instrument will still output to the track that
contains the instrument - only auxiliary outputs are available to the External Instrument
device.

Feeding Sidechain Inputs

Some effects have so-called “sidechain inputs.” A vocoder, for instance, imposes spectral
characteristics taken from one signal (say, spoken word) onto another signal, for instance a
string pad. The vocoder is inserted as an audio effect into the string track. It has a sidechain
input for the speech signal, which has to be delivered from another track. So, we create an
additional audio track named “Speech” and set its Output Type chooser to the “Strings”
track. From the Output Channel chooser, we select the vocoder’s sidechain input.
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Some vocoder plug-ins include a built-in synthesizer to generate the “carrier” signal. In
this case, the only difference from the above procedure is that the vocoder instrument is
dragged into a MIDI track. Feeding the side-chain audio input works as described above.

(1 11]

Please note that Ableton’s Auto Filter, Compressor, Gate and Vocoder devices have their
own sidechain controls with integrated routing choosers that match those found in tracks.
Thus when using these devices, it is not necessary to follow the above procedure - you can
simply select the sidechain source from within the device itself.

Layering Instruments

Suppose that we have a MIDI track containing an instrument playing a string sound, which
we would like to augment by adding a brass sound playing the same notes. This can be
easily done by adding a MIDI track that contains an instrument playing the brass sound and
setting its Input Type chooser to tap the string track’s Post FX signal.

Routing a Speech Signal
Into a Vocoder’s
Sidechain Input.
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Using an Auxiliary MIDI
Track to Layer
Instruments.

Perhaps you wonder why this works, given that the string track’s output is audio and not
MIDI. When routing MIDI in from another track, we are tapping the MIDI at the latest possible

stage, which is after any MIDI Effects, and just before the instrument.
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Chapter 14
Mixing

14.1 The Live Mixer

Live includes a mixer section that is accessible from two views:

1241.3
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iw 4MiDI I (5] | The Arrangement View
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Mixer.

In the Arrangement View, the mixer appears as a horizontal strip to the right of the track
area. To display all mixer controls for a track, unfold the track using the @ button next to
its name, and adjust its height accordingly.
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The Session View is a standard vertical mixer layout. You'll likely find the Session View mixer
more intuitive than the Arrangement mixer, which comes in handy when you work with
automation. Note that the Tab key toggles between the Arrangement and Session Views.

The View menu options listed below show or hide mixer components. You can use different
mixer view setups in the Session View and in the Arrangement View:

e In/Out
e Sends
e Returns

o Mixer

Track Delays
e Crossfader

The Mixer Section selectors on the right-hand side of the screen duplicate the View Menu
commands, making it possible to quickly show or hide different mixer components.

Stop Clips

mll

The Session View Mixer.

The Mixer Section
Selectors.
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Let's look at the mixer controls:
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The Mixer Controls.

1. The Meter shows the track’s RMS (average) and peak output level. While moni-
toring, however, it shows the input level.

2. The Volume control adjusts the track’s output level. With multiple tracks selected,
adjusting the volume of one of them will adjust the others as well.

3. The Pan control positions the track’s output in the stereo field. To reset the Pan
control to center, click on its associated triangle. With multiple tracks selected,
adjusting the pan knob for one of them will adjust the others as well.

4. To mute the track’s output, turn off the Track Activator switch. With multiple
tracks selected, toggling one of their Track Activators will toggle the others as
well.

5. The Solo switch solos the track by muting all other tracks, but can also be used
for cueing. With multiple tracks selected, pressing any of their Solo switches
will solo all of them. Otherwise, tracks can only be soloed one at a time unless
the the (PC) / (Mac) modifier is held down or the Exclusive Solo
option in the Record/Warp/Launch Preferences is deactivated.

6. If the Arm Recording button is on, the track is record-enabled. With multiple
tracks selected, pressing any of their Arm switches will arm all of them. Other-
wise, tracks can only be armed one at a time unless the the (Ctrl ] (PC) /
(Mac) modifier is held down or the Exclusive Arm option in the Record/Warp/
Launch Preferences is deactivated. With Exclusive Arm enabled, inserting an
instrument into a new or empty MIDI track will automatically arm the track.
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14.1.1 Session Mixer Features
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The Mixer section of the Session Mixer has several additional features that are not visible by
default. The mixer is resizable, and dragging upwards on the top of the mixer will extend the
height of the track meters, adding tick marks, a numeric volume field and resettable peak
level indicators. Increasing a track’s width in this state will add a decibel scale alongside the
meter’s tick marks.

These enhancements are tailored for use in traditional mixing settings, but are available
anytime the Mixer section is displayed.

Because of the enormous headroom of Live's 32-bit floating point audio engine, Live’s
meters can be driven far “into the red” without causing the signals to clip. The only time
that signals over 0 dB will be problematic is when routing to or from physical inputs and
outputs, like those of your sound card, or when saving audio to a file.

Nevertheless, Live provides this optional visual feedback for signals that travel beyond 0 dB
in any track.

The Session Mixer's
Possibilities.
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14.2 Audio and MIDI Tracks

Audio and MIDI tracks in Live are for hosting and playing clips, as explained earlier.

You can add new audio and MIDI tracks to your Live Set's mixer at any time using the
appropriate Create menu commands.

Tracks can also be created by double-clicking or pressing Return] on files in the Browser to
load them, or by dragging objects from the Browser into the space to the right of Session
View tracks or below Arrangement View tracks. Devices or files loaded into Live in this
manner will create tracks of the appropriate type (e.g., a MIDI track will be created if a MIDI
file or effect is dragged in).

A track is represented by its track title bar. You can click on a track title bar to select
the track and then execute an Edit menu command on the track. One such command is
Rename. One can quickly rename a series of tracks by executing this command (or the
Rename shortcut (Ctl )R] (PC)/ (& B[R] (Mac)) and then using the Tab key to move from
title bar to title bar. When a # symbol precedes a name, the track will get a number that
updates automatically when the track is moved. Adding additional # symbols will prepend
the track number with additional zeros. You can also enter your own info text for a track via
the Edit Info Text command in the Edit menu or in the tracks's @ (PC)/ (Cul & (Mac)
context menu.

2 Audio 3 MiDi Master

You can drag tracks by their title bars to rearrange them, or click and drag on their edges to
change their width (in the Session View) or height (in the Arrangement View).

Multiple adjacent or nonadjacent tracks can be selected at once by (& ]-clicking or
(Ctl]-clicking, respectively. If you drag a selection of nonadjacent tracks, they will be
collapsed together when dropped. To move nonadjacent tracks without collapsing, use
+ arrow keys instead of the mouse.

When multiple tracks are selected, adjusting one of their mixer controls will adjust the same
control for the other tracks. If the tracks in the multi-selection have differing values for any

Tracks are Represented
by Track Title Bars.
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particular knob or slider parameter (volume, for example), this difference will be maintained
as you adjust the parameter.

If you drag a track’s title bar to the Browser it will be saved as a new Set. If a track contains
audio clips, Live will manage the copying of the referenced sampled into this new location
based on the selection in the Collect Samples on Export chooser. You can then type in a
name for the newly created Set or confirm the one suggested by Live with .

Tracks are deleted using the Edit menu’s Delete command.

14.3 Group Tracks

|Il

You can combine any number of “normal” audio or MIDI tracks into a special kind of summing
container called a Group Track. To create a Group Track, select the tracks to include and
execute the Edit menu’s Group Tracks command.

Group Tracks cannot contain clips, but they are similar to audio tracks in that they have mixer
controls and can host audio effects. Group Tracks provide a quick way to create submixes,
and also offer the ability to fold and unfold their contained clip tracks via the @ button in
the title bar. This can help you to organize large Sets by hiding away tracks that you don’t
need to see.
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When tracks are placed into a group, their Audio To routing choosers are automatically
assigned to “Group” unless they already had a custom routing (i.e. to a destination other

An Unfolded Group
Track Visualized in
Session View...
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than “Master.”) You can also use a Group Track purely as a “folder” track by rerouting the
outputs of the contained tracks to some other destination.
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Once a Group Track has been created, tracks can be dragged into or out of the group.
Deleting a Group Track deletes all of its contents, but a group can be dissolved back into
individual tracks by executing the Edit Menu'’s Ungroup Tracks command.

Group Tracks in Arrangement View show an overview of the clips in the contained tracks.
In Session View, slots in Group Tracks have launch and stop buttons whenever at least one
clip is available in a given scene. Launching or stopping this button has the same effect
as launching or stopping all contained clips. Likewise, selecting a Group Slot serves as a
shortcut for selecting all of the contained clips.

14.4 Return Tracks and the Master Track

In addition to Group Tracks and tracks that play clips, a Live Set has a Master track and up
to twelve return tracks; these cannot play clips, but allow for more flexible signal processing
and routing.

The return tracks and the Master track occupy the right-hand side of the Session mixer view
and the bottom end of the Arrangement View.

Note that you can hide and show the return tracks using the Returns command in the View
menu.

Like the “normal” clip tracks, the returns and the Master can host any number of effects.
However, whereas a clip track’s effect processes only the audio within that track, return tracks
can process audio sent to them from numerous tracks.

For example, suppose you want to create rhythmic echoes with a delay effect. If you drag
the effect into a clip track, only clips playing in this track will be echoed. Placing this effect

...and in Arrangement
View.
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in a return track lets it receive audio from any number of tracks and add echoes to them.

O Sends Sands Sarlda Sarlda

Q).. O Q)
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A clip or group track’s Send control regulates how much of the track’s output feeds the
associated return track’s input. What's more, even the return track’s own output can be
routed to its input, allowing you to create feedback. Because runaway feedback can boost
the level dramatically and unexpectedly, the Send controls in Return tracks are disabled by
default. To enable them, @ (PC)/ [Ctl & (Mac) on a Return track’s Send knob and select
Enable Send or Enable All Sends.

Every return track has a Pre/Post toggle that determines if the signal a clip track sends to
it is tapped before or after the mixer stage (i.e., the pan, volume and track-active controls).
The “Pre"” setting allows you to create an auxiliary mix that is processed in the return track,
independently of the main mix. As the return track can be routed to a separate output, this
can be used to set up a separate monitor mix for an individual musician in a band.

The Master track is the default destination for the signals from all other tracks. Drag effects
here to process the mixed signal before it goes to the master output. Effects in the Master
track usually provide mastering-related functions, such as compression and/or EQ.

You can create multiple return tracks using the Create menu’s Insert Return Track command,
but by definition, there is only one Master track.

14.5 Using Live's Crossfader

Live includes a crossfader that can create smooth transitions between clips playing on
different tracks. Live's crossfader works like a typical DJ-mixer crossfader, except that it
allows crossfading not only two, but any number of tracks — including the returns.

The Send Controls and
Pre/Post Toggle.
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The crossfader is accessed via the Session View's mixer selectors. It features seven different
crossfade curves so that you can choose the one that fits your style the best. To change the
curve, @ (PC)/ S (Mac) on the crossfader, then select an entry from the context
menu.
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Choose from Seven
Crossfader Curves.

The chart below details the power level and response of each crossfader curve.
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A+B Power Level Crossfader Response

Transition

Dipped

Intermediate

Constant
Power

Slow Fade

Slow Cut

Crossfader Curve
Properties.

= \ Fast Cut [
A

The crossfader can be mapped to any continuous MIDI controller (absolute or incremental).
In addition to the crossfader’s central slider, its absolute left and right positions are separately
available for MIDI or keyboard mapping. There are two special scenarios for remote control
with respect to the crossfader:

¢ A key mapped to any one of the three assignable crossfader positions (left, center or
right) will toggle the crossfader’s absolute left and right positions.

¢ Mapping to two of the three fields allows for a “snapping back” behavior when one
of the assigned keys is held down and the other is pressed and released.

C’T‘)“ mll (r)ll mll (r)ll mll

3 4 5 6 7
5 5 5 5 =
L] * L] L] L] :??

i-IIl CATEN | BEm[e] | ] [COEm | - Crossfade Assign

Buttons.



CHAPTER 14. MIXING 195

Each track has two Crossfade Assign buttons, A and B. The track can have three states with
respect to the crossfader:

e If neither Assign button is on, the crossfader does not affect the track at all.

e If Ais on, the track will be played unattenuated as long as the crossfader is in the left
half of its value range. As the crossfader moves toward the right across the center
position, the track fades out. At the crossfader’s rightmost position, the track is muted.

e Likewise, if B is on, the track’s volume will be affected only as the crossfader moves
left across its center position.

It is important to understand that the Crossfade Assign buttons do not affect the signal
routing: The crossfader merely influences the signal volume at each track’s gain stage. The
track can be routed to an individual output bus regardless of its crossfade assignment. In
studio parlance, you can think of the crossfader as an on-the-fly VCA group.

As with almost everything in Live, your crossfading maneuvers can be recorded into the
Arrangement for later in-depth editing. To edit each track’s crossfade assignment, please
choose "Mixer” from the Envelope Device chooser and “X-Fade Assign” from the Control
chooser. The crossfader’s automation curve is accessible when “Mixer” is chosen from the
Master track’s Device chooser and “Crossfade” is selected from its Control chooser.

14.6 Soloing and Cueing

By default, soloing a track simply mutes all other tracks (except in some cases where tracks
are feeding other tracks). The signal from the soloed tracks is heard through their respective
outputs, with the pan setting of each track preserved. Soloing a clip track leaves any return
tracks audible, provided that the Solo in Place option is enabled in the Solo button’s context
menu (3 (PC)/ [Ctl & (Mac)). Solo in Place can also be set as the default behavior by
selecting the entry in the Options menu.

Soloing a return track mutes the main output of all other tracks, but still allows you to hear
any signals that arrive at the return via track sends.

Live allows you to replace the standard soloing operation with a cueing operation that lets
you preview tracks as though you were cueing a record on a DJ mixer. This allows choosing
clips and adjusting effects without the audience hearing, before bringing tracks into the mix.
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In order to set Live up for cueing, you must be using an audio interface with at least four
dedicated outputs (or two dedicated stereo outputs). The respective settings are accessible
in the Session View mixer. Make sure you have the Mixer and In/Out options checked in the
View menu.
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1. The Master Out chooser selects the output on your interface to be used as the
main output.

2. The Cue Out chooser selects the output on your hardware interface to be used
for cueing. This has to be set to an output other than that selected for the Master.
If the desired outputs don't show up in these choosers, please check the Audio
Preferences.

3. Activate cueing by setting the Solo/Cue Mode switch to “Cue.”

4. The tracks’ Solo switches are now replaced by Cue switches with headphone
icons. When a track’s Cue switch is pressed, that track’s output signal will be
heard through the output selected in the Cue Out chooser. Note that the Track
Activator switch on the same track still controls whether or not the track is heard
at the Master output.

5. The Cue Volume control adjusts the volume of the cueing output.

Note that when cueing is set up and activated, the output of audio files that you are
previewing in the Browser is also heard through the Cue Out.

The Cueing-Related
Session Mixer Controls.
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14.7 Track Delays

A Track Delay control is available for every track in Live. The control allows delaying or pre-
delaying the output of tracks in milliseconds in order to compensate for human, acoustic,
hardware and other real-world delays.

This section of the interface can be shown or hidden using its respective Mixer Section
selector.

| | | | | | Stop Clips

Track Delay Track Delay Track Delay Track Delay Track Delay Track Delay Track Delay |
[ 0.00ms [ 0.00 ms [ 0.00 ms [ 0.00 ms [ 0.00ms [ 0.00ms [ 0.00 ms o)

We do not recommend changing track delays on stage, as it could result in undesirable
clicks or pops in the audio signal. Micro-offsets in Session View clips can be achieved using
the nudge buttons in the Clip View, however track delays can be used in the Arrangement
View for such offsets.

Note that delay compensation for plug-ins and Live devices is a separate feature, and is
automatic by default. Unusually high Track Delay settings or reported latencies from plug-
ins may cause noticeable sluggishness in the software. If you are having latency-related
difficulties while recording and playing back instruments, you may want to try turning off
device delay compensation, however this is not normally recommended. You may also find
that adjusting the individual track delays is useful in these cases. Note that the Track Delay
controls are unavailable when device delay compensation is deactivated.

The Track Delay Control
and Selector.
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Chapter 15

Recording New Clips

This chapter is about recording new clips from audio and MIDI input signals. Note that this
is a different kind of recording than the capturing of Session clips into the Arrangement.

For successful audio recording, please make sure the audio preferences are set up properly.
For more on this, please see the built-in program lesson on setting up Audio Preferences.
Also, keep in mind that devices such as microphones, guitars and turntables do not operate
at line level, meaning that they will need to have their levels boosted before they can be
recorded. For these devices, you must therefore use either an audio interface with a preamp,
or an external preamp.

15.1 Choosing an Input

A track will record whatever input source is shown in its In/Out section, which appears when
the View menu’s In/Out option is checked. (In the Arrangement View, unfold and resize the
track in order to completely see the In/Out section.)
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Audio tracks default to recording a stereo signal from the external input pair “1/2.” MIDI
tracks default to recording all MIDI that is coming in through the active external input
devices. The computer keyboard is, by default, activated as a pseudo-MIDI input device,
allowing you to record MIDI even if no MIDI controller hardware is currently available.

For every track, you can choose an input source other than the default: any mono or stereo
external input, a specific MIDI channel from a specific MIDI-in device, audio from ReWire
slave programs or a signal coming from another track. The Routing chapter describes these
options in detail.

15.2 Arming (Record-Enabling) Tracks

Clear Envelope
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Clear Envelope A

To select a track for recording, click on its Arm button. It doesn’t matter if you click a track’s
Arm button in the Session View or in the Arrangement View, since the two share the same
set of tracks.

By default, armed tracks are monitored, meaning that their input is passed through their
device chain and to the output, so that you can listen to what is being recorded. This
behavior is called “auto-monitoring” and you can change it to fit your needs.

The Track In/Out Section
in the Arrangement
(Left) and Session View
(Right).

Track Arm Buttons in the
Arrangement (Left) and
Session (Right) Mixers.
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If you are using a natively supported control surface, arming a MIDI track will automatically
lock this control surface to the instrument in the track.

Clicking one track’s Arm button unarms all other tracks unless the (Ctrl | (PC)/ (Mac)
modifier is held. If multiple tracks are selected, clicking one of their Arm buttons will arm
the other tracks as well. Arming a track selects the track so you can readily access its devices
in the Track View.

15.3 Recording

Recording can be done in both the Session and the Arrangement Views. If you want to
record onto more than one track simultaneously and/or prefer viewing the recording linearly
and in-progress, the Arrangement View may be the better choice. If you want to break your
recording seamlessly into multiple clips or record while you are also launching clips in Live,
use the Session View.

15.3.1 Recording Into the Arrangement
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Recording Into the
Arrangement.
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1. Recording commences when the Control Bar's Record button is activated and
the Play button is pressed.

2. Recording creates new clips in all tracks that have their Arm button on.

3. When the Overdub switch is on, the new clips contain a mix of the signal already
in the track and the new input signal. The Overdub option only applies to MIDI
tracks.

4. To prevent recording prior to a punch-in point, activate the Punch-In switch. This
is useful for protecting the parts of a track that you do not want to record over
and allows you to set up a pre-roll or “warm-up” time. The punch-in point is
identical to the Arrangement Loop’s start position.

5. Likewise, to prevent recording after the punch-out point, activate the Punch-Out
switch. The punch-out point is identical to the Arrangement Loop’s end position.

6. When you are recording into the Arrangement Loop, Live retains the audio
recorded during each pass.

You can later “unroll” a loop recording, either by repeatedly using the Edit menu's Undo
command or graphically in the Clip View: After loop recording, double-click on the new clip.
In the Clip View's Sample Display, you can see a long sample containing all audio recorded
during the loop-recording process. The Clip View's loop brace defines the audio taken in
the last pass; moving the markers left lets you audition the audio from previous passes.

15.3.2 Recording Into Session Slots

You can record new clips, on the fly, into any Session slots.
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Recording a New Clip
Into the Session View.

1. Set the Global Quantization chooser to any value other than “None” to obtain
correctly cut clips.

2. Activate the Arm button for the tracks onto which you want to record. Clip
Record buttons will appear in the empty slots of the armed tracks.

3. Click on any of the Clip Record buttons to commence recording. A new clip
will appear in the slot with a red Clip Launch button that shows it is currently
recording. To go from recording immediately into loop playback, press the clip’s
Launch button.

4. Alternatively, you can click a Clip Stop button or the Stop button in the Control
Bar to stop recording, leaving the new clip silent.

Note that, by default, launching a Session View scene will not activate recording in empty
record-enabled slots belonging to that scene. However, you can use the Start Recording
on Scene Launch option from the Record/Warp/Launch Preferences to tell Live that you do
want empty scene slots to record under these circumstances.
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15.3.3 Overdub Recording MIDI Patterns

Live makes pattern-oriented recording of drums and the like quite easy. Using Live's Impulse
instrument and the following technique, you can successively build up drum patterns while
listening to the result. Or, using an instrument such as Simpler, which allows for chromatic

playing, you can build up melodies or harmonies, note by note.

1.
2.

Note that holding (Alt (PC)/ (Mac) while double-clicking the empty slot to create

Set the Global Quantization chooser to one bar.

To automatically quantize the notes you are about to record, choose an appro-
priate value for Record Quantization.

. Double-click any of the Session View slots in the desired MIDI track (the one

containing the Impulse or other instrument). A new, empty clip will appear in the
slot. The new clip will default to a loop length of one bar, but you can change
that by double-clicking the clip and changing its loop properties.

Arm the track.
Launch the clip.

The notes you play are added into the looping clip, and you can observe your
recording in the Clip View.

. By default, the Control Bar's Overdub switch is activated, so that you can build

your pattern layer by layer. However, if you would like to pause recording for a
moment to rehearse, you can deactivate the Overdub switch. The contents of
the clip will continue to play, but you can play along without being recorded.
When you are ready to record again, simply turn on the Overdub switch.

Stop recording by pressing a Clip Stop button or the Stop button in the Control
Bar.

a new clip will implicitly arm the track and launch the clip.

At any time while overdub recording is going on, you can use the Undo command to remove

the last take, or even draw, move or delete notes in the Clip View's Note Editor.

Note that you can also add notes to existing Session clips while the Overdub switch is on.



CHAPTER 15. RECORDING NEW CLIPS 204

15.3.4 MIDI Step Recording

The MIDI Editor allows you to record notes with the transport stopped by holding down keys
on your controller or computer MIDI keyboard and advancing the insert mark according to
the grid settings. This process, known as step recording, allows you to enter notes at your
own pace, without needing to listen to a metronome or guide track.

2] 1] 3
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1. Arm the MIDI track that contains the clip into which you want to record.
2. Enable the Preview switch in the clip’s MIDI Editor.

3. Click in the MIDI Editor to place the insert mark at the position where you want
to begin recording.

Pressing on your computer keyboard will move the insert mark to the right, according
to the grid settings. Any notes that are held down as you press will be added to the
clip. If you continue holding notes as you press again, you will extend their duration. To
delete notes that you've just recorded, keep them depressed and press [+].

The step recording navigators can also be MIDI mapped.

Step Recording in the
MIDI Editor.
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15.4 Recording in Sync

Live keeps the audio and MIDI you have recorded in sync, even when you later decide on a
different song tempo. In fact, Live allows you to change the tempo at any time before, after
and even during recording. You could, for instance, cheat a bit by turning down the tempo
to record a technically difficult part, and pull it up again afterwards.

It is important to record in sync to make sure everything will later play in sync.

rap | 14 || 4 -1

The easiest way to record in sync is to play along with or to use the built-in metronome,
which is activated via its Control Bar switch and will begin ticking when the Play button is
pressed or a clip is launched.

A 1

To adjust the metronome volume, use the mixer’s Preview Volume knob.

peocwe6«

Notice that Live's metrical interpretation of the audio being played can be edited, at any
time, using the Warp Markers. Warp Markers can be used to fix timing errors and to change
the groove or feel of your recordings. Using Warp Markers, you can fix things in your
recordings that would otherwise require complicated editing or could not be done at all.
Likewise, the metrical interpretation of recorded MIDI can be changed after recording, using
the MIDI clip’s Original BPM controls.

The Metronome Switch.

The Preview Volume
Knob.
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15.5 Recording Quantized MIDI Notes

If you will be recording MIDI, you have the option of automatically quantizing MIDI notes
while recording. The Record Quantization chooser in the Edit menu allows selecting the
meter subdivisions with which your recorded notes will align. When recording into Session
slots or into the Arrangement, record quantization is an independent step in Live’s Undo
history. This means that if, for example, you recorded with Record Quantization set to
“Eighth Note Triplet Quantization” and then changed your mind, using the Edit menu’s
Undo command would undo only the quantization and leave your recording otherwise
intact.

For Session and Arrangement recording, the Record Quantization setting cannot be changed
mid-recording.

When overdub recording with the Clip View Loop activated, changes to the Record Quan-
tization take effect immediately, and they cannot be separately undone with the Edit menu
command.

Recorded MIDI notes can also be quantized post-recording with the Edit menu’s Quantize
command, as described in the chapter on editing MIDI.

15.6 Recording with Count-in

A count-in for recording can be set in Live's Record/Warp/Launch Preferences. When the
Count-In preference is set to any value other than “None,” Live will not begin recording
until the count-in is complete. The Arrangement Position fields in the Control Bar display
the count-in in orange as bars-beats-sixteenths.

The count-in runs from negative bars-beats-sixteenths (beginning at -2.1.1., for example,
with a Count-In setting of 2 bars) up to 1.1.1., at which point recording commences.

Note that count-in recording does not apply when Live is synced to external MIDI devices
or being used as a ReWire slave.

The Count-In is
Displayed in the Control
Bar.
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15.7 Setting up File Types

The following Preferences from the Record/Warp/Launch tab are relevant to the sample files
that are created by recording:

e The sample file type you would like Live to create can be chosen from the File Type
chooser in the Record/Warp/Launch Preferences.

e The bit depth of the sample file you will create by recording can be chosen from the
Bit Depth chooser in the Record/Warp/Launch Preferences.

You can save time by setting up reasonable defaults for the clips you are recording in the
Record/Warp/Launch Preferences tab. In particular, it is smart to indicate the rough category
of sound to be recorded by choosing the appropriate default Warp Mode. If you decide
later on a different song tempo, the program will automatically maintain good sound quality,
usually without further adjustment.

15.8 Where are the Recorded Samples?

Recorded samples are stored with the current Set's Project folder, under Samples/Recorded.
Until the Set is saved, it remains at the location specified by the Temporary Folder preference
which is found in the Preferences’ File/Folder tab. To make sure Live will not run out of disk
space while recording into a new Set, please make sure the Temporary Folder is on a drive/
partition with sufficient free space.

15.9 Using Remote Control for Recording

Using Key Map Mode and MIDI Map Mode, you can operate Live's recording functions
without using the mouse.

You can map the Control Bar's Record and transport controls as well as the track Arm buttons.
For recording into the Session slots, you can map the individual slots as well as the relative
navigation controls to initiate recording remotely; for instance:
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. and another key to start and end recording in the respective track.
You can also map the step recording navigators.
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|
Loop — ——— The Step Recording
Fosition — | Arrows.

This allows you to, for example, use MIDI foot pedals to move the clip’s insert mark, thereby
keeping both hands free for playing a keyboard.
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Chapter 16

Working with Instruments and
Effects

Every track in Live can host a number of devices. These devices can be of three different
sorts:

¢ MIDI effects act upon MIDI signals and can only be placed in MIDI tracks.

¢ Audio effects act upon audio signals and can be placed in audio tracks. They can also
be placed in MIDI tracks as long as they are “downstream” from an instrument.

e Instruments are devices that reside in MIDI tracks, receive MIDI and output audio.

The Track View is where you insert, view and adjust the devices for the selected track. To
select a track and open the Track View to access its devices, double-click the track’s name.
The Track View appears in the bottom area of the Live screen.
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To save space in the Track View, a device can be collapsed by double-clicking on its title bar
or by choosing Fold from its @& (PC)/ ® (Mac) context menu.

Ao o

@ @ @ Devices Can Be Folded.

To learn about a particular device and how to operate it, consult the Live Audio Effect
Reference, Live MIDI Effect Reference or the Live Instrument Reference.

To learn about creating and using custom groupings of instruments and effects, check out
the Instrument, Drum and Effect Racks chapter.

Get "hands-on” with devices by assigning their parameters to MIDI or key remote control.
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16.1 Using the Live Devices

O Live Devices

© ___

I= @ Electric Ablston Device
I> [ External Instrumant Ablaton Device
> [ Impulse Ableton Device
1> [l Operator Ableton Device
1> [ Sampler Ableton Device
> [ Simpler Ableton Device
> [ Tension Ableton Device

1= (] mIDI Effects
v =7 Audio Effects

I+ [l Audio Effect Rack Ablaton Devica
¥ [l Auto Filter Ablaton Devica
© EowomowH  Av 264120071204
[ Cut-O-Mowve L Adv 26.11.2007, 12:04

Click on the Device Browser selector to access the palette of Live's built-in devices. You will
notice that MIDI effects, audio effects and instruments each have their own folders in the
Browser.

The easiest way to place a device in a track is to double-click on it in the Browser, which
creates a new track to hold the device. Alternatively, select a destination track by clicking
within it, then select a device or preset in the Browser and press [Return] to add it to the
selected track.

You can also drag devices into tracks or drop areas in the Session and Arrangement Views,
or into the Track View. Dragging a sample to the Track View of a MIDI track creates a Simpler
instrument with this sample loaded.

Note: If you are using an external input signal to feed your Live track using the default
settings, the track’s Arm button in the mixer must be activated in order to hear the input
through the devices in your track’s device chain. On MIDI tracks, this is normally activated
automatically when inserting an instrument.

The Live Device Browser.
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This is how you would play live instruments through effects on a track, for example, or use
a MIDI keyboard's input to play a track’s instrument. Note that you can easily move from

this setup into recording new clips for further use in Live. If you have alternative monitoring
preferences, please see the Monitoring section to learn how to make these settings.

To add another device to the track, simply drag it there or double-click its name to append
it to the device chain. Signals in a device chain always travel from left to right.

You can drop audio effects in at any point in an audio track’s device chain, keeping in mind
that the order of effects determines the resulting sound. The same is true for a MIDI track’s
device chain.

If you drop an instrument into a MIDI track’s device chain, be aware that signals following
(to the right of) the instrument are audio signals, available only to audio effects. Signals
preceding (to the left of) the instrument are MIDI signals, available only to MIDI effects. This
means that it's possible for a MIDI track’s device chain to hold all three types of devices: first
MIDI effects, then an instrument, and finally audio effects.

MIDI and Audio Track
Arm Buttons
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To remove a device from the chain, click on its title bar and press your computer’s
or key, or select Delete from the Edit menu. To change the order of devices, drag a
device by its title bar and drop it next to any of the other devices in the Track View. Devices
can be moved to other tracks entirely by dragging them from the Track View into the Session
or Arrangement Views.

Edit menu commands such as cut, copy, paste and duplicate can be used on devices.
Pasted devices are inserted in front of the selected device. You can paste at the end of
a device chain by clicking in the space after the last device, or by using the key to
move the selection there. Generally, devices can be placed, reordered and deleted without
interrupting the audio stream.

.'E:s-.‘a‘r.'.'n is {
i C\ £ E
r) 9 4 5 25 dB

Devices are turned on and off using their Activator switches. Turning a device off is like
temporarily deleting it: The signal remains unprocessed, and the device does not consume
CPU cycles. Live devices generally do not load down the CPU unless they are active.
For more information, please refer to the CPU load section. The Freeze Track command
discussed there is especially helpful when working with CPU-intensive devices.

"-__ » Operator

A MIDI Track’s Device
Chain Can Contain All
Three Device Types.

Device Activator
Switches.
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Devices in Live's tracks have input and output level meters. These meters are helpful in
finding problematic devices in the device chain: Low or absent signals will be revealed by
the level meters, and relevant device settings can then be adjusted, or the device can be
turned off or removed.
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Note that no clipping can occur between devices because there is practically unlimited
headroom. Clipping can occur when an overly strong signal is sent to a physical output or
written to a sample file.

Further information about track types in Live can be found in the Routing and I/O chapter, in-
cluding information on using return tracks to distribute the effect of a single device amongst
several tracks. After reading about using devices in Live, it might also be interesting to look
into clip envelopes, which can modulate individual device parameters on a per-clip basis.

16.1.1 Live Device Presets

Every Live device can store and retrieve their parameter settings as presets. Presets for Live
instruments and effects are managed through the Device Browser. Each device appears
there as a folder that can be opened to reveal its presets.

The Level Meters
Between Devices in a
Chain.
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You can browse and load presets quickly with the computer keyboard:
e Scroll up and down using the and keys.
e Close and open device folders using the and ) keys.
e Press to load a device or preset.

» Operator I_/.‘:’.\.I o

Clicking a device's Hot-Swap Presets button will temporarily link the Browser to a device,
calling up its presets in the Device Browser. With the device and Browser linked in this
manner, you can quickly browse, load and audition different presets. You can even replace
the current device with a new one by simply selecting another device’s preset. To load a
device’s default factory settings, select the parent folder of its presets (i.e., the one with the
device's name) from the Device Browser.

The link between the Device Browser and the device will be broken if a different view is
selected, or if the Hot-Swap button is pressed again. Preset hot-swapping can also be
cancelled with a press of the key or by pressing the close button in the Hot-Swap
bar at the top of the Browser.

Note that although importing via the Browser is the recommended method, presets can
also be dropped directly into Live from the Explorer (Windows)/Finder (Mac).

Presets in the Device
Browser.

The Hot-Swap Presets
Button.
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Saving Presets

You can create and save any number of your own presets in the Device Browser.
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Click the Save Preset button to save a device's current settings (including any custom info
text) as a new preset. You will be redirected to the Browser, where you can press [Return
to use Live's suggested name, or you can type one of your own. You can also save presets
to specific folders in the Browser (such as your Current Project folder) by dragging from the
title bar of the device and dropping into the Browser location of your choice.

For detailed information on what can be done with the Browser, please see the Manag-
ing Files and Sets chapter. For more on how to store project-specific presets, see the
appropriate section.

Default Presets

Presets saved to the Defaults folders in Live's Library will load in place of Live’s generic device
settings. There are also Defaults folders that allow you to customize how Live responds to
various user actions, such as sample dropping and slicing.

Library = o
Nama Ty
D Clips

& [ Audio Effects
i> [T] Dropping Samples

] D Instruments
&= (7] MIDI Effects
& 7] siicing

To save the current settings of a device as a default preset, open the 3 (PC)/ v}
(Mac) context menu on the device’s header and select “Save as Default Preset.” This works

The Save Preset Button.

The Default Presets
folders in Live’s Library.
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for all of Live's instruments, MIDI effects and audio effects (including the various types of
Racks). If you have already saved a default preset for a particular device, Live will ask you
before overwriting it.

To specify how Live behaves when dragging a sample to a Drum Rack or the Track View of
a MIDI track:

e Create an empty Simpler or Sampler
e Adjust the parameters as you like

¢ Drag the edited device to the “On Drum Rack” or “On Track View" folder, which can
be found at Library/Defaults/Dropping Samples

To adjust how Live behaves when slicing an audio file:

e Create an empty Drum Rack

Add an empty Simpler or Sampler to the Drum Rack to create a single chain

Add any additional MIDI or Audio Effects to this chain

Adjust parameters in any of the devices

Assign Macro Controls to any of the controls in the chain’s devices
¢ Drag the entire Drum Rack to the Library/Defaults/Slicing folder

You can create multiple slicing presets and choose between them in the Slicing Preset
chooser in the slicing dialog.

16.2 Using Plug-Ins

The collection of devices that you can use in Live can be extended with plug-ins. Live
supports Steinberg Media’s VST Plug-ins format, as well as the Audio Units (AU) Plug-ins
format (Mac OS X only).

Working with VST and Audio Units Plug-ins is very much like working with Live devices. VST
and AU instruments can only be placed in Live MIDI tracks and, like Live instruments, they
will receive MIDI and output audio signals. Plug-in audio effects can only be placed in audio
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tracks or following instruments. Please see the previous section, Using the Live Devices, for
details.
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Audio Units and VST Plug-ins are browsed and imported using the Plug-In Device Browser,
which is accessed via its selector. Plug-in instruments can be differentiated from plug-in
effects in the Browser, as they appear with a keyboard icon.

The Browser’s search functionality is only available for Audio Units Plug-ins, as is loading
presets directly from Track View devices via the Hot-Swap button. In some instances, factory
presets for Audio Units will only appear in the Browser once the device has been placed in
a track and its Hot-Swap button activated.

Note: The first time you start Live, no plug-ins will appear in the Plug-In Device Browser,
as you must first “activate” your plug-in sources. Activating your plug-in sources tells Live
which plug-ins you want to use and where they are located on your computer. Information
on activating (and deactivating) plug-in sources can be found later in this chapter, in the
sections on the VST Plug-in folder and Audio Units Plug-ins.

Note for “Intel® Mac” users: Intel@® Mac computers cannot natively run VST or AU plug-
ins that have been written for the PowerPC platform. Only plug-ins of type (Universal) or
(Intel®)) can be used in Live.

If you install/de-install a plug-in while the program is running, Live will not detect your
changes or implement them in the Plug-In Device Browser until the next time you start the
program. Use the Rescan button in the File/Folder Preferences to rescan your plug-ins while

The Plug-In Device
Browser.
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Live is running, so that newly installed devices become immediately available in the Plug-In
Device Browser.

You can also rescan if you believe that your plug-in database has somehow become cor-
rupted. Holding down the (PC) / (Mac) modifier while pressing Rescan will

delete your plug-in database altogether and run a clean scan of your plug-ins.

16.2.1 Plug-Ins in the Track View
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Once a plug-in is dragged from the Browser into a track, it will show up in the Track View.
For plug-ins with fewer than 32 modifiable parameters, a Live panel will represent all of the
parameters as horizontal sliders. Plug-ins that contain more than 32 parameters will open
with an empty panel, which you can then configure to show the parameters you want to
access. The plug-in’s original interface can be opened in a separate window.

& polyiblit

W (B SectionCne Mixeri Osci Lave

1.92 dB

Mixeri Osc2 Love The Plug—ln Unfold
1.51 dB Button.

You can view or hide the plug-in's parameters by toggling the © button in the plug-in's
title bar.
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The X-Y control field can be used to control two plug-in parameters at once and is therefore
especially well-suited for live control. To assign any two plug-in parameters to the Live panel
X-Y field, use the drop-down menus directly beneath it.

Showing Plug-In Panels in Separate Windows
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The Plug-In Edit button opens a floating window that shows the original VST or Audio Units
Plug-in panel. Changing parameters on the floating window has the same effect as changing
them in the Live panel, and vice versa.

There are a few important Plug-In Preference settings for working with plug-in edit windows:

o If activated, the Auto-Open Plug-In Windows Preference assures that plug-in edit
windows open automatically when plug-ins are loaded into tracks from the Browser.

e If the Multiple Plug-In Windows option in the Plug-In Preferences is activated, you can
open any number of plug-in windows at once. Even with this option off, you can hold
down the [Ctl | (PC)/ (& & (Mac) modifier when opening a new plug-in window to
keep the previous window(s) from closing.

e Using the Auto-Hide Plug-In Windows preference, you can choose to have Live display
only those plug-in windows belonging to the track that is currently selected.

You can use the View menu’s Show/Hide Plug-In Windows command or the (Ctrl_J(Alt  ][P)
(PC)/ (& At ~J[P] (Mac) shortcut to hide and show your open plug-in windows. Notice
that the name of the track to which the plug-in belongs is displayed in the title bar of the
plug-in editor window.

The Plug-In Edit Button.
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Plug-In Configure Mode
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Configure Mode allows you to customize Live’s panel to show only the plug-in parameters
that you need to access. To do this:

e Enter Configure Mode by pressing the “Configure” button in the device’s header.

e Click on a parameter in the plug-in edit window to add it to Live's panel. (For some
plug-ins, it may be necessary to actually change the parameter’s value. Additionally,
certain plug-ins do not “publish” all of their parameters to Live. These parameters
cannot be added to Live's panel.)

While in Configure Mode, parameters in Live's panel can be reordered or moved by dragging
and dropping them to new locations. Parameters can be deleted by pressing the
key. If you try to delete a parameter that has existing automation data, clip envelopes, or
MIDI, key or Macro mappings, Live will warn you before proceeding.

The parameters that you assign are unique for each instance of a given plug-in in your Set,
and are saved with the Set.

Certain plug-ins do not have their own windows, and instead only show their parameters in
Live's panel. For these plug-ins, it is not possible to delete parameters when in Configure
Mode (although they can still be moved and reordered).

There are several ways to add plug-in parameters to Live's panel without entering Configure
Mode:

o Adjusting a parameter in the plug-in's floating window creates temporary entries for
that parameter in the clip envelope and automation choosers, as well as the choosers

The Configure Button.
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in the panel’s X-Y field. These entries are removed when you adjust another param-
eter. To make the entry permanent (thus adding it to Live’s panel), either edit the
parameter’s automation or clip envelope, select another parameter in the automation
or clip envelope choosers or select the temporary parameter in one of the X-Y field’s
choosers.

When a parameter is changed on a plug-in’s edit window during recording, automation
data is recorded automatically. When recording is stopped, the automated parameters
are automatically added to Live's panels for any plug-ins that were adjusted.

When in MIDI, key or Macro mapping mode, adjusting any parameter in the plug-in’s
window will create it in Live's panel. The new panel entry will be automatically selected,
allowing you to map it immediately.

Once a plug-in is placed in a track and you have (optionally) configured its parameters in
Live's panel, you can use it just like a Live device:

You can map MIDI controller messages to all of the parameters in Live’s panel.

You can drag or copy the device to different locations in the device chain or to other
tracks, according to the rules of audio effects and instruments.

You can modulate its continuous parameters with clip envelopes.

You can use the multiple 1/O features of some plug-ins by assigning them as sources
or targets in the routing setup of tracks. See the Routing and I/O chapter for details.

You can create custom info text for the plug-in.

Macintosh only: The floating editor windows of some VST Plug-ins do not receive computer
key strokes. This is generally an implementation error in the plug-in itself. If it is necessary
to type into a plug-in window, for instance for entering a serial number or unlock code, hold
down while clicking the Plug-In Edit button. The editor window will then appear as
a "normal” application window, rather than as a floating window, and receive your typing.
Note that this functionality is intended only as a workaround for the limitations of such plug-
ins. We recommend closing the window after you have finished typing, then reopening it
normally before working with the plug-in parameters.
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16.2.2 Plug-In Performance Options

The CPU Preferences contain a Plug-In Buffer Size setting for balancing plug-in latency and
performance. Here you can set the number of samples processed at any one time by the
plug-in. Higher settings may result in a noticeable performance increase but will also result
in higher latencies.

With the “As Audio Buffer” setting selected, the plug-in will calculate the exact number of
samples per millisecond as the computer’s sound card. This setting usually means that very
few dropouts or performance problems will occur, especially with DSP cards.

The size of the computer’s sound card buffer (i.e., the number of samples it calculates per
millisecond) can be set using the Buffer Size setting in the Audio Preferences.

16.3 VST Plug-Ins

16.3.1 The VST Plug-In Folder

When you start Live for the first time, you will need to activate your VST Plug-in sources
before working with VST Plug-ins. Depending on your computer platform, you may also
have to tell Live about the location of the VST Plug-in folder containing the devices you
want to use. In order to set up your VST sources, press the Activate button in the Plug-In
Device Browser, or open the File/Folder Preferences by pressing (Ctd ][, ] (PC)/ (& (. ]

(Mac). There you will find the Plug-In Sources section.

Plug-in Sources

Rescan Plug-ins L 1
Use V5T Plug-in Custom Foldar _
VST Plug-n Custom Folder ( Browse

ChProgram Files\Wsiplugins)

For Windows, proceed as follows:

1. Use the VST Plug-In Custom Folder entry to tell Live about the location of your
VST Plug-ins: Click the Browse button to open a folder-search dialog for locating
and selecting the appropriate folder.

Setting up VST Plug-In
Sources for Windows.
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2. Once you have selected a VST Custom Folder and Live has scanned it, the path
will be displayed. Note that, on Windows, Live may have found a path in the
registry without the need for browsing.

3. Make sure that the Use VST Plug-In Custom Folder option is set to “On,” so
that your selected folder is an active source for VST Plug-ins in Live. Note that
you can choose not to use your VST Plug-ins in Live by turning off the Use VST
Plug-In Custom Folder option.

Plug-in Sources
Rescan Plug-ins

Use Audic Units

Use VST Plug-In System Foldars o

Use VST Plug-In Custom Folder

VST Plug-in Custom Folder
Mot Sel

Set up your VST Plug-ins under Mac OS X by doing the following:

1. Your VST Plug-ins will normally be installed in the following folder in your home
and local directories: /Library/Audio/Plug-Ins/VST. You can turn Live's use of
these plug-ins on or off with the Use VST Plug-ins in System Folders option.

2. You may have an alternative folder in which you store your VST Plug-ins (perhaps
those that you use only with Live). You can use VST Plug-ins in this folder in addi-
tion to, or instead of, those in the System folders. To tell Live about the location
of this folder, click the Browse button next to the VST Plug-In Custom Folder

entry to open a folder-search dialog for locating and selecting the appropriate
folder.

3. Note that you can turn off your VST Plug-ins in this folder using the Use VST
Plug-In Custom folder option.

Once you have configured your Plug-In Preferences, the Plug-In Device Browser will display
all plug-ins it finds in the selected VST Plug-in folder(s) as well as any sub-folders.

It is also possible to use VST Plug-ins stored in different folders on your computer. To do
this, create a Mac OS or Windows alias of the folder where additional VST Plug-ins are
stored, and then place the alias in the VST Plug-In Custom folder (or in the VST Plug-In

Setting up VST Plug-In
Sources for Mac OS X.
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System folder on Mac OS X) selected in Live’s File/Folder Preferences. The alias can point
to a different partition or hard drive on your computer. Live will scan the set VST Plug-in
folder as well as any alias folders contained therein.

Some VST Plug-ins contain errors or are incompatible with Live. During the scanning process,
these may cause the program to crash. When you re-launching Live, a dialog will appear
to inform you about which plug-in caused the problem. Depending on what Live detects
about the plug-in, you may be given the choice between performing another scan or
making the problematic plug-in unavailable. If you choose to rescan and they crash the
program a second time, Live will automatically make them unavailable, meaning that they
will not appear in the Plug-In Device Browser and will not be rescanned again until they are
reinstalled.

16.3.2 VST Programs and Banks

Every VST Plug-in instance “owns"” a bank of programs. A program is meant to contain one
complete set of values for the plug-in's controls.
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To select a program from the plug-in's bank, use the chooser below the title bar. The number
of programs per bank is fixed. You are always working “in” the currently selected program,
that is, all changes to the plug-in's controls become part of the selected program.

Note that VST programs are different from Live device presets: Whereas the presets for a
Live device are shared among all instances and Live Sets, the VST programs “belong” to
this specific instance of the VST Plug-in.

¥ ([E & polyiblit
To rename the current program, select the VST program chooser and execute the Edit
menu’s Rename Plug-In Preset command. Then type in a new program name and confirm

by pressing .

The VST Plug-In
Program Chooser.

Renaming a VST Plug-In
Program.
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VST programs and banks can be imported from files. Clicking the VST Program Load button
brings up a standard file-open dialog for locating the desired file.

Windows only: Please select from the File Type menu whether you want to locate VST
Device Program files or VST Device Bank files.

To save the currently selected program as a file, click the VST Program/Bank Save button to
bring up a standard file-save dialog; select “VST Device Program” from the Format menu
(Macintosh)/from the File Type menu (Windows); select a folder and name. For saving the
entire bank as a file, proceed likewise but choose “VST Device Bank” as a file type/format.

16.4 Audio Units Plug-Ins

Audio Units Plug-ins are only available in Mac OS X. In most respects, they operate just like
VST Plug-ins.

O® @ rsros @
DiyL Fb Fit Cutoff Rvb Damp
A A
0.z 0.96 0.13
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Fy i
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The first time you open Live, Audio Units Plug-ins will not appear in the Plug-In Device
Browser. In order to activate your Audio Units as a plug-in source, please press the Activate
button in the Plug-In Device Browser, or go to the File/Folder Preferences by pressing
crl )] (PC)/ (& ¥ ) (Mac). There you will find the Plug-In Sources section. Turning

The VST Program/Bank
Load Button (Left) and
Save Button (Right).

An Audio Units Plug-In.
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on the Use Audio Units option activates Audio Units Plug-ins so that they appear in Live’s
Plug-In Device Browser.

Note that you can always turn this option off later if you decide not to use Audio Units.

Plug-In Sources

Rescan Plug-ins Resca

Use Audio Units [om |

Use V5T Plug-In System Folders O

Audio Units Plug-ins sometimes have a feature that allows choosing between different
modes for the device. You might be able to choose, for example, between different levels
of quality in the rendering of a reverb. Choosers for these device modes can only be
accessed through the original plug-in panel, which is opened using the Plug-In Edit button.

Pattern

Play Stop

FEEEEE

Audio Units have presets that function just like those for the Live effects. However, some
AU presets cannot be dragged to different locations in the Browser, as they are read-only.

Audio Units presets have an .aupreset extension and are stored in the following directory
according to their manufacturer's name:

[Home]/Library/Audio/Presets/[Manufacturer Namel]/[Plug-in Name]

16.5 Device Delay Compensation

Live automatically compensates for delays caused by Live and plug-in instruments and
effects, including those on the return tracks. These delays can arise from the time taken by
devices to process an input signal and output a result. The compensation algorithm keeps
all of Live's tracks in sync, regardless of what their devices are doing, while minimizing delay
between the player’s actions and the audible result.

Activating Audio Units
Plug-Ins.

Opening an Audio Units
Plug-In Window.
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Device delay compensation is on by default and does not normally have to be adjusted
in any way. However, Live Sets that were created with Live 4 or earlier will open without
device delay compensation. To manually turn latency compensation on (or off), use the
Delay Compensation option in the Options menu.

Unusually high individual track delays or reported latencies from plug-ins may cause no-
ticeable sluggishness in the software. If you are having latency-related difficulties while
recording and playing back instruments, you may want to try turning off device delay com-
pensation, however this is not normally recommended. You may also find that adjusting the
individual track delays is useful in these cases.

Note that device delay compensation can, depending on the number of tracks and devices
in use, increase the CPU load.



229

Chapter 17

Instrument, Drum and Effect Racks
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A Rack is a flexible tool for working with effects, plug-ins and
device chain. Racks can be used to build complex signal processors, dynamic performance
instruments, stacked synthesizers and more. Yet they also streamline your device chain
by bringing together your most essential controls. While Racks excel at handling multiple
devices, they can extend the abilities of even a single device by defining new control
relationships between its parameters.

instruments in a track’s

Racks greatly expand upon the concept of device groups introduced in Live 5. The device
groups of any Live Sets imported from Live 5 are automatically converted to Racks by Live
8. Note that these Live Sets, once saved, can no longer be opened in older versions of Live.

An Audio Effect Rack.
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17.1  An Overview of Racks

17.1.1 Signal Flow and Parallel Device Chains

In any of Live's tracks, devices are connected serially in a device chain, passing their signals
from one device to the next, left to right. By default, the Track View displays only a single
chain, but there is actually no limit to the number of chains contained within a track.

Racks allow (among other things) additional device chains to be added to any track. When a
track has multiple chains, they operate in parallel: In Instrument and Effect Racks, each chain
receives the same input signal at the same time, but then processes its signal serially through
its own devices. The output of each of the parallel chains is mixed together, producing the
Rack’s output.

Drum Racks also allow multiple parallel chains to be used simultaneously, but their chains
process input somewhat differently: Rather than receiving the same input signals, each
Drum Rack chain receives input from only a single assigned MIDI note.

The entire contents of any Rack can be thought of as a single device. This means that adding
a new Rack at any point in a device chain is no different than adding any other device, and
Racks can contain any number of other Racks. If more devices are placed after a Rack in a
track’s device chain, the Rack’s output is passed on to them, as usual.

17.1.2 Macro Controls

(1) Audio Effect Rack @@
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One unique property of Racks are their Macro Controls.

The Macro Controls.



CHAPTER 17. INSTRUMENT, DRUM AND EFFECT RACKS 231

The Macro Controls are a bank of eight knobs, each capable of addressing any number of
parameters from any devices in a Rack. How you use them is up to you — whether it be
for convenience, by making an important device parameter more accessible; for defining
exotic, multi-parameter morphs of rhythm and timbre; or for constructing a mega-synth,
and hiding it away behind a single customized interface. See Using the Macro Controls for
a detailed explanation of how to do this.

For the greatest degree of expression, try MIDI-mapping the Macro Controls to an external
control surface.

17.2 Creating Racks

Four Rack variants cover the range of Live's devices: Instrument Racks, Drum Racks, Audio
Effect Racks and MIDI Effect Racks. Just as with track types, each kind of Rack has rules
regarding the devices it contains:

e MIDI Effect Racks contain only MIDI effects, and can only be placed in MIDI tracks.

e Audio Effect Racks contain only audio effects, and can be placed in audio tracks.
They can also be placed in MIDI tracks, as long as they are “downstream” from an
instrument.

e Instrument Racks contain instruments, but can additionally contain both MIDI and
audio effects. Inthis case, all MIDI effects have to be at the beginning of the Instrument
Rack’s device chain, followed by an instrument, and then any audio effects.

e Drum Racks are similar to Instrument Racks; they can contain instruments as well as
MIDI and audio effects and their devices must be ordered according to the same signal
flow rules. Drum Racks can also contain up to six return chains of audio effects, with
independent send levels for each chain in the main Rack.

There are different ways to create Racks. A new, empty Rack can be created by dragging a
generic Rack preset (“Audio Effect Rack,” for example) from the Device Browser into a track.
Devices can then be dropped directly into the Rack’s Chain List or Devices view, which are
introduced in the next section.

If a track already has one or more devices that you would like to group into a Rack, then
simply select the title bars of those devices in the Track View, and & (PC)/ 8 (Mac)
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on one of the title bars to reveal the Group and Group to Drum Rack commands in the
context menu. Note that if you repeat one of these commands again on the same device,
you will create a Rack within a Rack. You can also group multiple chains within a Rack using
the same procedure. Doing this also creates a Rack within a Rack. In the Track View, the
contents of Racks are always contained between end brackets: Just as with punctuation or
in mathematics, a Rack within a Rack will have a pair of brackets within a pair of brackets.

To ungroup devices, dismantling their Racks, select the Rack’s title bar, and then use the
Edit menu or the context menu to access the Ungroup command.

17.3 Looking at Racks

2 3 4
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1. Racks have distinct views that can be shown or hidden as needed. Therefore,
every Rack has a view column on its far left side that holds the corresponding
view selectors. The actual view selectors available differ depending on whether

Components of an
Effect Rack.

Components of a Drum
Rack.
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an Instrument, Drum or Effect Rack is being used.
2. Macro Controls

3. Chain List. In Drum Racks, this view can include both drum chains and return
chains.

4. Devices

5. Racks are also identifiable by their round corners, which bracket and enclose their
content. When the Devices view is shown, the end bracket visually detaches itself
to keep the Rack hierarchy clear.

6. Pad View. This is unique to Drum Racks.

To move, copy or delete an entire Rack at once, simply select it by its title bar (as opposed
to the title bars of any devices that it contains). When selected, a Rack can also be renamed
by using the Edit menu’s Rename command. You can also enter your own info text for a
Rack via the Edit Info Text command in the Edit menu or in the Racks's (3 (PC)/ (Cul |8
(Mac) context menu.

When all of a Rack’s views are hidden, its title bar will fold into the view column, making the
entire Rack as slim as possible. This has the same effect as choosing Fold from the &3 (PC)
/ (el ]8 (Mac) context menu or double-clicking on the Rack’s title bar.

If you would like to locate a particular device in a Rack without searching manually through
its entire contents, you will appreciate this navigation shortcut: 3 (PC) / ® (Mac)
on the Track View selector, and a hierarchical list of all devices in the track’s device chain will
appear. Simply select an entry from the list, and Live will select that device and move it into
view for you.
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The Chain List in an
Audio Effect Rack.

As signals enter a Rack, they are first greeted by the Chain List. We will therefore also
choose this point for our own introduction.

The Chain List represents the branching point for incoming signals: Each parallel device
chain starts here, as an entry in the list. Below the list is a drop area, where new chains can

be added by dragging and dropping presets, devices, or even pre-existing chains.

Note: Racks, chains and devices can be freely dragged into and out of other Racks, and
even between tracks. Selecting a chain, then dragging and hovering over another Session
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or Arrangement View track will give that track focus; its Track View will open, allowing you
to drop your chain into place.

Since the Track View can show only one device chain at a time, the Chain List also serves as
a navigational aid: The list selection determines what will be shown in the adjacent Devices
view (when enabled). Try using your computer keyboard’s and (4] keys to change the
selection in the Chain List, and you'll find that you can quickly flip through the contents of a
Rack.

The Chain List also supports multi-selection of chains, for convenient copying, organizing
and regrouping. In this case, the Devices view will indicate how many chains are currently
selected.

Each chain has its own Chain Activator, as well as Solo and Hot-Swap buttons. Chains in
Instrument, Drum and Audio Effect Racks also have their own volume and pan sliders, and
Drum Rack chains have additional send level and MIDI assignment controls. Like Live Clips,
entire chains can be saved and recalled as presets in the Device Browser. You can give a
chain a descriptive name by selecting it, then choosing the Edit menu’s Rename command.
You can also enter your own info text for a chain via the Edit Info Text command in the Edit
menu or in the chain’s @ (PC) / ® (Mac) context menu. The context menu also
contains a color palette where you can choose a custom chain color.

17.4.1 Auto Select

L Effect Rack + B
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Auto Select in an Audio
Effect Rack.
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Drum Rack

@

When the Auto Select switch is activated, every chain that is currently processing signals
becomes selected in the Chain List. In Drum Racks, this feature will select a chain if it
receives its assigned MIDI input note. In Instrument and Effect Racks, Auto Select works in
conjunction with zones, which are discussed next, and is quite helpful when troubleshooting
complex configurations.

17.5 Zones

Zones are sets of data filters that reside at the input of every chain in an Instrument or Effect
Rack. Together, they determine the range of values that can pass through to the device
chain. By default, zones behave transparently, never requiring your attention. They can
be reconfigured, however, to form sophisticated control setups. The three types of zones,
whose editors are toggled with the buttons above the Chain List, are Key, Velocity, and
Chain Select. The adjacent Hide button whisks them out of sight.

Note: Audio Effect Racks do not have key or velocity zones, since these two zone types
filter MIDI data only. Likewise, Drum Racks have no zones at all; they filter MIDI notes based
on choosers in their chain lists.

Zones contain a lower, main section, used for resizing and moving the zone itself, and
a narrow upper section that defines fade ranges. Resizing of either section is done by
clicking and dragging on its right or left edges, while moving is accomplished by clicking
and dragging a zone from anywhere except its edges.

Auto Select in a Drum
Rack.
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17.5.1 Signal Flow through Zones

To understand how zones work, let's examine the signal flow in a MIDI Effect Rack. Our
MIDI Effect Rack resides in the device chain of a MIDI track, and therefore processes MIDI
signals. We will assume that it contains four parallel device chains, each containing one

MIDI effect.

1.

All MIDI data in the track is passed to its device chain, and therefore into the
input of the MIDI Effect Rack.

. Our MIDI Effect Rack has four device chains, all of which receive the same MIDI

data at the same time.

Before any MIDI data can enter a device chain, it must be able to pass through
every zone in that chain. Every chain in a MIDI Effect Rack has three zones: a
key zone, a velocity zone and a chain select zone.

An incoming MIDI note gets compared to a chain’s key zone. If the MIDI note lies
within the key zone, it is passed to the next zone for comparison; if it does not,
then we already know that the note will not be passed to that chain’s devices.

The same comparisons are made for the chain’s velocity and chain select zones.
If a note also lies within both of these zones, then it is passed to the input of the
first device in that chain.

. The output of all parallel chains is mixed together to produce the MIDI Effect

Rack’s final output. If there happened to be another device following after
the Rack in the track’s device chain, it would now receive the Rack’s output for
processing.
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17.5.2 Key Zones
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When the Key button is selected, the Key Zone Editor appears to the right of the Chain List,
illustrating how each chain maps to the full MIDI note range (nearly 11 octaves). Chains will
only respond to MIDI notes that lie within their key zone. The zones of individual chains may
occupy any number of keys, allowing for flexible “keyboard split” setups.

Key zone fade ranges attenuate the velocities of notes entering a chain.

17.5.3 Velocity Zones
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Each chain in an Instrument Rack or MIDI Effect Rack also has a velocity zone, specifying the
range of MIDI Note On velocities that it will respond to.

The Velocity Zone Editor, when displayed, replaces the Key Zone Editor to the right of the
Chain List. MIDI Note On velocity is measured on a scale of 1-127, and this value range

The Key Zone Editor.

The Velocity Zone Editor.
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spans the top of the editor. Otherwise, the functionality here is identical to that of the Key
Zone Editor.

Velocity zone fade ranges attenuate the velocities of notes entering a chain.

17.5.4 Chain Select Zones
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Activating the Chain button in an Instrument or Effect Rack displays the Chain Select Editor.
These Racks have chain select zones, which allow you to filter chains spontaneously via a
single parameter. The editor has a scale of 0-127, similar to the Velocity Zone Editor. Above
the value scale, however, you will find a draggable indicator known as the Chain selector.

The chain select zone is a data filter just like the other zones; although all chains in a Rack
receive input signals, only those with chain select zones that overlap the current value of the
Chain selector can be addressed and thereby produce output.

By default, the chain select zones of Instrument and MIDI Effect Racks filter only notes,
ignoring all other incoming MIDI events (such as MIDI CCs). To filter all MIDI events, enable
the Chain Selector Filters MIDI Ctrl option, available in the contextmenu @ (PC)/ [Ctrl |8
(Mac) of a Rack’s title bar or Chain Select Ruler.

In MIDI Effect Racks, fade ranges attenuate the velocities of notes entering a chain. In
Instrument Racks and Audio Effect Racks, which both output audio signals, fade ranges
attenuate the volume level at each chain’s output. So what happens, then, if the Chain
selector is moved outside of the chain select zone where a sound is currently playing? If
the zone ends in a fade range, the chain’s output volume is attenuated to zero while the
Chain selector is outside of the zone. If the zone had no fade range, the output volume

The Chain Select Editor.
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is not attenuated, allowing the chain’s effects (like long reverb tails or delays) to fade out
according to their own settings.

Let's consider how we can make use of chain select zones in a performance situation:

Making Preset Banks Using Chain Select
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Unlike the other zone types, the default length of a chain select zone is 1, and the default
value is 0. From this setup, we can quickly create “preset banks” using the Chain Select
Editor.

Again, we will use a Rack with four chains as our starting point. Each of the four chains
contain different effects that we would like to be able to switch between. To make this
a "hands-on” experience, we have MIDI-mapped the Chain selector to an encoder on an
external control surface.

Let's move the chain select zones of the second and third chains so that each of our zones is
occupying its own adjacent value: The first chain’s zone has a value of 0, the second chain’s
zone has a value of 1, the third has a value of 2, and the fourth has a value of 3.

Since each of our chain select zones has a unique value, with no two zones overlapping,
we now have a situation where only one chain at a time can ever be equal to the Chain
selector value (shown at the top of the editor). Therefore, by moving the Chain selector, we
determine which chain can process signals. With our MIDI encoder at hand, we can now
flip effortlessly between instrument or effect setups.

Using Chain Select
Zones to Create Effects
Presets.
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Crossfading Preset Banks Using Fade Ranges
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Crossfading Between
Effects Presets Using
Chain Select Zones.

Taking the previous example one step further, we can tweak our chain select zones to
produce a smooth transition between our “presets.” To accomplish this, we will make use
of our zones’ fade ranges.

To create some room for fading, let's extend the length of our zones a bit. Setting the zones
as shown maintains four exclusive values for our presets, so that each still has one point
where neither of the others are heard. We crossfade between the presets over eight steps.
If this is too rough a transition for your material, simply reposition the zones to maximize the
fade ranges.

17.6 Drum Racks

We've already talked a bit about Drum Racks, and most of their features are the same as
those found in Instrument and Effect Racks. But Drum Racks have a slightly different layout,
some unique controls and special behavior that is optimized for creating drum kits.



CHAPTER 17. INSTRUMENT, DRUM AND EFFECT RACKS 242

2 3
[ : [ : |
() Drum Rack i [ZX 1]
® c#z 5 o#z | Chain Recelve Play  Choke  Senda Sendb Vol  Pan Audio To
e iz A Kick 1ol €3 |[None o] | §59.69d[-nf b | [BOOME C E[S] @ | lii
O [ e | G B1 | B sicosticn § 1579 oSG o |00 [ 16R <[@l[S] @ | lii
HH Snare Hit 01 o[ €3 |None | § BBz oi[-nfoe | OONEI oL <[E[S] @ | lii
M [s M[e][s ME[s v = =
Ea—— = a0 = heee TN Ftan il e =TT, i
OvenHat|| Cl.Hat | PecalHat|| Buz A autiity ji 57908 [-nr o6 | [G0ME [ 5L «@[S] @ [Rack Cuput_<jj
A w s Mr[s|m BICODE m b Reverb ji [nfdB|[-infdB | @IOOME C (@[S | [Rack Output <[
® rix Sidestick | Snare Hit | Cowbell 4 . . .
1 a Big Drop Audio Effects Here The Chain List in a Drum
oM SIM S5|M S|M s v
Rack.

1. In addition to the standard selectors found on all Racks, Drum Racks have four
additional controls in the view column. From top to bottom, these are the Auto
Select button and toggles for the Input/Output, Send, and Return sections.

2. Input/Output Section. The Receive chooser sets the incoming MIDI note to which
the drum chain will respond. The list shows note names, MIDI note numbers and
standard GM drum equivalents. The Play slider sets the outgoing MIDI note that
will be sent to the devices in the chain. The Choke chooser allows you to set
a chain to one of sixteen choke groups. Any chains that are in the same choke
group will silence the others when triggered. This is useful for choking open
hihats by triggering closed ones, for example. If “All Notes” is selected in the
Receive chooser, the Play and Choke choosers are disabled — in this case, the
chain simply passes the note that it receives to its devices. The small Preview
button to the left of these choosers fires a note into the chain, making it easy to
check your mappings away from a MIDI controller.

3. Mixer Section. In addition to the mixer and Hot-Swap controls found in other
Rack types, Drum Racks also have send sliders. These sliders allow you to set the
amount of post-fader signal sent from each drum chain to any of the available
return chains. Note that send controls are not available until return chains have
been created.

4. Return Chains. A Drum Rack’s return chains appear in a separate section at the
bottom of the chain list. Up to six chains of audio effects can be added here,
which are fed by send sliders in each of the drum chains above.

The Audio To chooser in the mixer for return chains allows you to route a return chain's
output to either the main output of the Rack or directly to the return tracks of the Set. In
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Drum Racks that are nested within other Drum Racks, both drum chains and return chains
can route “upwards” to the returns of any of the Drum Racks that contain them.

17.6.1 Pad View
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The Pad View is unique to Drum Racks and offers an easy way to map and manipulate
samples and devices. Each pad represents one of the 128 available MIDI notes. The pad
overview to the right shifts the set of visible pads up or down in octave increments, either by
dragging the view selector to a new area or by using your computer keyboard’s and (1)
keys. Use the (PC)/ (Mac) modifier to shift the view by single rows instead.

Almost any object from Live’s Browser — samples, effects, instruments and presets — can be
dragged onto a pad, mapping automatically to the pad’s note and creating or reconfiguring
internal chains and devices as necessary. Dropping a sample onto an empty pad, for
example, creates a new chain containing a Simpler, with the dropped sample ready to
play from the pad’s note. If you then drag an audio effect to the same pad, it is placed
downstream from the Simpler in the same chain. To replace the Simpler, simply drop another
sample onto the same pad - any downstream audio effects or upstream MIDI effects will be
left intact and only the Simpler and sample will be replaced.

If a multi-selection of samples is dropped onto an empty pad, new Simplers and chains will
be mapped upwards chromatically from this pad, replacing any other samples that may have
already been assigned to the pads in question (but, as before, leaving any effects devices
alone). (PC) / [& & (Mac)-dragging a multi-selection layers all of the samples to

Pad View.
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a single pad, by creating a nested Drum Rack with all of its chains set to receive that pad's
note.

Dragging a pad to another pad swaps the note mapping between the pads. This means that
any MIDI clips triggering the affected notes will now play the “wrong” sounds — although
this might be exactly what you want. [Alt (PC) / (@ & (Mac)-dragging one pad to
another will layer any chains from both pads in a nested Drum Rack.

You can always change your mappings from within the chain list as well, by adjusting the
Receive choosers. The Pad View will update automatically to reflect your changes. If you
set the same Receive note for multiple chains, that note’s pad will trigger them all.

If you're working with lots of nested Racks, the inner structure can quickly become compli-
cated. Pad View can make it much easier to work by letting you focus on only the top level:
the notes and sounds. It's important to remember that a pad represents a note, rather than
a chain. More specifically, it represents all chains, no matter how deep in the Rack, that are
able to receive that pad’s note. What you can control with each pad is related to how many
chains it represents:

e An empty pad shows only the note it will trigger. When you mouse over it, the Status
Bar will display this note, as well as the suggested GM instrument.

¢ A pad that triggers only one chain shows the name of the chain. In this case, the pad
serves as a handy front-end for many controls that are normally accessed in the chain
list, such as mute, solo, preview and Hot-Swap. You can also rename and delete the
chain via the pad.

¢ A pad that triggers multiple chains shows “Multi” as its name, and its mute, solo and
preview buttons will affect all of its chains. If you mute and solo chains individually
within the chain list, the pad’s icons reflect this mixed state. Hot-Swap and renaming
are disabled for a Multi pad, but you can delete all of its chains at once.

Although Pad View is designed for easy editing and sound design, it also excels as a
performance interface, particularly when triggered by a hardware control surface with pads.
If your pad controller is one of Ableton’s natively supported control surfaces, simply select
it as a control surface in the MIDI/Sync tab of Live's Preferences. From then on, as long as
you have a Drum Rack on a track that's receiving MIDI, your pad controller will trigger the
pads that are visible on your screen. If you scroll the pad overview to show a different set of
pads, your controller will update automatically.
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17.6.2 Slicing

Although Live automatically warps audio files to match your Set's tempo, you can get even
more flexibility out of your loops via a process called slicing. Slicing involves dividing the
audio into small chunks and assigning each chunk to a single MIDI note, leaving your original
audio file unaffected. The Drum Rack provides an ideal environment for working with sliced
files, and most of the setup happens automatically.

To get started, select an audio clip from within your Set or the Browser, click & (PC) /
8 (Mac) to open the clip’s context menu, and select the Slice to New MIDI Track
command:

Create ona slice per: 116 Note: 7|

The current clip reglon is & beats long
- this will result in 32 slices.

Slicing Preset:  |Buili-in

€ OK X Cancel

The Slicing dialog offers a list of slicing divisions, as well as a chooser to select the Slicing
Preset. The top chooser allows you to slice at a variety of beat resolutions or according to
the clip’s transients or Warp Markers. Since a Rack can contain a maximum of 128 chains,
Live won't let you proceed if your choice would result in more than 128 slices. You can fix
this by either setting a lower slice resolution or by selecting a smaller region of the clip to
slice. If your audio file is in REX format, the slicing will be based on the file’s internal timing
information and you won't see this chooser.

The Slicing Preset chooser contains a few Ableton-supplied slicing templates, as well as any
of your own that you may have placed in your Library’s default presets folder.

Once you've made your slicing choices and clicked OK, a number of things will happen:

1. A new MIDI track will be created, containing a MIDI clip. The clip will contain
one note for each slice, arranged in a chromatic sequence.

2. A Drum Rack will be added to the newly created track, containing one chain per
slice. Each chain will be triggered by one of the notes from the clip, and will
contain a Simpler with the corresponding audio slice loaded.

The Slicing Dialog.
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3. The Drum Rack’s Macro Controls will be pre-assigned to useful parameters for
the Simplers, as determined by the settings in the selected slicing preset. In the
factory Slicing presets, these include basic envelope controls and parameters to
adjust the loop and crossfade properties of each slice. Adjusting one of these
Macros will adjust the mapped parameter in each Simpler simultaneously.

Note: Live will take a few moments to process all of this information.

Playing the MIDI clip will trigger each chain in the Drum Rack in order, according to the
timing information that you specified or that was embedded in the audio. This opens up
many new editing possibilities, including:

Resequencing Slices
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By default, your sliced MIDI data will form a chromatically-ascending “staircase” pattern in
order to trigger the correct chains in their original order. But you can create new patterns

by simply editing the MIDI notes. You can achieve a similar effect by dragging the Drum
Rack’s pads onto each other to swap their note mappings.
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Using Effects on Slices

Because each slice lives in its own chain in the Drum Rack, you can easily process individual
slices with their own audio effects. To process several slices with the same set of effects,
multi-select their chains in the Drum Rack’s chain list and press (Ctl |-G to group them to
their own nested Rack. Then insert the effects after this new sub-Rack.

For even more creative possibilities, try inserting MIDI effects before the Drum Rack. The
Arpeggiator and Random devices can yield particularly interesting results.

Slicing is most commonly applied to drum loops, but there’s no reason to stop there.
Experiment with slicing audio from different sources, such as voices and ambient textures.
The same sorts of resequencing and reprocessing operations can be applied to anything
you slice — sometimes with unexpected results.

17.7 Using the Macro Controls
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With the potential for developing complex device chains, Macro Controls keep things man-

ageable by taking over the most essential parameters of a Rack (as determined by you, of

course). Once you have set up your ideal mapping, the rest of the Rack can be hidden away.

The Macro Control view's dedicated Map Mode button opens the door to this behavior.
Enabling Macro Map Mode causes three things to happen:

e All mappable parameters from a Rack’s devices will appear with a colored overlay;

Making Macro Control
Assignments in Map
Mode.
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e Map buttons will appear beneath each Macro Control dial;
e The Mapping Browser will open.
The following steps will get you started mapping:
1. Enable Macro Map Mode by clicking the Map Mode button;
2. Select a device parameter for mapping by clicking it once;

3. Map the parameter by clicking on any Macro Control’s Map button. The details
will be added to the Mapping Browser. By default the Macro will take its name
and units from the device parameter it is controlling.

4. Refine the value range if desired using the Min/Max sliders in the Mapping
Browser. Inverted mappings can be created by setting the Min slider’s value
greater than the Max slider’s value. The current values can also be inverted by
pressing & (PC)/ [Ctl ] & (Mac) on the entry in the Mapping Browser.

5. Select another device parameter if you'd like to create more mappings, or click
on the Map Mode button once more to exit Macro Map Mode.

Note that once assigned to a Macro Control, a device parameter will appear disabled, since
it hands over all control to the Macro Control (although it can still be modulated externally,
via Clip Envelopes).

You can edit or delete your assignments at any time using the Mapping Browser (which only
appears when Map Mode is enabled).

If more than one parameter is assigned to a single Macro, the Macro’s name will revert to its
generic name (e.g., Macro 3). The Macro’s units will also change to a 0 to 127 scale, except
when all parameters possess both the same unit type and the same unit range.

Macro controls can be given custom names, colors and info text entries via the corresponding
commands in the Edit menu orthe @ (PC)/  (Mac) context menu.

17.8 Mixing With Racks

Any Instrument or Drum Rack that contains more than one chain can be viewed and mixed
alongside the tracks in the Session View's mixer. A track that contains these Racks will have
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a © button in its title bar, which will fold the Rack’s mixer in or out. Likewise, any nested
chains within the Rack will also have this button. This makes it easy to get an overview of
your Rack’s hierarchy — or hide it when you just want to work on your mix.
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Chains in the Session View mixer look similar to tracks, but they have no clip slots. Their
mixing and routing controls mirror those found in the Rack’s chain list, so any changes made
to these controls in either area will be reflected in the other immediately. Likewise, many
chain operations such as reordering, renaming and regrouping can be performed from either
the mixer or the chain list. Clicking in a chain’s mixer title bar shows only that chain’s devices
in the Track View.

As with tracks, when chains are multiselected in the Session View mixer, adjusting a mixer
parameter for one of the chains will adjust the same parameter in the other selected chains.
Note that this behavior only applies to parameters adjusted via the Session mixer and not
when adjusting the same parameters in the Rack’s chain list.

Mixing Rack Chains in
the Session View.
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17.8.1 Extracting Chains

All chains can be dragged from their parent Racks and placed into other tracks or Racks,
either from the chain list or from the Session View mixer. A Drum Rack’s return chains can
also be extracted, and will create new return tracks if dragged to the mixer. Drum chains
have an additional feature: when dragged from the mixer to a new track, they take their
MIDI notes with them. For example, if you are working on a MIDI drum loop within a single
track and decide that you would like to move just the snare onto its own track, simply select
the snare chain’s title bar in the mixer and drag it to the mixer’s drop area. This creates a
new track with the full contents of the snare chain: both its devices and its MIDI data. If you
would like to extract only the devices, drag from the chain list instead of from the mixer.

Drums * Kick CH OH Rim Clave Shake Clap a Reverb b Delay Masrer
ormes | A
[ pumse ] Drop Files and B
. Davices Hera FA Variant
empty....
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Extracting Drum Chains
in the Mixer Extracts
MIDI Data.



251

Chapter 18

Automation and Editing Envelopes

Often, when working with Live's mixer and devices, you will want the controls’ movements
to become part of the music. The movement of a control across the song timeline is called
automation; a control whose value changes in the course of this timeline is automated.
Practically all mixer and device controls in Live can be automated, including the song
tempo.

18.1 Recording Automation

Creating automation is straightforward: All changes of a control that occur while the Control
Bar's Record switch is on become automation. Try recording automation for a control, for
instance a mixer volume slider. After recording, play back what you have just recorded
to see and hear the effect of the control movement. You will notice that a little LED has
appeared in the slider thumb to indicate that the control is now automated. Try recording
automation for track panning and the Track Activator switch as well; their automation LEDs
appear in their upper left corners.
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18.2 Deleting Automation

To delete automation data, @ (PC) / & (Mac) on an automated control to open
its context menu and select Delete Automation. The automation LED disappears, and the
control’s value stays constant across the entire song. You can also delete automation by
editing breakpoint envelopes.

18.3 Overriding Automation

In practice, you will often want to try out new control moves without overwriting existing
automation data. Well, nothing is forever in the world of infinite Undo, but it's easy to
disable a control’s automation temporarily to avoid overwriting existing data: If you change
an automated control’s value while not in Record mode, the automation LED goes off to
indicate the control's automation is inactive. Any automation is therefore overridden by the
current manual setting.

3 1 1 1/'-IHR @ |jJ'..'H. 1 Bar &

When one or more of the automated controls in your Live Set are not active, the Control
Bar's Back to Arrangement button lights up. This button serves two purposes:

1. ltreminds you that the current state of the controls differs from the state captured
in the Arrangement.

Volume, Pan and the
Track Activator Switch
Have Been Automated.

The Back to
Arrangement Button.
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2. You can click on it to reactivate all automation and thereby return to the automa-

tion state as it is written “on tape.”

18.4 Drawing and Editing Automation

In the Arrangement View, automation curves can be viewed and edited as breakpoint

envelopes.
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“unfold” the track by clicking the @ button next

to the track name. (Note that, for Group Tracks, you may need to expand the
track’s height in order to see its envelopes.)

2. Clicking on one of the track’s mixer or device controls will display this control’s

envelope on the clip track.

3. Envelopes appear “on top of” the audio waveform or MIDI display. An enve-
lope’s vertical axis represents the control value and the horizontal axis represents
time. For switches and radio buttons, the value axis is discontinuous.

4. The Fades/Device chooser either selects audio clip fades, the track mixer, one

Automation Envelopes
in the Arrangement
View.
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of the track’s devices or “None” to hide the envelope. It also provides you with
an overview of which devices actually have automation by showing an LED next
to their labels. You can make things clearer still by selecting “Show Automated
Parameters Only” from the bottom of the chooser.

5. The Automation Control chooser selects a control from the device chosen in the
Fades/Device chooser. The labels of automated controls have an LED.

Once an envelope has been selected on the track, several new buttons appear:

6. The @ button moves the envelope into its own automation lane below the clip.
You can then select another automation parameter from the choosers to view it
simultaneously. If the Fades/Device chooser is set to “None”, this button will be
hidden.

7. The @ button hides its respective automation lane. Note that hiding a lane
from view does not deactivate its envelope.

8. If any automation lanes have been created for a given track, you can hide or
show them all by clicking the additional @ button that appears at the bottom
of the track’s title bar.

Clicking @ (PC) / [ctl & (Mac) on a track name or automation lane header opens
a context menu with additional options for viewing envelopes. This context menu also
contains commands to quickly clear all automation envelopes for the track or any of its
devices.

18.4.1 Drawing Envelopes
With Draw Mode enabled, you can click and drag to “draw” an envelope curve.
b i i 1|/ & OVR | =+ | 1Bar

To toggle Draw Mode, select the Draw Mode option from the Options menu, click on the

Control Bar's Draw Mode switch, or press (PC)/ (Mac).

The Draw Mode Switch.
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Drawing an Envelope.

Drawing creates steps as wide as the visible grid, which you can modify using a number
of handy shortcuts. For freehand drawing, you can hide the grid using the Snap to Grid
Options menu entry or the (CtrlJ{4] (PC)/ (Mac) shortcut. To temporarily enable
freehand drawing while the grid is shown, hold down (PC) / (Mac) while
drawing.

18.4.2 Editing Breakpoints

With Draw Mode off, the envelope display looks and works differently. The line segments
and the breakpoints connecting them become draggable objects. Clicking and dragging in
the envelope’s background defines a selection. Here is what you can do:

e Double-click at a position on a line segment to create a new breakpoint there.
e Double-click on a breakpoint to delete it.

e Click and drag a breakpoint to move it to the desired location. If the breakpoint you
are dragging is in the current selection, all other breakpoints in the selection will follow
the movement.

Ly \, ib*.
| To Move all Breakpoints
! | Within the Selection,
Drag Any One of Them.

Your movement is constrained by the neighboring breakpoints unless you hold down
the modifier while dragging, which will eliminate breakpoints as you wipe over
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them. Holding down the (PC)/ (Mac) modifier while dragging switches

to a finer resolution.

¢ Click and drag a line segment between two breakpoints to move it vertically, without
affecting the breakpoint’s horizontal position. If the line segment is in the current
selection, the envelope is moved vertically across the selected timespan. Live inserts
breakpoints at the selection’s edges to make sure the move only affects the selected
part of the envelope.

Dragging an Envelope
Line Segment Moves the
Segment Vertically.

18.4.3 Locking Envelopes

When moving clips, Live normally moves all automation with the clip. Sometimes, you
might want to lock the envelopes to the song position rather than to the clips, and the
Arrangement View's Lock Envelopes switch does just that.

You can also choose to lock envelopes from the Options menu.
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18.4.4 Edit Menu Commands

When working with automation data, the Edit menu commands behave differently depend-
ing on whether or not your selection is within the clip track or its automation lanes.
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To copy, cut, delete or duplicate automation from a track, independent of the associated
clip, make sure the parameter you want to work with is in its own lane. Any edit commands
applied to an envelope selection within a single lane will only apply to this envelope. The clip
itself will be unaffected. You can also work with envelopes in multiple lanes simultaneously.

If you want your edits to apply to both the clip and all of its associated envelopes, apply
edit commands to a selection in the clip track.

Note that Live allows you to copy and paste envelope movements not only from one point
in time to another, but also from one parameter to another. Since the parameters may be
completely unrelated, this can have unexpected (but possibly interesting) results.

18.4.5 Editing the Tempo Automation
The ability to dynamically stretch and compress audio to track any tempo or tempo variation
is one of Live’s specialties. In Live, the song tempo is just another automated control.

To edit the song tempo envelope, unfold the Master track, choose “Mixer” from the top
envelope chooser and “Song Tempo” from the bottom one.

A Master

When adjusting the tempo envelope, you might want to scale the value axis display, which
is the function of the two value boxes below the envelope choosers: The left box sets the
minimum, and the right box sets the maximum tempo displayed, in BPM.

Note that these two controls also determine the value range of a MIDI controller assigned
to the tempo.

The Tempo Envelope.
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Chapter 19

Clip Envelopes

Every clip in Live can have its own clip envelopes. The aspects of a clip that are influenced by
clip envelopes change depending upon clip type and setup; clip envelopes can do anything
from representing MIDI controller data to modulating device parameters. In this chapter, we
will first look at how all clip envelopes are drawn and edited, and then get into the details
of their various applications.

19.1 The Clip Envelope Editor

006

Use the Clip View Box
Selector to Bring up the
Envelopes Box.
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To work with clip envelopes, bring up the Clip View's Envelopes box by activating the
rightmost Clip View Box selector panel. The Envelopes box contains two choosers for
selecting an envelope to view and edlit.

Envelopes i+
Start
OO
(Transpose) End
Cvetume ) [ ][]

Pan

Sample -+

Loop

Region/Loop | Fosition
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Length
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The top menu is the Device chooser, which selects a general category of controls with which
to work. Device chooser entries are different for different kinds of clips:

¢ Audio clips have entries for “Clip” (the clip’s sample controls), every effect in the track’s
device chain and the mixer.

¢ MIDI clips have entries for “MIDI Ctrl” (MIDI controller data) and every device in the
track’s device chain.

The bottom menu, the Control chooser, selects among the controls of the item chosen in
the top menu. In both choosers, parameters with altered clip envelopes appear with LEDs
next to their names. You can simplify the appearance of these choosers by selecting “Show
Modulated Parameters Only” from either of them.

The "quick-chooser” buttons below the menus select commonly edited controls.

Clicking the menus or the quick-chooser buttons brings up the Envelope Editor showing
the selected envelope, instead of the Sample Display or MIDI Editor. You can toggle the
display by clicking on the title bars of the Sample/Notes and Envelopes boxes.

The techniques for drawing and editing clip envelopes are the same as those for automation
envelopes in the Arrangement View.

If you create a nice section of envelope that you want to have repeat several times, try the
following:

The Clip View's
Envelopes Box.
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1. Enclose the desired selection in the loop brace, and click the brace so that it is
selected. This will execute the Edit menu’s Select Loop command, which selects
all material in the loop.

2. Copy the envelope with (Ctrl][C] (PC)/ (& S)(C] (Mac).
3. Shift the loop brace to the right by one loop length with (4.
4. Paste the envelope with (PC)/ (Mac).

Note that you can use the arrow keys to quickly manipulate the loop brace and start/end
markers in other useful ways to expedite clip envelope editing tasks.

To delete a clip envelope (i.e., to set it back to its default value), first go to Edit/Select All,
then to Edit/Delete.

Let us now look at some uses of clip envelopes.

19.2 Audio Clip Envelopes

Clip envelopes extend Live's “elastic” approach to audio and, in conjunction with Live’s
audio effects, turn Live into a mighty sound-design tool. Using clip envelopes with audio
clips, you can create an abundance of interesting variations from the same clip in real time
— anything from subtle corrections to entirely new and unrelated sounds.

19.2.1 Clip Envelopes are Non-Destructive

Using clip envelopes, you can create new sounds from a sample without actually affecting
the sample on disk. Because Live calculates the envelope modulations in real time, you can
have hundreds of clips in a Live Set that all sound different, but use the same sample.

You can, of course, export a newly created sound by rendering, or by resampling. In the
Arrangement View, you can use the Consolidate command to create new samples.
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19.2.2 Changing Pitch and Tuning per Note

Drop a sample loop from the Browser into Live and play it. Click on the Transpose quick-
chooser button. You can now alter the pitch transposition of individual notes in the sample
as you listen to it.

The fast way to do this is by enabling Draw Mode and drawing steps along the grid.
Deactivate Draw Mode to edit breakpoints and line segments. This is useful for smoothing
the coarse steps by horizontally displacing breakpoints.

1 [£ 3 4 5

o
H
1 12 13 4 15

o

The Transposition
Envelope with Steps
(Top) and Ramps

i (Bottom).

Note that the warp settings determine how accurately Live’s time-warping engine tracks
the envelope shape. To obtain a more immediate response, reduce the Grain Size value in
Tones and Texture Mode or choose a smaller value for the Transients control in Beats Mode.

To correct the tuning of individual notes in the sample, hold down the (Ctl ] (PC) /

(Mac) modifier while drawing or moving breakpoints to obtain a finer resolution.
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To scroll the display, hold down the (PC)/ Alt ~=] (Mac) modifier while
dragging.
Pitch is modulated in an additive way. The output of the transposition envelope is simply

added to the Transpose control’s value. The result of the modulation is clipped to stay in
the available range (-48..48 semitones in this case).

19.2.3 Muting or Attenuating Notes in a Sample

Click on the Volume quick-chooser to access an audio clip’s volume envelope. By drawing
steps in Draw Mode or creating shapes with breakpoints, you can impose an arbitrary volume
shape onto the sample.

i

1/1 1/16

The volume envelope’s output is interpreted as a relative percentage of the clip volume
slider’s current value. The result of the clip envelope’s modulation can therefore never
exceed the absolute volume setting, but the clip envelope can drag the audible volume
down to silence.

19.2.4 Scrambling Beats

One very creative use of clip envelopes is to modulate the sample offset. Sample offset
modulation makes the most sense for rhythmical samples, and is only available for clips that
are set up to run in the Beats Warp Mode.

Try sample offset modulation with a one-bar drum loop: Make sure Beats Mode is chosen;
in the Envelopes box, choose “Clip” from the Device chooser and “Sample Offset” from

Imposing a Volume
Envelope on a Sample.
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the Control chooser. The Envelope Editor appears with a vertical grid overlay. In envelope
Draw Mode, set steps to non-zero values to hear the loop scrambled. What is going on?

Imagine the audio is read out by a tape head, the position of which is modulated by the
envelope. The higher a value the envelope delivers, the farther away the tape head is from
its center position. Positive envelope values move the head towards the “future,” negative
values move it towards the “past.” Fortunately, Live performs the modulation in beats rather
than centimeters: A vertical grid line is worth a sixteenth note of offset and the modulation
can reach from plus eight sixteenths to minus eight sixteenths.

Sample offset modulation is the tool of choice for quickly creating interesting variations of
beat loops. We discourage using this technique for “analytical” cut-and-splice tasks; they
are much easier to perform using Live's Arrangement View, and the results can easily be
consolidated into new clips.

1 1.2 1.3 14 2

Some sample offset envelope gestures have a characteristic effect: a downward “escalator”
shape, for instance, effectively repeats the step at the envelope’s beginning. Similarly, a
smooth ramp with a downwards slope is slowing time and can create nice slurring effects
when the slope is not quite exactly 45 degrees; try this with a 1/32 Transients setting.

19.2.5 Using Clips as Templates

As you are making creative use of clip envelopes, the clips containing them develop a life
of their own, independent of the original sample. You might wonder at a point: What does
this clip sound like with a different sample? This is easy to find out by selecting the clip
so that it is displayed in the Clip View and dragging the desired sample from one of the

Repeating Steps and
Slowing Time with the
Sample Offset Envelope.
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File Browsers, or the Session or Arrangement View, onto the Clip View. All clip settings,
including the envelopes, will remain unaltered; only the sample will be replaced.

19.3 Mixer and Device Clip Envelopes

Clip envelopes can be used to modulate mixer and device controls. Since mixer and
device controls can also be controlled by the Arrangement’s automation envelopes, this is
a potential source of confusion. However, clip envelopes differ from automation envelopes
in one important way: Whereas automation envelopes define the value of a control at any
given point in time, clip envelopes can only influence this defined value. This difference
allows the two types of envelopes to work together in harmony when controlling the same
parameter.

Imagine that you have recorded volume automation for an audio clip so that it gradually
fades out over four bars. What happens to your fade-out when you create a clip envelope
that gradually increases the mixer volume over four bars? At first, your fade-out will become
a crescendo, as the clip envelope gradually increases the volume within the range allowed
by the automation envelope. But, once the decreasing automated value meets with the
increasing clip envelope value, the fade-out will begin, as automation forces the absolute
control value (and the operable range of the clip envelope) down.

19.3.1 Modulating Mixer Volumes and Sends

Notice that there are actually two volume modulations: Clip Volume and Mixer Volume.
The latter is a modulation for the mixer’s gain stage and therefore affects the post-effect
signal. To prevent confusion, a small dot below the mixer’s volume slider thumb indicates
the actual, modulated volume setting.

Modulating the Mixer
Volume. The Little Dot
Below the Volume Slider
Thumb Represents the
Modulated Volume
Setting.
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As you raise and lower the Volume slider, you can observe the dot following your movement
in a relative fashion.

Modulating the track’s Send controls is just as easy. Again, the modulation is a relative
percentage: The clip envelope cannot open the send further than the Send knob, but it can
reduce the actual send value to minus infinite dB.

2D

19.3.2 Modulating Pan

The Pan envelope affects the mixer pan stage in a relative way: The pan knob's position
determines the intensity of the modulation. With the pan knob set to the center position,
modulation by the clip envelope can reach from hard left to hard right; the modulation
amount is automatically reduced as you move the pan knob towards the left or right. When
the pan knob is turned all the way to the left, for instance, the pan clip envelope has no
effect at all.

19.3.3 Modulating Device Controls

All devices in a clip’s track are listed in the upper clip envelope Device chooser. Modulating
the devices’ controls works just as you would expect. When modulating device controls, it
is important to keep the interaction of clip envelopes and device settings in mind: Unlike
a device preset, the clip envelope cannot define the values for the devices’ controls, it can
only change them relative to their current setting.

19.4 MIDI Controller Clip Envelopes

Whether you are working with a new MIDI clip that was recorded directly into Live, or one
from your files, Live allows you to edit and create MIDI controller data for the clip in the
form of clip envelopes.

Modulating a Send. The
Send Knob's Position
Ring Indicates the
Modulated Value.
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Choose “MIDI Ctrl” from a MIDI clip’s Device chooser and use the Control chooser below
it to select a specific MIDI controller. You can create new clip envelopes for any of the
listed controllers by drawing steps or using breakpoints. You can also edit clip envelope
representations of controller data that is imported as part of your MIDI files or is created
while recording new clips: Names of controllers that already have clip envelopes appear
with an adjacent LED in the Control chooser.

Live supports most MIDI controller numbers up to 119, accessible via the scroll bar on the
right side of the menu. Note that devices to which you send your MIDI controller messages
may not follow the conventions of MIDI control channel assignments, so that “Pitch Bend”
or “Pan,” for example, will not always achieve the results that their names imply.

1 12 1.3 14 2 2.2 il
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Many of the techniques described in the following section on unlinking a clip envelope from
its associated clip can be adapted for use with MIDI controller clip envelopes.

19.5 Unlinking Clip Envelopes From Clips

A clip envelope can have its own local loop/region settings. The ability to unlink the
envelope from its clip creates an abundance of exciting creative options, some of which we
will present in the rest of this chapter.

A MIDI Controller Clip
Envelope.
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19.5.1 Programming a Fade-Out for a Live Set

Let us start with a straightforward example. Suppose you are setting up a Live Set and wish
to program a fade-out over eight bars to occur when a specific clip is launched - but all you
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1. Choose the Clip Volume envelope, and unlink it from the sample.

Region/Loop

The clip envelope’s loop braces now appear colored to indicate this envelope
now has its own local loop/region settings. The loop/region controls in the
Envelopes box “come to life.”

2. Make sure the clip envelope’s Loop switch is off. Notice the Sample box's Loop
switch is not affected. The sample will keep looping although the envelope is
now playing as a “one-shot.”

3. Type "8" into the leftmost envelope loop-length value box.

4. Zoom the envelope display out all the way by clicking on the Envelope’s time
ruler and dragging upwards.

5. Insert a breakpoint at the region end and drag it to the bottom (zero percent).
Now, as you play the clip, you can hear the one-bar loop fading out over eight bars.

Please note: toggling Linked Mode changes the envelope data. Toggling back and forth

Using a Clip Envelope to
Create a Fade-Out Over
Several Repetitions of a
Loop.
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effectively deletes the envelope data. To return to the previous state, please use the Edit
menu’s Undo command.

19.5.2 Creating Long Loops from Short Loops

Let us take this a step further. For a different part of your set, you would like to use the
same one-bar loop — because it sounds great — but its repetition bores you. You would like
to somehow turn it into a longer loop.

We depart from the clip we just set up to fade out over eight bars. Activate the clip volume
envelope’s Loop switch. Now, as you play the clip, you can hear the eight-bar fade-out
repeating. You can draw or edit any envelope to superimpose onto the sample loop. This,
of course, not only works for volume but for any other control as well; how about a filter
sweep every four bars?

Note that you can create as much time as needed in the Envelope Editor, either by dragging
the loop braces beyond the view limit, or by entering values into the numeric region/loop
controls.

You can choose an arbitrary loop length for each envelope, including odd lengths like 3.2.1.
It is not hard to imagine great complexity (and confusion!) arising from several odd-length
envelopes in one clip.

L 4
3

_a I

To keep this complexity under control, it is important to have a common point of reference.
The start marker identifies the point where sample or envelope playback depart from when
the clip starts.

The Sample (Left) and
Envelope (Right) Start
Marker.
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Note that the start/end markers and loop brace are subject to quantization by the zoom-
adaptive grid, as is envelope drawing.

19.5.3 Imposing Rhythm Patterns onto Samples

So far, we have been talking about imposing long envelopes onto small loops. You can
also think of interesting applications that work the other way around. Consider a sample
of a song that is several minutes long. This sample could be played by a clip with a one-
bar volume envelope loop. The volume envelope loop now works as a pattern that is
repeatedly “punching” holes into the music so as to, perhaps, remove every third beat. You
can certainly think of other parameters that such a pattern could modulate in interesting
ways.

19.5.4 Clip Envelopes as LFOs

If you are into sound synthesis, you may want to think of a clip envelope with a local loop as
an LFO. This LFO is running in sync with the project tempo, but it is also possible to set up
a loop period odd enough to render the envelope unsynchronized. By hiding the grid, you
can adjust the clip envelope loop start and end points completely independent of meter
grid.
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Chapter 20

Working with Video

Live’s flexible architecture makes it the perfect choice for scoring to video. You can trim
video clips to select parts of them and use Warp Markers to visually align music in the
Arrangement View with the video. You can then render your edited video file along with
your audio.

Before diving in, you will want to be familiar with the concepts presented in the Tempo
Control and Warping chapter.

If you are interested in syncing Live with external video equipment, you'll also want to read
the chapter on synchronization.

20.1 Importing Video

Live can import movies in Apple QuickTime format (.mov) to be used as video clips. Movie
files appear in Live's File Browser alongside audio files and Live Sets, and can be imported
in the same way, by simply dragging them into the Live Set.

Note that Live will only display video for video clips residing in the Arrangement View.
Movie files that are loaded into the Session View are treated as audio clips.
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20.2 The Appearance of Video in Live

20.2.1 Video Clips in the Arrangement View

A video clip in the Arrangement View looks just like an audio clip, except for the “sprocket
holes” in its title bar.

Live also displays a movie file’s QuickTime markers, if present, in the Arrangement View and
Clip View. QuickTime markers are created by external video authoring applications, and
although they cannot be selected or edited in any way by Live, they do provide visual cues
that can be helpful when scoring. Note that these markers are always read from the original
movie file, and are not stored in the Live Set or video clip.

For the most part, video clips in the Arrangement View are treated just like audio clips. They
can be trimmed, for example, by dragging their right or left edges. However, there are
some editing commands that, when applied to a video clip, will cause it to be replaced by
an audio clip (which by definition has no video component). This replacement only occurs
internally — your original movie files are never altered. The commands which will cause this
are: Consolidate, Reverse and Crop.

A Video Clip with a
QuickTime Marker.
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20.2.2 The Video Window
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The Video Window is a separate, floating window that always remains above Live's main
window. It can be dragged to any location you like, and it will never get covered up by
Live. You can toggle its visibility with a command in the View menu. The Video Window can
be resized by dragging its bottom right-hand corner. The size and location of this window
are not specific to the Set, and will be restored when you open a video again. The video
can be shown in full screen (and optionally on a second monitor) by double-clicking in the
Video Window. (PC) / (Mac) double-click in the Video Window to restore it
to original size of the video.

Movies with Partial Tracks

In the QuickTime file format, the audio and video components do not have to span the
entire length of a movie; gaps in playback are allowed. During gaps in video, Live's Video
Window will display a black screen; gaps in audio will play silence.
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20.2.3 Clip View

Soundtrack composers will want to note the Tempo Master option in Live’s Clip View. When
scoring to video, video clips are usually set as tempo masters, while audio clips are left as
tempo slaves. These are, therefore, the default warp properties of clips in the Arrangement
View. In this scenario, adding Warp Markers to a video clip defines “hit points” that the
music will sync to. Note that a video clip’s Warp switch needs to be activated in order for
the clip to be set as the tempo master.
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Remember from the Tempo Control and Warping chapter that, although any number of
warped Arrangement clips can have the Tempo Master option activated, only the bottom-
most, currently playing clip is the actual tempo master.

This also means that it is possible for video clips that are not the current tempo master to
become warped, resulting in warped video output in the Video Window.

Warp Markers

While dragging a Warp Marker belonging to a video clip, you will notice that the Video
Window updates to show the corresponding video frame, so that any point in the music can
be easily aligned with any point in the video clip.

Since Live displays a movie file's embedded QuickTime markers, they can be used as
convenient visual cues when setting Warp Markers.

Setting a Video Clip as
Tempo Master.
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20.3 Matching Sound to Video

In Live, it takes just a few steps to get started with video. Let's look at a common scenario —
matching a piece of music to edits or hit points in a video:

1. Make sure that Live's Arrangement View is visible. Your computer keyboard’s
key will toggle between the Session View and Arrangement View.

2. Drag a QuickTime movie from Live’s File Browser and drop it into an audio track
in the Arrangement View. The Video Window will appear to display the video
component of the movie file. (Remember that you can move this window to any
convenient location on the screen.)

3. Now that the video clip is loaded, drag an audio clip into the Arrangement View’s
drop area. A new track will automatically be created for it. Unfold both tracks so
you can see their contents by clicking the @ buttons to the left of their names.

4. Double-click on the video clip’s title bar to view it in the Clip View. In the
Sample box, make sure that the Warp button is enabled. Warped clips in the
Arrangement View can be set as tempo master or slave. We want the Master/
Slave switch set to Master, which will force the rest of the clips in the Live Set to
adapt to the video clip’s tempo (i.e., its normal playback rate).

5. Now add Warp Markers to the video clip, and adjust them to your liking. The
locations of the Warp Markers define the synchronizing points between our music
and our video. Notice how the video clip’s waveform in the Arrangement View
updates to reflect your changes as you make them.

6. If desired, enable the Arrangement Loop to focus on a specific section of the
composition.

7. When you have finished, choose the Export Audio/Video command from Live’s
File menu. All of your audio will be mixed down and saved as a single audio file.
You can also export your video file using this command.
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20.4 Video Trimming Tricks

Commonly, composers receive movie files with a few seconds of blank space before the
“real” beginning of the action. This pre-roll (“two-beep”) serves as a sync reference for
the mixing engineer, who expects that the composer’s audio files will also include the same
pre-roll. While working on music, however, the pre-roll is in the composer’s way: It would be
more natural for the movie action to start at song time 1.1.1 and SMPTE time 00:00:00:00.
This can be accommodated by trimming video clips, as follows.

First, we drop a movie file at the start of the Arrangement (1.1.1).

sy e —— A Video Clip at the Start
of the Arrangement.

Next, we double-click on the video clip’s title bar to display its contents in the Clip View.

There, we drag the Start Marker to the right so the video clip starts at the beginning of the
action.

Dragging the Start
Marker behind the
Pre-Roll.

Now, both the action and the music to be composed start at 1.1.1 / 00.00.00.00. Once the
music is done and ready to be rendered to disk, we need to bring back the pre-roll:
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In the Arrangement View, we select all materials (Edit menu/Select All), then drag the entire
composition a few seconds to the right:

il ] ; 12 ; d 3 : . 4

Now, we click on the video clip’s title bar (to deselect everything else), then drag the video
clip’s left edge to the left as far as possible to reveal the pre-roll again.

il . i 2 e T S R e et

The Export Audio/Video command, by default, creates sample files as long as the Arrange-
ment selection; as the video clip is still selected, the exported sample file will have the exact
same duration as the original movie file, including the pre-roll.

The Video Clip and the
Final Clip of Music.

The Video Clip with
Pre-Roll Restored.
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Chapter 21

Live Audio Effect Reference

Live comes with a selection of custom-designed, built-in audio effects. The “Working with
Instruments and Effects” chapter explains the basics of using effects in Live.

21.1 Auto Filter
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The Auto Filter Effect.
The Auto Filter effect provides classic analog filter emulation. It can be modulated by an

envelope follower and/or an LFO to create moving filter effects. The envelope follower can

track either the filtered signal or an external sidechain source.
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There are four different filter types: lowpass, highpass, bandpass and notch. For each type,
the X-Y controller adjusts frequency (to adjust, click and drag on the X-axis) and Q (also
called resonance; to adjust, click and drag on the Y-axis). You can also click on the Freq and
Q numeric displays and type in exact values.

Low Q values create a broad filter curve, while higher values introduce a narrow, resonant
peak to the sound. With bandpass filtering, Q sets the bandwidth of the passed signal.

The Quantize Beat control applies quantized modulation to the filter frequency. With Quan-
tize Beat off, frequency modulation follows the control source. Turning this feature on
updates the filter modulation rhythmically with “stepped” changes that track the master
tempo. The numbered buttons represent 16th notes, so, for example, selecting “4” as a
beat value produces a modulation change once per beat.

The Envelope section controls how the envelope modulation affects the filter frequency.
The Amount control defines the extent to which the envelope affects the filter frequency,
while the Attack control sets how the envelope responds to rising input signals. Low Attack
values cause a fast response to input levels; high values integrate any changes gradually,
creating a looser, slower response. Think of it as adding inertia to the response.

Lower Release values cause the envelope to respond more quickly to falling input signals.
Higher values extend the envelope’s decay.

Normally, the signal being filtered and the input source that triggers the envelope follower
are the same signal. But by using sidechaining, it is possible to filter a signal based on
the envelope of another signal. To access the Sidechain parameters, unfold the Auto Filter
window by toggling the & button in its title bar.

Enabling this section with the Sidechain button allows you to select another track from
the choosers below. This causes the selected track’s signal to trigger the filter's envelope
follower, instead of the signal that is actually being filtered.

The Gain knob adjusts the level of the external sidechain’s input, while the Dry/Wet knob
allows you to use a combination of sidechain and original signal as the envelope follower’s
trigger. With Dry/Wet at 100%, the envelope follower tracks the sidechain source exclusively.
At 0%, the sidechain is effectively bypassed. Note that increasing the gain does not increase
the volume of the source signal in the mix. The sidechain audio is only a trigger for the
envelope follower and is never actually heard.

The Auto Filter also contains a Low Frequency Oscillator to modulate filter frequency in a
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periodic fashion. The respective Amount control sets how much the LFO affects the filter.
This can be used in conjunction with or instead of the envelope follower.

The Rate control specifies the LFO speed. It can be set in terms of hertz, or synced to the
song tempo, allowing for controlled rhythmic filtering.

Available LFO waveform shapes are sine (creates smooth modulations with rounded peaks
and valleys), square, triangle, sawtooth up, sawtooth down, and sample and hold (generates
random positive and negative modulation values) in mono and stereo.

There are two LFOs, one for each stereo channel. The Phase and Offset controls define the
relationship between these two LFOs.

Phase keeps both LFOs at the same frequency, but can set the two LFO waveforms “out of
phase” with each other, creating stereo movement. Set to “180”, the LFO outputs are 180
degrees apart, so that when one LFO reaches its peak, the other is at its minimum.

Spin detunes the two LFO speeds relative to each other. Each stereo channel is modulated
at a different frequency, as determined by the Spin amount.

For sample and hold, the Phase and Spin controls are not relevant and do not affect the
sound. Instead, the Auto Filter offers two kinds of sample and hold: The upper sample and
hold type available in the chooser provides independent random modulation generators for
the left and right channels (stereo), while the lower one modulates both channels with the
same signal (mono).

21.2 Auto Pan
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The Auto Pan Effect.
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Auto Pan offers LFO-driven manipulation of amplitude and panning for creating automatic
panning, tremolo and amplitude modulation, and beat-synchronized chopping effects.

Auto Pan’s LFOs modulate the amplitude of the left and right stereo channels with sine,
triangle, sawtooth down or random waveforms.

The Shape control pushes the waveform to its upper and lower limits, “hardening” its shape.
The waveform can be set to “Normal” or “Invert” (use “Invert” to, for example, create the
saw up waveform from the saw down waveform).

LFO speed is controlled with the Rate control, which can be set in terms of hertz. Rate can
also be synced to the song tempo.

Though both LFOs run at the same frequency, the Phase control lends the sound stereo
movement by offsetting their waveforms relative to each other. Set this to “180”, and the
LFOs will be perfectly out of phase (180 degrees apart), so that when one reaches its peak,
the other is at its minimum. Phase is particularly effective for creating vibrato effects.

The Offset control shifts the start point of each LFO along its waveform.

The device's influence on incoming signals is set with the Amount control.

21.3 Beat Repeat
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Beat Repeat allows for the creation of controlled or randomized repetitions of an incoming
signal.

The Beat Repeat Effect.
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The Interval control defines how often Beat Repeat captures new material and begins re-
peating it. Interval is synced to and set in terms of the song tempo, with values ranging
from “1/32" to “4 Bars.” The Offset control shifts the point defined by Interval forward in
time. If Interval is set to “1 Bar,” for example, and Offset to “8/16", material will be captured
for repetition once per bar on the third beat (i.e., halfway, or eight-sixteenths of the way,
through the bar).

You can add randomness to the process using the Chance control, which defines the likeli-
hood of repetitions actually taking place when Interval and Offset “ask” for them. If Chance
is set to 100 percent, repetitions will always take place at the given Interval/Offset time; if
set to zero, there will be no repetitions.

Gate defines the total length of all repetitions in sixteenth notes. If Gate is set to "4/16",
the repetitions will occur over the period of one beat, starting at the position defined by
Interval and Offset.

Activating the Repeat button bypasses all of the above controls, immediately capturing
material and repeating it until deactivated.

The Grid control defines the grid size — the size of each repeated slice. If set to “1/16", a
slice the size of one sixteenth note will be captured and repeated for the given Gate length
(or until Repeat is deactivated). Large grid values create rhythmic loops, while small values
create sonic artifacts. The No Triplets button sets grid division as binary.

Grid size can be changed randomly using the Variation control. If Variation is set to “0”,
grid size is fixed. But when Variation is set to higher values, the grid fluctuates considerably
around the set Grid value. Variation has several different modes, available in the chooser
below: Trigger creates variations of the grid when repetitions are triggered; 1/4, 1/8 and
1/16 trigger variations in regular intervals; and Auto forces Beat Repeat to apply a new
random variation after each repetition — the most complex form of grid variation in Beat
Repeat (especially if triplets are also allowed).

Beat Repeat's repetitions can be pitched down for special sonic effects. Pitch is adjusted
through resampling in Beat Repeat, lengthening segments to pitch them down without again
compressing them to adjust for the length change. This means that the rhythmical structure
can become quite ambiguous with higher Pitch values. The Pitch Decay control tapers the
pitch curve, making each repeated slice play lower than the previous one. Warning: This is
the most obscure parameter of Beat Repeat.
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Beat Repeat includes a combined lowpass and highpass filter for defining the passed fre-
quency range of the device. You can turn the filter on and off, and set the center frequency
and width of the passed frequency band, using the respective controls.

The original signal (which was received at Beat Repeat’s input) is mixed with Beat Repeat's
repetitions according to one of three mix modes: Mix allows the original signal to pass
through the device and have repetitions added to it; Insert mutes the original signal when
repetitions are playing but passes it otherwise; and Gate passes only the repetitions, never
passing the original signal. Gate mode is especially useful when the effect is housed in a
return track.

You can set the output level of the device using the Volume control, and apply Decay to
create gradually fading repetitions.

21.4 Chorus
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The Chorus effect uses two parallel time-modulated delays to create chorus (thickening) and
flanging effects.

Each delay has its own delay time control, calibrated in milliseconds. Delay 1 has a highpass
filter that can remove low frequencies from the delayed signal. Greater highpass values let
only very high frequencies pass through to Delay 1.

Delay 2 can switch among three different modes. When off, only Delay 1 is audible. In Fix
Mode, only Delay 1's delay time will be modulated. When Mod is activated, Delay 2 will
receive the same modulation as Delay 1.

The Chorus Effect.
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To set both delay lines to Delay 1's delay time, turn on the link button (“="). This is especially
useful if you want to change both delays with a single gesture.

The Modulation X-Y controller can impart “motion” to the sounds. To change the modula-
tion rate for the delay times, click and drag along the horizontal axis. To change the amount
of modulation, click and drag along the vertical axis.

You can also make changes by entering parameter values in the Amount and Rate fields be-
low the X-Y controller. The Amount value is in milliseconds, while the modulation frequency
rate is in Hertz.

Clicking the *20 switch multiplies the modulation frequency by 20 to achieve more extreme
sounds.

The Feedback control determines how much of the output signal feeds back into the input,
while the Polarity switch sets (surprisel) the polarity. Polarity changes have the most effect
with high amounts of feedback and short delay times.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
100 percent when using Chorus in a return track.

Enabling the Crisp option via the & (PC)/ [Ctl | (Mac) context menu can improve the
sound quality, particularly at higher frequencies. This is enabled by default, except when
loading Sets that use Chorus and were made in earlier versions of Live.

21.5 Compressor
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The Compressor Effect.
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A compressor reduces gain for signals above a user-settable threshold. Compression re-
duces the levels of peaks, opening up more headroom and allowing the overall signal level
to be turned up. This gives the signal a higher average level, resulting in a sound that is
subjectively louder and “punchier” than an uncompressed signal.

The latest incarnation of the Compressor effect merges the functionality of the former
Compressor | and Compressor Il devices into a single unit, and adds additional functionality
such as external sidechaining, adjustable knee, more EQ options, an improved peak mode,
and a new feedback model, which is lovingly based on some classic hardware compressors.
The new Compressor is fully backward-compatible with Compressor | and Compressor ||
presets.

A compressor's two most important parameters are the Threshold and the compression
Ratio:

The Threshold slider sets where compression begins. Signals above the threshold are
attenuated by an amount specified by the Ratio parameter, which sets the ratio between
the input and output signal. For example, with a compression ratio of 3, if a signal above
the threshold increases by 3 dB, the compressor output will increase by only 1 dB. If a signal
above the threshold increases by 6 dB, then the output will increase by only 2 dB. A ratio of
1 means no compression, regardless of the threshold.

The Knee control adjusts how gradually or abruptly compression occurs as the threshold
is approached. With a setting of 0 dB, no compression is applied to signals below the
threshold, and full compression is applied to any signal at or above the threshold. With very
high ratios, this so-called “hard knee” behavior can sound harsh. With higher (or “soft")
knee values, the compressor begins compressing gradually as the threshold is approached.
For example, with a 10 dB knee and a -20 dB threshold, subtle compression will begin at
-30 dB and increase so that signals at -10 dB will be fully compressed.

The easiest way to visualize Compressor’s behavior is by observing how the graph changes
when you adjust the threshold, ratio, and knee values. Input level is measured on the
horizontal axis, while output level is represented vertically. Next to the graph is the Gain
Reduction meter, which shows how much the gain is being reduced at any given moment.
The more reduction, the more audible the effect; a gain reduction above é dB or so might
produce the desired loudness, but significantly alters the sound and is easily capable of
destroying its dynamic structure. This is something that cannot be undone in later production
steps. Keep this in mind especially when using a compressor, limiter or sound loudness-
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maximizing tool in the master channel. Less is often more here.

Because compression reduces the volume of loud signals and opens up headroom, you can
use the Output slider so that the peaks once again hit the maximum available headroom.
The Output meter shows the output signal’s level. Enabling the Makeup button below the
Output slider automatically compensates the output level if the threshold and ratio settings
change.

The Attack and Release controls are essential parameters for controlling the response time
of Compressor by defining how fast it reacts to input-level changes.

Attack defines how long it takes to reach maximum compression once a signal exceeds
the threshold, while Release sets how long it takes for the compressor to return to normal
operation after the signal falls below the threshold.

A slight amount of attack time (10-50 ms) allows peaks to come through unprocessed,
which helps preserve dynamics by accentuating the initial portion of the signal. If these
peaks cause overloads, you can try shortening the attack time, but extremely short times
take the “life” out of the signal, and may lead to a slight “buzziness” caused by distortion.
Short release times can cause “pumping” as the compressor tries to figure out whether to
compress or not; while generally considered an undesirable effect, some engineers use it
on full drum kits to give unusual “sucking” effects. Careful adjustment of attack and release
times is essential when it comes to compression of rhythmical sources. If you are not used
to working with compressors, play a drum loop and spend some time adjusting Attack,
Release, Threshold and Gain. It can be very exciting!

A compressor can only react to an input signal once it occurs. Since it also needs to apply
an attack/release envelope, the compression is always a bit too late. A digital compressor
can solve this problem by simply delaying the input signal a little bit. Compressor offers
three different Lookahead times: zero ms, one ms and ten ms. The results may sound pretty
different depending on this setting.

Compressor can be used in three different EF (envelope follower) modes. With Peak se-
lected, Compressor reacts to short peaks within a signal. RMS mode causes Compressor
to be less sensitive to very short peaks and compress only when the incoming level has
exceeded the threshold for a slightly longer time. Opto mode results in a non-linear release
curve. Specifically, the release behavior is faster initially, and slows down as the gain reduc-
tion approaches zero. So which type should you use? There's no “right” answer, of course,
but there are some common uses for each mode. Peak mode is more aggressive and pre-
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cise, and so works well for limiting tasks where you need to ensure that there are absolutely
no signals over the set threshold. RMS is closer to how people actually perceive loudness
and is usually considered more “musical.” Opto mode, because of its non-linear release
time is often considered “smooth” and natural sounding. Opto compressors are commonly
used on vocals, bass and electric guitar. But as always, when it comes to compression, trust
your ears and not the meters!

In addition to the EF modes, Compressor offers three Model types that offer further options
for how the device measures and responds to signal levels. FF1 and FF2 are both “feed-
forward” models, which analyze the loudness of the incoming signal. These are the models
used in the former Compressor | and Compressor |l devices, respectively. FBis a “feedback”
model, which analyzes the output of the device and then self-adjusts its compression be-
havior. Because feedback compressors analyze signals that have already been compressed,
their Attack and Release parameters are a bit less precise, and act more like “suggestions” to
the compressor. But feedback compression generally results in a much “smoother” sound,
with less overall gain reduction but also less potential for distortion artifacts. The classic
analog compressor models that are so highly sought after in hardware-based studios are
generally all feedback models. Note that, for reasons of quantum physics, Lookahead and
external sidechaining are disabled when using the FB model; Ableton’s engineers are hard
at work developing code that will allow our software to predict the future, but we don't
anticipate having this available until at least the next major release.

21.5.1 Sidechain Parameters
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Normally, the signal being compressed and the input source that triggers the compressor

The Compressor Device
With Sidechain Section.
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are the same signal. But by using sidechaining, it is possible to compress a signal based
on the level of another signal or a specific frequency component. To access the Sidechain
parameters, unfold the Compressor window by toggling the & button in its title bar.

The sidechain parameters are divided into two sections. On the left are the external controls.
Enabling this section with the Sidechain button allows you to select any of Live's internal
routing points from the choosers below. This causes the selected source to act as the
compressor’s trigger, instead of the signal that is actually being compressed.

The Gain knob adjusts the level of the external sidechain’s input, while the Dry/Wet knob
allows you to use a combination of sidechain and original signal as the compressor’s trigger.
With Dry/Wet at 100%, the compressor is triggered entirely by the sidechain source. At
0%, the sidechain is effectively bypassed. Note that increasing the gain does not increase
the volume of the source signal in the mix. The sidechain audio is only a trigger for the
compressor and is never actually heard.

Note that FB mode and automatic Makeup are not available when using external sidechain.

On the right of the external section are the controls for the sidechain EQ. Enabling this
section causes the compressor to be triggered by a specific band of frequencies, instead of
a complete signal. These can either be frequencies in the compressed signal or, by using
the EQ in conjunction with an external sidechain, frequencies in another track’s audio.

The headphones button between the external and EQ sections allows you to listen to only
the sidechain input, bypassing the compressor’s output. Since the sidechain audio isn't
fed to the output, and is only a trigger for the compressor, this temporary listening option
can make it much easier to set sidechain parameters and hear what's actually making the
compressor work.

21.5.2 Compression Tips

This section presents some tips for using Compressor effectively, particularly with the
sidechain options.
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Mixing a Voiceover

Sidechaining is commonly used for so-called “ducking” effects. For example, imagine that
you have one track containing a voiceover and another track containing background music.
Since you want the voiceover to always be the loudest source in the mix, the background
music must get out of the way every time the narrator is speaking. To do this automatically,
insert a Compressor on the music track, but select the narration track’s output as the external
sidechain source.

Sidechaining in Dance Music

Sidechaining/ducking is a dance music producer’s secret weapon because it can help to
ensure that basslines (or even whole mixes) always make room for the kick drum. By
inserting a compressor on the bass (or master) track and using the kick drum’s track as the
sidechain input, you can help to control problematic low frequencies that might interfere
with the kick drum’s attack.

Using the sidechain EQ in conjunction with this technique can create ducking effects even if
you only have a mixed drum track to work with (as opposed to an isolated kick drum). In this
case, insert the Compressor on the track you want to duck. Then choose the drum track as
the external sidechain source. Then enable the sidechain EQ and select the lowpass filter.
By carefully adjusting the Frequency and Q settings, you should be able to isolate the kick
drum from the rest of the drum mix. Using the sidechain listen mode can help you tune the
EQ until you find settings you're happy with.

Note that mastery of these techniques may result in a noticeable increase in drink tickets,
remix offers and dates.
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21.6 Corpus
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Corpus is an effect that simulates the acoustic characteristics of seven types of resonant
objects. Developed in collaboration with Applied Acoustics Systems, Corpus uses physical
modelling technology to provide a wide range of parameters and modulation options.

The full version of Corpus is not included with the standard version of Live, but is bundled
with the Collision instrument as a special feature available for purchase separately.

The frequency and/or decay rate of the resonance can be MIDI modulated, by enabling the
Frequency and/or Off Decay switches in the Sidechain section. The MIDI From choosers
allow you to select the MIDI track and tapping point from which to receive MIDI note
information.

With Frequency enabled, the tuning of the resonance is determined by the incoming MIDI
note. If multiple notes are held simultaneously, the Last/Low switch determines whether the
last or the lowest note will have priority.

The Transpose and Fine knobs allow for coarse and fine offset of the MIDI-modulated tuning.
PB Range sets the range in semitones of pitch bend modulation. With Frequency disabled,
the Tune control adjusts the base frequency of the resonance in Hertz. The corresponding
MIDI note number and fine tuning offset in cents is displayed below.

Enabling Off Decay causes MIDI note off messages to mute the resonance. The slider below
the switch determines the extent to which MIDI note off messages mute the resonance. At
0%, note offs are ignored, and the decay time is based only on the value of the Decay
parameter, which is located under the Resonance Type selector. This is similar to how

The Corpus Effect.
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real-world mallet instruments such as a marimbas and glockenspiels behave. At 100%, the
resonance is muted immediately at note off, regardless of the Decay time.

You can hide or show the Sidechain parameters by toggling the € button in Corpus’s title
bar. This button will light up if the sidechain is active.

Corpus contains a Low Frequency Oscillator to modulate the resonant frequency. The
Amount control sets how much the LFO affects the frequency.

The Rate control specifies the LFO speed. It can be set in terms of Hertz, or synced to the
song tempo, allowing for controlled rhythmic modulation.

Available LFO waveform shapes are sine (creates smooth modulations with rounded peaks
and valleys), square, triangle, sawtooth up, sawtooth down and two types of noise (stepped
and smooth).

Although only one set of LFO controls is visible, there are actually two LFOs, one for each
stereo channel. The Phase and Spin controls define the relationship between these two
LFOs.

Phase (available only when the LFOs are synced to song tempo) keeps both LFOs at the
same frequency, but can set the two LFO waveforms “out of phase” with each other, creating
stereo movement. Set to “180", the LFO outputs are 180 degrees apart, so that when one
LFO reaches its peak, the other is at its minimum. With Phase set to “360" or “0” the two
LFOs run in sync.

Spin (only available when the LFOs are in Hertz mode) detunes the two LFO speeds relative
to each other. Each stereo channel is modulated at a different frequency, as determined by
the Spin amount.

For the noise waveforms, the Phase and Spin controls are not relevant and do not affect the
sound.

Spread detunes the two resonators in relation to each other. Positive values raise the pitch
of the left resonator while lowering the pitch of the right one, while negative values do the
opposite. At 0%, the resonators are tuned the same.

The type chooser allows you to select from seven types of physically modeled resonant
objects:

e Beam simulates the resonance properties of beams of different materials and sizes.
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e Marimba, a specialized variant of the Beam model, reproduces the characteristic tuning
of marimba bar overtones which are produced as a result of the deep arch-cut of the
bars.

e String simulates the sound produced by strings of different materials and sizes.

e Membrane is a model of a rectangular membrane (such as a drum head) with a variable
size and construction.

e Plate simulates sound production by a rectangular plate (a flat surface) of different
materials and sizes.

e Pipe simulates a cylindrical tube that is fully open at one end and has a variable
opening at the other (adjusted with the Opening parameter.)

e Tube simulates a cylindrical tube that is fully open at both ends.

The quality chooser controls the tradeoff between the sound quality of the resonators and
performance by reducing the number of overtones that are calculated. “Basic” uses minimal
CPU resources, while “Full” creates more sophisticated resonances. This parameter is not
used with the Pipe or Tube resonators.

The Material knob adjusts the variation of the damping at different frequencies. At lower
values, low frequency components decay slower than high frequency components (which
simulates objects made of wood, nylon or rubber). At higher values, high frequency com-
ponents decay slower (which simulates objects made of glass or metal). This parameter is
not used with the Pipe or Tube resonators.

The Radius parameter is only available for the Pipe and Tube resonators. Radius adjusts the
radius of the pipe or tube. As the radius increases, the decay time and high frequency sustain
both increase. At very large sizes, the fundamental pitch of the resonator also changes.

The Decay and Material/Radius parameters can also be controlled with the X-Y controller.

Ratio is only available for the Membrane and Plate resonators, and adjusts the ratio of the
object’s size along its x and y axes.

The Brightness control adjusts the amplitude of various frequency components. At higher
values, higher frequencies are louder. This parameter is not used with the Pipe or Tube
resonators.
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Inharm. (Inharmonics) adjusts the pitch of the resonator’s harmonics. At negative values,
frequencies are compressed, increasing the amount of lower partials. At positive values,
frequencies are stretched, increasing the amount of upper partials. This parameter is not
used with the Pipe or Tube resonators.

Opening, which is only available for the Pipe resonator, scales between an open and closed
pipe. At 0%, the pipe is fully closed on one side, while at 100% the pipe is open at both
ends.

The Listening L and R controls adjust the location on the left and right resonator where the
vibrations are measured. At 0%, the resonance is monitored at the object’s center. Higher
values move the listening point closer to the edge. These parameters are not used with
the Pipe or Tube resonators, which are always measured in the middle of their permanently
open end.

The Hit knob adjusts the location on the resonator at which the object is struck or otherwise
activated. At 0%, the object is hit at its center. Higher values move the activation point
closer to the edge. This parameter is not used with the Pipe or Tube resonators.

The processed signal is fed through a lowpass and highpass filter that can be controlled
with an X-Y controller. To define the filter bandwidth, click and drag on the vertical axis. To
set the position of the frequency band, click and drag on the horizontal axis. The filter can
be toggled on or off with the Filter switch.

Width adjusts the stereo mix between the left and right resonators. At 0%, both resonators
are fed equally to each side, resulting in mono output. At 100%, each resonator is sent
exclusively to one channel.

Bleed mixes a portion of the unprocessed signal with the resonated signal. At higher values,
more of the original signal is applied. This is useful for restoring high frequencies, which
can often be damped when the tuning or quality are set to low values. This parameter is
unavailable with the Pipe or Tube resonators.

Gain boosts or attenuates the level of the processed signal, while the Dry/Wet control
adjusts the balance between the dry input signal and the signal sent to Corpus’s processing.
Turning Dry/Wet down will not cut resonances that are currently sounding, but rather stop
new input signals from being processed.

Corpus contains a built-in limiter that automatically activates when the audio level is too
high. This is indicated by the LED in the upper-right corner of Corpus’s display.
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21.7 Dynamic Tube
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The Dynamic Tube effect infuses sounds with the peculiarities of tube saturation. An in-
tegrated envelope follower generates dynamic tonal variations related to the level of the
input signal.

Three tube models, A, B and C, provide a range of distortion characteristics known from
real amplifier tubes. Tube A does not produce distortions if Bias is set low, but will kick in
whenever the input signal exceeds a certain threshold, creating bright harmonics. Tube C
is a very poor tube amp that produces distortions all the time. The qualities of Tube B lie
somewhere between these two extremes.

The Tone control sets the spectral distribution of the distortions, directing them into the
higher registers, or through the midrange and deeper.

The Drive control determines how much signal reaches the tube; greater Drive yields a
dirtier output. The intensity of the tube is controlled by the Bias dial, which pushes the
signal into the celebrated realms of nonlinear distortion. With very high amounts of Bias,
the signal will really start to break apart.

The Bias parameter can be positively or negatively modulated by an envelope follower,
which is controlled with the Envelope knob. The more deeply the envelope is applied, the
more the Bias point will be influenced by the level of the input signal. Negative Envelope
values create expansion effects by reducing distortion on loud signals, while positive values
will make loud sounds dirtier.

Attack and Release are envelope characteristics that define how quickly the envelope reacts

The Dynamic Tube
Effect.
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to volume changes in the input signal. Together, they shape the dynamic nature of the
distortions. Note that if Envelope is set to zero, they will have no effect.

Cut or boost the device’s final signal level with the Output dial.

Aliasing can be reduced by enabling Hi-Quality mode, which can be accessed via the (3
(PC) / ® (Mac) context menu. This improves the sound quality, particularly with high
frequency signals, but there is a slight increase in CPU usage.

21.8 EQ Eight
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The EQ Eight effect is an equalizer featuring up to eight parametric filters per input channel,
useful for changing a sound'’s timbre. It extends the functionality of the former EQ Four
device, and is fully backward-compatible with EQ Four presets.

The input signal can be processed using one of three modes: Stereo, L/R and M/S. Stereo
mode uses a single curve to filter both channels of a stereo input equally. L/R mode provides
an independently adjustable filter curve for the left and right channels of a stereo input; M/S
mode (Mid/Side) provides the same functionality for signals that have been recorded using
M/S encoding.

When using the L/R and M/S modes, both curves are displayed simultaneously for reference,
although only the active channel is editable. The Edit switch indicates the active channel,
and is used to toggle between the two curves.

The filters can switch between six responses. From left to right in the display, these are:
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e Low cut (cuts frequencies below the specified frequency);

o Low shelf (boosts or cuts frequencies lower than the specified frequency);
e Bell curve (boosts or cuts over a range of frequencies);

e Notch (sharply cuts frequencies within a narrow range);

¢ High shelf (boosts or cuts frequencies higher than the specified frequency);
e High cut (cuts frequencies above the specified frequency).

Each filter band can be turned on or off independently. Turn off bands that are not in use
to save CPU power.

To edit the filter curve, click and drag on the filter dots in the display. Horizontal movement
changes the filter frequency, while vertical movement adjusts the filter band’s gain. To adjust
the filter Q (also called resonance or bandwidth), hold down the (PC)/ (Mac)
modifier while dragging the mouse. Note that the gain cannot be adjusted for the low cut,
notch and high cut filters. In these modes, vertical dragging adjusts the filter Q.

You can also use the numbered filter selector buttons to select a band for editing, and then
edit parameter values with the Freq, Gain and Q dials (and/or type values into the number
fields below each dial).

To achieve really drastic filtering effects, assign the same parameters to two or more filters.

As boosting will increase levels and cutting will decrease levels, use the global Gain field to
optimize the output level for maximum level consistent with minimum distortion.

The Scale field will attenuate the gain of all filters that support gain (all except low cut, notch
and high cut).

Enabling Hi-Quality mode via the O (PC)/ ® (Mac) context menu can improve the
sound quality, particularly with low frequency signals or when working at high sample rates.
There is a slight increase in CPU usage in Hi-Quality mode.
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21.9 EQ Three
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If you have ever used a good DJ mixer you will know what this is: An EQ that allows you to
adjust the level of low, mid and high frequencies independently.

Each band can be adjusted from -infinite dB to +6 dB using the gain controls. This means
that you can completely remove, for example, the bass drum or bassline of a track, while
leaving the other frequencies untouched.

You can also turn on or off each band using the On/Off buttons located under the gain
controls. These buttons are especially handy if assigned to computer keys.

EQ Three gives you visual confirmation of the presence of a signal in each frequency band
using three green LEDs. Even if a band is turned off, you can tell if there is something going
on in it. The internal threshold for the LEDs is set to -24 dB.

The frequency range of each band is defined via two crossover controls: FreglLo and FregHi.
If FregLo is set to 500 Hz and FregHi to 2000 Hz, then the low band goes from 0 Hz to 500
Hz, the mid band from 500 Hz to 2000 Hz and the high band from 2000 Hz up to whatever
your soundcard or sample rate supports.

A very important control is the 24 dB/48 dB switch. [t defines how sharp the filters are
cutting the signal at the crossover frequency. The higher setting results in more drastic
filtering, but needs more CPU.

Note: The filters in this device are optimized to sound more like a good, powerful analog
filter cascade than a clean digital filter. The 48 dB Mode especially does not provide a
perfect linear transfer quality, resulting in a slight coloration of the input signal even if all

The EQ Three Effect.
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controls are set to 0.00 dB. This is typical behavior for this kind of filter, and is part of EQ
Three's unique sound. If you need a more linear behavior choose 24 dB Mode or use the
EQ Eight.

21.10 Erosion
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The Erosion effect degrades the input signal by modulating a short delay with filtered noise
or a sine wave. This adds noisy artifacts or aliasing/downsampling-like distortions that sound
very “digital.”

To change the sine wave frequency or noise band center frequency, click and drag along
the X-axis in the X-Y field. The Y-axis controls the modulation amount. If you hold down the
At ] (PC)/ (At g (Mac) modifier key while clicking in the X-Y field, the Y-axis controls
the bandwidth. Note that bandwidth is not adjustable when Sine is selected.

The Frequency control determines the color, or quality, of the distortion. If the Mode control
is set to Noise, this works in conjunction with the Width control, which defines the noise
bandwidth. Lower values lead to more selective distortion frequencies, while higher values
affect the entire input signal. Width has no effect in Sine Mode.

Noise and Sine use a single modulation generator. However, Wide Noise has independent
noise generators for the left and right channels, which creates a subtle stereo enhancement.

The Erosion Effect.



CHAPTER 21. LIVE AUDIO EFFECT REFERENCE 298

21.11 External Audio Effect
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The External Audio Effect is a bit different than Live's other effects devices. Instead of
processing audio itself, it allows you to use external (hardware) effects processors within a
track’s device chain.

The Audio To chooser selects the outputs on your computer’s audio hardware that will go
to your external device, while the Audio From chooser selects the inputs that will bring
the processed signal back into Live. As with the track inputs and outputs, the list of
available inputs and outputs depends on the Audio Preferences, which can be reached via
the “Configure...” option at the bottom of each chooser.

Below each chooser is a Peak level indicator that shows the highest audio level attained.
Click on the indicators to reset them.

The Gain knobs next to the choosers adjust the levels going out of and back into Live. These
levels should be set carefully to avoid clipping, both in your external hardware and when
returning the audio to your computer.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
100 percent if using the External Audio Effect in a return track.

The Invert button inverts the phase of the processed signal coming back into Live.

Since hardware effects introduce latency that Live cannot automatically detect, you can
manually compensate for any delays by adjusting the Latency slider. The button next to this
slider allows you to set your latency compensation amount in either milliseconds or samples.
If your external device connects to Live via a digital connection, you will want to adjust your

The External Audio
Effect.
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latency settings in samples, which ensures that the number of samples you specify will be
retained even when changing the sample rate. If your external device connects to Live via
an analog connection, you will want to adjust your latency settings in milliseconds, which
ensures that the amount of time you specify will be retained when changing the sample
rate. Note that adjusting in samples gives you finer control, so even in cases when you're
working with analog devices, you may want to “fine tune” your latency in samples in order
to achieve the lowest possible latency. In this case, be sure to switch back to milliseconds
before changing your sample rate.

Note: If the Delay Compensation option is unchecked in the Options menu, the Latency

slider is disabled.

For instructions on how to accurately set up latency compensation for your hardware, please
see the "Driver Error Compensation” lesson.

21.12 Filter Delay
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The Filter Delay provides three independent delay lines, each preceded by linked lowpass
and highpass filters. This allows applying delay to only certain input signal frequencies, as
determined by the filter settings. The feedback from each of the three delays is also routed
back through the filters.

Each of the three delays can be switched on and off independently. The Filter Delay device
assigns delay 1 to the input signal’s left channel, delay 2 to the left and right channels and

The Filter Delay Effect.
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delay 3 to the right channel. The Pan controls at the right can override the delay channels'
outputs; otherwise each delay outputs on the channel from which it derives its input.

Each delay channel’s filter has an associated On switch, located to the left of each X-Y
controller. The X-Y controllers adjust the lowpass and highpass filters simultaneously for
each delay. To edit filter bandwidth, click and drag on the vertical axis; click and drag on
the horizontal axis to set the filter band's frequency.

To refer delay time to the song tempo, activate the Sync switch, which allows using the Delay
Time beat division chooser. The numbered switches represent time delay in 16th notes. For
example, selecting “4" delays the signal by four 16th notes, which equals one beat (a quarter
note) of delay. With Sync Mode active, changing the Delay Time field percentage value
shortens and extends delay times by fractional amounts, thus producing the “swing” type
of timing effect found in drum machines.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit the delay
time, click and drag up or down in the Delay Time field, or click in the field and type in a
value.

The Feedback parameter sets how much of the output signal returns to the delay line input.
Very high values can lead to runaway feedback and produce a loud oscillation — watch your
ears and speakers if you decide to check out extreme feedback settings!

Each delay channel has its own volume control, which can be turned up to +12 dB to
compensate for drastic filtering at the input.

The Dry control adjusts the unprocessed signal level. Set it to minimum if using Delay in a
return track.
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Flanger uses two parallel time-modulated delays to create flanging effects.

Flanger's delays can be adjusted with the Delay Time control. The Feedback control sends
part of the output signal back through the device input, while the Polarity switch (“+" or
"-") sets the polarity. Delay Time and Feedback can be changed simultaneously using the
effect’s X-Y controller.

Periodic control of delay time is possible using the envelope section. You can increase or
decrease the envelope amount (or invert its shape with negative values), and then use the
Attack and Release controls to define envelope shape.

Flanger contains two LFOs to modulate delay time for the left and right stereo channels.
The LFOs have six possible waveform shapes: sine, square, triangle, sawtooth up, sawtooth
down and random. The extent of LFO influence on the delays is set with the Amount control.

LFO speed is controlled with the Rate control, which can be set in terms of hertz. Rate can
also be synced to the song tempo and set in meter subdivisions (e.g., sixteenth notes).

The Phase control lends the sound stereo movement by setting the LFOs to run at the same
frequency, but offsetting their waveforms relative to each other. Set this to “180"”, and the
LFOs will be perfectly out of phase (180 degrees apart), so that when one reaches its peak,
the other is at its minimum.

Spin detunes the two LFO speeds relative to each other. Each delay is modulated at a
different frequency, as determined by the Spin amount.

The Flanger Effect.
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Adjusting the HiPass control will cut low frequencies from the delayed signal.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
100 percent if using Flanger in a return track.

Hi-Quality mode can be toggled on or off viaa & (PC)/ (Ctl & (Mac) context menu
entry. Enabling Hi-Quality results in a brighter sound, but there is a very slight increase in
CPU usage.

21.14 Frequency Shifter
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The Frequency Shifter moves the frequencies of incoming audio up or down by a user-
specified amount in Hertz. Small amounts of shift can result in subtle tremolo or phasing
effects, while large shifts can create dissonant, metallic sounds.

The Coarse and Fine knobs set the amount of shift that will be applied to the input. For
example, if the input is a sine wave at 440 Hz and the frequency is set to 100 Hz, the output
will be a sine wave at 540 Hz.

By changing the Mode from Shift to Ring, Frequency Shifter switches from classical frequency
shifting to ring modulation. In Ring mode, the selected frequency amount is added to and
subtracted from the input. For example, if the incoming audio signal (A) is a sine wave at
440 Hz and the Frequency is set to 100 Hz (B), the output will contain partials at 340 Hz (A-B)
and 540 Hz (A+B).

The Frequency Shifter
Effect.
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The Drive button enables a distortion effect, while the slider below it controls the level of
the distortion. Drive is only available in Ring mode.

Enabling the Wide button creates a stereo effect by inverting the polarity of the Spread value
for the right channel. This means that increasing the Spread value will shift the frequency
down in the right channel while shifting it up in the left. Note that Wide has no effect if the
Spread value is set to O.

Frequency Shifter contains two LFOs to modulate the frequency for the left and right stereo
channels. The LFOs have six possible waveform shapes: sine, square, triangle, sawtooth
up, sawtooth down and random. The extent of LFO influence on the frequency is set with
the Amount control.

LFO speed is controlled with the Rate control, which can be set in terms of Hertz. Rate can
also be synced to the song tempo and set in meter subdivisions (e.g., sixteenth notes).

The Phase control lends the sound stereo movement by setting the LFOs to run at the same
frequency, but offsetting their waveforms relative to each other. Set this to “180"”, and the
LFOs will be perfectly out of phase (180 degrees apart), so that when one reaches its peak,
the other is at its minimum.

Spin detunes the two LFO speeds relative to each other. Each stereo channel is modulated
at a different frequency, as determined by the Spin amount.

When using the random waveform, the Phase and Spin controls are not relevant and do not
affect the sound.

The Dry/Wet control adjusts the balance between the processed and dry signals. This knob
is called Mix when Drive is enabled. Note that the Drive effect is post-Mix, which means
that you can use Frequency Shifter as a pure distortion effect by enabling Drive and setting
Mix to 0%.

Frequency shifting is accomplished by simply adding or subtracting a value in Hertz to the
incoming audio. This is distinct from pitch shifting, in which the ratios of the incoming
frequencies (and thus their harmonic relationships) are preserved. For example, imagine
you have an incoming audio signal consisting of sine waves an octave apart at 440 Hz and
880 Hz. To pitch shift this up an octave, we multiply these frequencies by two, resulting in
new frequencies at 880 Hz and 1760 Hz.
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21.14.1 Frequency Shifter Tips

Frequency shifting and ring modulation can produce some very interesting sounds. Here
are some tips for using the Frequency Shifter device.

Drum tuning

Tuning sampled acoustic drums can be tricky. Using a sampler’s transposition controls often
changes the character of the sounds in unrealistic ways, resulting in “pinched” or “tubby”
samples. Frequency shifting can be a useful alternative.

Try using the device in Shift mode with the Dry/Wet amount at 100%. Then adjust the Fine
frequency no more than about 100 Hz up or down. This should change the apparent size
and tuning of the drum while retaining the quality of the original sample.

Phasing

To create lush phasing effects, try using extremely small amounts of shift (no more than
about 2 Hz). Note that the phasing is caused by the interaction of the processed and dry
signals, so you won't hear an effect until you adjust the Dry/Wet balance so that both are
audible; the strongest phasing will be heard when Dry/Wet is at 50%.

Tremolo

In Ring mode, frequencies below the audible range (about 20 Hz) create a tremolo effect.
You can also impart a sense of stereo motion to the tremolo by turning on Wide and using
small Spread values.

Learning more...

Try putting a Spectrum device after the Frequency Shifter to watch how the signal changes
as you change parameters. To get a good overview of what's happening, try using a simple,
continuous sine wave as your input.



CHAPTER 21. LIVE AUDIO EFFECT REFERENCE 305

21.15 Gate
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The Gate effect passes only signals whose level exceeds a user-specified threshold. A gate
can eliminate low-level noise that occurs between sounds (e.g., hiss or hum), or shape a
sound by turning up the threshold to where it cuts off reverb or delay tails or truncates an
instrument’s natural decay.

The Threshold slider sets the gate’s sensitivity. If the gate is open and passing signal (i.e.,
the signal exceeds the gate threshold), the green LED lights.

The Attenuation slider, located beneath the Threshold fader, can attenuate signals below
the threshold rather than just cutting them off. If set to -inf dB, a closed gate will mute the
input signal. A setting of 0.00 dB means that even if the gate is closed, there is no effect
on the signal. Settings in between these two extremes attenuate the input to a greater or
lesser degree when the gate is closed.

With the Flip button enabled, the gate works in reverse; the signal will only pass if its level
is below the threshold.

The Attack time determines how long it takes for the gate to switch from closed to open
when a signal goes from below to above the threshold. Very short attack times can produce
sharp clicking sounds, while long times soften the sound’s attack.

When the signal goes from above to below the threshold, the Hold time kicks in. (Note
to tech heads: the gate has hysteresis, so the release occurs about 3 dB lower than the
threshold.) After the hold time expires, the gate closes over a period of time set by the
Release parameter.

The Gate Effect.
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Normally, the signal being gated and the input source that triggers the gate are the same
signal. But by using sidechaining, it is possible to gate a signal based on the level of another
signal. To access the Sidechain parameters, unfold the Gate window by toggling the &
button in its title bar.

Enabling this section with the Sidechain button allows you to select another track from the
choosers below. This causes the selected track’s signal to act as the gate’s trigger, instead
of the signal that is actually being gated.

The Gain knob adjusts the level of the external sidechain’s input, while the Dry/Wet knob
allows you to use a combination of sidechain and original signal as the gate’s trigger. With
Dry/Wet at 100%, the gate is triggered entirely by the sidechain source. At 0%, the sidechain
is effectively bypassed. Note that increasing the gain does not increase the volume of the
source signal in the mix. The sidechain audio is only a trigger for the gate and is never
actually heard.

Sidechain gating can be used to superimpose rhythmic patterns from one source onto
another. For example, a held pad sound can be triggered with the rhythm of a drum loop
by inserting a Gate on the pad’s track and choosing the drum loop’s track as the sidechain
input.

21.16 Grain Delay
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The Grain Delay effect slices the input signal into tiny particles (called “grains”) that are then
individually delayed and can also have different pitches compared to the original signal

The Grain Delay Effect.
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source. Randomizing pitch and delay time can create complex masses of sound and rhythm
that seem to bear little relationship to the source. This can be very useful in creating new
sounds and textures, as well as getting rid of unwelcome house guests, or terrifying small
pets (just kidding!).

To refer delay time to the song tempo, activate the Sync switch, which allows using the Delay
Time beat division chooser. The numbered switches represent time delay in 16th notes. For
example, selecting “4" delays the signal by four 16th notes, which equals one beat (a quarter
note) of delay. With Sync Mode active, changing the Delay Time field percentage value
shortens and extends delay times by fractional amounts, thus producing the “swing” type
of timing effect found in drum machines.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit the delay
time, click and drag up or down in the Delay Time field, or click in the field and type in a
value.

You can route each parameter to the X-Y controller’s horizontal or vertical axis. To assign a
parameter to the X-axis, choose it from the parameter row below the controller. To assign a
parameter to the Y-axis, use the parameter row on the left side.

The Feedback parameter sets how much of the output signal returns to the delay line input.
Very high values can lead to runaway feedback and produce a loud oscillation — watch your
ears and speakers if you decide to check out extreme feedback settings!

You can transpose the grain pitch with the Pitch parameter, which acts much like a crude
pitch shifter.

The Spray control adds random delay time changes. Low values smear the signal across
time, which adds “noisiness” to the sound. High Spray values completely break down the
structure of the source signal, introducing varying degrees of rhythmic chaos. This is the
recommended setting for anarchists.

The Random Pitch control adds random variations to each grain’s pitch. Low values create
a sort of mutant chorusing effect, while high values can make the original source pitch
completely unintelligible. This parameter can interact with the main Pitch control, thus
allowing degrees of stability and instability in a sound’s pitch structure.

The size and duration of each grain is a function of the Frequency parameter. The sound of
Pitch and Spray depends very much on this parameter.
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Grain Delay now also has a dry/wet control; it can be routed to the vertical axis of the X-Y
controller.

21.17 Limiter
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The Limiter effect is a mastering-quality dynamic range processor that ensures that the
output does not exceed a specified level. Limiter is ideal for use in the Master track, to
prevent clipping. A limiter is essentially a compressor with an infinite ratio. (For more
information about compression theory, see the manual entry for the Compressor device.)

The Gain knob allows you to boost or attenuate the incoming level before applying limiting.

Ceiling sets the absolute maximum level that the Limiter will output. If your incoming signal
level has no peaks that are higher than the ceiling, Limiter will have no effect.

The Stereo / L/R switch determines how Limiter treats peaks that occur on only one side of
the stereo signal. In L/R mode, Limiter functions as two separate limiters, with independent
limiting for each channel. Stereo mode applies limiting to both channels whenever either
of them has a peak that requires compression. L/R mode allows Limiter to apply more
compression, but with some distortion of the stereo image.

The Lookahead chooser affects how quickly Limiter will respond to peaks that require com-
pression. Shorter Lookahead times allow for more compression, but with an increase in
distortion - particularly in the bass.

The Release knob adjusts how long it takes for Limiter to return to normal operation after
the signal falls below the ceiling. With Auto enabled, Limiter analyzes the incoming signal

The Limiter Effect.
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and sets an appropriate release time automatically.

The meter gives a visual indication of how much gain reduction is being applied to the
signal.

Note that any devices or channel faders that appear after Limiter may add gain. To ensure
that your final output will never clip, place Limiter as the last device in the Master track’s
device chain and keep your Master fader below 0 dB.

21.18 Looper
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Looper is an audio effect based on classic real-time looping devices. It allows you to record
and loop audio, creating endless overdubs that are synced to your Set. If the Set is not
playing, Looper can analyze incoming audio and set Live's tempo to match it. You can also
predefine a loop length before recording and Live's tempo will adjust so that your loop fits
into the specified number of bars. Furthermore, audio can be imported to Looper to create
a background for newly overdubbed material, or exported from Looper as a new clip.

The top half of Looper’s interface is a large display area optimized for easy readability
during performance. During recording, the entire display area turns red. After recording,
the display shows the current position in the loop and the total loop length in bars and
beats.

Looper’s transport buttons work in a similar way to other transport controls in Live. The
Record button records incoming audio until another button is pressed. This overwrites any
audio currently stored in Looper. Overdub continues to add additional layers of incoming

The Looper Effect.
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audio that are the length of the originally recorded material. The Play button plays back the
current state of Looper’s buffer without recording any new material. The Stop button stops
playback.

The behavior of the transport controls changes depending on whether or not Live’s playback
is running. With the transport running, Looper behaves like a clip, and is subject to launch
quantization as determined by the Quantization chooser. When Live's playback is stopped,
Looper’s transport engages immediately, regardless of the Quantization setting.

The Clear button erases Looper's buffer. If you press Clear in Overdub mode while the
transport is running, the contents of the buffer are cleared but the tempo and length are
maintained. Pressing Clear in any other mode resets the tempo and length.

The Undo button erases everything that you've overdubbed since the last time Overdub
was enabled. Your original recording, and anything that was overdubbed in a previous pass,
is preserved. After pressing Undo, the button changes to Redo, which replaces the material
removed by the last undo.

The large button below the transport controls is the Multi-Purpose Transport Button. As
with the normal transport buttons, this button’s behavior changes depending on Looper's
current playback state, and whether or not material has already been recorded. If the buffer
is empty, a single click starts recording. If Looper is recording, overdubbing or stopped,
a single click switches to play mode. During playback, a click switches to overdub mode,
allowing you to toggle back and forth between overdub and playback via additional single
clicks.

Quickly pressing the button twice stops Looper, from either play or overdub mode. Clicking
and holding the button for two seconds while in play mode activates Undo or Redo. Pressing
and holding for two seconds while stopped clears Looper’s buffer.
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Looper’s Multi-Purpose Transport Button is optimized for use with a MIDI footswitch. To
assign a footswitch, enter MIDI Map Mode, click the button and then press your attached
footswitch. Then exit MIDI Map Mode.

The Tempo Control chooser affects how Looper determines the tempo of recorded material:
e None: Looper’s internal tempo is independent of Live’s global tempo.

e Follow song tempo: The speed of Looper's playback will be adjusted so that the
recorded material plays back at Live's global tempo.

e Set & Follow song tempo: Live's global tempo will be adjusted to match the tempo
of material recorded into Looper. Any subsequent changes to Live's global tempo will
adjust the speed of Looper’s playback so that the recorded material plays back at the
new global tempo.

The Record Length chooser is used to set the length of recorded material. Its behavior
changes depending on whether or not Live's global transport is running and, depending on
the setting of the Tempo Control chooser, can set Live's global tempo:

e Song running: If Looper's Record Length chooser is set to the default “x bars,” Looper
will record until you press another transport button. If you specify a fixed number of
bars to record by selecting another option in the chooser, Looper will record for the

Diagram of Looper’s
Multi-Purpose Transport
Button Behavior
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specified time and then switch to Play or Overdub, as determined by the button next
to this chooser.

e Song not running: If Looper’s Record Length chooser is set to the default “x bars,”
Looper will make a guess about the tempo of the material you've recorded as soon as
you press Overdub, Play or Stop. But this might result in a tempo that’s twice or half
as fast as you'd like. If you first specify a fixed number of bars, Looper’s tempo will
adjust so that your recording fits into this time.

The Song Control chooser determines how Looper's transport controls will affect Live's
global transport:

e None means that Looper's transport controls have no effect on Live's global transport.

e Start Song will start Live's global transport whenever Looper enters Play or Overdub
mode. Looper’s Stop button has no effect on the global transport.

e Start & Stop Song locks Live’s global transport to Looper’s transport controls. Entering
Play or Overdub mode will start Live's transport, while pressing Looper’s Stop button
will stop Live's transport.

The "*2" button doubles the length of Looper’s recording buffer. Any material that you've
already recorded will simply be duplicated. This allows you to, for example, record a series
of one-bar ideas, and then overlay a series of two-bar ideas. The length and tempo of
Looper’s buffer is shown in the display area.

Similarly, the “:2" button cuts the length of the current buffer in half. The material in the
currently playing half is kept, while the other half is discarded.

K

The “Drag me!” area in the display allows you to export Looper’s buffer as a new audio file.
You can drag and drop to the Browser or directly to a track, creating a new clip. The newly
created clip’s Warp mode will be set to Re-Pitch by default. You can also drag audio files to
the “Drag mel” area, which will replace the contents of Looper's buffer. You can then use
this material as a bed for further overdubs, for example.

The Speed knob adjusts Looper’s playback speed (and thus pitch). The up and down arrow
buttons to the left are shortcuts to raise or lower the pitch by octaves (thus doubling or
halving the playback speed). These buttons are subject to the Quantization chooser setting.

Enabling the Reverse button plays the previously recorded material backwards. Any material
that you overdub after enabling Reverse will be played forward. Note that disabling Reverse
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will then swap this behavior; the original material will play forward again, while the material
that was overdubbed while Reverse was enabled will play backwards. Engaging the Reverse
button is subject to the Quantization chooser setting.

Feedback sets the amount of previously recorded signal that is fed back into Looper when
overdubbing. When set to 100%, the previously recorded material will never decrease in
volume. When set to 50%, it will be half as loud with each repetition. Any changes to the
Feedback amount won't take effect until the next repetition. Note that Feedback has no
effect in Play mode; each repetition will be at the same volume.

The Input -> Output chooser provides four options for monitoring Looper's input:

e Always allows the input signal to be heard regardless of Looper's playing or recording
state. You'll typically want to choose Always when using Looper as an effect in a single
track.

o Never means that the input signal will never be heard. You'll typically want to choose
Never when using Looper as an effect in a return track, where it may be fed by send
levels from a variety of other tracks.

e Rec/OVR means that the input is only audible when recording or overdubbing, but
not when Looper is in Play mode or stopped. This is useful for situations in which
you are feeding audio to multiple tracks, each containing its own Looper. If each of
these Loopers is controlled with its own foot pedal, you can switch the recording and
playback state while playing an instrument, without having to worry about monitor
settings.

¢ Rec/OVR/Stop allows the input signal to be heard except when Looper is in play mode.
This is similar to Beat Repeat’s Insert mode, and can be used to record material that
can suddenly interrupt your live playing.

21.18.1 Feedback Routing

Looper can be used as both a source and a target for internal routing to other tracks. This
allows you to, for example, create Looper overdubs that continually feed back through
another track’s devices. To set this up:

1. Insert Looper on a track.
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2. Record at least one pass of material into Looper.
3. Create another audio track.

4. In the new track’s top Audio From and Audio To choosers, select the
track containing the Looper.

5. In the new track’s bottom Audio From and Audio To choosers, select
“Insert-Looper.”

6. Switch this track’s Monitoring to “In.”
7. Add additional effects devices to the device chain of the new track.
8. Put Looper into Overdub mode.

Looper's output will now be routed through the other track’s device chain and then back
into itself, creating increasingly processed overdub layers with each pass.

21.19 Multiband Dynamics
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The Multiband Dynamics device is a flexible tool for modifying the dynamic range of au-
dio material. Designed primarily as a mastering processor, Multiband Dynamics allows for
upward and downward compression and expansion of up to three independent frequency
bands, with adjustable crossover points and envelope controls for each band. Each fre-
quency range has both an upper and lower threshold, allowing for two types of dynamics
processing to be used simultaneously per band.

The Multiband Dynamics
Effect.
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21.19.1 Dynamics Processing Theory

To understand how to use the Multiband Dynamics device, it helps to understand the four
different methods of manipulating dynamics.

1

When we use the term “compression,” we're typically talking about lowering the level of
signals that exceed a threshold. This is how Live's Compressor works, and is more accurately
called downward compression because it pushes loud signals down, thus reducing the
dynamic range. But it is also possible to reduce a signal’s dynamic range by raising the
levels of signals that are below a threshold. This much-less-common form of compression
is called upward compression. As you can see from this diagram, employing either type of
compression results in a signal with a smaller dynamic range than the original.

downward compression
(common)

original smaller original smaller
[dynamic |[dynamic dynamic dynamic
range range range range

Downward and Upward
Compression.

upward compression
(uncommon)

The opposite of compression is expansion. A typical expander lowers the levels of signals
that are below a threshold. This is how Live's Gate works, and is more accurately called
downward expansion because it pushes quiet signals down, thus increasing the dynamic
range. It is also possible to increase a signal’s dynamic range by raising the levels of signals
that are above a threshold. Like upward compression, this technique is known as upward
expansion and is much less common. This diagram shows that either type of expansion
results in a signal with a larger dynamic range.
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upward expansion
(uncommon)

original larger original larger
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downward expansion
(common)

To summarize:

e Downward compression (common): make loud signals quieter

Upward compression (uncommon): make quiet signals louder

Downward expansion (common): make quiet signals quieter

Upward expansion (uncommon): make loud signals louder

The Multiband Dynamics device allows for all of these types of processing. In fact, because
the device allows for incoming audio to be divided into three frequency bands, and each
band has both an upper and lower threshold, a single instance of Multiband Dynamics can
provide six types of dynamics processing simultaneously.

21.19.2 Interface and Controls

The High and Low buttons toggle the high and low bands on or off. With both bands
off, the device functions as a single-band effect. In this case, only the Mid controls affect
the incoming signal. The frequency sliders below the High and Low buttons adjust the
crossovers that define the frequency ranges for each band. If the low frequency is set to
500 Hz and the high frequency is set to 2000 Hz, then the low band goes from 0 Hz to 500

Downward and Upward
Expansion.
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Hz, the mid band from 500 Hz to 2000 Hz and the high band from 2000 Hz up to whatever
your soundcard or sample rate supports.

Each band has activator and solo buttons. With the activator button disabled for a given
band, its compression/expansion and gain controls are bypassed. Soloing a band mutes
the others. The Input knobs boost or attenuate the level of each band before it undergoes
dynamics processing, while the Output knobs to the right of the display adjust the levels of
the bands after processing.

The display area provides a way of both visualizing your dynamics processing and adjusting
the relevant compression and expansion behavior. For each band, the output level is
represented by large bars, while the input level before processing is represented by small
bars. With no processing applied, the input meters will be aligned with the top of the output
meters. The scaling along the bottom of the display shows dB. As you adjust the gain or
dynamics processing for a band, you can see how its output changes in comparison to its
input.

As you move your mouse over the display, the cursor will change to a bracket as it passes
over the edges of the blocks on the left or right side. These blocks represent the signal levels
under the Below and over the Above thresholds, respectively. Dragging left or right on the
edges of these blocks adjusts the threshold level. Holding down while dragging
a threshold will adjust the same threshold for all bands. Hold down (At ] (PC) / (Alt =

(Mac) to simultaneously adjust the Above and Below thresholds for a single band.

As you mouse over the middle of the block, the cursor will change to an up-down arrow.
Click and drag up or down to make the signal within the selected volume range louder or
quieter. Holding down while dragging up or down will adjust the volume of the
same block for all bands. Hold down (At ] (PC) / [Alt 5 (Mac) to simultaneously adjust
the Above and Below volumes for a single band. Double-clicking within the region resets
the volume to its default.

In technical terms, lowering the volume in the block above the Above threshold applies
downward compression, while raising it applies upward expansion. Likewise, lowering the
volume in the block below the Below threshold applies downward expansion, while raising
it applies upward compression. In all cases, you are adjusting the ratio of the compressor
or expander.

The thresholds and ratios of all bands can also be adjusted via the column to the right of
the display. The “T,” “B” and “A" buttons at the bottom right of the display area toggle
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between displaying the Time (attack and release), Below (threshold and ratio) and Above
(threshold and ratio) for each band.

For the Above thresholds, Attack defines how long it takes to reach maximum compression
or expansion once a signal exceeds the threshold, while Release sets how long it takes for
the device to return to normal operation after the signal falls below the threshold.

For the Below thresholds, Attack defines how long it takes to reach maximum compression
or expansion once a signal drops below the threshold, while Release sets how long it takes
for the device to return to normal operation after the signal goes above the threshold.

With Soft Knee enabled, compression or expansion begins gradually as the threshold is
approached.

The RMS/Peak switch also affects how quickly Multiband Dynamics responds to level
changes. With Peak selected, the device reacts to short peaks within a signal. RMS mode
causes it to be less sensitive to very short peaks and to begin processing only when the
incoming level has crossed the threshold for a slightly longer time.

The global Output knob adjusts the overall output gain of the device.

The Time control scales the durations of all of the Attack and Release controls. This allows
you to maintain the same relative envelope times, but make them all faster or slower by the
same amount.

The Amount knob adjusts the intensity of the compression or expansion applied to all bands.
At 0%, each compressor/expander has an effective ratio of 1, meaning that it has no effect
on the signal.

21.19.3 Multiband Dynamics Tips

Multiband Dynamics is a feature-rich and powerful device, capable of up to six independent
types of simultaneous processing. Because of this, getting started can be a bit intimidating.
Here are some real-world applications to give you some ideas.
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Basic Multiband Compression

By using only the upper thresholds, Multiband Dynamics can be used as a traditional “down-
ward” compressor. Adjust the crossover points to suit your audio material, then apply down-
ward compression (by dragging down in the upper blocks in the display or by setting the
numerical ratios to values greater than 1.)

De-essing

To remove "harshness” caused by overly loud high frequency content, try enabling only the
upper band and setting its crossover frequency to around 5 kHz. Then gradually adjust the
threshold and ratio to apply subtle downward compression. It may help to solo the band to
more easily hear the results of your adjustments. Generally, de-essing works best with fairly
fast attack and release times.

Uncompression

Mastering engineers are often asked to perform miracles, like adding punch and energy to a
mix that has already been heavily compressed, and thus has almost no remaining transients.
Most of the time, these mixes have also been heavily maximized, meaning that they also
have no remaining headroom. Luckily, upward expansion can sometimes help add life back
to such overly squashed material. To do this:

e Turn down the Input knob to provide some additional headroom.
o Adjust the Above thresholds for the bands so that they're below the highest peaks.

¢ Add a small amount of upward expansion to each band. Be careful - excessive upward
expansion can make transients very loud.

e Carefully adjust the attack and release times for each band. Note that, unlike in typical
downward compression, very fast attack times will increase the impact of transients,
while slower times result in a more muffled sound.

Note: Adding a maximizer or limiter to boost gain after you've returned some peaks to your
material may simply destroy them again.
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21.20 Overdrive
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Overdrive is a distortion effect that pays homage to some classic pedal devices commonly
used by guitarists. Unlike many distortion units, it can be driven extremely hard without
sacrificing dynamic range.

The distortion stage is preceded by a bandpass filter that can be controlled with an X-Y
controller. To define the filter bandwidth, click and drag on the vertical axis. To set the
position of the frequency band, click and drag on the horizontal axis. These parameters can
also be set via the slider boxes below the X-Y display.

The Drive control sets the amount of distortion. Note that 0% does not mean zero distortion!

Tone acts as a post-distortion EQ control. At higher values, the signal has more high-
frequency content.

The Dynamics slider allows you to adjust how much compression is applied as the distortion
is increased. At low settings, higher distortion amounts result in an increase in internal
compression and make-up gain. At higher settings, less compression is applied.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
100 percent if using Overdrive in a return track.

The Overdrive Effect.
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21.21 Phaser
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Phaser uses a series of all-pass filters to create a phase shift in the frequency spectrum of a
sound.

The Poles control creates notches in the frequency spectrum. The Feedback control can
then be used to invert the waveform and convert these notches into peaks (or poles). Filter
cutoff frequency is changed with the Frequency control, which can be adjusted in tandem
with Feedback using the effect’s X-Y controller.

The device has two modes, Space and Earth, for changing the spacing of notches along the
spectrum, and hence the “color” of the sound. This effect can be further adjusted with the
Color control.

Periodic control of the filter frequency is possible using the envelope section. You can
increase or decrease the envelope amount (or invert its shape with negative values), and
then use the Attack and Release controls to define envelope shape.

Phaser contains two LFOs to modulate filter frequency for the left and right stereo channels.
The LFOs have six possible waveform shapes: sine, square, triangle, sawtooth up, sawtooth
down and random. The extent of LFO influence on the filter frequency is set with the
Amount control.

LFO speed is controlled with the Rate control, which can be set in terms of hertz. Rate can
also be synced to the song tempo and set in meter subdivisions (e.g., sixteenth notes).

The Phase control lends the sound stereo movement by setting the LFOs to run at the same
frequency, but offsetting their waveforms relative to each other. Set this to “180", and the

The Phaser Effect.
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LFOs will be perfectly out of phase (180 degrees apart), so that when one reaches its peak,
the other is at its minimum.

Spin detunes the two LFO speeds relative to each other. Each filter frequency is then
modulated using a different LFO frequency, as determined by the Spin amount.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
100 percent if using Phaser in a return track.

21.22 Ping Pong Delay
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The Ping Pong Delay effect uses a single tapped delay line to create a delay that jumps
from the left to the right output.

The delay is preceded by a lowpass and highpass filter that can be controlled with an X-Y
controller. To define the filter bandwidth, click and drag on the vertical axis. To set the
position of the frequency band, click and drag on the horizontal axis.

To refer delay time to the song tempo, activate the Sync switch, which allows using the
Delay Time beat division chooser. The numbered switches represent time delay in 16th
notes. For example, selecting “4" delays the signal by four 16th notes, which equals one
beat (a quarter note) of delay. This delay time represents the time it takes for the input
signal to appear at the left channel. The delay time between the input and the right channel
is twice as long.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit the delay

The Ping Pong Delay
Effect.
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time, click and drag up or down in the Delay Time field, or click in the field and type in a
value.

The Feedback parameter controls how much of the right channel output signal returns to
the delay line input. The feedback loop also includes a filter that can color the feedback
sound, thus producing different timbres with successive echoes.

The Freeze button, labeled “F”, will cause the delay to endlessly cycle the audio which is in
its buffer at the moment that the button is pressed, ignoring any new input until Freeze is
disabled.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
100 percent if using Ping Pong Delay in a return track.

Changing the delay time while Ping Pong Delay is processing audio can cause abrupt
changes in the sound of the delayed signal. You can choose between three delay transition
modes viathe @ (PC)/ [Ctl & (Mac) context menu of the device’s title bar:

e Repitch causes a pitch variation when changing the delay time, similar to the behavior
of old hardware delay units.

e Fade creates a crossfade between the old and new delay times. This sounds similar
to time stretching if the delay time is gradually changed. Fade mode is the default
option.

e Jump immediately jumps to the new delay time. Note that this will cause an audible
click if the delay time is changed while delays are sounding. Jump mode corresponds
to the default behavior prior to Live 8. When loading Sets that were made in earlier
versions, Jump will be selected automatically.
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21.23 Redux
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Nostalgic for the famed low-resolution sound quality of the Ensonig Mirage, Fairlight CMI
or Commodore-64 computer? Redux returns us to the Dark Ages of digital by reducing a
signal’s sample rate and bit resolution.

The Downsample section has two parameters: “Downsample” and a downsample Mode
switch.

If the downsample dial is set to “1", every input sample passes to the output and the signal
does not change. If set to “2", only every second sample will be processed, so the result
sounds a bit more “digital.” The higher the number, the lower the resulting sample rate,
and the more “deconstructed” the sound. Downsampling is like applying a mosaic effect
to an image: There's a loss of information and sharp edges occur between the blocks.

The Downsample Mode switch defines if the downsampling either interpolates over a smaller
range (“soft,” down to 20.0 samples) or does not interpolate over a larger range (“hard,”
down to 200 samples).

Bit Reduction is similar, but while downsampling superimposes a grid in time, bit reduction
does the same for amplitude.

If the Bit Reduction amplitude dial is set to 8, amplitude levels are quantized to 256 steps
(8 bit resolution). If set to 1, the result is pretty brutal: Each sample contains either a full
positive or full negative signal, with nothing in between.

Bit Reduction defines an input signal of 0dB as 16 bit. Signals above 0dB are clipped, and
the red overload LED will light up.

The Redux Effect.
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Turning off Bit Reduction results in modest CPU savings.

21.24 Resonators
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This device consists of five parallel resonators that superimpose a tonal character on the
input source. It can produce sounds resembling anything from plucked strings to vocoder-
like effects. The resonators are tuned in semitones, providing a musical way of adjusting
them. The first resonator defines the root pitch and the four others are tuned relative to this
pitch in musical intervals.

The input signal passes first through a filter, and then into the resonators. There are four
input filter types to select from: lowpass, bandpass, highpass and notch. The input filter
frequency can be adjusted with the Frequency parameter.

The first resonator is fed with both the left and right input channels, while the second and
fourth resonators are dedicated to the left channel, and the third and fifth to the right
channel.

The Note parameter defines the root pitch of all the resonators ranging from C1 to C5.
It can also be detuned in cents using the Fine parameter. The Decay parameter lets you
adjust the amount of time it takes for the resonators to be silent after getting an input signal.
The longer the decay time, the more tonal the result will be, similar to the behavior of an
undamped piano string. As with a real string, the decay time depends on the pitch, so low
notes will last longer than higher ones. The Const switch holds the decay time constant
regardless of the actual pitch.

The Resonators Effect.
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Resonators provides two different resonation modes. Mode A provides a more realistic
sounding resonation, while Mode B offers an effect that is especially interesting when
Resonator I's Note parameter is set to lower pitches.

The brightness of the resulting sound can be adjusted using the Color control.

All of the resonators have an On/Off switch and a Gain control. A resonator that is turned
off does not need CPU. Turning off the first resonator does not affect the other ones.

Resonators Il through V follow the Note parameter defined in Resonator |, but they can each
be individually transposed +/- 24 semitones using the Pitch controls and detuned in cents
using the Detune controls.

The output section features the obligatory Dry/Wet control and a Width parameter that
affects only the wet signal and blends the left and right outputs of Resonators -V into a
mono signal if set to zero.

21.25 Reverb
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21.25.1 Input Processing

The input signal passes first through high and low cut filters, whose X-Y controller allows
changing the band’s center frequency (X-axis) and bandwidth (Y-axis). Either filter may be
switched off when not needed to save CPU power.

The Reverb Effect.
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Predelay controls the delay time, in milliseconds, before the onset of the first early reflection.
This delays the reverberation relative to the input signal. One's impression of the size of a
real room depends partly on this delay. Typical values for “natural” sounds range from 1ms
to 25ms.

21.25.2 Early Reflections

These are the earliest echoes that you hear after they bounce off a room’s walls, before
the onset of the diffused reverberation “tail.” Their amplitude and distribution give an
impression of the room’s character.

|u

The Shape control “sculpts” the prominence of the early reflections, as well as their overlap
with the diffused sound. With small values, the reflections decay more gradually and the
diffused sound occurs sooner, leading to a larger overlap between these components. With
large values, the reflections decay more rapidly and the diffused onset occurs later. A
higher value can sometimes improve the source’s intelligibility, while a lower value may give
a smoother decay.

Spin applies modulation to the early reflections. The X-Y control accesses the depth and
frequency of these modulations. A larger depth tends to provide a less-colored (more
spectrally neutral) late diffusion response. If the modulation frequency is too high, doppler
frequency shifting of the source sound will occur, along with surreal panning effects. Spin
may be turned off, using the associated switch, for modest CPU savings.

21.25.3 Global Settings

The Quality chooser controls the tradeoff between reverb quality and performance. “Eco”
uses minimal CPU resources, while “High” delivers the richest reverberation.

The Size parameter controls the “room’s” volume. At one extreme, a very large size will
lend a shifting, diffused delay effect to the reverb. The other extreme — a very small value —
will give it a highly colored, metallic feel.

The Stereo Image control determines the width of the output’s stereo image. At the highest
setting of 120 degrees, each ear receives a reverberant channel that is independent of the
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other (this is also a property of the diffusion in real rooms). The lowest setting mixes the
output signal to mono.

21.25.4 Diffusion Network

The Diffusion network creates the reverberant tail that follows the early reflections. The
decay time control adjusts the time required for this tail to drop to 1/1000th (-60 dB) of its
initial amplitude.

High and low shelving filters provide frequency-dependent reverberation decay. The high-
frequency decay models the absorption of sound energy due to air, walls and other materials
in the room (people, carpeting and so forth). The low shelf provides a thinner decay. Each
filter may be turned off to save CPU consumption.

The Freeze control freezes the diffuse response of the input sound. When on, the reverber-
ation will sustain almost endlessly. Cut modifies Freeze by preventing the input signal from
adding to the frozen reverberation; when off, the input signal will contribute to the diffused
amplitude. Flat bypasses the high and low shelf filters when freeze is on. If Flat is off, the
frozen reverberation will lose energy in the attenuated frequency bands, depending on the
state of the high and low shelving filters.

The Echo Density and Scale parameters provide additional control over the diffusion’s den-
sity and coarseness, and, when the room size is extremely small, have a large impact on the
coloration contributed by the diffusion.

The Chorus section adds a little modulation and motion to the diffusion. Like the Spin
section, you can control the modulation frequency and amplitude, or turn it off.

21.25.5 Output

At the reverb output, you can adjust the effect’s overall Dry/Wet mix, and vary the amplitude
of reflections and diffusion with the Reflect Level and Diffuse Level controls.
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21.26 Saturator
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Saturator is a waveshaping effect that can add that missing dirt, punch or warmth to your
sound. It can coat input signals with a soft saturation or drive them into many different
flavors of distortion.

An X-Y grid helps to visualize Saturator’s shaping curve. The shaper’s input and output values
are mapped to the X and Y axes, respectively. The curve defines the transfer function, which
is the extent to which output values fluctuate in relation to input values. Because this is
usually a nonlinear process, the incoming signal is reshaped to a greater or lesser degree
depending upon its level at each moment in time.

Incoming signals are first clipped to the dB level set by the Drive control. The meter on the
right side of the display shows how much Saturator is influencing the signal.

Signal shaping has six fixed modes: Analog Clip, Soft Sine, Medium Curve, Hard Curve,
Sinoid Fold and Digital Clip. There is also the flexible Waveshaper mode, featuring six
adjustable waveshaping parameters.

In the Analog Clip and Digital Clip modes, the signal is clipped completely and immediately.
Soft Sine, Medium Curve and Hard Curve modes soften signal clipping to varying degrees.
Sinoid Fold mode can be good for special effects.

The most dramatic effects can be created by selecting the Waveshaper curve, which has its
own dedicated set of controls. To access these six parameter fields, unfold the Saturator
window by toggling the @ button in its title bar.

The Waveshaper mode’s six additional parameters are: Drive, Lin, Curve, Damp, Depth and

The Saturator Effect.
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Period.

e Drive determines how much the input signal will be influenced by the Waveshaper
parameters. Setting Drive to zero will negate the effect entirely.

e Lin works together with the Curve and Depth parameters to alter the linear portion of
the shaping curve.

e Curve adds mostly third-order harmonics to the input signal.
e Damp flattens any signal near the grid’s origin. It behaves like an ultra-fast noise gate.

e Depth controls the amplitude of a sine wave that is superimposed onto the distortion
curve.

e Period determines the density of ripples in the superimposed sine wave.

The DC button activates a DC filter at Saturator’s input stage. This is mainly useful for
removing DC offsets from audio material that contains them.

Activating the Color button enables two filters. The first of these, controlled with the Base
control, dictates how much the effect will be reduced or increased for very low frequencies.
The second filter, essentially an equalizer, is used for controlling higher frequencies. It is
shaped with the Freq (cutoff frequency), Width and Depth controls.

The Output control attenuates the level at the device output. When the Soft Clip switch is
activated, Saturator will also apply an instance of its “Analog Clip” curve to the output.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
100 percent when using Saturator in a return track.

Aliasing can be reduced by enabling Hi-Quality mode, which can be accessed via the
(PC)/ ® (Mac) context menu. This improves the sound quality, particularly with high
frequency signals, but there is a slight increase in CPU usage.
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21.27 Simple Delay

The Simple Delay provides two independent delay lines, one for each channel (left and
right).

To refer delay time to the song tempo, activate the Sync switch, which allows using the
Delay Time beat division chooser. The numbered switches represent time delay in 16th
notes. For example, selecting “4" delays the signal by four 16th notes, which equals one
beat (a quarter note) of delay.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit the delay
time, click and drag up or down in the Delay Time field, or click in the field and type in a
value.

The Feedback parameter defines how much of each channel’s output signal feeds back into
the delay lines’ inputs. Internally, they are two independent feedback loops, so a signal on
the left channel does not feed back into the right channel and vice versa.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
100 percent when using Simple Delay in a return track.

Changing the delay time while Simple Delay is processing audio can cause abrupt changes
in the sound of the delayed signal. You can choose between three delay transition modes

viathe @ (PC)/ ® (Mac) context menu of the device’s title bar:

e Repitch causes a pitch variation when changing the delay time, similar to the behavior
of old hardware delay units.

The Simple Delay Effect.
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e Fade creates a crossfade between the old and new delay times. This sounds similar
to time stretching if the delay time is gradually changed. Fade mode is the default
option.

e Jump immediately jumps to the new delay time. Note that this will cause an audible
click if the delay time is changed while delays are sounding. Jump mode corresponds
to the default behavior prior to Live 8. When loading Sets that were made in earlier
versions, Jump will be selected automatically.

21.28 Spectrum
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The Spectrum Device.

Spectrum performs realtime frequency analysis of incoming audio signals. The results are
represented in a graph, with dB along the vertical axis and frequency/pitch along the
horizontal. The peak levels are retained on the graph until the song is restarted. Note
that Spectrum is not an audio effect, but rather a measurement tool - it does not alter the
incoming signal in any way.

The Block chooser selects the number of samples that will be analyzed in each measurement.
Higher values result in better accuracy, but at the expense of increased CPU load.
Channel determines which channel is analyzed - left, right or both.

The Refresh slider determines how often Spectrum should perform an analysis. As with the
Block parameter, this allows for a tradeoff between accuracy and CPU load. A fast response
time is more accurate, but also more CPU intensive.
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The Avg slider allows you to specify how many blocks of samples will be averaged for each
update of the display. With a setting of one, each block is shown. This results in much more
activity in the display, which can be useful for finding the spectrum of short peaks. As you
increase the Avg value, the display updates more smoothly, providing an average of the
spectrum over time. This is more consistent with the way we actually hear.

The Graph button switches between displaying the spectrum as a single interpolated line
and discrete frequency bins.

The Scale X buttons allow you to toggle the scaling of the frequency display between
linear, logarithmic, and semitone. Note that logarithmic and semitone are actually the same
scaling, but switch the legending at the top of the display between Hertz and note names.
Linear scaling is particularly useful for detailed analysis of high frequencies.

As you move your mouse over Spectrum’s display, a box appears that shows the amplitude,
frequency and note name at the pointer’s position. The Range/Auto button at the bottom left
of Spectrum’s interface toggles between manually and automatically adjusting the display’s
dynamic range. With Range selected, you can zoom and scroll the amplitude by moving
your mouse over the amplitude legending on the display’s left side. Drag vertically to scroll
and horizontally to zoom. You can also use the Range sliders to set the minimum and
maximum amplitude values shown. With Auto selected, the display automatically scales
itself based on the incoming audio level. Note that in Auto mode, the Range sliders and
zooming are disabled.

To get an even better view, you can toggle the location of the display between the device
chain and Live’s main window by clicking the €@ button in Spectrum’s title bar.
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21.29 Utility
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Utility can perform some very useful tasks, especially in combination with other devices.

The Mute button simply silences the incoming signal when enabled. Note: The active/mute
controls of a track are always placed at the very end of the signal chain. However, since you
can place Utility anywhere in a signal chain, you can use its mute function to cut the input
of a delay line or reverb without turning off the output of these devices.

The Gain control adjusts the level of the input signal +/- 35 dB.

The Channel Mode chooser allows selective processing of the left and right channels of a
sample. If, for example, Left is selected, the right channel is ignored and the left channel
appears on both outputs. This is especially useful if you have a stereo file that contains
different information on both channels and you want to use only one.

The Panorama chooser pans the signal anywhere in the stereo field.

The Width control acts as a continuous mono to stereo controller when set from 0 to 100
percent. However, beyond 100 percent the output starts to “fold in” on itself. At 200
percent the output contains only the difference between the left and right channels. If
either Left or Right have been chosen in the Channel Mode chooser, the Width control has
no function and is therefore disabled.

At the bottom of the device you will find two Phase controls, one for each channel. As their
names imply, they invert the phase of each channel.

The Utility Effect.
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21.30 Vinyl Distortion
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The Vinyl Distortion effect emulates some of the typical distortions that occur on vinyl records
during playback. These distortions are caused by the geometric relationships between the
needle and the recorded groove. The effect also features a crackle generator for adding
noisy artifacts.

The Tracing Model section adds even harmonic distortion to the input signal. Adjust the
amount of distortion with the Drive knob, or click and drag vertically in the Tracing Model
X-Y display. To adjust the distortion’s frequency or “color,” drag horizontally in the X-Y
display or double-click on the Freq field and type in a value. Holding the (PC) /
(Mac) modifier while dragging vertically in the X-Y display changes the frequency
band’s Q (bandwidth).

The Pinch Effect section adds odd harmonics to the input signal. These distortions typically
occur 180 degrees out of phase, creating a richer stereo image. The Pinch Effect has the
same controls as the Tracing Model, but generates a rather different sound.

The Drive control increases or decreases the overall distortion amount created by both the
Tracing Model and Pinch.

There are two distortion modes: Soft and Hard. The Soft Mode simulates the sound of a
dub plate, while Hard Mode is more like that of a standard vinyl record.

The stereo/mono switch determines whether the Pinch distortion occurs in stereo or mono.
Set it to stereo for realistic simulation of vinyl distortions.

The Crackle section adds noise to the signal, with noise density set by the Density control.

The Vinyl Distortion
Effect.
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The Volume control adjusts the amount of gain applied to the noise.

21.31 Vocoder
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A vocoder is an effect that combines the frequency information of one audio signal (called
the carrier) with the amplitude contour of another audio signal (called the modulator). The
modulator source is generally something with a clear rhythmic character such as speech or
drums, while the carrier is typically a harmonically-rich synthesizer sound such as a string or

pad. The most familiar application of a vocoder is to create “talking synthesizer” or robotic
voice effects.

Vocoders work by running both the carrier and modulator signals through banks of bandpass
filters. The output level of each of the modulator’s filters is then analyzed and used to control
the volume of the corresponding filter for the carrier signal.

Live's Vocoder should be inserted on the track that contains the audio material you plan to

use as your modulator. The Carrier chooser then provides a variety of options for the carrier
signal:

¢ Noise uses Vocoder's internal noise generator as the carrier source. With this selected,
an X-Y display is shown which allows you to adjust the character of the noise. The
horizontal axis adjusts downsampling. Click and drag to the left to decrease the
sample rate of the carrier’s output. The vertical axis adjusts the density of the noise.
Click and drag downward to decrease the density.

The Vocoder Effect.
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e External allows you to select any available internal routing points from the choosers
below. This is the option you'll want for classic “robot voice” applications.

¢ Modulator uses the modulator itself as the carrier. This essentially outputs a resynthe-
sized version of the modulator signal, but allows you to use Vocoder’s sound-shaping
controls to adjust the sound.

e Pitch Tracking enables a monophonic oscillator, which tunes itself to the pitch of the
modulator. The High and Low sliders allow you to limit the frequency range that the
oscillator will attempt to track. Choose from sawtooth or one of three pulse waveforms
and adjust the coarse tuning of the oscillator via the Pitch slider. Pitch tracking is
particularly effective with monophonic modulator sources such as melodic instruments
or voices. Note that the oscillator only updates its frequency when it detects a clear
pitch. It then maintains this pitch until it detects a new one. This means that changing
the oscillator's parameters or causing it to reset (when grouping Vocoder's track, for
example) can cause unexpected changes in the sound. With polyphonic material or
drums, pitch tracking is generally unpredictable (but can be very interesting.)

Particularly when using external carrier sources, a vocoder’s output can sometimes lose a
lot of high end. Enabling the Enhance button results in a brighter sound by normalizing the
spectrum and dynamics of the carrier.

The Unvoiced knob adjusts the volume of an additional noise generator, which is used to
resynthesize portions of the modulator signal that are pitchless, such as “f” and “s” sounds.

Sens. sets the sensitivity of the unvoiced detection algorithm. At 100%, the unvoiced noise
generator is always on. At 0%, only the main carrier source is used. The Fast/Slow switch
adjusts how quickly Vocoder switches between unvoiced and voiced detection.

Vocoder’s large central area shows the levels of the individual bandpass filters. Clicking
within this display allows you to attenuate these levels.

The Bands chooser sets the number of filters that will be used. Using more bands results in
a more accurate analysis of the modulator’s frequency content, but requires more CPU.

The Range sliders adjust the frequency range over which the bandpass filters will operate.
For most sources, a fairly large range works well, but you may want to adjust the outer limits
if the sound becomes too piercing or bassy. The BW control sets the bandwidth of the
filters. At low percentages, each filter approaches a single frequency. As you increase the
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bandwidth, you increase the overlap of the filter bands. A bandwidth of 100% is the most
accurate, but higher or lower settings can create interesting effects.

The Precise/Retro switch toggles between two types of filter behavior. In Precise mode,
all filters have the same gain and bandwidth. In Retro mode, bands become narrower and
louder at higher frequencies.

Gate sets a threshold for the filterbank. Any bands whose levels are below the threshold
will be silent.

The Level slider boosts or cuts Vocoder’s output.

Depth sets how much of the modulator's amplitude envelope is applied to the carrier’s
signal. At 0%, the modulator’s envelope is discarded. At 200%, only high amplitude peaks
will be used. 100% results in “classic” vocoding.

The Attack and Release controls set how quickly Vocoder responds to amplitude changes
in the modulator signal. Very fast times preserve the transients of the modulator, but can
cause distortion artifacts.

The Mono/Stereo switches determine how many channels are used for the carrier and
modulator. In Mono mode, both the carrier and modulator are treated as mono sources.
Stereo uses a mono modulator but processes the carrier in stereo. L/R processes both the
carrier and modulator signals in stereo.

The frequencies of the carrier’s filterbank can be shifted up or down via the Formant knob.
With voice as the modulator, small Formant changes can alter the apparent gender of the
source.

The Dry/Wet control adjusts the balance between the processed and dry signals.

21.31.1 Vocoder Tips

This section explains how to set up the most common Vocoder applications.

Singing Synthesizer

The classic vocoder application is the “singing synthesizer.” To set this up in Live:
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1. Insert Vocoder in the track that contains your vocal material. You can either use
a clip that contains a prerecorded voice clip or, to process a live vocal signal,
connect a microphone to a channel on your audio hardware and choose this as
the input source for the track.

2. Insert a synthesizer such as Analog in another track. Again, you can either create
a MIDI clip to drive this synthesizer or play it live.

3. Set the vocoder’s Carrier chooser to External.

4. Select the synthesizer track in the vocoder's Audio From choosers. (For best
results, choose Post FX in the bottom chooser.)

5. If you're creating your synthesizer and vocal material in real time, make sure the
Arm button is enabled on both tracks.

6. Play the synthesizer as you speak into the microphone. You'll hear the rhythm of
your speech, but with the timbral character and frequencies of the synthesizer.
To hear the vocoded signal alone, solo the voice track so that the “normal”
synthesizer track is muted.

Note: you'll generally get the best results if your synthesizer sound is bright and rich in
harmonics. Try sawtooth-based patches to improve the intelligibility of the voice. For even
more brightness and clarity, try adjusting the Unvoiced control and/or enabling Enhance.

Formant Shifter
If the Vocoder is set to use the modulator as its own carrier, it can be used as a powerful
formant shifter. To do this:

1. Set the Carrier chooser to Modulator.

2. Set the Depth to 100%.

3. Enable Enhance.

Now experiment with different settings of the Formant knob to alter the character of the
source. For even more sound-sculpting possibilities, try adjusting the various filterbank
parameters as well.
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Chapter 22

Live MIDI Effect Reference

Live comes with a selection of custom-designed, built-in MIDI effects. The “Working with
Instruments and Effects” chapter explains the basics of using effects in Live.

22.1 Arpeggiator
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B 1« 1251 0 The Arpeggiator Effect.

Live's Arpeggiator effect takes the individual MIDI notes from a held chord (or single note),
and plays them as a rhythmical pattern. The sequence and speed of the pattern can be
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controlled by the device, which also provides a full complement of both classic and original
arpeggiator features.

Arpeggiators are a classic element in Eighties synth music. The name originates with the
musical concept of the “arpeggio,” in which the notes comprising a chord are played as
a series rather than in unison. “Arpeggio” is derived from the lItalian word “arpeggiare,”
which refers to playing notes on a harp.

22.1.1 Style and Rate Sections

Arpeggiator’s Style chooser determines the sequence of notes in the rhythmical pattern.
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Play Order places notes in the pattern according to the order in which they are played. This
is therefore only recognizable when more than one chord or note has been played.

In addition to the Arpeggiator styles above, there are three settings for creating random
arpeggios:

e Choosing Random will produce a continuously randomized sequence of the incoming
MIDI notes.

e Random Other creates random patterns from incoming MIDI notes, but will not repeat
a given note until all other incoming notes have been used.

e Random Once creates one random pattern from incoming MIDI notes and repeats
that pattern until the incoming MIDI changes, at which point a new pattern is created.

Arpeggiator will play the pattern of notes at the speed set by the Rate control, which can
be calibrated in either milliseconds or beat-time using the neighboring Sync/Free button.
With Sync chosen, Arpeggiator will be synced to the song tempo.

A Gate control to the right of Rate determines the length of notes played by Arpeggiator
as a percentage of the current Rate setting. Any setting larger than 100% will therefore play
notes that overlap (i.e., are legato).

The rhythmic pattern generated by Arpeggiator does not necessarily have to be straight;
a selection of groove patterns can be applied with the respective control just beneath the
Mode chooser. Grooves in Arpeggiator behave similarly to grooves in clips, and the intensity
of the groove is determined by the Amount slider in the Groove Pool.

With the Hold parameter active, Arpeggiator will continue to play the pattern even after
the keyboard keys have been released. The pattern will be repeated until any other key is
pressed. When Hold is active and any of the original keys also remain physically held, notes

“Pinky Up" and “Pinky
UpDown”.

“Thumb Up” and
“Thumb UpDown".
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can be added to the pattern simply by playing them. Notes can also be removed from the
pattern in this scenario by playing them a second time, allowing the gradual buildup and
rearrangement of the pattern over time.

Tip: If you want the pattern to stop playing, momentarily deactivate Hold.

The Offset parameter shifts the sequence of notes in the pattern by the number of places
selected with the control. This is best illustrated with an example: A setting of “1” makes
the second note in the pattern play first, and the first note last. If you imagine the pattern
as a circle of notes that is played in a clockwise direction from a set start point, the Offset
parameter effectively rotates this circle counter-clockwise one note at a time, changing
where in the pattern play begins.

With the Repeats parameter, the pattern can be set to repeat a specified number of times
until it is retriggered. A setting of “inf” will repeat the pattern indefinitely. Hint: This
feature provides an excellent way of emulating the strum of a guitar or playing a chord as
an arpeggio once or twice. Another interesting effect can be achieved by combining this
feature with the Retrigger parameter, which we will explain in a moment. This can be used
to create rhythmically generated arpeggios separated by pauses.

The Retrigger parameter resets the pattern so that it starts again from the beginning.
Retriggering can be deactivated (Off), set to occur when new notes are pressed (Note) or
set to occur at a specified song position or beat-time (Beat). Beat retriggering can be
specified in terms of notes or bars and is aligned with song position. An LED in the upper
right corner of the section indicates when the pattern has been retriggered.

22.1.2 Transposition and Velocity Sections

The pattern generated by Arpeggiator can be transposed; the device’s transposition controls
allow forcing this transposition into a specific major or minor key or (using the Transpose
chooser’s Shift option) doing it in semitones. The distance between transposition steps is
set in scale intervals (for Major and Minor transposition) or semitones (for Shift transposition)
with the Distance control. Using the Steps parameter, you can choose the number of times
the sequence is transposed. When Distance is set to a positive value, a setting of 8 Steps will
transpose the sequence a total of eight times, playing it in higher notes each time. (When
Distance is set to a negative value, the sequence will transpose lower each time.)
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The dynamics of Arpeggiator are controlled using the velocity section. With Velocity set
to “On” and Target set to 0, for example, the sequence will gradually fade out, eventually
reaching O velocity. The Decay control sets the amount of time Arpeggiator takes to reach
the Target velocity. With Retrigger activated, retriggering of the sequence will also retrigger
the velocity slope.

Tip: The velocity section’s Retrigger option can be used in conjunction with Beat retriggering
to add rhythm to the dynamic slope.

22.2 Chord
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This effect assembles a chord, as the name implies, from each incoming note and up to six
others of user-defined pitch. The Shift 1-6 knobs allow selecting the pitch of the notes that
contribute to the chord from a range of +/- 36 semitones relative to the original. Setting
Shift 1 to +4 semitones and Shift 2 to +7 semitones, for example, yields a major chord in
which the incoming note is the root.

The Velocity control beneath each Shift knob makes further harmonic sculpting possible,
given that the instrument allows for changes in volume or timbre as function of velocity. It
is a relative control, with a range of 1 to 200 percent (100 percent defined as playing at a
velocity equal to that of the incoming MIDI note). Use the Velocity controls to do anything
from adding slight overtones to washing out most of the other chord elements.

The order in which pitches are added to the chord is inconsequential: The effect of a
+12 semitone shift added with the Shift 1 control, for example, is equal in effect to a +12
semitone shift added with the Shift 6 control.

The Chord Effect.
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Note that no two notes of the same pitch can contribute to the chord, and that selecting
the same shift value twice (e.g., +8 semitones on both Shift 2 and Shift 3) will result in the
latter control appearing disabled, indicating that it is a duplicate and therefore not in use.
Actually, there is no such thing as two notes with the same pitch playing at the same time
within the entire Live universe.

22.3 Note Length
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Note Length alters the length of incoming MIDI notes. It can also be used to trigger notes
from MIDI Note Off messages, instead of the usual Note On messages.

When the device is set to trigger from a Note On message, only the timing controls are
available. The length of held notes can be adjusted in milliseconds or synced in relation
to the song tempo. Gate defines the percentage of the Length value that notes should be
held for. At 200 percent, the Gate parameter will double a note’s length.

When the device is set to trigger from a Note Off event (the moment at which a played note
is released), the timing of an incoming note will be delayed by its length (because it will be
starting at the point at which it would have been stopping). Note Length’s other settings
will then determine the duration of the newly triggered note.

Three other parameters are available when the device is triggering from Note Off messages:

On/Off Balance - This determines the velocity of the output note. It is a balance between
the incoming note’s Note On and Note Off velocities. If your MIDI keyboard does not
support MIDI Note Off velocity, you can just set this to zero.

The Note Length Effect.
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Decay Time — This is the time needed for an incoming note’s velocity to decay to zero. The
decay begins immediately from the moment the device receives a MIDI Note On message.
The value at the time of Note Off will become the velocity of the output MIDI note.

Key Scale — The pitch of incoming notes can be used to alter the length of the output notes.
With positive values, notes below C3 will be made progressively longer, and notes above
C3 will be made shorter. Negative values will invert this relationship.

22.4 Pitch
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Pitch is a transposition tool that changes incoming note pitch by +/- 128 semitones.

The Range and Lowest controls act together to define a pitch range through which notes are
allowed to pass. Notes outside of the defined pitch range will be blocked, and the effect’s
LED light will flash when this happens.

Notes outside of the pitch range are limited based on their untransposed pitch, prior to the
transposition stage of the effect.

The Pitch Effect.
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22.5 Random
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Random adds an element of the unknown to the otherwise commonplace pitch parameter.
The Chance control defines the likelihood that an incoming note’s pitch will be changed by a
random value. You can think of it as being something like a dry/wet control for randomness.

The random value that determines the pitch change is created by two variables: The Choices
control defines the number of different random notes possible, from a range of 1 to 24; the
Scale control value is multiplied by the Choices control value, and the result dictates the
pitches that random notes are allowed to have relative to that of the incoming note.

For example, if you play the note C3 with Chance set to 50 percent, Choices set to 1 and
Scale set to 12, half of the resulting notes will play at C3 and half will play at C4. But with
Chance set to 50 percent, Choices set to 12 and Scale set to 1, half of the resulting notes
will play at C3 and half will play at one of any semitone that is between C#3 and C4.

These examples assume that the Sign buttons are set to “Add” and the Mode button is
set to “Rnd.” The Sign controls decide whether the random alteration adds to the original
note’s pitch, subtracts from it, or does a little of both. The LEDs below the Sign controls
give you a visual idea of how output pitch compares with that of the original.

The Mode button determines whether the alteration will be random or, when set to “Alt,”
will cycle between the allowed output notes in a fixed order (sometimes known as “cycle
round-robin”). The Chance control behaves a bit differently in Alt mode - at 100 percent,
the next output note will always be the next note in the series. At 0 percent, the next output
note will always be the incoming note.

For example, with Chance set to 100 percent, Choices set to 12 and Scale set to 1, playing

The Random Effect.
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C3 once will trigger C3, and each successive C3 will trigger the next semitone higher until
the device reaches C4, at which point it will start over at C3. But with Chance set to 100
percent, Choices set to 2 and Scale set to 2, incoming C3s will alternate between C3 and
D3. This setting is perfect for simulating upbow and downbow alternation with stringed
instruments, or alternating right- and left-hand drum samples.

Hint: Try using the Scale effect after Random to constrain the output values to a specific
harmonic range. Using Random’s Alt mode with the Scale device allows you to create a
simple step-sequencer.

22.6 Scale

() Scale @@

Scale alters incoming note pitch based on a scale mapping. Each incoming note is given
an outgoing equivalent on the X-Y scale map of the effect: All incoming Cs, for example,
might be converted to outgoing Ds.

The X-Y scale map is 12 squares in length and width, corresponding to the 12 notes in a full
octave. Darker squares represent the black keys on a keyboard. The base of the diagonal
scale (the lower left square) shown on the map can be changed using the Base control. The
X-axis of the map shows incoming note values, and the Y-axis their outgoing equivalents.
Use mouse-clicks to move or delete the yellow squares, which define where an incoming
note will be sent on the scale. (Deleting a note on the scale map means that it will no longer

play.)

The Range and Lowest controls work together to define the note range within which scale

The Scale Effect.
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mapping will take effect. Outside of the range defined by these controls, the Scale effect
will be inapplicable, and the LED light will flash to indicate that some notes are not being
processed by the effect, but are playing at their unaltered pitch.

22.7 Velocity
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Velocity re-maps the 127 MIDI note velocity values. It can function on MIDI Note On or
Note Off messages, or both, depending on the setting of the Operation chooser.

The Out Low and Out Hi knobs control the outgoing velocity (from 1 to 127), which is
represented by the Y-axis of the X-Y display. Incoming velocities that are shown in the
display are within the range chosen by the Range and Lowest controls, and are represented
on the X-axis. The resulting curve shows how velocity is being altered by the effect.

If Lowest and Out Low are both set to zero, and Range and Out Hi are set to 127, the display
will show a straight diagonal line that indicates the equivalent of an effect bypass: Softly
played notes are being output quietly, and vice versa. If instead, Out Hi is set to zero and
Out Low to 127, the slope of the line will be reversed, and softly played notes will actually
produce the loudest output.

What happens to incoming notes that are outside of the range set with the Range and
Lowest controls? This depends on which Mode is selected.

e Clip Mode does just what it says: It clips incoming note velocities so that they stay
within the range.

The Velocity Effect.
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e Gate Mode removes incoming notes altogether if their velocities are outside of the
range. You will see the little LED below the X-Y display flash when a note is blocked
by gating.

e In Fixed Mode, the Out Hi velocity defines all outgoing note velocities, regardless of
incoming note velocity.

The Random function adds or subtracts a random value to the all velocities, and is repre-
sented by a gray area on the display curve.

The Drive and Compand controls can be combined to create more complex curves. Com-
pand is a simultaneous expanding and compressing tool. When set to values greater than
zero, it forces incoming notes to the outer boundaries of the curve, making them play ei-
ther loudly or softly. Compand values of less than zero, on the other hand, force outgoing
velocity toward the mid-range. Drive pushes all values in the curve to the outer extremes.
Use these two controls together to sculpt or even redefine the dynamic structure of a piece.
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Chapter 23

Live Instrument Reference

Live comes with a selection of custom-designed, built-in instruments. The “Working with
Instruments and Effects” chapter explains the basics of using instruments in Live.

The boxed version of Live 8 ships with the Essential Instrument Collection, a multi-gigabyte
library of meticulously sampled and selected instruments ready for use in either Simpler or
Sampler. Learn how to access the EIC sounds at the end of this chapter.

23.1 Analog
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Analog is a virtual analog synthesizer, created in collaboration with Applied Acoustics Sys-
tems. With this instrument, we have not attempted to emulate a specific vintage analog
synthesizer but rather to combine different features of legendary vintage synthesizers into
a modern instrument. Analog generates sound by simulating the different components of
the synthesizer through physical modeling. This technology uses the laws of physics to
reproduce how an object or system produces sound. In the case of Analog, mathematical
equations describing how analog circuits function are solved in real time. Analog uses no
sampling or wavetables; the sound is simply calculated in real time by the CPU according
to the values of each parameter. This sound synthesis method ensures unmatched sound
quality, realism, warmth and playing dynamics.

The full version of Analog is not included with the standard version of Live, but is a special
feature available for purchase separately.

23.1.1 Architecture and Interface

Analog’s signal flow is shown in the figure below:

L o
Oscillator 1 - | Filter1 = Amp]1 R
i 11 I 1
LFO 1 ] ] L
rrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrr 5 —
LFO 1 Filter Env 1 Amp Env 1 a
S|t~
g L
Oscillator 2 o = Y .| CFilter2 = Amp?2 R
L L
A g [ A A
Q- LFO 2
LFO 2 Filter Env 2 Amp Env 2
Noise - Diagram of Analog’s
Signal Flow.

The primary sound sources of the synthesizer are two oscillators and a noise generator.
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These sources can be independently routed to two different multi-mode filters, which are
each connected to an amplifier. Furthermore, the signal flow can be run through the filters
in series or in parallel.

Analog also features two low-frequency oscillators (LFOs) which can modulate the oscillators,
filters and amplifiers. Additionally, each filter and amplifier has its own envelope generator.

The Analog interface consists of two parts: the display surrounded on all sides by the shell.
The shell contains the most important controls for a given section while the display updates
to show parameter visualizations and additional controls for the selected section. In addition
to the synthesis modules, there is a Global section that contains general performance
parameters such as instrument volume, vibrato and polyphony.

23.1.2 Oscillators

Shape Oclave Semi Detune
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Analog's two oscillators use physical modelling to capture the character of vintage hardware
oscillators. Because they use modelling instead of wavetables, they avoid aliasing.

Each oscillator can be turned on or off independently via the switch labelled Osc 1 or Osc
2 in the shell, and the oscillator’s output level is adjusted by the slider to the right of this
activator.

The F1/F2 slider controls the balance of the oscillator's output to each of the two filters.
When the slider is at the center position, equal amounts of signal will be sent to both filters.
When set all the way to the top or bottom, signal will only be sent to Filter 1 or Filter 2
respectively.

Display and Shell
Parameters for the two
Oscillators.
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The Shape chooser selects the oscillator's waveform. The choices are sine, sawtooth, rectan-
gular and white noise. When rectangular is selected, the Pulse Width parameter is enabled
in the display, which allows you to change the pulse width of the waveform. Low Width
values result in a very narrow waveform, which tends to sound tinny or “pinched.” At 100%,
the waveform is a perfect square, resulting in only odd harmonics. The pulse width can also
be modulated by an LFO, via the slider next to Width. Note that this parameter is only
enabled when the corresponding LFO is enabled.

The Octave, Semi and Detune knobs in the shell function as coarse and fine tuners. Oc-
tave transposes the oscillator by octaves, while Semi transposes up or down in semitone
increments. The Detune knob adjusts in increments of one cent (up to a maximum of three
semitones (300 cents) up or down).

Oscillator pitch can be modulated according to the settings of the Pitch Mod and Pitch Env
parameters in the display. The LFO slider sets the amount that the LFO modulates pitch.
Again, this parameter is only enabled if the LFO is on. The Key slider controls how much
the oscillator tuning is adjusted by changes in MIDI note pitch. The default value of 100%
means that the oscillator will conform to a conventional equal tempered scale. Higher or
lower values change the amount of space between the notes on the keyboard. At 0%, the
oscillator is not modulated by note pitch at all. To get a sense of how this works, try leaving
one of the oscillators at 100% and setting the other's Key scaling to something just slightly
different. Then play scales near middle C. Since C3 will always trigger the same frequency
regardless of the Key value, the oscillators will get farther out of tune with each other the
farther away from C3 you play.

The Pitch Env settings apply a ramp that modulates the oscillator’s pitch over time. Initial
sets the starting pitch of the oscillator while Time adjusts how long it will take for the pitch
to glide to its final value. You can adjust both parameters via the sliders or by adjusting the
breakpoints in the envelope display.

The Sub/Sync parameters in the display allow you to apply either a sub-oscillator or a hard
synchronization mode. When the Mode chooser is set to Sub, the Level slider sets the
output level of an additional oscillator, tuned an octave below the main oscillator. The
sub-oscillator produces a square wave when the main oscillator’s Shape control is set to
rectangle or sawtooth and a sine wave when the main oscillator is set to sine. Note that the
sub-oscillator is disabled when the main oscillator’s Shape is set to white noise.

When the Mode chooser is set to Sync, the oscillator's waveform is restarted by an internal
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oscillator whose frequency is set by the Ratio slider. At 0%, the frequency of the internal
oscillator and the audible oscillator match, so sync has no effect. As you increase the Ratio,
the internal oscillator’s rate increases, which changes the harmonic content of the audible
oscillator. For maximum analog nastiness, try mapping a modulation wheel or other MIDI
controller to the Sync ratio.

23.1.3 Noise Generator
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The Noise generator produces white noise and includes its own -6db/octave low-pass filter.
The generator can be turned on or off via the Noise switch in the shell. Its output level is
adjusted by the slider to the right of this activator.

The F1/F2 slider controls the balance of the noise generator’s output to each of the two
filters. When the slider is at the center position, equal amounts of signal will be sent to both
filters. When set all the way to the top or bottom, signal will only be sent to Filter 1 or Filter
2 respectively.

The Color knob sets the frequency of the internal low-pass filter. Higher values result in
more high-frequency content.

Note that Noise has only shell parameters, so adjusting them does not change what is shown
in the display.

Analog’s Noise
Generator.
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23.1.4 Filters
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Analog’s two multi-mode filters come equipped with a flexible routing architecture, multiple
saturation options and a variety of modulation possibilities. As with the oscillators, all
parameters can be set independently for each filter.

The Fil 1 and Fil 2 switches in the shell toggle the respective filter on and off. The chooser
next to the filter activator selects the filter type from a selection of 2nd and 4th order
low-pass, band-pass, notch, high-pass and formant filters.

The resonance frequency of the filter is adjusted with the Freq knob in the shell, while the
amount of resonance is adjusted with the Reso control. When a formant filter is chosen in
the chooser, the Reso control cycles between vowel sounds.

Below each mode chooser is an additional control which differs between the two filters. In
Filter 1, the To F2 slider allows you to adjust the amount of Filter 1's output that will be
sent to Filter 2. The Slave switch below Filter 2's mode chooser causes this filter's cutoff
frequency to follow the cutoff of Filter 1. If this is enabled, Filter 2's cutoff knob controls the
amount of offset between the two cutoff amounts. If any of Analog’s modulation sources
are controlling Filter 1's cutoff, Filter 2 will also be affected by them when Slave is enabled.

In addition to the envelope controls, the displays for the filters contain various modulation
parameters and the Drive chooser. Cutoff frequency and resonance can be independently
modulated by LFO, note pitch and filter envelope via the sliders in the Freq Mod and Res
Mod sections respectively. Positive modulation values will increase the cutoff or resonance
amounts, while negative values will lower them.

The Drive chooser in the display selects the type of saturation applied to the filter output.

Display and Shell
Parameters for the two
Filters.
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The three Sym options apply symmetrical distortion, which means that the saturation be-
havior is the same for positive and negative values. The Asym modes result in asymmetrical
saturation. For both mode types, higher numbers result in more distortion. Drive can be
switched off entirely by selecting Off in the chooser. Experiment with the various options to
get a sense of how they affect incoming signals.

23.1.5 Amplifiers
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After the filters, the signal is routed to an amplifier which further shapes the sound with
an amplitude envelope and panning. All parameters can be set independently for each
amplifier.

The Amp 1 and Amp 2 switches in the shell toggle the respective amplifier on and off, while
the output level is controlled by the Level knob. The Pan knob sets the position of the
amplifier's output in the stereo field.

In addition to the envelope controls, the displays for the amplifiers contain various modula-
tion parameters. The Pan and Level amounts can be independently modulated by LFO, note
pitch and amp envelope via the sliders in the Pan Mod and Level Mod sections respectively.
Note that, when using note pitch as the modulation source for Level, middle C will always
sound the same regardless of the modulation amount. Positive values will cause the level
to increase for higher notes.

Display and Shell
Parameters for the two
Amplifiers.
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23.1.6 Envelopes
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In addition to the pitch envelopes in the oscillator sections, Analog is equipped with inde-
pendent envelopes for each filter and amplifier. All four of these envelopes have identical
controls, which are housed entirely within the display. Each envelope is a standard ADSR
(attack, decay, sustain, release) design and features velocity modulation and looping capa-
bilities.

The attack time is set with the Attack slider. This time can also be modulated by velocity
via the Att<Vel slider. As you increase the Att<Vel value, the attack time will become
increasingly shorter at higher velocities.

The time it takes for the envelope to reach the sustain level after the attack phase is set by
the Decay slider.

The Sustain slider sets the level at which the envelope will remain from the end of the decay
phase to the release of the key. When this knob is turned all the way to the left, there is no
sustain phase. With it turned all the way to the right, there is no decay phase.

The overall envelope level can be additionally modulated by velocity via the Env<Vel slider.

The S.Time slider can cause the Sustain level to decrease even if a key remains depressed.
Lower values cause the Sustain level to decrease more quickly.

Finally, the release time is set with the Release knob. This is the time it takes for the envelope
to reach zero after the key is released.

The Slope switches toggle the shape of the envelope segments between linear and expo-
nential. This change is also represented in the envelope visualization.

Analog’s Envelope
Parameters.
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Normally, each new note triggers its own envelope from the beginning of the attack phase.
With Legato enabled, a new note that is played while another note is already depressed will
use the first note’s envelope, at its current position.

Enabling the Free switch causes the envelope to bypass its sustain phase and move directly
from the decay phase to the release phase. This behavior is sometimes called “trigger”
mode because it produces notes of equal duration, regardless of how long the key is
depressed. Free mode is ideal for percussive sounds.

The Loop chooser offers several options for repeating certain segments of the envelope
while a key is depressed. When Off is selected, the envelope plays once through all of its
segments without looping.

With AD-R selected, the envelope begins with the attack and decay phases as usual, but
rather than maintaining the sustain level, the attack and decay phases will repeat until the
note is released, at which point the release phase occurs. ADR-R mode is similar, but also
includes the release phase in the loop for as long as the key is held.

Note that in both AD-R and ADR-R modes, enabling Free will cause notes to behave as if
they're permanently depressed.

ADS-R mode plays the envelope without looping, but plays the attack and release phases
once more when the key is released. With short attack and release times, this mode can
simulate instruments with audible dampers.

23.1.7 LFOs
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Display and Shell
Parameters for the two
LFOs.
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Analog’s two LFOs can be used as modulation sources for the oscillators, filters and ampli-
fiers. As with the other sections, each LFO has independent parameters.

The LFO 1 and LFO 2 switches in the shell toggle the respective LFO on and off, while the
Rate knob sets the LFO's speed. The switch next to this knob toggles the Rate between
frequency in Hertz and tempo-synced beat divisions.

The Wave chooser in the display selects the waveform for the LFO. The choices are sine,
triangle, rectangle and two types of noise. The first noise type steps between random values
while the second uses smooth ramps. With Tri or Rect selected, the Width slider allows you
to adjust the pulse width of the waveform. With Tri selected, low Width values shift the
waveform towards an upwards sawtooth, while higher values result in a downward saw. At
50%, the waveform is a perfect triangle. The behavior is similar with the Rect setting. At
50%, the waveform is a perfect square wave, while lower and higher values result in negative
or positive pulses, respectively. Note that Width is disabled when the LFO’s waveform is set
to sine or the noise modes.

The Delay slider sets how long it will take for the LFO to start after the note begins, while
Rate sets how long it takes the LFO to reach its full amplitude.

With Retrig enabled, the LFO restarts at the same position in its phase each time a note is
triggered. The Offset slider adjusts the phase of the LFO's waveform.

23.1.8 Global Parameters
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The Global shell and display parameters adjust how Analog responds to MIDI data, as well
as controls for performance parameters such as vibrato and glide.

Display and Shell
Parameters for the
Global Options.
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The Volume control in the shell adjusts the overall output of the instrument. This is the
instrument’s master level, and can boost or attenuate the output of the ampilifier sections.

The Vib switch turns the vibrato effect on or off, while the percentage slider next to it adjusts
the amplitude of the vibrato. Analog’s vibrato effect is essentially an additional LFO, but is
hardwired to the pitch of both oscillators. The Rate slider sets the speed of the vibrato.

Turning on the vibrato effect enables the four additional Vibrato parameters in the display.
The Delay slider sets how long it will take for the vibrato to start after the note begins, while
Attack sets how long it takes for the vibrato to reach full intensity.

The Error slider adds a certain amount of random deviation to the Rate, Amount, Delay and
Attack parameters for the vibrato applied to each polyphonic voice.

The Amt<MW slider adjusts how much the modulation wheel will affect the vibrato intensity.
This control is relative to the value set by the Amount percentage slider in the shell.

The Uni switch in the shell turns on the unison effect, which stacks multiple voices for each
note played. The Detune slider next to this switch adjusts the amount of tuning variation
applied to each stacked voice.

Turning on the unison effect enables the two additional Unison parameters in the display.
The Voices chooser selects between two or four stacked voices, while the Delay slider
increases the lag time before each stacked voice is activated.

The Gli switch turns the glide effect on or off. This is used to make the pitch slide between
notes rather than changing immediately. With Legato enabled, the sliding will only occur if
the second note is played before the first note is released. The Time slider sets the overall
speed of the slide.

Turning on the glide effect enables an additional Glide Mode chooser in the display. Se-
lecting Const causes the glide time to be constant regardless of interval. Choosing Prop
(proportional) causes the glide time to be proportional to the interval between the notes.
Large intervals will glide slower than small intervals.

The Keyboard section in the display contains all of Analog’s polyphony and tuning parame-
ters. The Voices chooser sets the available polyphony, while Priority determines which notes
will be cut off when the maximum polyphony is exceeded. When Priority is set to High,
new notes that are higher than currently sustained notes will have priority, and notes will be
cut off starting from the lowest pitch. Low is the opposite. A Priority setting of Last gives
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priority to the most recently played notes, cutting off the oldest notes as necessary.

The Octave, Semi and Tuning controls function as coarse and fine tuners. Octave transposes
the entire instrument by octaves, while Semi transposes up or down in semitone increments.
The Tuning slider adjusts in increments of one cent (up to a maximum of 50 cents up or
down).

PB Range sets the range in semitones of pitch bend modulation.

Stretch simulates a technique known as stretch tuning, which is a common tuning modifica-
tion made to electric and acoustic pianos. At 0%, Analog will play in equal temperament,
which means that two notes are an octave apart when the upper note’s fundamental pitch is
exactly twice the lower note’s. Increasing the Stretch amount raises the pitch of upper notes
while lowering the pitch of lower ones. The result is a more brilliant sound. Negative values
simulate “negative” stretch tuning; upper notes become flatter while lower notes become
sharper.

The Error slider increases the amount of random tuning error applied to each note.

The four Quick Routing buttons in the left side of the display provide an easy way to quickly
set up common parameter routings. The upper left option configures a parallel routing
structure, with each oscillator feeding its own filter and amplifier exclusively. The upper
right button is similar, but the oscillators each split their output evenly between the two
filters. The bottom left option feeds both oscillators into Filter 1 and Amp 1, disabling Filter
2 and Amp 2 entirely. Finally, the bottom right option configures a serial routing structure,
with both oscillators feeding Filter 1, which is then fed exclusively to Filter 2 and Amp 2.

Note that the Quick Routing options do not affect any changes you may have made to
the oscillator level, tuning or waveform parameters — they only adjust the routing of the
oscillators to the filters and subsequent amplifiers.
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23.2 Collision
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Collision is a synthesizer that simulates the characteristics of mallet percussion instruments.
Created in collaboration with Applied Acoustics Systems, Collision uses physical modeling
technology to model the various sound generating and resonant components of real (or
imagined) objects.

The full version of Collision is not included with the standard version of Live, but is bundled
with the Corpus effect as a special feature available for purchase separately.

23.2.1 Architecture and Interface

Collision’s sound is produced by a pair of oscillators called Mallet and Noise, which feed a
pair of independent (or linked) stereo resonators. While the oscillators produce the initial
component of the sound, it is the resonator parameters that have the greatest impact on
the sound’s character.

Collision’s interface is divided into tabs, which are further divided into sections. The Excitator
tab contains the controls for the Mallet and Noise oscillators. The Resonator tabs contain
the parameters for the independent resonator sections, while the Link tab allows you to
adjust both resonators simultaneously.

The LFO tab contains two independent low-frequency oscillators (LFOs), which can each
modulate multiple parameters. Similarly, the MIDI tab allows for MIDI pitch bend, modula-
tion wheel and aftertouch messages to be routed to multiple destinations.

To the right of the resonators is a section of global parameters, including overall output
volume, polyphony and resonator routing options.

The Collision Instrument.
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In addition to serving as organizational aids, Collision’s tabs contain LEDs that light up to
indicate that their contained sections are active. Disabling unused sections can save CPU.

23.2.2 Excitator Tab

The Excitator tab contains parameters for the Mallet and Noise sections. These model the
behavior of a mallet striking a surface, and provide Collision’s fundamental sound. These
section’s parameters only control the initial impulse, which is a much smaller component of
Collision’s overall sound than the resonators.

Note that if both the Mallet and Noise sections are turned off, Collision will not make sound.

The Mallet Section
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The Mallet section simulates the impact of a mallet against a surface. The parameters adjust
the physical properties of the mallet itself.

Volume controls the overall output level of the mallet section, while the Noise knob sets the
amount of impact noise that is included in each mallet strike. This is useful for simulating
the “chiff” sound of a felt-wrapped mallet head. The Volume and Noise parameters can be
modulated by pitch and velocity by adjusting the K (Key) and V (Velocity) sliders, respectively.

The Stiffness knob adjusts the hardness of the mallet. At low levels, the mallet is soft, which
results in fewer high frequencies and a longer, less distinct impact. As you increase the
stiffness, the impact time decreases and high frequencies increase. This parameter can also
be modulated by pitch and velocity via the Key and Vel sliders.

Collision’s Mallet
Section.
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The Color knob sets the frequency of the noise component. At higher values, there are less
low frequencies in the noise. This parameter has no effect if Noise is set to 0.

The Mallet section can be toggled on or off via the switch next to its name.

The Noise Section
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The Noise section can be used instead of, or in addition to, the Mallet section. Like the
Mallet, the Noise section produces Collision’s initial impulse sound. But Noise also produces
a white noise component, which is then fed into a multimode filter and a dedicated envelope
generator.

Volume controls the overall output level of the Noise section, and can be modulated by pitch
and velocity by adjusting the K (Key) and V (Velocity) sliders below the knob, respectively.

To the right are the filter controls. The type chooser allows you to choose between low-pass,
high-pass, and two types of band-pass filters. Filter cutoff and resonance can be adjusted
by the sliders above the filter display, or by dragging within the display itself. In BP mode,
the second slider adjusts resonance, while in LP+HP mode, it adjusts bandwidth. The filter
frequency can also be modulated by note pitch, velocity or the envelope generator, via the
K, V and E sliders below the display.

The envelope generator is a standard ADSR (attack, decay, sustain, release).

The attack time — how quickly Noise reaches full volume - is set with the A (Attack) slider,
while the time it takes for the envelope to reach the sustain level after the attack phase is
set by the D (Decay) slider.

The S (Sustain) slider sets the level at which the envelope will remain from the end of the

Collision’s Noise
Section.
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decay phase to the release of the key. When this slider is set to O, there is no sustain phase.
With it set to 100, there is no decay phase.

Finally, the release time is set with the R (Release) slider. This is the time it takes for the
envelope to reach zero after the key is released.

The Noise section can be toggled on or off via the switch next to its name.

23.2.3 Resonator Tabs
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The majority of Collision’s character is determined by the parameters in the two Resonator
tabs. Each stereo resonator can be toggled on or off via the switch in its tab. Keep in mind
that if both resonators are turned off, no sound will be produced.

Each resonator section is further divided into three subsections. On the left are controls
related to tuning. In the center are the controls that determine the physical properties of the
resonant object. To the right are mixer controls. Each resonator’s center subsection contains
a "Copy to” button. Pressing this button copies this subsection’s parameter settings from
the currently selected resonator to the other resonator.

The "“link” tab between the Resonator tabs allows you to adjust parameters for both res-
onators simultaneously. The behavior here is similar to what happens when you edit the
properties for a multi-selection of clips: parameters that have differing values will display the
value range (either on the control for knobs or in the status bar for sliders and choosers) and
can be adjusted with the linked control. Dragging the parameter to its absolute maximum
or minimum value will make the settings thereafter identical, adjustable as a single value.

Collision’s Resonators.
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Tuning Section
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The Tune and Fine knobs function as coarse and fine tuning controls. Tune moves up or
down in semitone increments, while Fine adjusts in increments of one cent (up to a maximum

of one quarter tone (50 cents) up or dow

n).

The Key slider below the Tune knob controls how much the resonator’s tuning is adjusted
by changes in MIDI note pitch. The default value of 100% means that the resonator will
conform to a conventional equal tempered scale. At 200%, each half step on the keyboard
will result in a whole step change in tuning. At negative values, the resonator will drop in

pitch as you play higher on the keyboard

The Pitch Envelope parameters apply a ramp that modulates the resonator’s pitch over time.
Pitch sets the starting pitch while Time adjusts how long it will take the pitch to glide to its
final value. The starting pitch can be modulated by velocity via the Vel slider.

Physical Properties Section
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The type chooser allows you to select from seven types of physically modeled resonant
objects:

¢ Beam simulates the resonance properties of beams of different materials and sizes.

e Marimba, a specialized variant of the Beam model, reproduces the characteristic tuning
of marimba bar overtones which are produced as a result of the deep arch-cut of the
bars.

e String simulates the sound produced by strings of different materials and sizes.

e Membrane is a model of a rectangular membrane (such as a drum head) with a variable
size and construction.

e Plate simulates sound production by a rectangular plate (a flat surface) of different
materials and sizes.

e Pipe simulates a cylindrical tube that is fully open at one end and has a variable
opening at the other (adjusted with the Opening parameter.)

e Tube simulates a cylindrical tube that is closed at both ends.

The quality chooser controls the tradeoff between the sound quality of the resonators and
performance by reducing the number of overtones that are calculated. “Basic” uses minimal
CPU resources, while “Full” creates more sophisticated resonances. This parameter is not
used with the Pipe or Tube resonators.

The Decay slider adjusts the internal damping of the resonator, which determines its decay
time. Off Decay determines the extent to which MIDI note off messages mute the resonance.
At 0%, note offs are ignored, and the decay time is based only on the value of the Decay
parameter. This is similar to how real-world mallet instruments such as a marimbas and
glockenspiels behave. At 100%, the resonance is muted immediately at note off, regardless
of the Decay time.

The Material slider adjusts the variation of the damping at different frequencies. At lower
values, low frequency components decay slower than high frequency components (which
simulates objects made of wood, nylon or rubber). At higher values, high frequency com-
ponents decay slower (which simulates objects made of glass or metal). This parameter is
not used with the Pipe or Tube resonators.

The Radius parameter is only available for the Pipe and Tube resonators. This slider adjusts
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the radius of the pipe or tube. As the radius increases, the decay time and high frequency
sustain both increase. At very large sizes, the fundamental pitch of the resonator also
changes.

The Decay and Material/Radius parameters can also be controlled with the X-Y controller,
and modulated by note pitch and velocity via the sliders below the X-Y panel.

Ratio is only available for the Membrane and Plate resonators, and adjusts the ratio of the
object’s size along its x and y axes.

The Brightness control adjusts the amplitude of various frequency components. At higher
values, higher frequencies are louder. This parameter is not used with the Pipe or Tube
resonators.

The Inharmonics knob adjusts the pitch of the resonator’s harmonics. At negative values,
frequencies are compressed, increasing the amount of lower partials. At positive values,
frequencies are stretched, increasing the amount of upper partials. This parameter is not
used with the Pipe or Tube resonators. Inharmonics can also be modulated by velocity via
the slider below the knob.

Opening, which is only available for the Pipe resonator, scales between an open and closed
pipe. At 0%, the pipe is fully closed on one side, while at 100% the pipe is open at both
ends. This parameter can also be modulated by velocity via the slider below the knob.

The Listening L and R controls adjust the location on the left and right resonator where the
vibrations are measured. At 0%, the resonance is monitored at the object's center. Higher
values move the listening point closer to the edge. These parameters are not used with
the Pipe or Tube resonators, which are always measured in the middle of their permanently
open end.

The Hit knob adjusts the location on the resonator at which the object is struck or otherwise
activated. At 0%, the object is hit at its center. Higher values move the activation point
closer to the edge. This parameter is not used with the Pipe or Tube resonators. The Hit
position can also be randomized by increasing the value of the Rd. (Random) slider below

the knob.
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Mixer Section
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Each resonator has its own Volume and Pan controls. Pan can also be modulated by note
pitch via the K (Key) slider below the knob.

The Bleed control mixes a portion of the original oscillator signal with the resonated signal.
At higher values, more of the original signal is applied. This is useful for restoring high
frequencies, which can often be damped when the tuning or quality are set to low values.

23.2.4 LFO Tab
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Collision’s two independent LFOs can be used as modulation sources for a variety of excitator
and resonator parameters, which are selectable in the Destination choosers. Additionally,
they can modulate each other.

The LFO 1 and LFO 2 switches toggle the respective LFO on and off, while the waveform
chooser determines the wave shape. The choices are sine, square, triangle, sawtooth up,

Resonator Mixer.

Collision’s LFOs.
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sawtooth down and two types of noise. The first noise type steps between random values
while the second uses smooth ramps.

The switch next to the waveform chooser toggles the LFO's rate between frequency in Hertz
and tempo-synced beat divisions.

Depth sets the overall intensity of the LFO, while Rate adjusts its speed. The sliders below
these parameters allow for additional modulations; Depth can be modulated by velocity
while Rate can be modulated by note pitch.

With Retrig. enabled, triggering a note restarts the LFO with the waveform phase set by
the Offset parameter. The Offset slider adjusts the phase.

Each LFO can modulate two targets, which are set via the Destination choosers. The intensity
of the modulations is adjusted with the Amount sliders. Note that these modulation amounts
are relative to the LFO's Depth value.

23.2.5 MIDI Tab
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The MIDI tab allows for a wide variety of internal MIDI mappings. The MIDI controllers
Pitch Bend, Modulation Wheel, and Aftertouch can be mapped to two destinations each,
with independent modulation intensities set via the Amount sliders. Note that pitch bend
is hardwired to pitch modulation, but can still be routed to an additional target.

Collision’s MIDI Tab.
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The Global Section
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The global section contains the parameters that relate to the overall behavior and perfor-
mance of Collision.

The Volume knob acts as Collision’s master output control.

Collision contains a built-in limiter that automatically activates when the audio level is too
high. This is indicated by the LED above Collision’s global Volume control.

The Structure buttons determine whether Collision’s resonators are arranged in series (1 >
2) orin parallel (1 + 2).

When in series, Mallet and Noise output to Resonator 1. This resonator’s output is then
mixed down to mono and routed to Resonator 2, as well as to its own mixer (in stereo.)
Note that Resonator 1 must be turned on when using serial mode:

Mallet \
Resonator 1
Noise / \

In parallel mode, the output of Mallet and Noise is mixed and then sent directly to both
resonators, which then output to their own mixers.

Resonator2 —

Collision’s Global
Section.

Resonatorsin 1> 2
(Serial) Configuration.
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Mallet
\ Resonator 1 —

Resonator2 —

Noise

The Voices chooser sets the available polyphony. Since each voice that's used requires
additional CPU, you may need to experiment with this chooser to find a good balance
between playability and performance, particularly on older machines.

With Retrig. enabled, notes which are already sounding will be immediately stopped when
retriggered, rather than generating an additional voice. This can be useful for keeping CPU
down when working with long decay times.

23.2.6 Sound Design Tips

Although Collision has been designed to model the behavior of objects that exist in the
physical world, it is important to remember that these models allow for much more flexibility
than their physical counterparts. While Collision can produce extremely realistic simulations
of conventional mallet instruments such as marimbas, vibraphones and glockenspiels, it
is also very easy to “misuse” the instrument’s parameters to produce sounds which could
never be made by an acoustic instrument.

To program realistic instrument simulations, it helps to think about the chain of events that
produces a sound on a mallet instrument (a marimba, for example), and then visualize those
events as sections within Collision:

e a beater (Mallet) strikes a tuned bar (Resonator 1).
e the tuned bar's resonance is amplified by means of a resonating tube (Resonator 2).

Thus the conventional model consists of the Mallet excitator and the two resonators in a
serial (1 > 2) configuration.

Of course, to program unrealistic sounds, anything goes:

Resonatorsin 1 + 2
(Parallel) Configuration.
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e try using the Noise excitator, particularly with long envelope times, to create washy,
quasi-granular textures. These parameters can also be used to simulate special acous-
tic effects such as bowed vibraphones or crystal glasses.

e experiment with the resonators in parallel (1 + 2) configuration.
e use the LFOs and MIDI controllers to modulate Collision’s parameters.

A word of caution: in many ways, Collision’s models are idealized versions of real-world
objects. Consequently, it is very easy to program resonances that are much more sensitive
to input than any physical resonator could be. Certain combinations of parameters can cause
dramatic changes in volume. Make sure to keep output levels low when experimenting with
new sounds.

23.3 Drum Machines

Drum Machines is a multisampled collection of classic drum computers, recorded and pro-
grammed by Puremagnetik. The samples are arranged into Drum Rack presets, for easy
editing and performance possibilities.

The full version of Drum Machines is not included with the standard version of Live, but is a
special feature available for purchase separately.

23.3.1 Drum Machines Installation

Drum Machines is installed separately from the main Live installation. To install, drag the
Drum Machines Live Pack into the Live application window, either from your operating
system or from Live's Browser.

After you have installed the Drum Machines Live Pack, you will need to authorize it. Further
details can be found at the Ableton website!.

1 http://www.ableton.com/authorize
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23.3.2 Accessing the Drum Machines

After installation, the Drum Machines presets are accessed through Live's Device Browser, in
exactly the same way as Live's other built-in instruments. You will find them as categorized
presets within the Drum Rack folder. Drum Machines presets are therefore loaded just like
any other device, by dragging a preset from the Browser into an empty MIDI track.

All of the Drum Machines presets are conveniently mapped to Macro Controls for greater
expression.

Additionally, Drum Machines includes a comprehensive collection of Live Clips, which are
installed to your Library. Loading a Live Clip to an empty MIDI track loads a combination of
MIDI notes, an instrument and custom effects that you can use as a starting point for your
own creative work.

23.4 Electric

@ Electric Aals@ @
MALLET FORK DAMPER PICKUP GLOBAL
Noisa Tine Tone Keybd
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Vel Vel Stretch
50 % /R | 50% 3/% | 61% 34% |-1.1dB
Key Key Key Key Type  Key P. Bend
[e4%d Fi00% I <7 %4

Electric is a software electric piano based on the classic instruments of the seventies, and
developed in collaboration with Applied Acoustics Systems. Each component of these
instruments has been modeled using cutting edge physical modeling technology to provide
realistic and lively sounds. Physical modeling uses the laws of physics to reproduce the
behavior of an object. In other words, Electric solves, in real time, mathematical equations
describing how its different components function. No sampling or wavetables are used
in Electric; the sound is simply calculated in real time by the CPU according to the values
of each parameter. Electric is more than a simple recreation of vintage instruments; its

The Electric Instrument.



CHAPTER 23. LIVE INSTRUMENT REFERENCE 376

parameters can be tweaked to values not possible with the real instruments to get some
truly amazing new sounds that still retain a warm acoustic quality.

The full version of Electric is not included with the standard version of Live, but is a special
feature available for purchase separately.

23.4.1 Architecture and Interface

The mechanism of the electric piano is actually quite simple. A note played on the keyboard
activates a mallet that hits a fork. The sound of that fork is then amplified by a magnetic
coil pickup and sent to the output, very much like an electric guitar. The fork is made of
two parts, called the tine bar and tone bar. The tine bar is where the mallet hits the fork
while the tone bar is a tuned metal resonator, sized appropriately to produce the correct
pitch. Once the fork is activated, it will continue to resonate on its own for a long time. But
releasing the key applies a damper to the fork, which mutes it more quickly.

The Electric interface is divided into five main sections, some of which are further divided
into related subsections. The first four main sections (Mallet, Fork, Damper and Pickup)
correspond to the sound producing components mentioned above. The Global section
contains parameters that affect overall behavior and performance, such as pitch bend and

polyphony.

23.4.2 Mallet Section

The Mallet section contains the parameters related to the physical properties of the mallet
itself, as well as how it's affected by your playing.

The Stiffness control adjusts the hardness of the mallet’s striking area. Higher values simulate
a harder surface, which results in a brighter sound. Lower values mean a softer surface and
a more mellow sound. The Force knob adjusts the intensity of the mallet's impact on the
fork. Low values simulate a soft impact while high values mean a hard impact.

The stiffness and force can also be modified by velocity and note pitch, via the Vel and Key
sliders found below the knobs.
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The Noise subsection simulates the impact noise caused by the mallet striking the fork. The
Decay knob adjusts how long it takes for this noise to fade to silence, while the Pitch control
sets the center frequency. Level adjusts the overall volume of the noise component. An
additional Key scaling control adjusts how much the noise volume is determined by note

pitch.

23.4.3 Fork Section

The Fork section is further divided into Tine and Tone subsections. This area is the heart of
Electric’'s sound generating mechanism.

The Tine subsection controls the portion of the fork that is directly struck by the mallet.
The Decay knob adjusts how long it takes the tine's sound to fade out while a note is
held. The Color knob controls the relative amplitude of high and low partials in the tine’s
spectrum. Low values increase the amount of low harmonics, while higher values result in
higher harmonics. The amplitude of the tine is adjusted with the Level knob. This level can
be further modulated by note pitch via the Key scaling control.

The Tone subsection controls the secondary resonance of the fork. Decay and Level param-
eters here work in the same way as their Tine counterparts.

The Release knob applies to both the Tine and Tone areas and controls the decay time of
the fork’s sound after a key is released.

23.4.4 Damper Section

The metal forks in an electric piano are designed to sustain for a long time when a key
is held. The mechanism that regulates this sustain is called the damper. When a key is
pressed, that note’s damper is moved away from its fork. When the key is released, the
damper is applied to the fork again to stop it from vibrating. But the dampers themselves
make a small amount of sound, both when they are applied and when they are released.
This characteristic noise is modelled in Electric’s Damper section.

The Tone knob adjusts the stiffness of the dampers. Turning this control to the left simulates
soft dampers, which produces a mellower sound. Turning it to the right increases the
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hardness of the dampers, producing a brighter sound. The overall amount of damper noise
is adjusted with the Level control.

The Att/Rel knob adjusts whether or not damper noise is present when the dampers are
applied to the fork or when they are released. When turned to the left, damper noise is only
present during the attack phase of the note. When turned to the right, the noise is present
only during the release phase. In the center, an equal amount of noise will be added during
both the attack and release.

23.4.5 Pickup Section

The Pickup section simulates the behavior of the magnetic coil pickup that amplifies the
sound of the resonating fork.

The R-W buttons switch between two different types of pickups. In the R position, Electric
simulates electro-dynamic pickups, while W is based on an electro-static model.

The Input knob is used to adjust the amount of the fork’s signal that is fed to the pickup,
which in turn affects the amount of distortion applied to the overall signal. The Output knob
controls the amount of signal output by the pickup section. Different combinations of these
two knobs can yield very different results. For example, a low amount of input with a high
amount of output will produce a cleaner sound than a high input with a low output. The
output level can be further modulated by note pitch via the Key scaling control.

The Symmetry and Distance knobs adjust the physical location of the pickup in relation to
the tine. Symmetry simulates the vertical position of the pickup. In the center position, the
pickup is directly in front of the tine, which results in a brighter sound. Turning the knob to
the left or right moves the pickup below or above the tine, respectively. Distance controls
how far the pickup is from the tine. Turning the knob to the right increases the distance,
while turning it to the left moves the pickup closer. Note that the sound becomes more
overdriven as the pickup approaches the tine.

23.4.6 Global Section

The Global section contains the parameters that relate to the overall behavior and perfor-
mance of Electric.
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The Volume knob sets Electric’s overall output level.

The Voices chooser sets the available polyphony. Since each voice that’s used requires
additional CPU, you may need to experiment with this chooser to find a good balance
between playability and performance, particularly on older machines.

The Semi and Detune controls function as coarse and fine tuners. Semi transposes the entire
instrument up or down in semitone increments, while the Detune slider adjusts in increments
of one cent (up to a maximum of 50 cents up or down).

Stretch simulates a technique known as stretch tuning, which is a common modification
made to both electric and acoustic pianos and is an intrinsic part of their characteristic
sound. At 0%, Electric will play in equal temperament, which means that two notes are
an octave apart when the upper note’s fundamental pitch is exactly twice the lower note’s.
But because the actual resonance behavior of a vibrating tine or string differs from the
theoretical model, equal temperament tends to sound “wrong” on pianos. Stretch tuning
attempts to correct this by sharpening the pitch of upper notes while flattening the pitch
of lower ones. The result is a more brilliant sound. Negative values simulate “negative”
stretch tuning; upper notes become flatter while lower notes become sharper.

P Bend sets the range in semitones of pitch bend modulation.

23.5 External Instrument
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The External Instrument device is not an instrument itself, but rather a routing utility that

The External Instrument.
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allows you to easily integrate external (hardware) synthesizers, ReWire devices and multi-
timbral plug-ins into your projects. It sends MIDI out and returns audio.

The two MIDI To choosers select the output to which the device will send MIDI data. The
top chooser selects either a physical MIDI port, a ReWire slave destination or a multitimbral
plug-in. If you select a MIDI port (for use with an external synthesizer), the second chooser’s
options will be MIDI channel numbers. If you've chosen a ReWire slave such as Reason as
your routing target, the choices will be the specific devices available in the slave project:

Ext. Instrument <+ R
MID
Dr.REX 1 -
M Hardware Interface
MW subTractor 1
W rier
WOrREX 1
Redrum 1
Mo Dutput

If another track in your set contains a multitimbral plug-in, you can select this track in the
top chooser. In this case, the second chooser allows you to select a specific MIDI channel
in the plug-in.

The Audio From chooser provides options for returning the audio from the hardware synth,
plug-in, or ReWire device. If you're routing to a hardware synth, use this chooser to select
the ports on your audio interface that are connected to the output of your synth. The
available choices you'll have will depend on the settings in the Audio Preferences.

If you're routing to a ReWire slave, the Audio From chooser will list all of the audio channels
available in the slave. Select the audio channel that corresponds to the instrument to which
you are sending MIDI. If you're routing to a multitimbral plug-in on another track in your
Live Set, the Audio From chooser will list the auxiliary outputs in the plug-in. Note that the
main outputs will be heard on the track that contains the instrument.

The Gain knob adjusts the audio level coming back from the sound source. This level should
be set carefully to avoid clipping.

Since external devices can introduce latency that Live cannot automatically detect, you can
manually compensate for any delays by adjusting the Latency slider. The button next to this

ReWire Options Shown
in the Routing Choosers.
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slider allows you to set your latency compensation amount in either milliseconds or samples.
If your external device connects to Live via a digital connection, you will want to adjust your
latency settings in samples, which ensures that the number of samples you specify will be
retained even when changing the sample rate. If your external device connects to Live via
an analog connection, you will want to adjust your latency settings in milliseconds, which
ensures that the amount of time you specify will be retained when changing the sample
rate. Note that adjusting in samples gives you finer control, so even in cases when you're
working with analog devices, you may want to “fine tune” your latency in samples in order
to achieve the lowest possible latency. In this case, be sure to switch back to milliseconds
before changing your sample rate. Any latency introduced by devices within Live will
be compensated for automatically, so the latency slider will be disabled when using the
External Instrument Device to route internally. Latency adjustments when routing to ReWire
devices will probably not be necessary, as most ReWire-enabled programs also compensate
automatically. But if you feel that something is “off” in the timing of your set, try adjusting
this slider.

Note: If the Delay Compensation option is unchecked in the Options menu, the Latency

slider is disabled.

For more detailed information about routing scenarios with the External Instrument device,
please see the Routing and I/O chapter.

23.6 Impulse
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Impulse is a drum sampler with complex modulation capabilities. The eight drum samples

The Impulse Instrument.
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loaded into Impulse’s sample slots can be time-stretched, filtered and processed by enve-
lope, saturation, pan and volume components, nearly all of which are subject to random
and velocity-based modulation.

23.6.1 Sample Slots

Drag and drop samples into any of Impulse’s sample slots from the Browser or the Session
and Arrangement Views. Alternatively, each sample slot features a Hot-Swap button for
hot-swapping samples. Loaded samples can be deleted with your computer keyboard’s

or key.

Imported samples are automatically mapped onto your MIDI keyboard, providing that it is
plugged in and acknowledged by Live. C3 on the keyboard will trigger the leftmost sample,
and the other samples will follow suit in the octave from C3 to C4. Impulse’s eight slots
will appear labeled in the MIDI Editor’s key tracks when the Fold button is active, even if
the given key track is void of MIDI notes. Mapping can be transposed from the default by
applying a Pitch device, or it can be rearranged by applying a Scale device.

Each of the eight samples has a proprietary set of parameters, located in the area below the
sample slots and visible when the sample is clicked. Adjustments to sample settings are only
captured once you hit a new note — they do not affect currently playing notes. Note that
this behavior also defines how Impulse reacts to parameter changes from clip envelopes or
automation, which are applied once a new note starts. If you want to achieve continuous
changes as a note plays, you may want to use the Simpler.

Slot 8's parameters also include a Link button, located in the lower left corner, which links
slot 8 with slot 7. Linking the two slots allows slot 7’s activation to stop slot 8's playback,
and vice versa. This was designed with a specific situation in mind (but can, of course, be
used for other purposes): Replicating the way that closed hi-hats will silence open hi-hats.

Each slot can be played, soloed, muted or hot-swapped using controls that appear when
the mouse hovers over it.
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23.6.2 Start, Tune and Stretch

The Start control defines where Impulse begins playing a sample, and can be set up to
100 ms later than the actual sample beginning. The Transposition control adjusts the
transposition of the sample by +/- 48 semitones, and can be modulated by incoming note
velocity or a random value, as set in the appropriate fields.

The Stretch control has values from -100 to 100 percent. Negative values will shorten the
sample, and positive values will stretch it. Two different stretching algorithms are available:
Mode A is ideal for low sounds, such as toms or bass, while Mode B is better for high sounds,
such as cymbals. The Stretch value can also be modulated by MIDI note velocity.

23.6.3 Filter

The Filter section offers a broad range of filter types, each of which can impart different
sonic characteristics onto the sample by removing certain frequencies. The Frequency
control defines where in the harmonic spectrum the filter is applied; the Resonance control
boosts frequencies near that point. Filter Frequency can be modulated by either a random
value or by MIDI note velocity.

23.6.4 Saturator and Envelope

The Saturator gives the sample a fatter, rounder, more analog sound, and can be switched on
and off as desired. The Drive control boosts the signal and adds distortion. Coincidentally,
this makes most signals much louder, and should usually be compensated for by lowering
the sample’s volume control. Extreme Drive settings on low-pitched sounds will produce
the typical, overdriven analog synth drum sounds.

The envelope can be adjusted using the Decay control, which can be set to a maximum of
60 seconds. Impulse has two decay modes: Trigger Mode allows the sample to decay with
the note; Gate Mode forces the envelope to wait for a note off message before beginning
the decay. This mode is useful in situations where you need variable decay lengths, as is the
case with hi-hat cymbal sounds.
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23.6.5 Pan and Volume

Each sample has Volume and Pan controls that adjust amplitude and stereo positioning,
respectively. Both controls can be modulated: Pan by velocity and a random value, and
Volume by velocity only.

23.6.6 Global Controls

The parameters located to the right of the sample slots are global controls that apply to all
samples within Impulse’s domain. Volume adjusts the overall level of the instrument, and
Pitch adjusts the transposition of all samples. The Time control governs the time-stretching
and decay of all samples, allowing you to morph between short and stretched drum sounds.

23.6.7 Individual Outputs

When a new instance of Impulse is dragged into a track, its signal will be mixed with those
of the other instruments and effects feeding the audio chain of the track. It can oftentimes
make more sense to isolate the instrument or one of its individual drum samples, and send
this signal to a separate track. Please see the Routing chapter to learn how to accomplish
this for Impulse’s overall signal or for Impulse’s individual sample slots.

23.7 Latin Percussion

Latin Percussion is a multisampled library of acoustic percussion instruments from the worlds
of Brazilian, Afro-Cuban and African music. Developed in collaboration with e-instruments,
the collection consists of multi-articulation kits and instrument group presets, programmed
as Drum Racks for easy editing and performance possibilities. In addition to the instruments,
Latin Percussion comes with a collection of Live Sets that contain carefully programmed MIDI
patterns in a variety of traditional styles.

The full version of Latin Percussion is not included with the standard version of Live, butis a
special feature available for purchase separately.
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23.7.1 Latin Percussion Installation

Latin Percussion is installed separately from the main Live installation. To install, drag the
Latin Percussion Live Pack into the Live application window, either from your operating
system or from Live's Browser.

After you have installed Latin Percussion, you will need to authorize it. Further details can
be found at the Ableton website?.

23.7.2 Accessing the Latin Percussion Presets

After installation, the Latin Percussion presets are accessed through Live's Device Browser,
in exactly the same way as Live's other built-in instruments. You will find them in the Latin
Percussion folder within the Drum Rack folder. Latin Percussion presets are therefore loaded
just like any other device, by dragging a preset from the Browser into an empty MIDI track.

The “Latin Percussion Kit” presets load a complete collection of instruments. Individual
instrument groups are available in the preset folders.

Latin Parcussion

= B Bells A
> E Bells B
& P Balls €
» F Bells D

Preset Folders.

23.7.3 Modifying the Drum Racks

All of the Latin Percussion presets are conveniently mapped to Macro Controls for greater
expression. These include controls for tuning, room ambience and volume envelope.

From the Drum Rack’s Pad View, you can easily replace individual instruments or instrument
groups within the kit. For example, to swap one set of congas for another, use the Browser

2http://www.al::le‘con.com/authorize
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to navigate to the selected conga preset folder. Then drag the entire folder to the Drum
Rack’s pad view. This will replace all of the currently loaded conga components, leaving all
other pads alone. You can also unfold these preset folders to access individual instruments
within.

Latin Percussion also includes a collection of Live Sets, which are installed to your Library’s
"Clips” folder. These Sets load clips that combine MIDI notes and a percussion kit that you
can use as a starting point for your own creative work.

23.8 Operator
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Operator is an advanced and flexible synthesizer that combines the concept of “frequency
modulation” (FM) with classic subtractive and additive synthesis. It utilizes four multi-wave-
form oscillators that can modulate each other’s frequencies, creating very complex timbres
from a limited number of objects. Operator includes a filter section, an LFO and global
controls, as well as individual envelopes for the oscillators, filter, LFO and pitch.

With the release of Live 8, Operator has been dramatically overhauled with powerful new
features. Despite this, the interface is mostly unchanged, and presets and Sets that were
made with earlier versions of Operator are fully compatible with this update.

The full version of Operator is not included with the standard version of Live, but is a special
feature available for purchase separately.

The Operator
Instrument.
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23.8.1 General Overview

The interface of Operator consists of two parts: the display surrounded on either side by
the shell. The shell offers the most important parameters in a single view and is divided into
eight sections. On the left side, you will find four oscillator sections, and on the right side
from top to bottom, the LFO, the filter section, the pitch section and the global parameters.
If you change one of the shell parameters, the display in the center will automatically show
the details of the relevant section. When creating your own sounds, for example, you can
conveniently access the level and frequency of all oscillators at once via the shell, and then
adjust each individual oscillator's envelope, waveform and other parameters in its display.

Operator can be folded with the triangular button at its upper left. This is convenient if you
do not need to access the display details.
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Each of Operator’s oscillators can either output its signal directly or use its signal to modulate
another oscillator. Operator offers eleven predefined algorithms that determine how the
oscillators are connected. An algorithm is chosen by clicking on one of the structure icons
in the global display, which will appear if the bottom right (global) section of the shell is
selected. Signals will flow from top to bottom between the oscillators shown in an algorithm
icon. The algorithm selector can be mapped to a MIDI controller, automated, or modulated
in real time, just like any other parameter.

Operator Folded.
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Typically, FM synthesis makes use of pure sine waves, creating more complex waveforms
via modulation. However, in order to simplify sound design and to create a wider range of
possible sounds, we designed Operator to produce a variety of other waveforms, including
two types of noise. You can also draw your own waveforms via a partial editor. The
instrument is made complete with an LFO, a pitch envelope and a filter section. Note that
lots of “classic” FM synthesizers create fantastic sounds without using filters at all, so we
suggest exploring the possibilities of FM without the filter at first, and adding it later if
necessary.

Operator will keep you busy if you want to dive deep into sound design! If you want to break
the universe apart completely and reassemble it, you should also try modulating Operator’s
controls with clip envelopes or track automation.

23.8.2 Oscillator Section
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Built-in Waveforms

The oscillators come with a built-in collection of basic waveform types — sine, sawtooth,
square, triangle and noise — which are selected from the Wave chooser in the individual
oscillator displays. The first of these waveforms is a pure, mathematical sine wave, which
is usually the first choice for many FM timbres. We also added “Sine 4 Bit" and “Sine 8
Bit” to provide the retro sound adored by Cé4 fans, and “Saw D" and “Square D" digital
waveforms, which are especially good for digital bass sounds. The square, triangle and
sawtooth waveforms are resynthesized approximations of the ideal shape. The numbers
included in the displayed name (e.g., “Square 6") define how many harmonics are used
for the resynthesis. Lower numbers sound mellower and are less likely to create aliasing
when used on high pitches. There are also two built-in noise waveforms. The first, “Noise
Looped,” is a looping sample of noise. For truly random noise, choose “Noise White."”

User Waveforms

The “User” entry in the Wave chooser allows you to create your own waveforms by drawing
the amplitudes of the oscillator’s harmonics. You can also select one of the built-in waveforms
and then edit it in the same way. The small display next to the Wave chooser gives a realtime
overview of your waveform.

When your mouse is over the Oscillator display area, the cursor will change to a pencil.
Drawing in the display area then raises or lowers the amplitudes of the harmonics. As you
adjust the amplitudes, the Status Bar will show the number of the harmonic you're adjusting
as well as its amplitude. Holding (¢ ] and dragging will constrain horizontal mouse
movement, allowing you to adjust the amplitude of only one harmonic at a time.

You can switch between editing the first 16, 32 or 64 harmonics via the switches to the
right of the display. Higher harmonics can be generated by repeating the drawn partials
with a gradual fadeout, based on the settings in the Repeat chooser. Low Repeat values
result in a brighter sound, while higher values result in more high-end roll-off and a more
prominent fundamental. With Repeat off, partials above the 16th, 32nd or é4th harmonic
are truncated.

The B (PC)/ (Ctl & (Mac) context menu on the harmonics display offers options for
editing only the even or odd harmonics. Thisis setto “All” by default. The context menu also
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offers an option to toggle Normalize on or off. When enabled, the oscillator's overall output
level is maintained as you draw additional harmonics. When disabled, additional harmonics
add additional level. Note that the volume can become extremely loud if Normalize is off.

You can export your waveform in .ams format to the Library/Samples/Waveforms folder via
an option in the & (PC)/ (Ctl | (Mac) context menu. Ams files can be imported back
into Operator by dragging them from the Browser onto one of the oscillator's display areas.
Ams files can also be loaded into Simpler or Sampler.

Hint: Both the built-in and user waveforms can be copied and pasted from one oscillator to
another using the O (PC)/ (Ctl ] (Mac) context menu.

More Oscillator Parameters

The frequency of an oscillator can be adjusted in the shell with its Coarse and Fine controls.
An oscillator’s frequency usually follows that of played notes, but for some sounds it might
be useful to set one or more oscillators to fixed frequencies. This can be done for each
individual oscillator by activating the Fixed option. This allows the creation of sounds in
which only the timbre will vary when different notes are played, but the tuning will stay the
same. Fixed Mode would be useful, for example, in creating live drum sounds. Fixed Mode
also allows producing very low frequencies down to 0.1 Hz. Note that when Fixed Mode is
active, the frequency of the oscillator is controlled in the shell with the Frequency (Freq) and
Multiplier (Multi) controls.

Operator includes a special Osc<Vel control for each oscillator that allows altering frequency
as a function of velocity. This feature can be very useful when working with sequenced
sounds in which the velocity of each note can be adjusted carefully. Part of this functionality
is the adjacent Q (Quantize) button. If this control is activated, the frequency will only move
in whole numbers, just as if the Coarse control were being manually adjusted. If quantize is
not activated, the frequency will be shifted in an unquantized manner, leading to detuned
or inharmonic sounds (which very well could be exactly what you want...).

The amplitude of an oscillator depends on the Level setting of the oscillator in the shell
and on its envelope, which is shown and edited when the Envelope display is visible. The
envelopes can also be modified by note velocity and note pitch with the Vel and Key
parameters available in the Envelope section of each oscillator's display.



CHAPTER 23. LIVE INSTRUMENT REFERENCE 391

The phase of each oscillator can be adjusted using the Phase control in its display. With the
R (Retrigger) button enabled, the waveform restarts at the same position in its phase each
time a note is triggered. With R disabled, the oscillator is free-running.

As explained earlier oscillators can modulate each other when set up to do so with the
global display’s algorithms. When an oscillator is modulating another oscillator, two main
properties define the result: the amplitude of the modulating oscillator and the frequency
ratio between both oscillators. Any oscillator that is not modulated by another oscillator
can modulate itself, via the Feedback parameter in its display.

Aliasing

Aliasing distortion is a common side effect of all digital synthesis and is the result of the
finite sample rate and precision of digital systems. It mostly occurs at high frequencies. FM
synthesis is especially likely to produce this kind of effect, since one can easily create sounds
with lots of high harmonics. This also means that more complex oscillator waveforms, such
as “Saw 32,"” tend to be more sensitive to aliasing than pure sine waves. Aliasing is a
two-fold beast: A bit of it can be exactly what is needed to create a cool sound, yet a bit
too much can make the timbre unplayable, as the perception of pitch is lost when high
notes suddenly fold back into arbitrary pitches. Operator minimizes aliasing by working in
a high-quality Antialias mode. This is on by default for new patches, but can be turned off
in the global section. The Tone parameter in the global section also allows for controlling
aliasing. lts effect is sometimes similar to a lowpass filter, but this depends on the nature of
the sound itself and cannot generally be predicted. If you want to familiarize yourself with
the sound of aliasing, turn Tone up fully and play a few very high notes. You will most likely
notice that some notes sound completely different from other notes. Now, turn Tone down
and the effect will be reduced, but the sound will be less bright.



CHAPTER 23. LIVE INSTRUMENT REFERENCE 392

23.8.3 LFO Section
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The LFO in Operator can practically be thought of as a fifth oscillator. It runs at audio
rates, and it modulates the frequency of the other oscillators. It is possible to switch LFO
modulation on or off for each individual oscillator (and the filter) using the Dest. A buttons
in the LFO’s display. The intensity of the LFO’s modulation of these targets can be adjusted
by the Dest. A slider. The LFO can also be turned off entirely if it is unused.

The Dest. B chooser allows the LFO to modulate an additional parameter. The intensity of
this modulation is determined by the Dest. B slider.

The LFO offers a choice of classic LFO waveforms, sample and hold (S&H), and noise.
Sample and hold uses random numbers chosen at the rate of the LFO, creating the random
steps useful for typical retro-futuristic sci-fi sounds. The noise waveform is simply bandpass-
filtered noise.

Tip: FM synthesis can be used to create fantastic percussion sounds, and using the LFO
with the noise waveform is the key to great hi-hats and snares.

The frequency of the LFO is determined by the LFO Rate control in the shell, as well as
the low/high/sync setting of the adjacent LFO Range chooser. The frequency of the LFO
can follow note pitch, be fixed or be set to something in between. This is defined by the
Rate<Key parameter in the LFO's display. With the R (Retrigger) button enabled, the LFO
restarts at the same position in its phase each time a note is triggered. With R disabled, the
LFO is free-running.

The overall intensity of the LFO is set by the LFO Amount control in the shell. This parameter
scales both the Dest. A and B amounts and can be modulated by note velocity via the

Operator’s LFO
Parameters.
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display’s Amt<Vel control. The LFO's intensity is also affected by its envelope.

23.8.4 Envelopes

Operator has seven envelopes: one for each oscillator, a filter envelope, a pitch envelope
and an envelope for the LFO. All envelopes feature some special looping modes. Addition-
ally, the filter and pitch envelopes have adjustable slopes.

Each oscillator's volume envelope is defined by six parameters: three rates and three levels.
A rate is the time it takes to go from one level to the next. For instance, a typical pad sound
starts with the initial level "-inf dB” (which is silence), moves with an attack rate to its peak
level, moves from there to the sustain level with a decay rate, and then finally, after note-off
occurs, back to “-inf dB” at the release rate. Operator’s display provides a good overview of
the actual shape of any particular envelope and lets you directly adjust the curve by clicking
on a breakpoint and dragging. The breakpoints retain their selection after clicking, allowing
them to be adjusted with the keyboard’s cursor keys, if desired.

Hint: Envelope shapes can be copied and pasted from one oscillator to another in Operator
using the O (PC)/ [Ctrl |5 (Mac) context menu.

As mentioned above, the filter and pitch envelopes also have adjustable slopes. Clicking
on the diamonds between the breakpoints allows you to adjust the slope of the envelope
segments. Positive slope values cause the envelope to move quickly at the beginning, then
slower. Negative slope values cause the envelope to remain flat for longer, then move faster
at the end. A slope of zero is linear; the envelope will move at the same rate throughout
the segment.

With FM synthesis, it is possible to create spectacular, endless, permuting sounds; the key
to doing this is looping envelopes. Loop Mode can be activated in the lower left corner of
the display. If an envelope in Operator is in Loop Mode and reaches sustain level while the
note is still being held, it will be retriggered. The rate for this movement is defined by the
Loop Time parameter. (Note that envelopes in Loop Mode can loop very quickly and can
therefore be used to achieve effects that one would not normally expect from an envelope
generator.)

While Loop Mode is good for textures and experimental sounds, Operator also includes Beat
and Sync Modes, which provide a simple way of creating rhythmical sounds. If set to Beat
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Mode, an envelope will restart after the beat time selected from the Repeat chooser. In Beat
Mode, the repeat time is defined in fractions of song time, but notes are not quantized.
If you play a note a bit out of sync, it will repeat perfectly but stay out of sync. In Sync
Mode however, the first repetition is quantized to the nearest 16th note and, as a result, all
following repetitions are synced to the song tempo. Note that Sync Mode only works if the
song is playing, and otherwise it will behave like Beat Mode.

Note: To avoid the audible clicks caused by restarting from its initial level, a looped envelope
will restart from its actual level and move with the set attack rate to peak level.

There is also a mode called Trigger that is ideal for working with percussive sounds. In this
mode, note off is ignored. This means that the length of time a key is held has no effect on
the length of the sound.

The rates of all the envelopes in Operator can be scaled in unison by the Time control in
the global section of the shell. Note that beat-time values in Beat and Sync Modes are not
influenced by the global Time parameter. Envelope rates can be further modified by note
pitch, as dictated by the Time<Key parameter in the global section’s display. The rate of an
individual envelope can also be modified by velocity using the Time<Vel parameter. These
modulations in conjunction with the loop feature can be used to create very, very complex
things...

The pitch envelope can be turned on or off for each individual oscillator and for the LFO
using the Destination A-D and LFO buttons in its display. The intensity of this envelope’s
modulation of these targets can be adjusted by the Dest. A slider and the envelope can be
turned off altogether via the switch in the pitch section of the shell.

Like the LFO, the pitch envelope can modulate an additional parameter as chosen by the
Dest. B chooser. The intensity of this modulation is determined by the Amt. B slider and
the main Pitch Env value.

The pitch and filter envelopes each have an additional parameter called End, which deter-
mines the level the envelope will move to after the key is released. The rate of this envelope
segment is determined by the release time.

Tip: If the pitch envelope is only applied to the LFO and is looping, it can serve as another
LFO, modulating the rate of the first. And, since the envelope of the LFO itself can loop, it
can serve as a third LFO modulating the intensity of the first!
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23.8.5 Filter Section
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Operator’s filters can be very useful for modifying the sonically rich timbres created by the
oscillators. And, since the oscillators also provide you with the classic waveforms of analog
synthesizers, you can very easily build a subtractive synthesizer with them.

The filter section offers 14 different filter types including multiple varieties of lowpass,
bandpass, highpass and notch filters. The 12 and 24 dB modes refer to the amount of
attenuation. The 24 dB modes attenuate the filtered frequencies to a much greater degree
than the 12 dB types, and are commonly used in the creation of bass patches. The SVF
(state-variable filter) modes are 12 dB types but with a different architecture. They will
self-oscillate as their resonance is increased. The Ladder modes have 24 dB slopes and are
based on the filters found in some classic analog synthesizers.

The Envelope and Filter buttons in the filter section’s display area toggle between showing
the filter envelope and its frequency response. Filter cutoff frequency and resonance can
be adjusted in the shell or by dragging the filter response curve in the display area. Filter
frequency can also be modulated by note velocity, note pitch, the LFO and the filter enve-
lope. The Freg<Vel, Freq<Key and Envelope controls in the filter's display set these three
functions, respectively.

Tip: The @& (PC)/ ® (Mac) context menu on the Frequency knob contains an entry
called “Play by Key.” This automatically configures the filter for optimal key tracking by
setting Freq<Key to 100% and setting the cutoff to 466 Hz.

The filter’s signal can be routed through a waveshaper, whose curve type can be selected
via the Shaper chooser. The Drive slider boosts or attenuates the signal level being sent to
the waveshaper, while the overall balance between the dry and processed signals can be

Operators Filter Section.
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adjusted with the Dry/Wet control. With this set to 0%, the shaper and drive parameters are
bypassed.

23.8.6 Global Controls

The global section contains parameters that affect Operator’s overall behavior. Additionally,
the global display area provides a comprehensive set of modulation routing controls.

The maximum number of Operator voices (notes) playing simultaneously can be adjusted
with the Voices parameter in the global display. Ideally, one would want to leave this setting
high enough so that no voices would be turned off while playing, however a setting between
6 and 12 is usually more realistic when considering CPU power.

Tip: Some sounds should play monophonically by nature, which means that they should
only use a single voice. (A flute is a good example.) In these cases, you can set Voices to 1.
If Voices is set to 1, another effect occurs: Overlapping voices will be played legato, which
means that the envelopes will not be retriggered from voice to voice, and only pitch will
change.

A global Volume control for the instrument can be found in the global section of the shell,
and a Pan control is located in the global section’s display. Pan can be modulated by a
random factor or by note pitch, using the adjacent Rnd and Key controls, respectively.

The center of the global display allows for a wide variety of internal MIDI mappings. The
MIDI controllers Velocity, Key, Aftertouch, Pitch Bend and Mod Wheel can be mapped to two
destinations each, with independent modulation intensities set via the Amount sliders. Note
that Time<Key and pitch bend range have fixed assignments, although both modulation
sources can still be routed to an additional target. For more information about the available
modulation options, see the complete parameter list.
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23.8.7 Glide and Spread
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Operator includes a polyphonic glide function. When this function is activated, new notes
will start with the pitch of the last note played and then slide gradually to their own played
pitch. Glide can be turned on or off and adjusted with the Glide Time control in the pitch
display.

Operator also offers a special Spread parameter that creates a rich stereo chorus by using
two voices per note and panning one to the left and one to the right. The two voices are
detuned, and the amount of detuning can be adjusted with the Spread control in the pitch
section of the shell.

Tip: Whether or not spread is applied to a particular note depends upon the setting of
the Spread parameter during the note-on event. To achieve special effects, you could, for
instance, create a sequence where Spread is 0 most of the time and turned on only for some
notes. These notes will then play in stereo, while the others will play mono.

The pitch section also contains a global Transpose knob.

23.8.8 Strategies for Saving CPU Power

If you want to save CPU power, turn off features that you do not need or reduce the number
of voices. Specifically, turning off the filter or the LFO if they do not contribute to the sound
will save CPU power.

For the sake of saving CPU resources, you will also usually want to reduce the number
of voices to something between 6 and 12, and carefully use the Spread feature. The

Operator’s Pitch Section.
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Interpolation and Antialias modes in the global display can also be turned off to conserve
CPU resources.

Note that turning off the oscillators will not save CPU power.

23.8.9 Finally...

Operator is the result of an intense preoccupation with FM synthesis and a love and dedi-
cation to the old hardware FM synthesizers, such as the Yamaha SY77, the Yamaha TX81Z
and the NED Synclavier Il. FM synthesis was first explored musically by the composer and
computer music pioneer John Chowning in the mid-1960s. In 1973, he and Stanford Uni-
versity began a relationship with Yamaha that lead to one of the most successful commercial
musical instruments ever, the DX7.

John Chowning realized some very amazing and beautiful musical pieces based on a syn-
thesis concept that you can now explore yourself simply by playing with Operator in Live.

We wish you loads of fun with it!

23.8.10 The Complete Parameter List

The function of each Operator parameter is explained in the forthcoming sections. Remem-
ber that you can also access explanations of controls in Live (including those belonging to
Operator) directly from the software by placing the mouse over the control and reading the
text that appears in the Info View. Parameters in this list are grouped into sections based
on where they appear in Operator.

Global Shell and Display

Time - This is a global control for all envelope rates.

Tone — Operator is capable of producing timbres with very high frequencies, which can
sometimes lead to aliasing artifacts. The Tone setting controls the high frequency content
of sounds. Higher settings are typically brighter but also more likely to produce aliasing.

Volume — This sets the overall volume of the instrument.
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Algorithm — An oscillator can modulate other oscillators, be modulated by other oscillators,
or both. The algorithm defines the connections between the oscillators and therefore has a
significant impact on the sound that is created.

Voices — This sets the maximum number of notes that can sound simultaneously. If more
notes than available voices are requested, the oldest notes will be cut off.

Retrigger (R) — When enabled, notes that are enabled will be retriggered, rather than gen-
erating an additional voice.

Interpolation — This toggles the interpolation algorithm of the oscillators and the LFO. If
turned off, some timbres will sound more rough, especially the noise waveform. Turning
this off will also save some CPU power.

Antialias — This toggles Operator’s high-quality antialias mode, which helps to minimize
high-frequency distortion. Disabling this modes reduces the CPU load.

Time<Key — The rates of all envelopes can be controlled by note pitch. If the global
Time<Key parameter is set to higher values, the envelopes run faster when higher notes are

played.
Pitch Bend Range (PB Range) — This defines the effect of MIDI pitch bend messages.

Pan —Use this to adjust the panorama of each note. This is especially useful when modulated
with clip envelopes.

Pan<Key (Key) — If Pan<Key is set to higher values, low notes will pan relatively more to the
left channel, and higher notes to the right. Typically this is used for piano-like sounds.

Pan<Random (Rnd) — This defines the extent to which notes are randomly distributed be-
tween the left and right channels.

Modulation Targets

These modulation targets are available as MIDI routing destinations in the global display,
and also as modulation targets for the LFO and pitch envelope.

Off - Disabled this controller's modulation routing.

OSC Volume A-D — Modulates the volume of the selected oscillator.
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OSC Crossfade A/C — Crossfades the volumes of the A and C oscillators based on the value
of the modulation source.

OSC Crossfade B/D — Crossfades the volumes of the B and D oscillators based on the value
of the modulation source.

OSC Feedback — Modulates the amount of feedback for all oscillators. Note that feedback
is only applied to oscillators that are not modulated by other oscillators.

FM Drive — Modulates the volume of all oscillators which are modulating other oscillators,
thus changing the timbre.

Filter Frequency — Modulates the cutoff frequency of the filter.

Filter Q — Modulates the resonance of the filter.

Filter Envelope Amount — Modulates the filter's envelope intensity.

Shaper Drive — Modulates the amount of gain applied to the filter's waveshaper.
LFO Rate — Modulates the rate of the LFO.

LFO Amount — Modulates the intensity of the LFO.

Pitch Envelope Amount — Modulates the intensity of the pitch envelope.
Volume - Modulates Operator’s global output volume.

Panorama — Modulates the position of Operator’s output in the stereo field.
Tone — Modulates the global Tone parameter.

Time — Modulates the global control for all envelope rates.

Pitch Shell and Display

Pitch Envelope On — This turns the pitch envelope on and off. Turning it off if it is unused
saves some CPU power.

Pitch Envelope Amount (Pitch Env) — This sets the overall intensity of the pitch envelope. A
value of 100% means that the pitch change is exactly defined by the pitch envelope’s levels.
A value of -100% inverts the sign of the pitch envelope levels.
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Spread — If Spread is turned up, the synthesizer uses two detuned voices per note, one
each on the left and right stereo channels, to create chorusing sounds. Spread is a very
CPU-intensive effect.

Transpose — This is the global transposition setting for the instrument. Changing this pa-
rameter will affect notes that are already playing.

Pitch Envelope Rates<Velocity (Time<Vel) — This parameter exists for filter, pitch, LFO and
volume envelopes. It is therefore listed in the section on envelopes.

Glide (G) — With Glide on, notes will slide from the pitch of the last played note to their
played pitch. Note that all envelopes are not retriggered in this case if notes are being
played legato.

Glide Time (Time) — This is the time it takes for a note to slide from the pitch of the last
played note to its final pitch when Glide is activated. This setting has no effect if Glide is
not activated.

Pitch Envelope to Osc (Destination A-D) — The pitch envelope affects the frequency of the
respective oscillator if this is turned on.

Pitch Envelope to LFO (Destination LFO) — The pitch envelope affects the frequency of the
LFO if this is turned on.

Pitch Envelope Amount A - This sets the intensity of the pitch envelope’s modulation of the
oscillators and LFO.

Pitch Envelope Destination B — This sets the second modulation destination for the pitch
envelope.

Pitch Envelope Amount B — This sets the intensity of the pitch envelope’s modulation of the
secondary target.

Filter Shell and Display

Filter On - This turns the filter on and off. Turning it off when it is unused saves CPU power.

Filter Type — This chooser selects one of 14 filter types, including a variety of lowpass,
highpass, bandpass and notch filters. The filter names imply the part of the spectrum they
affect. A notch filter passes everything apart from its center frequency and is more audible
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with low resonance settings. The 24 dB filter modes attenuate the filtered frequencies to a
much greater degree than the 12 dB modes. The Ladder and SVF filters provide additional
filter architectures.

Filter Frequency (Freq) — This defines the center or cutoff frequency of the filter. Note that
the resulting frequency may also be modulated by note velocity and by the filter envelope.

Filter Resonance (Res) - This defines the resonance around the filter frequency of the lowpass
and highpass filters, and the width of the bandpass and notch filters.

Envelope / Filter Switches — These switches toggle the display between the filter’s envelope
and its frequency response.

Filter Frequency<Velocity (Freq<Vel) - Filter frequency is modulated by note velocity ac-
cording to this setting.

Filter Frequency<Key (Freq<Key) - Filter frequency is modulated by note pitch according
to this setting. A value of 100% means that the frequency doubles per octave. The center
point for this function is C3.

Filter Envelope Rates<Velocity (Time<Vel) — This parameter exists for filter, pitch, LFO and
volume envelopes. It is therefore listed in the section on envelopes.

Filter Frequency<Envelope (Envelope) - Filter frequency is modulated by the filter envelope
according to this setting. A value of 100% means that the envelope can create a maximum
frequency shift of approximately 9 octaves.

Shaper — This chooser selects the curve for the filter's waveshaper.
Drive — This boosts or attenuates the signal level being sent to the waveshaper.

Dry/Wet — This adjusts the balance between the dry signal and the signal processed by the
waveshaper.

LFO Shell and Display

LFO On - This turns the LFO (low-frequency oscillator) on and off. Turning it off when it is
unused saves some CPU power.
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LFO Waveform — Select from among several typical LFO waveforms. Sample and Hold
creates random steps, and Noise supplies bandpass-filtered noise. All waveforms are band-
limited to avoid unwanted clicks.

LFO Range — The LFO covers an extreme frequency range. Choose Low for a range from
50 seconds to 30 Hz, or Hi for 8 Hz to 12 kHz. Sync causes the LFO's rate to be synced to
your Set's tempo. Due to the possible high frequencies, the LFO can also function as a fifth
oscillator.

Retrigger (R) — When enabled, the LFO restarts at the same position in its phase each time
a note is triggered. With R disabled, the LFO is free-running.

LFO Rate (Rate) — This sets the rate of the LFO. The actual frequency also depends on the
setting of the LFO Range and the LFO Rate<Key controls.

LFO Amount (Mod) - This sets the overall intensity of the LFO. Note that the actual effect
also depends on the LFO envelope.

LFO to Osc (Destination A-D) — The LFO modulates the frequency of the respective oscillator
if this is turned on.

LFO Amount A - This sets the intensity of the LFO's modulation of the oscillators and filter.
LFO Destination B — This sets the second modulation destination for the LFO.
LFO Amount B - This sets the intensity of the LFO’s modulation of the secondary target.

LFO Envelope Rates<Velocity (Time<Vel) — This parameter exists for filter, pitch, LFO and
volume envelopes. It is therefore listed in the section on envelopes.

LFO Rate<Key (Rate<Key) - The LFO's frequency can be a function of note pitch. If this is set
to 100%, the LFO will double its frequency per octave, functioning like a normal oscillator.

LFO Amount<Velocity (Amt<Vel) — This setting adjusts modulation of the LFO intensity by
note velocity.

Oscillators A-D Shell and Display

Osc On - This turns the oscillator on and off.
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Osc Coarse Frequency (Coarse) — The relationship between oscillator frequency and note
pitch is defined by the Coarse and Fine parameters. Coarse sets the ratio in whole numbers,
creating a harmonic relationship.

Osc Fine Frequency (Fine) — The relationship between oscillator frequency and note pitch
is defined by the Coarse and Fine parameters. Fine sets the ratio in fractions of whole
numbers, creating an inharmonic relationship.

Osc Fixed Frequency On (Fixed) — In Fixed Mode, oscillators do not respond to note pitch
but instead play a fixed frequency.

Osc Fixed Frequency (Freq) — This is the frequency of the oscillator in Hertz. This frequency
is constant, regardless of note pitch.

Osc Fixed Multiplier (Multi) — This is used to adjust the range of the fixed frequency. Multiply
this value with the value of the oscillator’s Freq knob to get actual frequency in Hz.

Osc Output Level (Level) — This sets the output level of the oscillator. If this oscillator is
modulating another, its level has significant influence on the resulting timbre. Higher levels
usually create bright and/or noisy sounds.

Envelope / Oscillator Switches — These switches toggle the display between the oscillator’s
envelope and its harmonics editor.

16/32/64 - These switches set the number of partials that are available for user editing.

Osc Waveform (Wave) — Choose from a collection of carefully selected waveforms. You can
then edit them via the harmonics editor.

Osc Feedback (Feedback) — An oscillator can modulate itself if it is not modulated by another
oscillator. The modulation is dependent not only on the setting of the feedback control but
also on the oscillator level and the envelope. Higher feedback creates a more complex
resulting waveform.

Osc Phase (Phase) — This sets the initial phase of the oscillator. The range represents one
whole cycle.

Retrigger (R) — When enabled, the oscillator restarts at the same position in its phase each
time a note is triggered. With R disabled, the oscillator is free-running.

Repeat — Higher harmonics can be generated by repeating the drawn partials with a gradual
fadeout, based on the settings in the Repeat chooser. Low Repeat values result in a
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brighter sound, while higher values result in more high-end roll-off and a more prominent
fundamental. With Repeat off, partials above the 16th, 32nd or 64th harmonic are truncated.

Osc Frequency<Velocity (Osc<Vel) — The frequency of an oscillator can be modulated by
note velocity. Positive values raise the oscillator’s pitch with greater velocities, and negative
values lower it.

Osc Freg<Vel Quantized (Q) — This allows quantizing the effect of the Frequency<Velocity
parameter. If activated, the sonic result is the same as manually changing the Coarse
parameter for each note.

Volume Envelope Rates<Velocity (Time<Vel) — This parameter exists for filter, pitch, LFO and
volume envelopes. It is therefore listed in the section on envelopes.

Osc Output Level<Velocity (Vel) - This defines how much the oscillator’s level depends upon
note velocity. Applying this to modulating oscillators creates velocity-dependent timbres.

Osc Output Level<Key (Key) — This defines how much the oscillator’s level depends upon
note pitch. The center point for this function is C3.

Envelope Display

Envelope Attack Time (Attack) — This sets the time it takes for a note to reach the peak level,
starting from the initial level. For the oscilltor envelopes, the shape of this segment of the
envelope is linear. For the filter and pitch envelopes, the shape of the segment can be
adjusted.

Envelope Decay Time (Decay) — This sets the time it takes for a note to reach the sustain
level from the peak level. For the oscillator envelopes, the shape of this segment of the
envelope is exponential. For the filter and pitch envelopes, the shape of the segment can
be adjusted.

Envelope Release Time (Release) — This is the time it takes for a note to reach the end level
after a note-off message is received. For the oscillator envelopes, this level is always -inf
dB and the shape of the segment is exponential. For the filter and pitch envelopes, the
end level is determined by the End Level parameter and the shape of the segment can be
adjusted. This envelope segment will begin at the value of the envelope at the moment the
note-off message occurs, regardless of which segment is currently active.
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Envelope Initial Level (Initial) — This sets the initial value of the envelope.
Envelope Peak Level (Peak) — This is the peak level at the end of the note attack.

Envelope Sustain Level (Sustain) — This is the sustain level at the end of the note decay. The
envelope will stay at this level until note release unless it is in Loop, Sync or Beat Mode.

Envelope End Level (End) - (Filter and pitch envelopes only) This is the level reached at the
end of the Release stage.

Envelope Mode (Mode) - If this is set to Loop, the envelope will start again after the end of
the decay segment. If set to Beat or Sync, it will start again after a given beat-time. In Sync
Mode, this behavior will be quantized to song time. In Trigger mode, the envelope ignores
note off.

Envelope Beat/Sync Rate (Repeat) — The envelope will be retriggered after this amount of
beat-time, as long as it is still on. When retriggered, the envelope will move at the given
attack rate from the current level to the peak level.

Envelope Loop Time (Time) — If a note is still on after the end of the decay/sustain segment,
the envelope will start again from its initial value. The time it takes to move from the sustain
level to the initial value is defined by this parameter.

Envelope Rates<Velocity (Time<Vel) — Envelope segments will be modulated by note ve-
locity as defined by this setting. This is especially interesting if the envelopes are looping.
Note that this modulation does not influence the beat-time in Beat or Sync Modes, but the
envelope segments themselves.

The filter and pitch envelopes also provide parameters that adjust the slope of their envelope
segments. Positive slope values cause the envelope to move quickly at the beginning, then
slower. Negative slope values cause the envelope to remain flat for longer, then move faster
at the end. A slope of zero is linear; the envelope will move at the same rate throughout
the segment.

Attack Slope (A.Slope) — Adjusts the shape of the Attack envelope segment.
Decay Slope (D.Slope) — Adjusts the shape of the Decay envelope segment.
Release Slope (R.Slope) — Adjusts the shape of the Release envelope segment.
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Context Menu Parameters

Certain operations and parameters in Operator are only available via the 3 (PC)/ 9
(Mac) context menu. These include:

Copy commands for Oscillators — The & (PC) / [Ctl & (Mac) context menu of the
oscillator’s shell and envelope display provide options for copying parameters between
oscillators.

Envelope commands -The @ (PC)/ © (Mac) context menu for all envelope displays
provide options to quickly set all envelope levels to maximum, minimum, or middle values.

Harmonics editor commands—The 3 (PC)/ (Cul ] & (Mac) context menu for the harmonics
editor can restrict partial drawing to even or odd harmonics and toggle normalization of an
oscillator's output level. There is also a command to export the waveform as an .ams file.

Play By Key — This command, in the @ (PC)/ ® (Mac) context menu for the filter's
Freq control, optimizes the filter for key tracking by setting the cutoff to 466 Hz and setting
the Freq<Key to 100%.

23.9 Orchestral Strings, Brass, Woodwinds and Percussion

Orchestral Strings, Brass, Woodwinds and Percussion are high-quality orchestral sample
libraries created in collaboration with SONiVOX. These multi-gigabyte collections are care-
fully multisampled at a variety of velocities and with a number of articulations.

These products are not included with the standard version of Live, but are special features
available for purchase separately.

23.9.1 Installation

The orchestral libraries are installed separately from the main Live installation. To install,
drag the relevant Live Packs into the Live application window, either from your operating
system or from Live's Browser.



CHAPTER 23. LIVE INSTRUMENT REFERENCE 408

After you have installed the libraries of your choice, you will need to authorize them. Further
details can be found at the Ableton website3.

23.9.2 Using the Orchestral Presets

After installation, the orchestral instruments are accessed through Live's Device Browser, in
exactly the same way as Live's other built-in instruments. You will find them as categorized
presets within the Instrument Rack folder. These instruments are therefore loaded just like
any other device, by dragging a preset from the Browser into an empty MIDI track.

The presets are available in Full and Lite versions, allowing you to choose the right balance
of fidelity and polyphony for your needs. The Lite versions reduce CPU, RAM and disk
requirements by reducing the number of zones and sample layers used. Both the Full and
Lite presets use 24-bit multisamples. Additionally, you can Hot-Swap between different
quality levels of the same preset and any Macro edits you have already made will be
preserved after the swap.

There are also LE Packs available for each library which contain very efficient versions of the
instruments suitable for sketching out ideas. The LE instruments are all composed of 16-bit
sample files.

All of the orchestral presets are conveniently mapped to Macro Controls for greater expres-
sion.

Each instrument is available in Solo and Section presets which contain all available articula-
tions. Additionally, each instrument'’s articulation is available as a separate preset.

In the multi-articulation presets, the various articulations are separated into individual chains
in the Rack. You can switch between them in real time via the “Articulation” Macro control.

3http://www.able'con.com/authorize
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23.10 Sampler
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Sampler is a sleek yet formidable multisampling instrument that takes full advantage of Live’s
agile audio engine. It has been designed from the start to handle multi-gigabyte instrument
libraries with ease, and it imports most common library formats. But with Sampler, playback
is only the beginning; its extensive internal modulation system, which addresses nearly every
aspect of its sound, makes it the natural extension of Live’s sound-shaping techniques.

The full version of Sampler is not included with the standard version of Live, but is a special
feature available for purchase separately. Sampler users who want to share their presets
with all Live users can convert their work to Simpler presets. To do this, & (PC)/ [Ctl |8
(Mac) on Sampler's title bar and choose the Sampler -> Simpler command.

Getting started with Sampler is as easy as choosing a preset from the Device Browser. Like
all of Live's devices, Sampler’s presets are located in folders listed beneath its name. Presets
imported from third-party sample libraries are listed here, too, in the Imports folder.

Once you have loaded a Sampler preset into a track, remember to arm the track for recording
(which also enables you to hear any MIDI notes you might want to play), and then start

playing!

23.10.1 Multisampling

Before going on, let’s introduce the concept of multisampling. This technique is used to
accurately capture the complexity of instruments that produce dynamic timbral changes.
Rather than rely on the simple transposition of a single recorded sample, multisampling

The Sampler Instrument.
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captures an instrument at multiple points within its critical sonic range. This typically means
capturing the instrument at different pitches as well as different levels of emphasis (played
softly, moderately, loudly, etc.). The resulting multisample is a collection of all the individually
recorded sample files.

Sampler is designed to let you approach multisampling on whatever level you like: You can
load and play multisample presets, like those from Ableton’s Essential Instrument Collection,
import multisamples from third-party vendors, or create your own multisamples from scratch.

Importing Third-Party Multisamples

To import a third-party multisample, navigate to the file in Live’s File Browser and double-
click to import it into the Live Library. (Note that AKAl-formatted CD-ROMs require one
step before this can be done — please see the next section.)

Importing will create new Sampler presets, which you can find in the Device Browser under
Sampler/Imported. Live automatically brings up the Device Browser to show the new
presets, ready to drag in, sort, rename or delete.

Note that some multisample files will be converted to Instrument Rack presets that contain
several Sampler instances used to emulate the original more accurately.

For all multisample formats except Apple EXS24/GarageBand and Kontakt, Live will import
the actual audio data into the Library, where they will appear as new samples (found under
Samples/Imported). This means the new Sampler presets will work regardless of whether
the original multisample file is still around.

To import Apple EXS24/GarageBand and Kontakt multisamples, Live will create new Sampler
presets that reference the original WAV or AIF files. This means that removing the original
WAV or AIF files will render the new Sampler presets useless. Live's File Manager offers the
option to collect and save these external samples into the Library.

Mounting AKAI Multisample CDs

To import multisamples from AKAl-formatted CD-ROMs, you first have to mount the CD-
ROM so that Live can “see” its contents. This is only necessary because the legacy AKAI
CD format cannot be processed by the operating system like standard CD-ROM formats,
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which are mounted automatically upon inserting and can be browsed as usual with Live's
File Browser. Here are the steps:

1. Insert the AKAl-formatted sample CD.

2. On aMac, click on the title bar of Live's File Browser and select “All Volumes.” On
a PC, navigate Live’s File Browser to the Workspace by clicking on the Browser’s
title bar and selecting “Workspace.”

3. Click on the Browser item found at the bottom named “Find Sample CDs...”

4. Double-click the item that appears to import the CD’s contents.

23.10.2 Sampler's Tabs

Once you begin working with Sampler, you will notice that its features are organized categor-
ically into tabs, accessed from Sampler’s title bar. In addition to serving as an organizational
aid, each tab has LEDs that indicate if there is modulation information in the corresponding
area. We will get to know Sampler by examining each of these tabs.
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23.10.3 The Zone Tab
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Clicking on the Zone tab toggles the display of Sampler’s Zone Editor, which offers a hands-
on interface for mapping any number of samples across three types of ranges.

The Zone Editor opens in its own dedicated view, directly above the Track View. When used
in conjunction with Sampler’s other tabs, this layout greatly accelerates the creation and
editing of multisamples.

On the left side of the Zone Editor is the sample layer list, where multisamples are organized.
All of the individual samples belonging to a multisample are shown in this list, where they
are referred to as layers. For complex multisamples, this list can be quite long. Pressing @
(PC)/ [ctl |8 (Mac) within the sample layer list opens a context menu that offers a variety
of options for sorting and displaying the layers, distributing them across the keyboard and
various other sample management and “housekeeping” options.

The rest of the view is occupied by one of three editors that correspond to the sample layers:
the Key Zone Editor, the Velocity Zone Editor and the Sample Select Editor. These editors
can be horizontally zoomed by pressing & (PC)/ [Ctl ] & (Mac) within them to bring up
a context menu with sizing options.

Auto Select (Auto) — As MIDI notes arrive at Sampler, they are filtered by each sample layer’s
key, velocity and sample select zones. With Auto Select enabled, all sample layers that are
able to play an incoming note will become selected in the sample layer list for the duration
of that note.

Zone Fade Mode (Lin/Pow) — These buttons toggle the fade mode of all zones between
linear and constant-power (exponential) slopes.

The Key Zone Editor.
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Zone Editor View (Key/Vel/Sel) — These buttons toggle the display of the Key Zone, Velocity
Zone and Sample Select Editors.

The Sample Layer List

All samples contained in the currently loaded multisample are listed here, with each sample
given its own layer. For very large multisamples, this list might be hundreds of layers long!
Fortunately, layers can be descriptively named (according to their root key, for example).
Mousing over a layer in the list or a zone in the zone editors will display relevant information
about the corresponding sample in the Status Bar. Selecting any layer will load its sample
into the Sample tab for examination.

Key Zones

Key zones define the range of MIDI notes over which each sample will play. Samples are
only triggered when incoming MIDI notes lie within their key zone. Every sample has its
own key zone, which can span anywhere from a single key up to the full 127.

A typical multisampled instrument contains many individual samples, distributed into many
key zones. Samples are captured at a particular key of an instrument’s voice range (known
as their root key), but may continue to sound accurate when transposed a few semitones up
or down. This range usually corresponds to the sample’s key zone; ranges beyond this zone
are represented by additional samples, as needed.

By default, the key zones of newly imported samples cover the full MIDI note range. Zones
can be moved and resized like clips in the Arrangement View, by dragging their right or left
edges to resize them, then dragging them into position.

Zones can also be faded over a number of semitones at either end by dragging their top
right or left corners. This makes it easy to smoothly crossfade between adjacent samples as
the length of the keyboard is traversed. The Lin and Pow boxes above the sample layer list
indicate whether the zones will fade in a linear or exponential manner.
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Velocity Zones
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Velocity zones determine the range of MIDI Note On velocities that each sample will respond
to. The timbre of most musical instruments changes greatly with playing intensity. Therefore,
the best multisamples capture not only individual notes, but also each of those notes at
different velocities.

The Velocity Zone Editor, when toggled, appears alongside the sample layer list. Velocity is
measured on a scale of 1-127, and this number range appears across the top of the editor.
The functionality of the Velocity Zone Editor is otherwise identical to that of the Key Zone
Editor.

Sample Select Zones
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Each sample also has a Sample Select zone, which is a data filter that is not tied to any
particular kind of MIDI input. Sample Select zones are very similar to the Chain Select Zones

The Velocity Zone Editor.

The Sample Select
Editor.
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found in Racks, in that only samples with sample select values that overlap the current value
of the sample selector will be triggered.

The Sample Select Editor, when toggled, appears alongside the sample layer list. The
editor has a scale of 0-127, similar to the Velocity Zone Editor. Above the value scale is the
draggable indicator known as the sample selector.

Please note that the position of the sample selector only determines which samples are
available for triggering. Once a sample has been triggered, changing the position of the
sample selector will not switch to a different sample during playback.

23.10.4 The Sample Tab
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The playback characteristics of individual samples are set within the Sample tab. Most of
this tab is dedicated to displaying the waveform of the currently selected sample. Mousing
over the waveform will display relevant information about the sample in the Status Bar. It is
important to keep in mind that most of the values in this tab reflect the state of the currently
selected sample only. The Sample chooser always displays the current sample layer’s name,
and is another way to switch between layers when editing.

The RootKey, Detune, Vol and Pan parameters add basic per-sample mixing tools for quick
assembly and tweaking of multisamples.

Reverse — This is a global, modulatable control that reverses playback of the entire multi-
sample. Unlike the Reverse function in the Clip View, a new sample file is not generated.
Instead, sample playback begins from the Sample End point, proceeds backwards through
the Sustain Loop (if active), and arrives at the Sample Start point.

The Sample Tab.
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Snap — Snaps all start and end points to the waveform zero-crossings (points where the
amplitude is zero) to avoid clicks. As with Simpler, this snap is based on the left channel of
stereo samples, so a small Crossfade value may be necessary in some cases to completely
eliminate clicks.

Sample - Displays the name of the current sample layer, and can be used to quickly select
from among the sample layers of the loaded multisample.

Root Key (RootKey) — Defines the root key of the current sample.
Detune — The sample tuning can be adjusted here by +/- 50 cents.
Volume — A wide-range volume control, variable from full attenuation to a gain of +24 dB.

Pan — Samples can be individually panned anywhere in the stereo panorama.

Sample Playback

All of the following sample-specific parameters work in conjunction with the global volume
envelope (in the Filter/Global tab) to create the basic voicing of the Sampler instrument. If
you are unfamiliar with how envelopes work, you will find that they are well documented in
Operator's Envelopes section.

All time-based values in this tab are displayed in either samples or hours:seconds:millise-
conds, which can be toggled using the @ (PC)/ [Ctl | (Mac) context menu on any
of their parameter boxes. Samples in this context refer to the smallest measurable unit in
digital audio, and not to the audio files themselves, which we more commonly refer to as
“samples.”

Sample Start — The time value where playback will begin. If the volume envelope’s Attack
parameter is set to a high value, the audible result may seem to begin some time later than
the value shown here.

Sample End - The time value where playback will end (unless a loop is enabled), even if the
volume envelope has not ended.

Sustain Mode - The optional Sustain Loop defines a region of the sample where playback
will be repeated while the note is in the sustain stage of its envelope. Activating the Sustain
Loop also allows the Release Loop to be enabled. This creates several playback options:
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No Sustain Loop — Playback proceeds linearly until either the Sample End is reached
or the volume envelope completes its release stage.

Sustain Loop Enabled — Playback proceeds linearly until Loop End is reached, when it
jumps immediately to Loop Start and continues looping. If Release Mode is OFF, looping
will continue inside the Sustain Loop until the volume envelope has completed its release
stage.

Back-and-Forth Sustain Loop Enabled — Playback proceeds to Loop End, then reverses
until it reaches Loop Start, then proceeds again towards Loop End. If Release Mode is OFF,
this pattern continues until the volume envelope has completed its release stage.

Link — Enabling the Link switch sets Sample Start equal to Loop Start. Note that the Sample
Start parameter box doesn't lose its original value — it simply becomes disabled so that it
can be recalled with a single click.

Release Mode — Whenever the Sustain Loop is active, Release Mode can also be enabled.

OFF - The volume envelope’s release stage is active, but will occur within the Sustain
Loop, with playback never proceeding beyond Loop End.

Release Enabled — When the volume envelope reaches its release stage, playback will
proceed linearly towards Sample End.

Release Loop Enabled —When the volume envelope reaches its release stage, playback
will proceed linearly until reaching Sample End, when it jumps immediately to Release Loop
and continues looping until the volume envelope has completed its release stage.

Back-and-Forth Release Loop Enabled — When the volume envelope reaches its release
stage, playback will proceed linearly until reaching Sample End, then reverses until it reaches
Release Loop, then proceeds again towards Sample End. This pattern continues until the
volume envelope has completed its release stage.

Sustain- and Release-Loop Crossfade (Crossfade) — Loop crossfades help remove clicks from
loop transitions. By default, Sampler uses constant-power fades at loop boundaries. But by
turning off “Use Constant Power Fade for Loops” in the & (PC)/ ® (Mac) context
menu, you can enable linear crossfades.

Sustain- and Release-Loop Detune (Detune) - Since loops are nothing more than oscillations,
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the pitch of samples may shift within a loop, relative to the loop’s duration. With Detune,
the pitch of these regions can be matched to the rest of the sample.

Interpolation (Interpol) — This is a global setting that determines the accuracy of transposed
samples. Be aware that raising the quality level above “Normal” will place significant
demands on your CPU.

RAM Mode (RAM) - This is also a global control that loads the entire multisample into RAM.
This mode can give better performance when modulating start and end points, but loading
large multisamples into RAM will quickly leave your computer short of RAM for other tasks.
In any case, it is always recommended to have as much RAM in your computer as possible,
as this can provide significant performance gains.

23.10.5 The Pitch/Osc Tab
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The Pitch/Osc Tab.

The Modulation Oscillator

Sampler features one dedicated modulation oscillator per voice, which can perform fre-
quency or amplitude modulation (FM or AM) on the multisample. The oscillator is fully
featured, with 21 waveforms, plus its own loopable amplitude envelope for dynamic wave-
shaping. Note that this oscillator performs modulation only — its output is never heard
directly. What you hear is the effect of its output upon the multisample.
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The Pitch Envelope

The pitch envelope modulates the pitch of the sample over time, as well as of the Modulation
Oscillator, if it is enabled. This is a multi-stage envelope with Initial, Peak, Sustain and End
levels. The time needed to travel between the levels is determined by the Attack, Decay and
Release settings. The values of the envelope parameters can be adjusted via the sliders, or
by dragging the breakpoints in the envelope’s display. Clicking on the diamonds between
the breakpoints allows you to adjust the slope of the envelope segments. Positive slope
values cause the envelope to move quickly at the beginning, then slower. Negative slope
values cause the envelope to remain flat for longer, then move faster at the end. A slope of
zero is linear; the envelope will move at the same rate throughout the segment.

23.10.6 The Filter/Global Tab
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The Filter

Sampler features a polyphonic filter with an optional integrated waveshaper. The Morph
filter types can morph continuously from lowpass to bandpass to highpass to notch and
back to lowpass. Naturally, filter morphs can be automated.

Classic 24 dB lowpass, bandpass and highpass modes supplement the morphable filter's 12
dB and 24 dB modes.

The filter's cutoff frequency can be modulated over time by a dedicated filter envelope,
which works similarly to the envelope in the Pitch/Osc tab.

The Filter/Global Tab.
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Four different curves can be chosen for the waveshaper, and its overall intensity can be
controlled with the Amount slider. In addition, the signal flow direction can be adjusted with
the button above the waveshaper area. With the triangle pointing up, the signal passes
from the shaper to the filter. With the triangle pointing down, it passes from the filter to the
shaper.

Sampler

Filter

ESkHz 6.82 0.0
vorph el W Allack
0 Ip'bp 100 % 010

E ﬁ :?.:.:'-l Amount The Filter/Shaper Order

Shaper 8.0
Button.

The Volume Envelope
The volume envelope is global, and defines the articulation of Sampler’s voices. Up to 32

voices are available simultaneously from each instance of the device. Voice retriggering can
optionally be enabled by activating the Retrigger button to the right of the Voices chooser.

23.10.7 The Modulation Tab
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The Modulation Tab.
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The Modulation tab offers an additional loopable envelope, plus three LFOs, all capable of
modulating multiple parameters, including themselves. Each LFO can be free running, or
synced to the Live Set’s tempo, and LFOs 2 and 3 can produce stereo modulation effects.

LFO Attack (Attack) — This is the time needed for the LFO to reach maximum intensity. Use
this, for example, to gradually introduce vibrato as a note is held.

LFO Retrigger (Retrig) — Enabling Retrigger for an LFO will cause it to reset to its starting
point, or initial phase, on each new MIDI note. This can create hybrid LFO shapes if the LFO
is retriggered before completing a cycle.

LFO Offset (Offset) — This changes the starting point, or initial phase of an LFO, so that
it begins at a different point in its cycle. This can create hybrid LFO shapes if the LFO is
retriggered before completing a cycle.

LFO Rate < Key (Key) — Also known as keyboard tracking, non-zero values cause an LFO'’s
rate to increase relative to the pitch of incoming MIDI notes.

LFO Stereo Mode (Stereo) — LFOs 2 and 3 can produce two types of stereo modulation:
Phase or Spin. In phase mode, the right and left LFO channels run at equal speed, and the
Phase parameter is used to offset the right channel from the left. In spin mode, the Spin
parameter can make the right LFO channel run up to 50% faster than the left.

23.10.8 The MIDI Tab
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Pitch Bend Range

The MIDI tab’s parameters turn Sampler into a dynamic performance instrument. The MIDI
controllers Key, Velocity, Release Velocity, Aftertouch, Modulation Wheel, Foot Controller
and Pitch Bend can be mapped to two destinations each, with varying degrees of influence.

The MIDI Tab.
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23.11 Session Drums

Session Drums is a multisampled library of acoustic drumkits recorded by Chocolate Audio.
The collection consists of both stereo and multimic presets, programmed as Drum Racks for
easy editing and performance possibilities.

The stereo presets are “production-ready” kits, carefully processed to reflect modern pro-
duction techniques while keeping CPU and memory usage to a minimum. These kits come
in both Full (24-bit) and LE (16-bit) versions.

The multimic presets provide maximum flexibility. Each instrument is recorded with multiple
microphones and with minimal processing. The individual drum chains contains samples of
both the original instrument (either from a close or internal mic, depending on the drum)
and its “bleed” into a variety of additional open microphones. Each of these levels can be
mixed independently.

For maximum realism, each drum chain contains carefully programmed MIDI effects that
switch between related samples automatically as notes are retriggered. This eliminates the
“machine gun” effect common to sampled drum libraries.

The full version of Session Drums is not included with the standard version of Live, but is a
special feature available for purchase separately.

23.11.1 Session Drums Installation

Session Drums is installed separately from the main Live installation. To install, drag the
Session Drums Live Packs into the Live application window, either from your operating
system or from Live's Browser.

After you have installed Session Drums, you will need to authorize it. Further details can be
found at the Ableton website*.

4http://www.able'con.com/authorize
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23.11.2 Accessing the Session Drums Presets

After installation, the Session Drums presets are accessed through Live’s Device Browser, in
exactly the same way as Live's other built-in instruments. You will find them as categorized
presets within the Drum Rack folder. Session Drums presets are therefore loaded just like
any other device, by dragging a preset from the Browser into an empty MIDI track.

The presets are arranged into Stereo and Multimic folders in the Browser. Complete kits
and individual drums are listed in separate folders in each section.

23.11.3 Mixing the Drums

Because the Session Drums presets are organized as Drum Racks, the individual instruments
can be mixed alongside tracks in the Session mixer. Additionally, the multimic presets include
three return chains, which also appear in the mixer and can be mixed independently:

e Snare Bottom — this chain controls the level of the ambient vibration of the snares for
each instrument

e Overhead - controls the level of the stereo overhead mics
e Room — controls the level of the stereo room mics

For both the stereo and multimic kits, each drum'’s close or internal mic is shown as a channel
in the Session View mixer.

23.11.4 Modifying the Drumkits

All of the Session Drums presets are conveniently mapped to Macro Controls for greater
expression. The specific mappings differ between the stereo and multimic presets, although
all presets include the following two:

e Hihat Pedal - this Macro adjusts the openness of the hihat. This is primarily a control
for use by keyboard players; if you have an electronic drumkit with a hihat pedal that
sends CC4 data, this will control hihat openness automatically.
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e Velocity Sensitivity — this Macro adjusts the dynamic range of the drumkit. As you turn
up this control, the kit will play louder at high velocity and softer at low velocities.

In the stereo presets, the additional Macros control tuning and decay times for the individual
drums in the kit. In the multimic presets, they control the ambience and room characteristics
of the return chains in the Drum Rack.

From the Drum Rack’s Pad View, you can easily replace individual instruments within the kit.
For example, to replace a snare drum with one from another kit, use the Browser to navigate
to the folder of the desired kit's snare presets. Then drag the entire folder to the Drum
Rack’s pad view. This will replace all of the currently loaded snare components, leaving all
other pads alone. Because Ableton’s drum collections share common note mappings, this
works when swapping between any instruments in the Session Drums or Drum Machines
libraries.

You can also easily replace single instrument components via Live’s hot-swap functionality.
To exchange only a single tom, for example, click on its pad’s Hot-Swap button. Live will
automatically list all matching presets in the Browser, allowing you to chose another tom. Of
course, if you would like to replace the tom with another kind of instrument, you can simply
navigate to another folder and make your selection there.

Session Drums also includes a comprehensive collection of Live Clips, which are installed to
your Library. Loading a Live Clip to an empty MIDI track loads a combination of MIDI notes,
a drum kit and custom effects that you can use as a starting point for your own creative work.
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23.12 Simpler
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Simpler is an instrument that integrates the basic elements of a sampler with a set of classic
synthesizer parameters. A Simpler voice plays a user-defined sample section, which is in
turn processed by envelope, filter, LFO, volume and pitch components.

Presets created in Simpler can be converted for use in Sampler, and vice-versa. To do
this, @ (PC)/ [Cul ] (Mac) on Simpler’s title bar and choose the Simpler -> Sampler
command. In this way, presets created in Simpler can be further edited with Sampler’s
extended functionality.

23.12.1 Sample View

The Sample View displays the sample waveform. Samples can be dragged into Simpler
either directly from the Browser, or from the Session or Arrangement View in the form of
clips. In the latter case, Simpler will utilize only the section of the sample demarcated by
the clip’s start/end or loop markers. Samples can be replaced by dragging in a new sample,
or by activating the integrated Hot-Swap button.

Note: When playing instruments from Ableton’s Essential Instrument Collection, Simpler
runs in Multisample Mode. The Sample View has no function in this mode.

The Simpler Instrument.
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23.12.2 Sample Controls

Simpler plays a specific region or loop of the sample, as determined by a group of sample
controls.

The Start and Length controls work together to specify where Simpler begins and ends its
sweep of the sample. As the name implies, Start defines where sample playback starts.
The sample will play for the length defined by the Length parameter. Both parameters are
defined as a percentage of the whole region, so setting start to 25 percent and length to
50 percent, for example, will start playback 1/4 of the way through the sample and stop
playback at the 3/4 mark (using 50 percent of the sample).

Samples are played by Simpler as one-shots or as loops, depending on whether or not the
Loop switch is active. When looping is active, the Loop control dictates the length of the
loop, starting from the end of the playing sample. Simpler will play the first instance of a
looped sample beginning with the Start point, then continue playing only the loop region.

When the sample’s start or end points are moved, Simpler will try to preserve the loop length
for as long as possible by automatically adjusting the Start, Loop and Length settings.

It is possible for glitches or pops to occur between a looped sample’s start and end points
due to the discontinuity in waveform amplitude (i.e., the sample’s loudness). The Snap
switch will help mitigate these by forcing Simpler's loop markers to snap to zero-crossing
points in the sample (points where the amplitude is zero). Note: Snapping is based on the
left channel of stereo samples. It is therefore still possible, even with Snap activated, to
encounter glitches with stereo samples.

The transition from loop end to loop start can be smoothed with the Fade control, which
crossfades the two points. This method is especially useful when working with long, textural
samples. By default, Simpler uses constant-power fades. But by turning off “Use Constant
Power Fade for Loops” inthe &3 (PC)/ &) (Mac) context menu, you can enable linear
crossfades.

23.12.3 Zoom

Quite often, one starts with a longer region of a sample and ends up using only a small part
of it. Simpler's Sample view can be zoomed and panned just as in other parts of Live — drag
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vertically to zoom, and drag horizontally to pan different areas of the sample into view.

23.12.4 Envelope

Simpler contains three classic ADSR envelopes, as seen in most synthesizers, for shaping
the dynamic response of the sample. Volume-, filter frequency-, and pitch modulation are
all modifiable by toggling their respective buttons in the envelope section. Attack controls
the time in milliseconds that it takes for the envelope to reach its peak value after a note is
played. Decay controls the amount of time it takes for the envelope to drop down to the
Sustain level, which is held until the note is released. Release time is the amount of time
after the end of the note that it takes for the envelope to drop from the Sustain level back
down to zero.

The influence of envelopes on pitch and filter cutoff can be decided using the envelope
amount (Env) controls in each of these sections.

23.12.5 Filter

The Filter section offers classic 12 dB or 24 dB lowpass, bandpass and highpass filters, as
well as a notch filter, each of which can impart different sonic characteristics onto the sample
by removing certain frequencies from the waveform. The most important parameters are
the typical synth controls Frequency and Resonance. Frequency determines where in the
harmonic spectrum the filter is applied; Resonance boosts frequencies near that point.

The best way to understand the effects of these controls is simply to play with them!

The Frequency parameter can be modulated by an LFO, note velocity and an envelope -
each of which have an amount control in the Filter section. The Key (tracking) control allows
for shifting the filter’s frequency according to note pitch.

23.12.6 LFO

The LFO (low-frequency oscillator) section offers sine, square, triangle, sawtooth down,
sawtooth up and random waveforms. The LFO run freely at frequencies between 0.01 and
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30 Hz, or sync to divisions of the Set’s tempo. LFOs are applied individually to each voice,
or played note, in Simpler.

The Key parameter scales each LFO's Rate in proportion to the pitch of incoming notes. A
high Key setting assigns higher notes a higher LFO rate. If Key is set to zero, all voices’
LFOs have the same rate and may just differ in their phase.

The LFO will modulate the filter, pitch, panorama and volume according to the setting of
the LFO amount controls in each of these sections.

The time required for the LFO to reach full intensity is determined by the Attack control.

23.12.7 Glide and Spread

Simpler includes a glide function. When this function is activated, new notes will start from
the pitch of the last note played and then slide gradually to their own pitch. Two glide
modes are available: Glide, which works monophonically, and Portamento, which works
polyphonically. Glide is also adjusted with the Glide Time control.

Simpler also offers a special Spread parameter that creates a rich stereo chorus by using
two voices per note and panning one to the left and one to the right. The two voices are
detuned, and the amount of detuning can be adjusted with the Spread control.

Tip: Whether or not spread is applied to a particular note depends upon the setting of
the Spread parameter during the note-on event. To achieve special effects, you could, for
instance, create a sequence where Spread is zero most of the time and turned on only for
some notes. These notes will then play in stereo, while the others will play mono.

23.12.8 Pitch, Pan, Volume and Voices

Simpler plays back a sample at its original pitch if the incoming MIDI note is C3, however the
Transpose control allows transposing this by +/- 48 semitones. Pitch can also be modulated
by an LFO or pitch envelope using the amount controls in this section. The pitch envelope is
especially helpful in creating percussive sounds. Simpler reacts to MIDI Pitch Bend messages
with a sensitivity of +/- 5 semitones. You can also modulate the Transpose parameter with
clip envelopes and external controllers.
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The Voices parameter sets the maximum number of voices that Simpler can play simultane-
ously. If more voices are needed than have been allocated by the Voices chooser, “voice
stealing” will take place, in which the oldest voice(s) will be dropped in favor of those that
are new. For example, if your Voices parameter is set to 8, and ten voices are all vying to
be played, the two oldest voices will be dropped. (Simpler does try to make voice stealing
as subtle as possible.) A small LED near the Voices control flashes when a voice has been
stolen.

Panorama is defined by the Pan control, but can be further swayed by randomness or
modulated by the LFO.

Finally, the output volume of Simpler is controlled by the Volume control, which can also be
dependent upon note velocity, as adjusted by the Velocity control. Tremolo effects can be
achieved by allowing the LFO to modulate the Volume parameter.

23.12.9 Strategies for Saving CPU Power

Real-time synthesis needs lots of computing power. However, there are strategies for
reducing CPU load. Save the CPU spent on Simpler by doing some of the following:

e Turn off the Filter if it is not needed.

o Use filter types that are less expensive when possible. A filter’s cost correlates with the
steepness of its slope — “LP24" is more expensive than “LP12.”

e Turn off the LFO for a slightly positive influence on CPU.

e Stereo samples need significantly more CPU than mono samples, as they require twice
the processing.

e Decrease the number of simultaneously allowed voices with the Voice control.
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23.13 Tension
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Tension is a synthesizer dedicated to the emulation of string instruments, and developed in
collaboration with Applied Acoustics Systems. The synthesizer is entirely based on physical
modeling technology and uses no sampling or wavetables. Instead, it produces sound by
solving mathematical equations that model the different components in string instruments
and how they interact. This elaborate synthesis engine responds dynamically to the control
signals it receives while you play thereby reproducing the richness and responsiveness of
real string instruments.

The full version of Tension is not included with the standard version of Live, but is a special
feature available for purchase separately.

Tension features four types of excitators (two types of hammer, a pick and a bow) an accurate
model of a string, a model of the fret/finger interaction, a damper model and different types
of soundboards. The combination of these different elements allows for the reproduction of
a wide range of string instruments. Tension is also equipped with filters, LFOs and envelope
parameters that extend the sound sculpting possibilities beyond what would be possible
with “real-world” instruments. Finally, Tension offers a wide range of performance features,
including keyboard modes, portamento, vibrato and legato functions.

23.13.1 Architecture and Interface

It is the vibration from the string which constitutes the main sound production mechanism
of the instrument. The string is set into motion by the action of an excitator which can be

The Tension Instrument.
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a hammer, a pick or a bow. The frequency of the oscillation is determined by the effective
length of the string, which is controlled by the finger/fret interaction or termination. A
damper can be applied to the strings in order to reduce the decay time of the oscillation.
This is the case on a piano, for example, when felt is applied to the strings by releasing the
keys and sustain pedal. The vibration from the string is then transmitted to the body of the
instrument, which can radiate sound efficiently. In some instruments, the string vibration
is transmitted directly to the body through the bridge. In other instruments, such as the
electric guitar, a pickup is used to transmit the string vibration to an amplifier. In addition to
these main sections, a filter section has been included between the string and body sections
in order to expand the sonic possibilities of the instrument.

The Tension interface is divided into two main tabs, which are further divided into sections.
The String tab contains all of the fundamental sound producing components related to the
string itself: Excitator, String, Damper, Termination, Pickup and Body. The Filter/Global
tab contains the Filter section, as well as controls for global performance parameters. Each
section (with the exception of String and the global Keyboard section) can be enabled or
disabled independently. Turning off a section reduces CPU usage.

23.13.2 String Tab

The String tab contains the parameters related to the physical properties of the string itself,
as well as the way in which it's played.

The Excitator Section
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The modelled string can be played using different types of excitators in order to reproduce
different types of instruments and playing techniques. The excitator is selected using
the Type chooser, and the choices available are Bow, Hammer, Hammer (bouncing) and
Plectrum.

Bow - this excitator is associated with bowed instruments such as the violin, viola or cello.
The bow sets the string in sustained oscillation. The motion of the bow hair across the string
creates friction, causing the string to alternate between sticking to the hair and breaking free.
The frequency of this alternation between sticking and slipping determines the fundamental
pitch.

The Force knob adjusts the amount of pressure being applied to the string by the bow. The
sound becomes more “scratchy” as you increase this value. The friction between the bow
and the string can be adjusted with the Friction control. Higher values usually result in a
faster attack. Velocity adjusts the speed of the bow across the string. Finally, the Vel and
Key sliders below these three controls allow you to modulate their behavior based on note
velocity or pitch, respectively.

Hammer and Hammer (bouncing) - these two excitator types simulate the behavior of soft
hammers or mallets. Hammer models a hammer that is located below the string and strikes
it once before falling away. This type of mechanism is found in a piano, for example.
Hammer (bouncing) models a hammer that is located above the string and is dropped onto
it, meaning that it can bounce on the string multiple times. This playing mode can be found
on a hammered dulcimer, for example.

The mass and stiffness of the hammer are adjusted with the (surprise) Mass and Stiffness
knobs, while Velocity controls the speed at which the hammer is struck against the string. As
with the Bow excitator, these three parameters can be further modulated by note velocity
and pitch by adjusting the Vel and Key sliders. The behavior of the hammer is further
controlled by the Damping knob, which adjusts how much of the hammer’s impact force
is absorbed back into the hammer. It is somewhat analogous to the Stiffness parameter,
but instead of controlling the stiffness of the hammer's surface it adjusts the stiffness of
the virtual “spring” that connects the hammer to the mass that powers it. As you increase
the Damping amount, the interaction between the hammer and string will become shorter,
generally resulting in a louder, brighter sound.

Plectrum - a plectrum or “pick” is associated with instruments such as guitars and harpsi-
chords. It can be thought of as an angled object placed under the string that snaps the
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string into motion.

The Prot knob (for “protrusion”) adjusts how much of the plectrum’s surface area is placed
under the string. Lower values results in a “thinner,” smaller sound, as there is less mass
setting the string into motion. The Stiffness, Velocity and Damping knobs behave similarly
to the Hammer mode. And as with the previous modes, all three of these parameters can
be modulated by velocity or note pitch via the Vel and Key sliders.

The Position knob is applicable to each excitator model, and specifies the point on the string
where the excitator makes contact. At 0%, the excitator contacts the string at its termination
point, while at 50% it activates the string at its midpoint. The behavior is a bit different if
the Fix. Pos switch is enabled, however. In this case, the contact point is fixed to a single
location, rather than changing as the length of the string changes. This behavior is similar
to that of a guitar, where the picking position is always basically the same regardless of the
notes being played. On a piano, the excitator position is relative - the hammers normally
strike the string at about 1/7th of their length - and so is best modelled with Fix. Pos turned
off. The excitator’s position can additionally be modulated by velocity or note pitch, via the
Vel and Key sliders.

The Excitator section can be toggled on or off via the switch next to its name. With it off,
the string can only be activated by interaction with its damper. (If both the Excitator and
Damper sections are disabled, nothing can set the string in motion - if you find that you're
not producing any sound, check to see that at least one of these sections is on.)

Please note that the Excitator section’s parameters work closely together to influence the
overall behavior of the instrument. You may find that certain combinations of settings result
in no sound at all, for example.
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The String Section
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The vibration of the string is the main component of a stringed instrument’s sound. The
effective length of the string is also responsible for the pitch of the sound we hear.

The theoretical model of a resonating string is harmonic, meaning that the string’s partials
are all exact multiples of the fundamental frequency. Real-world strings, however, are all
more or less inharmonic, and this increases with the width of the string. The Inharm slider
models this behavior, causing upper partials to become increasingly out of tune as its value
increases.

The Damping slider adjusts the amount of high frequency content in the string’s vibration.
Higher values result in more upper partials (less damping). This parameter can be modulated
by note pitch via the <Key slider to its right.

The Decay slider determines how long it takes for the resonating string to decay to silence.
Higher values increase the decay time. The <Key slider next to Decay allows decay time to
be modulated by note pitch.

The Ratio knob sets the ratio of the decay time of the string’s oscillation during note onset
and release. When Ratio is turned all the way to the left, the time set by the Decay knob
sets the decay time for both the onset and release of the note. As you turn Ratio up, the
release time decreases but the onset decay time stays the same.

Tension’s String Section.
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The Vibrato Section

Tension Siring Filter/Glob
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Section.

The Vibrato section uses an LFO to modulate the string’s pitch. As with all of Tension’s
parameters, the controls in this section can be used to enhance the realism of a stringed
instrument model — or to create something never heard before.

The two most important parameters in this section are the Rate and Amount sliders. Rate
adjusts the frequency of the pitch variation, while Amount adjusts the intensity (amplitude)
of the effect.

The Delay slider sets how long it will take for the vibrato to start after the note begins, while
Attack sets how long it takes for the vibrato to reach full intensity (as set by the Amount

knob).

The <Mod slider adjusts how much the modulation wheel will affect the vibrato intensity.
This control is relative to the value set by the Amount knob.

The Error slider introduces unpredictability into the vibrato, by introducing random deviation
to the Rate, Amount, Delay and Attack parameters.
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The Damper Section
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All string instruments employ some type of damping mechanism that mutes the resonating
string. In pianos, this is a felt pad that is applied to the string when the key is released. In
instruments such as guitars and violins, the player damps by stopping the string’s vibration
with the fingers. Dampers regulate the decay of strings but also produce some sound of
their own, which is an important characteristic of a string instrument’s timbre.

Although a damper functions to mute the string rather than activate it, it is somewhat
analogous to a hammer, and shares some of the same parameters.

The Mass knob controls how hard the damper’s surface will press against the string. As you
increase the value, the string will mute more quickly.

The stiffness of the damper’s material is adjusted with the Stiffness control. Lower values
simulate soft materials such as felt, while higher values model a metal damper.

Note that very high Mass and Stiffness values can simulate dampers that connect with the
string hard enough to change its effective length, thus causing a change in tuning.

The Velocity control adjusts the speed with which the damper is applied to the string when
the key is released, as well as the speed with which it is lifted from the string when the key is
depressed. Be careful with this parameter - very high Velocity values can cause the damper
to hit the string extremely hard, which can result in a very loud sound on key release. Note
that the state of the Gated switch determines whether or not the Velocity control is enabled.
When the Gated switch is turned on, the damper is applied to the string when the key is
released. With Gated off, the damper always remains on the string, which means that the
Velocity control has no effect.

Tension’s Damper
Section.
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The Mass, Stiffness and Velocity parameters can be further modulated by note pitch, via the
sliders below.

The stiffness of the damper mechanism is adjusted with the Damping knob, which affects the
overall amount of vibration absorbed by the damper. Lower values result in less damping
(longer decay times.) But this becomes a bit less predictable as the Damping value goes
over 50%. At higher values, the mechanism becomes so stiff that it bounces against the
string. This in turn reduces the overall amount of time that the damper is in contact with the
string, causing an increase in decay time. The best way to get a sense of how this parameter
behaves is to gradually turn up the knob as you repeatedly strike a single key.

The Position knob serves an analogous function to the control in the Excitator section, but
here specifies the point on the string where the damper makes contact. At 0%, the damper
contacts the string at its termination point, while at 50% it damps the string at its midpoint.
The behavior is a bit different if the Fix. Pos switch is enabled, however. In this case, the
contact point is fixed to a single location, rather than changing as the length of the string
changes. The damper’s position can additionally be modulated by velocity or note pitch,
via the Vel and Key sliders.

The Damper section can be toggled on or off via the switch next to its name.

The Termination Section

Tension String Filter/Global 2 (W
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|:| TERMINATION Fing Mass Fing Stff Fret SHff FICKUP BODY Decay Low Cut  High Cul  StriBody Woluwme
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The Termination section models the interaction between the fret, finger and string. On
a physical instrument, this interaction is used to change the effective length of the string,
which in turn sets the pitch of the note played. The physical parameters of the finger are

Tension’s Termination
Section.
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adjusted with the Fing Mass and Fing Stiff knobs, which set the force the finger applies
to the string and the finger’s stiffness, respectively. The Mass amount can be additionally
modulated by velocity or note pitch via the sliders. The stiffness of the fret is modelled with
the Fret Stiff parameter.

The Pickup Section

Tension Siring Filter/Global Ll |
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The Pickup section models an electromagnetic pickup, similar to the type found in an electric
guitar or electric piano. The only control here is the Position slider, which functions similarly
to this parameter in the Excitator and Damper sections. At 0%, the pickup is located at
the string’s termination point, while at 50% it is under the midpoint of the string. Lower
values generally result in a brighter, thinner sound, while higher values have more fullness

and depth.

The Pickup section can be toggled on or off via the switch next to its name.

Tension’s Pickup Section.
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The Body Section
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The role of the body or soundboard of a string instrument is to radiate the vibration energy
from the strings. The body also filters these vibrations, based on its size and shape. In
some instruments, such as guitars, the body also includes an air cavity which boosts low
frequencies.

The body type chooser allows you to select from different body types modelled after physical
instruments.

You can set the size of the body from the small chooser, from extra small to extra large. In
general, as you increase the body size, the frequency of the resonance will become lower.
You can further modify the body’s frequency response with the Hi Cut and Low Cut knobs.

The decay time of the body’s resonance can be adjusted with the Decay knob. Higher values
mean a longer decay.

The Str/Body knob adjusts the ratio between the String section’s direct output and the signal
filtered by the Body section. When turned all the way to the right, there is no direct output
from the String section. When turned all the way to the left, the Body section is effectively
bypassed.

The Body section can be toggled on or off via the switch next to its name.

The lonely Volume knob to the right of this section sets the overall output of the instrument.
This knob is replicated on the Filter/Global tab.

Tension’s Body Section.
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23.13.3 Filter/Global Tab

The Filter/Global tab contains the filter parameters for the instrument, as well as global
controls.

The Filter Section

Tension r [ ] ol - |
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Tension’s Filter section features a highly configurable multi-mode filter that sits between the
String and Body sections. In addition, the filter can be modulated by a dedicated envelope
generator and low-frequency oscillator (LFO).

The filter's chooser allows you to select the filter type. You can choose between 2nd and
4th order low-pass, band-pass, notch, high-pass and formant filters.

The resonance frequency of the filter is adjusted with the Freq slider, while the amount of
resonance is adjusted with the Res control. When a formant filter is chosen in the chooser,
the Res control cycles between vowel sounds. The Freq and Res controls can each be
modulated by LFO, envelope or note pitch via the sliders below. Note that the LFO and
Env sliders have no effect unless the Envelope and LFO subsections are enabled.

The Envelope generator is a standard ADSR (attack, decay, sustain, release). This section
can be toggled on or off via the switch next to its name.

The attack time is set with the Attack knob. This time can also be modulated by velocity via
the Vel slider below the knob. As you increase the Vel value, the attack time will become
increasingly shorter at higher velocities.

Tension’s Filter Section.
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The time it takes for the envelope to reach the sustain level after the attack phase is set by
the Decay knob.

The Sustain knob sets the level at which the envelope will remain from the end of the decay
phase to the release of the key. When this knob is turned all the way to the left, there is no
sustain phase. With it turned all the way to the right, there is no decay phase. The sustain
level can be additionally modulated by velocity via the Vel slider below the knob. Higher
values result in an increased sustain level as the velocity increases.

Finally, the release time is set with the Release knob. This is the time it takes for the envelope
to reach zero after the key is released.

The LFO subsection provides an additional modulation source for the filter. This section can
be toggled on or off via the switch next to its name.

The waveform chooser sets the type of waveform used by the LFO. You can choose between
sine, triangle, rectangular and two types of random waveforms. The first random waveform
steps between random values while the second uses smoother ramps.

The Delay knob sets how long it will take for the LFO to start after the note begins, while
Attack sets how long it takes for the oscillator to reach its full amplitude.

The LFO's speed is set with the Rate knob. The switches below this knob toggle the Rate
between frequency in Hertz and tempo-synced beat divisions.

The entire Filter section can be toggled on or off via the switch next to its name.
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Global and Keyboard Parameters

Tension
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The remaining section contain all of the parameters that adjust how Tension responds to
MIDI data, as well as controls for performance parameters such as tuning and portamento.

The Keyboard section contains all of Tension’s polyphony and tuning parameters. The Voices
chooser sets the available polyphony, while Priority determines which notes will be cut off
when the maximum polyphony is exceeded. When Priority is set to High, new notes that
are higher than currently sustained notes will have priority, and notes will be cut off starting
from the lowest pitch. Low Priority is the opposite. A setting of Last gives priority to the
most recently played notes, cutting off the oldest notes as necessary.

The Octave, Semi and Tuning controls function as coarse and fine tuners. Octave transposes
the entire instrument by octaves, while Semi transposes up or down in semitone increments.
The Tuning slider adjusts in increments of one cent (up to a maximum of 50 cents up or
down).

The pitch bend modulation range in semitones is set by the P. Bend slider.

Stretch simulates a technique known as stretch tuning, which is a common tuning modifica-
tion made to electric and acoustic pianos. At 0%, Tension will play in equal temperament,
which means that two notes are an octave apart when the upper note’s fundamental pitch is
exactly twice the lower note's. But because the actual resonance behavior of a vibrating tine
or string differs from the theoretical model, equal temperament tends to sound “wrong”
on pianos. Increasing the Stretch amount raises the pitch of upper notes while lowering
the pitch of lower ones. The result is a more brilliant sound. Negative values simulate
“negative” stretch tuning; upper notes become flatter while lower notes become sharper.

Tension'’s Global and
Keyboard Parameters.
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The Error slider increases the amount of random tuning error applied to each note. Try very
high values if you would like to relive your experiences from junior high school orchestra.

The Unison section allows you to stack multiple voices for each note played. The switch
next to the name toggles the section on or off.

The Voices switch selects between two or four stacked voices, while Detune adjusts the
amount of tuning variation applied to each stacked voice. Low values can create a subtle
chorusing effect, while high values provide another good way to approximate a youth
orchestra. Increasing the Delay amount adds lag before each stacked voice is activated.

The Portamento section is used to make the pitch slide between notes rather than changing
immediately. The effect can be toggled on and off via the switch next to its name.

With Legato enabled, the sliding will only occur if the second note is played before the first
note is released.

Proportional causes the slide time to be proportional to the interval between the notes.
Large intervals will slide slower than small intervals. Disabling this switch causes the slide
time to be constant regardless of interval.

The Time slider sets the overall speed of the slide.

The Volume knob sets the overall output of the instrument.

23.13.4 Sound Design Tips

At first glance, Tension’s modular architecture may not seem so different from what you're
used to in other synthesizers; it consists of functional building blocks that feed information
through a signal path and modify it as it goes. But it's important to remember that Tension’s
components are not isolated from one another; what you do to one parameter can have
a dramatic effect on a parameter somewhere else. Because of this, it's very easy to find
parameter combinations that produce no sound at all. It's also very easy to create extremely
loud sounds, so be careful when setting levels!

When programming Tension, it may help to think about the various sections as if they really
are attached to a single, physical object. For example, a bow moving at a slow speed could
perhaps excite an undamped string. But if that string is constricted by an enormous damper,
the bow will need to increase its velocity to have any effect.
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To get a sense of what's possible, it may help to study how the presets were made. You'll
soon realize that Tension can do far more than just strings.

23.14 The Essential Instrument Collection

The boxed version of Live 8 ships with the Essential Instrument Collection, a multi-giga-
byte library of meticulously sampled instruments created in cooperation with SONiVOX,
Chocolate Audio and Puremagnetik.

Note — The Essential Instrument Collection is not included with downloadable purchases.
Download customers can choose, however, to have the Live 8 box including the Essential
Instrument Collection shipped to them later for an additional fee®.

23.14.1 EIC Installation

The Essential Instrument Collection is installed separately from the main Live installation.
The various instruments on the EIC DVD are grouped into separate Live Packs that can be
installed as needed. To install Live Packs, drag them into the Live application window, either
from your operating system or from Live's Browser.

After you have installed the EIC Live Packs, you will need to authorize them. Further details
can be found at the Ableton website®.

23.14.2 Accessing The EIC Instruments

After installation, the EIC instruments are accessed through Live's Device Browser, in exactly
the same way as Live's other built-in instruments. You will find them as categorized presets
within the Instrument Rack folder. EIC instruments are therefore loaded just like any other
device, by dragging a preset from the Browser into an empty MIDI track.

Shttp://www.ableton.com/shop
6http://www.able'con.com/authorize
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The EIC presets are available in Full and Lite versions, allowing you to choose the right
balance of fidelity and polyphony for your needs. The Lite version reduces CPU, RAM and
disk requirements by reducing the number of zones and sample layers used. Both the
normal and Lite presets use 24-bit multisamples.

There is also an EIC LE Pack available which contains very efficient versions of the EIC
instruments suitable for sketching out ideas. The LE instruments are all composed of 16-bit
sample files.

All of the EIC presets are conveniently mapped to Macro Controls for greater expression.

23.14.3 The Included Instruments

The following multisampled instruments are included:
¢ Acoustic Keyboards — Grand Piano, Harpsichord, Celesta
e Electric Keyboards — E-Piano MK 1, B3 Jazz Organ, B3 Rock Organ

e Orchestral Strings — Solo Strings (legato): Double Bass, Cello, Viola, Violin; Ensemble
Strings (legato, pizzicato)

e Orchestral Brass — Solo Brass (legato): French Horn, Bass Trombone, Tuba (Eb),
Trumpet; Ensemble Brass (legato, staccato)

e Orchestral Woodwinds — Solo Woodwinds (legato, legato vibrato): English Horn, Bas-
soon, Clarinet, French Oboe, Concert Flute, Alto Sax; Ensemble Woodwinds (legato)

¢ Plucked Instruments — Harp (fingers), Jazz Upright Bass, P-Bass (fingers, picks), Six-
String Nylon Guitar (tones, chords), Strat Clean (tones, chords)

e Mallets — Glockenspiel (hard mallets), Xylophone (hard mallets)
e Voice — Mixed Choir (ahh, ohh)

e Drum Machine — one drum machine, selected from the Drum Machines add-on prod-
uct

e Acoustic Drum Kit — one stereo multisampled drum kit, selected from the Session
Drums add-on product
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Special Features of the Guitar and Bass Banks

The EIC's guitar instruments have additional banks for single-key chords with strumming,
and the PBass instrument has a similar bank for down- and up- strokes played with a pick.
In all cases, lower octaves play down strums, while upper octaves play up strums.
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Chapter 24

Max For Live

() Max Audio Effect iy @@

Audie from Live

L (plugn) R

L [plugout- | R

Audio to Live A Generic Max Audio
Effect.

Max for Live, an add-on product co-developed with Cycling ‘74", allows users to extend and
customize Live by creating instruments, controllers, audio effects, and MIDI processors.

After installing Max for Live, you will need to point to it in Live's File/Folder Preferences:

Thttp://www.cycling74.com
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Mo Pragram Files\Wavos:

Sync
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Warp
Launch

Like all other Live devices, Max devices can have their own presets, which can be viewed
and loaded by unfolding the device in the Browser.

What a Max device actually does is dependent on its patch, which can be accessed by
pressing the Edit button in the Max device’s title bar.

Max Audio Effect ol - |

This launches the Max for Live application, with the current device loaded and ready for
editing.

After editing, you can save your Max patch and it will automatically update any devices
that use the patch in your current Live Set. Like samples, Max patches can be saved in
your Library or within Project folders. They can also be organized using Live's File Manager,
which can help ensure that your files and dependencies stay self-contained.

To learn more about building and editing Max devices, see the documentation that came
with Max for Live.

The Max Editor Chooser.

The Edit Button for a
Max Device.
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Chapter 25

Sharing Live Sets

Live provides tools to collaborate with other Live users by uploading and downloading Live
Sets from Ableton’s web server. Any media files which are needed by your Live Sets are
uploaded automatically, unless they are already on Ableton’s server. Likewise, any media
files which are needed by Sets that you download are only downloaded if you do not already
have them. This file management happens automatically.

25.1 Uploading Sets

The File Menu’s Share Live Set command saves the current Set to your web space at
ableton.com. After selecting this command, you will be asked to enter a name for your Live
Set.
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€1 Upload details x|

Enter the Set’s Name in
the Upload Details
Window.

If you are not already logged in to your ableton.com account, you will then be prompted to
enter your username and password.

Email or Usermama
dennis desantis

Password

p— -

(OK) (Cancel

Log In to Upload Your
Set.

After you have logged in, Live will begin uploading your Set, along with any referenced
media files that are not already on Ableton’s server. Depending on the size of your Set and
media, the upload can take some time. The process happens in the background, allowing
you to continue working normally with Live. If you quit the program while an upload is in
progress, you will be asked if you would like to resume it the next time you run Live.

25.1.1 Non-Portable Tracks

If your Set contains any devices which are not available to every Live user (e.g., any third-
party plug-ins or Ableton’s add-on instruments such as Operator), you will be given a chance
to Freeze the affected tracks before uploading. You will also have the option to Freeze any
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tracks that contain an External Instrument or External Audio Effect.

il © Non-Portable Tracks x|

The Sat you're about to upload uses a number of features which are not portable. To
ensure that other users can at least get an idea of your Live Set, you may Freeze the
affected tracks. Note that in some cases, Freezing is not possible.

Unfold the track entries balow to sas thair portability issues.

List of Affected Tracks (_Freeze ANl )
T Y
7 Drums ||
Contains an Ablaton add-on device "Corpus”

7 Bells ||
Contains an Ablaton add-on devica "Collision™

Contains V5T 2.0 plug-in “dominion v1.2"

7 Bass
Contains an Ableton add-on device "Operator”

Contains an external device

f (_Cancel ) (COK_) The Non-Portable Tracks
1 Dialog.

Note that Freezing is not always possible; Group Tracks, return tracks and the Master track,
for example, cannot be frozen.

25.2 Downloading Sets

You can download Live Sets that other users have uploaded to ableton.com. You can get
more information and find Sets at the Ableton website.

Thttp://www.ableton.com/share
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25.3 The Upload/Download Browser

All files that you download from Ableton’s server are stored locally on your machine, in
your cache. You can view any finished downloads or in-progress transfers via the Upload/
Download Browser, which can be accessed via its selector. Note that this selector is not
visible until your cache actually contains something.

i [ petit beat hip hop

>
O 119946360057
) Walcomal

=

You can load Sets via the Upload/Download Browser once they are finished downloading.
Sets that are in the process of transferring will display a progress bar, as well as icons to
pause or resume the transfer. Please note that the Upload/Download Browser shows the
contents of your cache, which is a read-only folder.

Note: Because downloaded media files are stored in your cache, it is possible for this folder
to become very large. Live automatically deletes older files from the cache to make room for
those that are new, so you should not use the cache for permanent storage. Once you have
opened a Set from the Upload/Download Browser, you should save it to your hard drive in
a new location. This will create a self-contained copy of the Set, as well as all referenced
media files.

The Upload/Download
Browser.
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Chapter 26

MIDI and Key Remote Control

To liberate the musician from the mouse, most of Live's controls can be remote-controlled
with an external MIDI controller and the computer keyboard. This chapter describes the
details of mapping to the following specific types of controls in Live's user interface:

1. Session View slots — Note that MIDI and computer key assignments are bound
to the slots, not to the clips they contain.

2. Switches and buttons — among them the Track and Device Activator switches,
the Control Bar’s tap tempo, metronome and transport controls.

3. Radio buttons — A radio button selects from among a number of options. One
instance of a radio button is the crossfader assignment section in each track,
which offers three options: The track is assigned to the crossfader’s A position,
the track is unaffected by the crossfader, or the track is affected by the crossfader’s
B position.

4. Continuous controls — like the mixer's volume, pan and sends.

5. The crossfader, the behavior of which is described in detail in the respective
section of the Mixing chapter.
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26.1 MIDI Remote Control

Live can be controlled remotely by external MIDI control surfaces, such as MIDI keyboards
or controller boxes. Live also supports the Akai APC40 , a topic that is covered in its own
chapter, for completely mouse-free program operation.

Before we explain how remote control assignments are made and implemented, let’s first
make the distinction between MIDI remote control and a separate use of MIDI in Live: as
the input for our MIDI tracks. Let's suppose that you are using a MIDI keyboard to play an
instrument in one of Live's MIDI tracks. If you assign C-1 on your MIDI keyboard to a Session
View Clip Launch button, that key will cease play C-1 of your MIDI track’s instrument, as it
now “belongs” solely to the Clip Launch button.

MIDI keys that become part of remote control assignments can no longer be used as input
for MIDI tracks. This is a common cause of confusion that can be easily resolved by observing
the Control Bar's MIDI indicators.

Before making any MIDI assignments, you will need to set up Live to recognize your control
surfaces. This is done in the MIDI/Sync tab of Live’s Preferences, which can be opened with
the keyboard shortcut (Ctrl [ ) (PC)/ (& &, ] (Mac).

26.1.1 Natively Supported Control Surfaces

Control Surfaces are defined in the table at the top of the MIDI/Sync tab. Up to six supported
control surfaces can be used simultaneously in Live.

Control Surface Input Output
1 [RemoleSL | [RemoleSL (Port 1)=| [RemoteSL (Porl 1) =| (Dump)
2 [Oxygendv2 w| [Oxygend (Port 1) =| [Owygend (Port 1) =] (Dump)
3 [Tranzport =| [RemoteSL (Port 2) =] [RemoteSL (Port 2)=| (Dump)
4 [None =] [Mone | [Mone =| (Dump)
5 [None | [Mone | [Mone =| (Dump)
6 [None | [Mone | [Mone | (Dump)

Open the first chooser in the Control Surface column to see whether your control surface
is supported natively by Live; if it is listed here, you can select it by name, and then define
its MIDI input and output ports using the two columns to the right. If your controller is not

Setting Up Control
Surfaces.
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listed here, don't fret — it can still be enabled manually in the next section, Manual Control
Surface Support.

Depending on the controller, Live may need to perform a “preset dump” to complete the
setup. If this is the case, the Dump button to the right of your control surface’s choosers in
the Live Preferences will become enabled. Before pressing it, verify that your control surface
is ready to receive preset dumps. The method for enabling this varies for each manufacturer
and product, so consult your hardware’s documentation if you are unsure. Finally, press the
Dump button; Live will then set up your hardware automatically.

Instant Mappings

In most cases, Live uses a standard method for mapping its functions and parameters to
physical controls. This varies, of course, depending upon the configuration of knobs, sliders
and buttons on the control surface. These feature-dependent configurations are known as
instant mappings.

Within Live's built-in lessons, you will find a Control Surface Reference that lists all currently
supported hardware, complete with the details of their instant mappings. The Lessons View
can be accessed at any time by selecting the Lessons option from the View menu.

Note: You can always manually override any instant mappings with your own assignments.
In this case, you will also want to enable the Remote switches for the MIDI ports that your
control surface is using. This is done in the MIDI Ports section of the MIDI/Sync Preferences
tab, and is described in the next section.

Instant mappings are advantageous because the control surface’s controllers will automati-
cally reassign themselves in order to control the currently selected device in Live.
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Control Surfaces Can
Follow Device Selection.

In addition to following device selection, natively supported control surfaces can be “locked”
to specific devices, guaranteeing hands-on access no matter where the current focus is in
your Live Set. To enable or disable locking, @ (PC)/ [Cti_]& (Mac) on a device's title
bar, and then select your preferred controller from the “Lock to...” context menu. You'll
recognize the same list of control surfaces that you defined in the MIDI/Sync Preferences.
By default, the instrument in a MIDI track will automatically be locked to the control surface
when the track is armed for recording.

cut Cirl+X (Z10)
Copy Clrl+C
Rename Device Ctri+R
Edil Info Text
Stat  Loop Lenglh Fade Sustain Release |LFO Pan | Vialume
Detete
C) \ O Group Cirl+G Q 6) Rand LFO
0.00% 100% 100% 0.00% Group To Drum Rack 0.0dB 50.0ms c 0.00 %)
Flller Freq Res Vel Fold - Transp LFO  Glide Spread | Vel
O O Show Presel Name 7| [ost 4 [0.00%] [Ooff <] (/‘)
'I'yDe Key Detune Env Time Vioices

Save as Default Preset

 Use Constant Power Fade for Loops Getting Hands-On:
Control Surfaces Can Be

Locked to Devices.

Simpler -> Samper

A hand icon in the title bar of locked devices serves as a handy reminder of their status.
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Note: Some control surfaces do not support locking to devices. This capability is indicated
for individual controllers in the Control Surface Reference lesson. Select the Lessons option
from the View menu to access Live’s built-in lessons.

26.1.2 Manual Control Surface Setup

If your MIDI control surface is not listed in the MIDI/Sync Preferences’ Control Surface
chooser, it can still be enabled for manual mapping in the MIDI Ports section of this tab.

MIDI Ports Track Sync  Remaote
P Input:  Oxygend (Port 1) oOn || ||
B Input:  RemoleSL {Port 1) on || I |
= Inpul:  RemoteSL (Port 2) of | ||

228888
SEEYEE

| |

| |
[ [ |
= Output: Oxygens (Port 1) [om ] |
= Output: RemoteSL (Port 1) [ |
[ [ |
[

off || I |
= Outpul: RemoteSL (Port 2) o || 1
= Qulpul: RemoleSL (Por 3) on on off

The MIDI Ports table lists all available MIDI input and output ports. To use an input port
for remote control of Live, make sure the corresponding switch in its Remote column is set
to “On.” You can use any number of MIDI ports for remote mapping; Live will merge their
incoming MIDI signals.

When working with a control surface that provides physical or visual feedback, you will also
need to enable the Remote switch for its output port. Live needs to be able to communicate
with such control surfaces when a value has changed so that they can update the positions
of their motorized faders or the status of their LEDs to match.

To test your setup, try sending some MIDI data to Live from your control surface. The Control
Bar's MIDI indicators will flash whenever Live recognizes an incoming MIDI message.

Once your controller is recognized by Live, you have completed the setup phase (but
we recommend that you take the time to select a Takeover Mode before you leave the
Preferences behind). Your next step will be creating MIDI mappings between your control
surface and Live. Luckily, this is a simple task, and you only need to do it for one parameter
at a time.

Defining Control
Surfaces Manually.
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26.1.3 Takeover Mode

Take-Over Mode

MIDI Ports rack Sync  Remote

When MIDI controls that send absolute values (such as faders) are used in a bank-switching
setup, where they address a different destination parameter with each controller bank, you
will need to decide how Live should handle the sudden jumps in values that will occur when
moving a control for the first time after switching the bank. Three takeover modes are
available:

None - As soon as the physical control is moved, its new value is sent immediately to its
destination parameter, usually resulting in abrupt value changes.

Pick-Up — Moving the physical control has no effect until it reaches the value of its destination
parameter. As soon as they are equal, the destination value tracks the control’s value 1:1.
This option can provide smooth value changes, but it can be difficult to estimate exactly
where the pick-up will take place.

Value Scaling — This option ensures smooth value transitions. It compares the physical
control’s value to the destination parameter’s value and calculates a smooth convergence of
the two as the control is moved. As soon as they are equal, the destination value tracks the
control’s value 1:1.

MIDI Controller
Takeover Mode.
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26.2 The Mapping Browser
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The Mapping Browser

Sampler Zone+d Sample PilchiOsc FilteriG and Selector.

All manual MIDI, computer keyboard and Macro Control mappings are managed by the
Mapping Browser. The Mapping Browser is hidden until one of the three mapping modes
is enabled. It will then display all mappings for the current mode. For each mapping, it
lists the control element, the path to the mapped parameter, the parameter’s name, and
the mapping’s Min and Max value ranges. The assigned Min and Max ranges can be edited
at any time, and can be quickly inverted with a @ (PC) / & (Mac) context menu
command. Delete mappings using your computer’s or key.

Note that Instant Mappings are context based and are not displayed in the Mapping Browser.
Their mapping structure can be displayed while working in Live by choosing the Lessons
option from the View menu and then opening the Control Surface Reference lesson.

26.2.1 Assigning MIDI Remote Control

1] KEY . 2% (8]
The MIDI Map Mode

Master Switch.
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Once your remote control setup has been defined in the MIDI/Sync Preferences, giving MIDI
controllers and notes remote control assignments is simple:

1. Enter MIDI Map Mode by pressing the MIDI switch in Live’s upper right-hand
corner. Notice that assignable elements of the interface become highlighted
in blue, and that the Mapping Browser becomes available. If your Browser is

closed, Alt (PC)/ (& At =B (Mac) will open it for you.
2. Click on the Live parameter that you'd like to control via MIDI.

3. Send a MIDI message by pressing a keyboard key, turning a knob, etc., on your
MIDI controller. You will see that this new MIDI mapping is now listed in the
Mapping Browser.

4. Exit MIDI Map Mode by pressing the MIDI switch once again. The Mapping
Browser will disappear, but you can always review your mappings by entering
MIDI Map Mode again.

26.2.2 Mapping to MIDI Notes

MIDI notes send simple Note On and Note Off messages to Live's interface elements. These
messages can produce the following effects on controls in Live:

e Session View Slots — Note On and Note Off messages affect clips in the slot according
to their Launch Mode settings.

e Switches — A Note On message toggles the switch’s state.
¢ Radio Buttons — Note On messages toggle through the available options.

e Variable Parameters — When assigned to a single note, Note On messages toggle the
parameter between its Min and Max values. When assigned to a range of notes, each
note is assigned a discrete value, equally spaced over the parameter’s range of values.

Hint: Session View slots can be assigned to a MIDI note range for chromatic playing: First
play the root key (this is the key that will play the clip at its default transposition), and then,
while holding down the root key, hold one key below the root and one above it to define
the limits of the range.
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26.2.3 Mapping to Absolute MIDI Controllers

Absolute MIDI controllers send messages to Live in the form of absolute values ranging
from O to 127. These values lead to different results depending on the type of Live control
to which they are assigned. A value message of 127, for example, might turn the Volume
control on a Live track all the way up or play a Session View clip. Specifically, MIDI controller
messages from O to 127 can produce the following effects on controls in Live:

e Session View Slots— Controller values 64 and above are treated like Note On messages.
Controller values 63 and below are treated like Note Off messages.

e Switches — For track activators and on/off buttons in devices, controller values that are
within the mapping’s Min and Max range turn the switch on. Controller values that are
above or below this range turn it off. You can reverse this behavior by setting a Min
value that is higher than its corresponding Max value. In this case, controller values
that are outside of the range turn the switch on, while values inside the range turn it
off. For all other switches (such as transport controls), controller values 64 and above
turn the switch on, while controller values below 64 turn it off.

e Radio Buttons — The controller's 0...127 value range is mapped onto the range of
available options.

¢ Continuous Controls — The controller's 0...127 value range is mapped onto the param-
eter's range of values.

Live also supports pitch bend messages and high-precision (“14-bit Absolute”) controller
messages with a 0...16383 value range. The above specifications apply to these as well,
except that the value range’s center is at 8191/8192.

26.2.4 Mapping to Relative MIDI Controllers

Some MIDI controllers can send “value increment” and “value decrement” messages instead
of absolute values. These controls prevent parameter jumps when the state of a control in
Live and the corresponding control on the hardware MIDI controller differ. For example,
imagine that you have assigned the pan knob on your control surface to the pan parameter
of atrackin Live. If the hardware control is panned hard right, and the Live control is panned
hard left, a slight movement in a hardware pan knob that sends absolute values would tell
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Live to pan right, causing an abrupt jump in the track’s panning. A pan knob sending relative
messages would prevent this, since its incremental message to Live would simply say, “Pan
slightly to the left of your current position.”

There are four types of relative controllers: Signed Bit, Signed Bit 2, Bin Offset and Twos
Complement.

Convention (Mode) Increment Decrement
Relative (Signed Bit) 001-064 065-127
Relative (Signed Bit 2) 065-127 001-064
Relative (Bin Offset) 065-127 063-001
Relative (2's Comp.) 001-064 127-065

Each of these are also available in a “linear” mode; Some MIDI encoders use "acceleration”
internally, generating larger changes in value when they are turned quickly. For control
surfaces that are not natively supported, Live tries to detect the controller type and whether
acceleration is being used or not.

You can improve the detection process by moving the relative controller slowly to the left
when you make an assignment. Live will offer its suggestion in the Status Bar's “mode”
chooser, but if you happen to know the relative controller type, you can manually select it.

Live will do the following with relative MIDI controller messages:

e Session View Slots — Value increment messages are treated like Note On messages.
Value decrement messages are treated like Note Off messages.

e Switches — Increment messages turn the switch on. Decrement messages turn it off.

e Radio Buttons — Increment messages make the radio button jump forward to the next
available option. Decrement messages make it jump backward.

e Continuous Controls — Each type of relative MIDI controller uses a different inter-
pretation of the 0...127 MIDI controller value range to identify value increments and
decrements:

Please consult the documentation that came with your MIDI controller if you need further
information on relative MIDI controllers.
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Relative Session View Navigation

Notice that you can make not only absolute mappings to individual slots and scenes, but
also relative mappings to move the highlighted scene and operate on the highlighted clips.

In both MIDI Map Mode and Key Map Mode, a strip of assignable controls appears below
the Session grid:

4] 3] 1] 2
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1. Assign these buttons to keys, notes or controllers to move the highlighted scene
up and down.

2. Assign this scene number value box to a MIDI controller — preferably an endless
encoder — to scroll through the scenes. For details, see the previous section on
Relative Map Modes.

3. Assign this button to launch the highlighted scene. If the Record/Warp/Launch
Preferences’ Select Next Scene on Launch option is checked, you can move
successively (and hopefully successfully!) through the scenes.

4. Assign these buttons to launch the clip at the highlighted scene, in the respective
track.

Relative Session mapping is useful for navigating a large Live Set, as Live always keeps the
highlighted scene at the Session View's center.

Mapping to Clip View Controls

The Clip View displays the settings for whichever clip happens to be currently selected, but
it will also display the settings of multi-selected clips. To avoid unpleasant musical surprises,
it is important to remember that creating remote control mappings for any control in the

The Relative Session
Mapping Strip.
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Clip View interface could potentially affect any clip in the Live Set. For this reason, we
recommend mapping Clip View controls to relative MIDI controllers to prevent undesirable
jumps in parameter values.

26.2.5 Computer Keyboard Remote Control

I} MiDi 4% D

Audio 11 Master

Creating control surface assignments for your computer keyboard is straightforward:

1. Enter Key Map Mode by pressing the KEY switch in the upper right-hand corner
of the Live screen. Notice that the assignable elements of the interface become
highlighted in red when you enter Key Map Mode. The Mapping Browser will
also become available. If the Browser is hidden, you will want to show it at this
point using the appropriate View menu command.

2. Click on the Live parameter that you wish to assign to a key. Remember that
only the controls that are shown with a red overlay are available for mapping.

3. Press the computer key to which you wish to assign the control. The details of
your new mapping will be displayed in the Mapping Browser.

4. Leave Key Map Mode by pressing Live's KEY switch once again. The Mapping
Browser will disappear, but your mappings can be reviewed at any time simply
by entering Key Map Mode again.

Keyboard assignments can produce the following effects in Live:

e Clips in Session View slots will be affected by mapped keys according to their Launch
Mode settings.

e Keys assigned to switches will toggle switch states.
¢ Keys assigned to radio buttons will toggle through the available options.

Please be sure not to confuse this remote control functionality with Live's ability to use
the computer keyboard as a pseudo-MIDI keyboard that can generate MIDI notes from

The Key Map Mode
Switch.
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computer keystrokes for use with instruments.
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Chapter 27

Using the APC40

The APC40 (Ableton Performance Controller) is a dedicated controller for Ableton Live, co-
designed by Ableton and Akai Professional®. This chapter will help you set up your APC40,
and introduce its capabilities.

27.1 Setup

Once the APC40 has been powered on and connected to your computer’s USB port, you
will need to select the APC40 in Live's Preferences. The APC40 is one of Live's natively
supported control surfaces, so setup is quite easy:

1. Open Live's Preferences from the Live menu in OS X, or the Options menu in
Windows;

2. Go to the MIDI/Sync Tab;

3. Select the APC40 preset from the Control Surface chooser. Then select the port
that the APC40 is connected to in the Input and Output choosers:

1 http://www.akaipro.com
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€1 Preferences

Control Surface Input

Output

[aPCan | [USB Audio Device =| [USB Audio Device =|| |

3 [None | [None
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4 [None =| [Mone

=| [None
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5 [None =| [Mone

=| [Mone
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6 [None | [None

=| [Mone

vl'
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27.2 Clip Launch Matrix

The APC40's matrix of buttons gives you physical access to the clips in your Session View.

The matrix has 40 three-color buttons arranged in a five-scene-deep-by-eight-track-wide

grid. The color-coding system lets you know exactly what is happening in each clip, and

directional controls let you move around inside your Session View.

Setting Up The APC40.
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Session View Clip and
Navigation Controls.

Pressing a Clip Launch button triggers the clip in the corresponding clip slot in Live. If the
track is armed to record, pressing the button records a new clip.

The buttons in the matrix light up in different colors so you know what’s going on:
e Amber: this slot contains a clip.
e Green: this clip is playing.
e Red: this clip is recording.

Many aspects of the Live interface are replicated in the APC40. You can stop all music in
a track with its Clip Stop button and fire horizontal lines of clips with the Scene Launch
buttons. Stop All Clips does just that.

The controller tells you what's going on in the software, but, importantly, the software also
reflects what's happening on the controller. The clip slots currently being controlled by the
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APC's button matrix are shown in Live with a red border.
The directional arrows and Shift button increase the scope of the eight-by-five grid:

e Pressing Up or Down moves you up or down one scene at a time. Hold the Shift
button while hitting Up or Down to move five scenes up or down.

e The Left and Right arrow keys move you left or right one track at a time. Hold the Shift
button while hitting Left or Right to move eight tracks at a time.

27.3 Session Overview

The APC40’s Session Overview lets you navigate through large Live Sets quickly without
looking at your computer screen. Hold down the Shift button and the matrix zooms out to
reveal an overview of your Session View. In the Session Overview, each clip launch button
represents a five-scene-by-eight-track block of clips, giving you a matrix of 125 scenes by
64 tracks. Hit a button to focus on that section of the Session View. For example, hitting
the Shift button and then pressing the button in row three, column one will put the focus
on scenes 11-15 and tracks 1-8. Furthermore, while Shift is held, each scene launch button
represents a block of 25 scenes (if they are available in your Set.)

In the Session Overview, the color coding is a little different:

e Amber: indicates the currently selected block of clips, which will be surrounded by the
red border in the software.

o Green: there are clips playing in that block of clips (though that may not be the block
of clips selected).

e Red: there are no clips playing in that range.

e No color: there are no tracks or scenes in that range.
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27.4 Mixer Section

The APCA40 features eight tracks, each with its own fader, solo/pre-cue, mute and record
arm buttons. A Master fader controls the master volume and a Cue Level knob controls cue
volume, so you can pre-listen to a clip or the metronome without your audience hearing it.
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Mixer Controls.

You can shift these eight tracks around the Session View using the directional controls. Press
the right or left arrows to move incrementally, one track at a time. Hold the Shift button and
press the right or left arrows to jump in blocks of eight tracks at a time.
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27.5 Device Control

The APCA40 features eight endless dials and four control buttons that map to your devices
automatically for flexibility and speed on stage or in the studio.

i

TRADH SELECTWN

---T

Device Controls.

The Track Selection buttons route the eight endless encoders to the first device or Rack on
that track, with LED rings to automatically show you the levels on the selected parameter.

Four buttons below the dials give you additional control options. Clip/Track lets you switch
between viewing the devices on a track or the properties of the clip currently playing on that
track. Device On/Off turns the currently selected device on or off. Device Left and Device
Right (indicated by two arrows) shift you one step sideways along a track’s device chain.

Some effects or virtual instruments have more than eight parameters. When holding down
the Shift button, these eight buttons let you select eight banks of eight device parameter
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controls. For more information, see the Control Surface Reference Lesson.

27.6 Transport and Global Buttons

Live's Play, Stop and Global Record buttons are all easily accessible, and four global buttons
access Live's functions, cleaning up your screen view onstage and freeing you from the
mouse in the studio:

LT e O
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e Detail View opens and closes the Clip/Track View, so you can see more of your clips.

e Record Quantization lets you toggle input quantization between ‘none’ and the last
selected quantization setting.

¢ MIDI Overdub lets you overdub on a MIDI clip.

Transport and Global
Controls.
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e Metronome turns the metronome on and off.

27.7 Track Control

The Track Control section covers pan settings or send levels for whichever eight tracks are
currently selected. It consists of eight endless dials with LED rings and four buttons: Pan,
Send A, Send B and Send C.

==

Track Controls.

The buttons let you select what the encoders are controlling, while the encoders control the
amount or depth of the pan or send levels.
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27.8 Tempo Control

Tap Tempo and Nudge Left/Right buttons are essential for live performance, helping you to
stay in sync with turntables, other musicians or a live band, and correct timing issues quickly.

S TN

As you hit the Tap Tempo button once every beat, the tempo of the Live Set will follow your
tapping.

You can also use tapping to count in: If you are working in a 4:4 signature, it takes four taps
to start song playback at the tapped tempo.

On stage and in the studio, you may find yourself in situations in which you need to adjust
to sources that aren't locked to one tempo, such as live musicians or turntables. You can
use the Nudge buttons to temporarily speed up or slow down Live’s playback to match what
you hear.

Tempo Control.
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27.9 Crossfader

The APC40's replaceable crossfader is an essential DJ control, and is also handy for control-
ling effect, volume and modulation curves.

S TN

Crossfader.

In Live, you can set any track as an A or B destination, and then crossfade between the A
and B selections.

Normal wear and tear can render a crossfader obsolete. The APC40’s crossfader is fully
replaceable from the bottom of the device, so you can extend the lifetime of this already
durable unit.
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27.10 Customizing the APC40 Controls

You can change the assignment of all of the knobs, faders and buttons on the APC40 by
enabling the Remote switches in the MIDI/Sync Preferences, as described in the section on
manual control surface setup.

MIDI Ports Track Sync  Remote

Input Muiltiface Mid O ot o
B Input  APC40 Input (USB Audio Device) off off [[[on |
I Oulpul: APC40 Output (USB Audio Device) [ o | [ on | [NGaN|

Owitpail: Multiface Midi Ooff Off o

Now, by entering Live's MIDI Map Mode, you can override the pre-assigned functions of all
of the APC40's knobs, faders and buttons. The eight Track Control knobs can be assigned
in four banks, which can be switched with the buttons below them. Likewise, the Device
Control knobs can be assigned in eight banks.

Tip: If you have overridden the APC40’s default mappings with manual mappings, you can
easily switch back to the defaults by deactivating the Remote switch of the APC40’s input
port. Activating the switch again will re-establish your manual mappings.

Setting Up The APC40
For Custom
Assignments.
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Chapter 28

Synchronization and ReWire

28.1 Synchronizing via MIDI

The MIDI protocol defines two ways to synchronize sequencers, both of which are supported
by Live. Both protocols work with the notion of a sync master, which delivers a sync signal
that is tracked by the sync slave(s).

e MIDI Clock. MIDI Clock works like a metronome ticking at a fast rate. The rate of the
incoming ticks is tempo-dependent: Changing the tempo at the sync master (e.g., a
drum machine) will cause the slave to follow the change. The MIDI Clock protocol also
provides messages that indicate the song position. With respect to MIDI Clock, Live
can act as both a MIDI sync master and slave.

e MIDI Timecode. MIDI Timecode is the MIDI version of the SMPTE protocol, the
standard means of synchronizing tape machines and computers in the audio and
film industry. A MIDI Timecode message specifies a time in seconds and frames
(subdivisions of a second). Live will interpret a Timecode message as a position in the
Arrangement. Timecode messages carry no meter-related information; when slaving
Live to another sequencer using MIDI Timecode, you will have to adjust the tempo
manually. Tempo changes cannot be tracked. Detailed MIDI Timecode preferences
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are explained later in this chapter. With respect to MIDI Timecode, Live can only act
as a MIDI sync slave, not a master.

28.1.1 Synchronizing External MIDI Devices to Live
Live can send MIDI Clock messages to an external MIDI sequencer (or drum machine). After

connecting the sequencer to Live and setting it up to receive MIDI sync, turn the device on
as a sync destination in Live's MIDI/Sync Preferences.

MIDI Ports Track Sync Remote

i Outpul: RemoteSL (Pon 2) [on [[on][ on |

The lower indicator LED next to the Control Bar's EXT button will flash when Live is sending
sync messages to external sequencers.

28.1.2 Synchronizing Live to External MIDI Devices

Live can be synchronized via MIDI to an external sequencer. After connecting the sequencer
to Live and setting it up to send sync, use Live’s MIDI/Sync Preferences to tell Live about
the connection.

MIDI Ports Track Sync  Remote

= Input  RemoleSL (Port 1) [on |en][ on |

When an external sync source has been enabled, the EXT button appears in the Control
Bar. You can then activate external sync either by switching on this button or by using the
External Sync command in the Options menu. The upper indicator LED next to the EXT
button will flash if Live receives useable sync messages.

Choosing a MIDI Slave
for Live.

Setting up Live as a MIDI
Slave.
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Live Devices

When Live is synced to an external MIDI device, it can accept song position pointers from
this device, syncing it not only in terms of tempo but in terms of its position in the song. If
the master jumps to a new position within the song, Live will do the same. However, if the
Control Bar's Loop switch is activated, playback will be looped, and song position pointers
will simply be “wrapped” into the length of the loop.

28.1.3 MIDI Timecode Options

Timecode options can be set up per MIDI device. Select a MIDI device from the MIDI/Sync
Preferences’ MIDI Ports list to access the settings.

The MIDI Timecode Frame Rate setting is relevant only if “MIDI Timecode” is chosen from
the MIDI Sync Type menu. The MIDI Timecode Rate chooser selects the type of Timecode
to which Live will synchronize. All of the usual SMPTE frame rates are available. When the
Rate is set to “SMPTE All,” Live will auto-detect the Timecode format of incoming sync
messages and interpret the messages accordingly. Note that you can adjust the Timecode
format that is used for display in the Arrangement View: Go to the Options menu, and then
access the Time Ruler Format sub-menu.

The MIDI Timecode Offset setting is also only relevant if “MIDI Timecode"” is chosen from
the Sync Type menu. You can specify a SMPTE time offset using this control. Live will
interpret this value as the Arrangement’s start time.

28.1.4 Sync Delay

The Sync Delay controls, which are separately available for each MIDI device, allow you to
delay Live’s internal time base against the sync signal. This can be useful in compensating
for delays incurred by the signal transmission. The Sync Delay for a specific MIDI device
appears as you select the MIDI device from the MIDI/Sync Preferences’ MIDI Ports list. To
adjust the delay, have both Live and the other sequencer play a rhythmical pattern with

The External Sync
Switch.
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pronounced percussive sounds. While listening to the output from both, adjust the Sync
Delay control until both sounds are in perfect sync.

MIDI Ports rack Sync Ramote

MIDI Clock Sync Delay
Sync Type

28.2 Connecting via ReWire

|

Live supports the ReWire interface for connecting with another ReWire-compatible audio
program running on the same computer.

The ReWire technology, developed by Propellerhead Software, provides ReWire-compatible
programs with:

e common access to the audio hardware;

e shared transport functionality;

¢ synchronization to audio word clock and song positioning;
e exchange of audio streams.

The programs in a ReWire connection play distinct roles: The ReWire master accesses the
audio hardware and provides mixing facilities; the ReWire slave(s) have no direct link to the
audio hardware, but instead send their audio output into the Master’s mixer.

Common ReWire master applications are Digidesign Pro Tools, Steinberg Cubase and Nu-
endo, Emagic Logic Audio, MOTU Digital Performer, Cakewalk Sonar and Cycling 74 Max/
MSP. Common ReWire slave applications are Propellerheads Rebirth, Propellerheads Rea-
son, Arturia Storm, Cakewalk Project 5 and Cycling 74 Max/MSP. Live can act as both a
ReWire master and slave.

Note that the ReWire protocol itself does not consume much CPU power. However, as
expected, running two audio-intensive programs on the same computer requires more

Adjusting Sync Delay.
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resources than running a single program.

28.2.1 Running Live in ReWire Master Mode

The step-by-step procedure for sending MIDI to and receiving audio from a ReWire slave
program is presented in the routing chapter.

28.2.2 Running Live in ReWire Slave Mode

In ReWire slave mode, Live can both receive MIDI from, but also send audio to the master
application. All of Live’s MIDI tracks are accessible to the master application as destinations
for MIDI signals, and all of its audio tracks and MIDI tracks containing instruments are
accessible as audio sources.

If you have not used Live yet, please launch Live so that it can install its ReWire engine in
your system.

Live will run in ReWire slave mode if it detects a running ReWire master application upon
startup. Therefore, always start the ReWire master application first, and then start Live.

Likewise, you will first have to quit Live, then the ReWire master application.
Live's operation in ReWire slave mode differs from the usual operation in some regards:

e Live will not have direct access to the audio interfaces; audio input/output is handled
by the ReWire master application. No audio input will be available to Live.

e The sample rate is determined by the host application rather than by Live.

e External synchronization will be disabled (synchronize to the ReWire master application
instead). Live will not send sync or controller messages to the MIDI output. Controlling
Live via MIDI is still possible.

e Live will not act as a ReWire master application. For instance, you cannot run Rebirth
as a ReWire slave of Live while Live is running as a ReWire slave of Cubase. You can,
however, run both Live and Rebirth as ReWire slaves of Cubase at the same time.
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e Time signature and tempo will be determined by the settings in the ReWire master
application. If your Live Set contains any tempo or time signature changes, they will
be ignored.

28.2.3 More on ReWire

You can find tutorials on connecting Live to specific ReWire master programs at the Ableton
tutorial website'.

The Ableton FAQ website? is the first place to go if you encounter ReWire-related problems.

If you cannot seem to find an answer there, please contact the Ableton support team?3.

Thttp://www.ableton.com/tutorials
Zhttp://www.ableton.com/faq
3http://www.ableton.com/support
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Chapter 29

Computer Audio Resources and
Strategies

Real-time audio processing is a demanding task for general-purpose computers, which are
usually designed to run spreadsheets and surf the Internet. An application like Live requires
a powerful CPU and a fast hard disk. This section will provide some insight on these issues,
and should help you avoid and solve problems with running audio on a computer.

29.1 Managing the CPU Load

To output a continuous stream of sound through the audio hardware, Live has to perform
a huge number of calculations every second. If the processor can't keep up with what
needs to be calculated, the audio will have gaps or clicks. Factors that affect computational
speed include processor clock rates (e.g., speed in MHz or GHz), architecture, memory
cache performance (how efficiently a processor can grab data from memory) and system
bus bandwidth — the computer’s “pipeline” through which all data must pass. For this
reason, many people involved with pro audio use computers that are optimized for musical

applications.
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Fortunately, Live supports multicore and multiprocessor systems, allowing the processing
load from things like instruments, effects and 1/0 to be distributed among the available
resources. Depending on the machine and the Live Set, the available processing power can
be several times that of older systems.

If you are working on a multicore or multiprocessor system, you will want to enable support
for it in the CPU tab of Live’s Preferences.

. werld . :) .

The Control Bar's CPU meter displays how much of the computer’s computational potential is
currently being used. For example, if the displayed percentage is 10 percent, the computer
is just coasting along. If the percentage is 100 percent, the processing is being maxed
out — it's likely that you will hear gaps, clicks or other audio problems. Note that the CPU
meter takes into account only the load from processing audio, not other tasks the computer
performs (e.g., managing Live's user interface).

Audio calculations have the highest priority in Live. Therefore, even if the CPU shows a high
percentage of processor usage, the audio stream should remain uninterrupted. However,
non-critical functions (such as screen redraws) might slow down because these tasks are
handled only when the audio processing “lightens up” a bit.

29.1.1 CPU Load from Multichannel Audio

One source of constant CPU drain is the process of moving data to and from the audio
hardware. This drain can be minimized by disabling any inputs and outputs that are not
required in a project. There are two buttons in the Audio Preferences to access the Input
and Output Configuration dialogs, which allow activating or deactivating individual ins and
outs.

Live does not automatically disable unused channels, because the audio hardware drivers
usually produce an audible “hiccup” when there is a request for an audio configuration
change.

The CPU Load Meter.
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29.1.2 CPU Load from Tracks and Devices

Generally, every track and device being used in Live incurs some amount of CPU load.
However, Live is “smart” and avoids wasting CPU cycles on tracks and devices that do not
contribute anything useful.

For example, dragging devices into a Live Set that is not running does not significantly
increase the CPU load. The load increases only as you start playing clips or feed audio into
the effects. When there is no incoming audio, the effects are deactivated until they are
needed again. (If the effect produces a “tail,” like reverbs and delays, deactivation occurs
only after all calculations are complete.)

While this scheme is very effective at reducing the average CPU load of a Live Set, it cannot
reduce the peak load. To make sure your Live Set plays back continuously, even under
the most intense conditions, play back a clip in every track simultaneously, with all devices
enabled.

29.1.3 Track Freeze

Live's Freeze Track command can greatly help in managing the CPU load incurred by devices
and clip settings. When you select a track and execute the Freeze Track command, Live
will create a sample file for each Session clip in the track, plus one for the Arrangement.
Thereafter, clips in the track will simply play back their “freeze files” rather than repeatedly
calculating processor-intensive device and clip settings in real time. The Freeze Track
command is available from Live’s Edit menu and from the & (PC)/ ® (Mac) context
menu of tracks and clips. Be aware that it is not possible to freeze a Group Track ; you can
only freeze tracks that hold clips.

Normally, freezing happens very quickly. But if you freeze a track that contains an External
Audio Effect or External Instrument that routes to a hardware effects device or synthesizer,
the freezing process happens in real-time. Live will automatically detect if real-time freezing
is necessary, and you'll be presented with several options for managing the process. Please
see the section on real-time rendering for an explanation of these options.

Once any processing demands have been addressed (or you have upgraded your machine!),
you can always select a frozen track and choose Unfreeze Track from the Edit menu to change
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device or clip settings. On slower machines, you can unfreeze processor-intensive tracks
one at a time to make edits, freezing them again when you are done.

Many editing functions remain available to tracks that are frozen. Launching clips can still be
done freely, and mixer controls such as volume, pan and the sends are still available. Other
possibilities include:

e Edit, cut, copy, paste, duplicate and trim clips;

e Draw and edit mixer automation and mixer clip envelopes;

e Consolidate;

e Record Session View clip launches into the Arrangement View;
e Create, move and duplicate Session View scenes;

¢ Drag frozen MIDI clips into audio tracks.

When performing edits on frozen tracks that contain time-based effects such as reverb,
you should note that the audible result may be different once the track is again unfrozen,
depending on the situation. This is because, if a track is frozen, the applied effects are not
being calculated at all, and therefore cannot change their response to reflect edited input
material. When the track is again unfrozen, all effects will be recalculated in real time.

4 Set (k| &
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Frozen Arrangement View tracks will play back any relevant material extending beyond the
lengths of their clips (e.g., the “tails” of Reverb effects). These frozen tails will appear in
the Arrangement as crosshatched regions located adjacent to their corresponding clips.
They are treated by Live as separate, “temporary” clips that disappear when unfrozen,
since the effect is then calculated in real time. Therefore, when moving a frozen clip in the
Arrangement, you will usually want to select the second, frozen tail clip as well, so that the
two remain together.

A Frozen Arrangement
Track with a Reverb Tail.
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For frozen Session clips, only two loop cycles are included in the frozen clip, which means
that clips with unlinked clip envelopes may play back differently after two loop cycles when
frozen.

The samples generated by the Freeze Track command are stored in your temporary recording
folder until you save your Live Set, at which point they are moved to the following project
folder sub-directory: Samples/Processed/Freeze. Please note that freeze files for tracks that
contain an External Instrument or External Audio Effect will be discarded immediately when
unfreezing.

You can also decide to flatten frozen tracks, which completely replaces the original clips and
devices with their audible result. The Flatten command is available from the Edit menu.

Besides providing an opportunity to conserve CPU resources on tracks containing a large
number of devices, the Track Freeze command simplifies sharing projects between comput-
ers. Computers that are a bit low on processing power can be used to run large Live Sets as
long as any CPU-intensive tracks are frozen. This also means that computers lacking certain
devices used in one Live Set can still play the Set when the relevant device tracks are frozen.

29.2 Managing the Disk Load

A hard drive’s access speed (which is related to, but not the same thing as rotational speed)
can limit Live's performance. Most audio-optimized computers use 7200 RPM or faster
drives. Laptops, to save power, often use 5400 RPM or slower drives, which is why projects
on laptops usually have lower track counts. The amount of disk traffic Live generates is
roughly proportional to the number of audio channels being written or read simultaneously.
A track playing a stereo sample causes more disk traffic than a track playing a mono sample.

The Disk Overload indicator flashes when the disk was unable to read or write audio quickly
enough. When recording audio, this condition causes a gap in the recorded sample; when
playing back, you will hear dropouts.

The Disk Overload
Indicator.
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Do the following to avoid disk overload:

¢ Reduce the amount of audio channels being written by choosing mono inputs instead
of stereo inputs in the Audio Preferences’ Channel Configuration dialog.

e Use RAM Mode for selected clips.

e Reduce the number of audio channels playing by using mono samples instead of
stereo samples when possible. You can convert stereo samples to mono using any
standard digital audio editing program, which can be called up from within Live.
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Chapter 30

Audio Fact Sheet

Prior to the release of Live 7, much of Ableton’s development effort was focused on carefully
and objectively testing Live's fundamental audio performance. As a result of this testing, we
have implemented a number of low-level improvements to the audio engine. We have also
written this fact sheet to help users understand exactly how their audio is (or is not) being
modified when using certain features in Live that are often misunderstood, as well as tips
for achieving the highest quality results.

As mentioned above, the focus of our research has been on objective (that is, quantifiable
and measurable) behavior. We make no claims about what you can hear because we can’t
possibly predict the variables that make up your listening environment, audio hardware,
hearing sensitivity, etc. Furthermore, this paper makes no claims about how Live compares
to other audio software. Rather, it is a summary of measurable facts about what Live actually
does under various conditions.

30.1 Testing and Methodology

As of this writing, every version of Live is subjected to a suite of 473 automated tests that
cover every aspect of Live’s functionality. We add additional tests as we add features, and
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we will never release an update unless it passes every test.

30.2 Neutral Operations

Procedures in Live that will cause absolutely no change in audio quality are referred to as
neutral operations. You can be sure that using these functions will never cause any signal
degradation. Applying neutral operations to audio that was recorded into Live ensures that
the audio will be unchanged from the point of analog-to-digital conversion. Applying neutral
operations to files imported into Live ensures that the imported audio will be identical to the
files saved on disk. Applying neutral operations to files being exported from Live ensures
that the quality of your output file will be at least as high as what you heard during playback.

The list of neutral operations found below is provided primarily as an abstract reference;
while all of these operations are, in fact, neutral, it is important to remember that each of
them may (and almost certainly will) occur within a context that also contains non-neutral
operations. For example, running an audio signal through an effects device is a non-neutral
operation. So any neutral operations that occur after it will, of course, still result in audio
that is altered in some way. Even a gain change is, technically, non-neutral.

Neutral operations include:

30.2.1 Undithered Rendering

The Export Audio/Video command renders Live's audio output to a file on disk. Rendering
is a neutral operation under certain conditions:

e the sample rate of the rendered file is the same as that set for the audio hardware in
Live's Preferences.

¢ no non-neutral operations have been applied.

Live's rendering performance is tested by loading three types of unprocessed audio files
(white noise, fixed-frequency sine waves and sine sweeps) in 16-, 24- and 32-bit word lengths
and rendering these to output files, also with varying bit resolutions. Phase cancellation
testing of the original and output files shows the following:
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e rendering to a file with the same bit depth as the original results in complete phase
cancellation.

e rendering to a file with a higher bit depth than the original results in complete phase
cancellation.

e rendering to a file with a lower bit depth than the original results in the smallest amount
of distortion possible within a 32-bit system.

30.2.2 Matching sample rate/no transposition

Playback of an unstretched audio file in Live is a neutral operation, provided that the file’s
sample rate is the same as that set in Live’s Preferences and that the file is played back
without transposition. This is verified by cancellation tests of rendered output. Please note
that “playback” in this context refers only to the audio within Live, prior to the point at which
it reaches your audio hardware.

30.2.3 Unstretched Beats/Tones/Texture/Re-Pitch Warping

If the tempo of a Clip is the same as the tempo of the Set, that clip will play back unstretched.
In this case, if the Warp mode of the Clip is set to Beats, Tones, Texture or Re-Pitch (but not
Complex or Complex Pro), playback will be neutral. Any Warping caused by changing the
Set's tempo is non-permanent, and audio that plays back unwarped at a given tempo will
always play back unwarped at that tempo, even if the tempo is changed and then changed
back. For example, if you've recorded some tracks at 120 BPM, but then decide you'd like
to slow the tempo down to record a particularly difficult solo passage, the original tracks
will play back neutrally again after returning the tempo to 120 BPM. Only the recording
made at the slower tempo will be stretched. Please note that grooves work by modifying
the positions of Warp markers. This means that playback of audio clips with groove applied
will be non-neutral even at the original tempo.

The neutrality of unstretched clip playback is verified by performing cancellation tests on
rendered output.
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30.2.4 Summing at Single Mix Points

Since version 7, Live uses double precision (64-bit) summing at all points where signals are
mixed, including Clip and return track inputs, the Master track and Racks. Mixing in Live is
thus a neutral operation for signals mixed at any single summing point. This is tested by
loading pairs of 24-bit files (white noise and fixed-frequency sine waves and their phase-
inverted complements), adding the pairs together eight times and rendering the output as
32-bit files. All tests result in perfect phase cancellation.

Please note that, while 64-bit summing is applied to each single mix point, Live's internal
processing is still done at 32-bit. Thus, signals that are mixed across multiple summing
points may still result in an extremely small amount of signal degradation. This combination
of 64-bit summing within a 32-bit architecture strikes an ideal balance between audio quality
and CPU/memory consumption.

30.2.5 Recording external signals (bit depth >/= A/D converter)

Recording audio signals into Live is a neutral operation, provided that the bit depth set in
Live's Preferences window is the same or higher than that of the A/D converters used for
the recording. In this context, “neutral” means “identical to the audio as it was delivered to
Live by the A/D converters.”

30.2.6 Recording internal sources at 32 bit

Audio that is recorded via internal routing will be identical to the source audio, provided
that the recording was made at 32 bits. To ensure neutral recordings of plug-in instruments
and any audio signals that are being processed by effects plug-ins, internal recording at 32
bits is recommended. Please note, however, that if the source audio is already at a lower
bit depth, internal recording at that bit depth will also be neutral (assuming that no effects
are used); internally recording an unprocessed 16 bit audio file at 32 bits will not increase
the sound quality.

The neutrality of internal recording is verified using cancellation tests.
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30.2.7 Freeze, Flatten

When tracks are frozen, the audio files that are created are 32 bit, which ensures that they
will not be lower quality than the audio heard prior to freezing. But there are some special
cases involving Freeze that result in non-neutral behavior and should be noted:

e Frozen Arrangement View tracks can include audio material that extends beyond the
end of the clip itself, such as reverb tails and delay repetitions. Frozen Session View
tracks, however, are always exactly two loop cycles long, so any audio that extends
beyond two loop cycles during un-frozen playback will be cut off after freezing.

o Time-based effects like reverbs and delays are processed in realtime for unfrozen clips,
so stopping playback during a reverb or delay tail will allow the tail to continue. In
contrast, frozen tails are rendered as audio, and so will stop abruptly during playback.

e Any parameter automations are rendered as part of the audio file for frozen Arrange-
ment View clips. Frozen Session View clips, however, take a “snapshot” of all parame-
ter values at the Arranger’s 1.1.1 position and retain them for the duration of the frozen
clip. This is analogous to the behavior with unfrozen clips; when playing normal clips
in Session View, any Arrangement automations are “punched out” until the Back to
Arrangement button is pressed.

e Frozen clips are always played back with Warp on and in Beats mode, which means
they are subject to the same non-neutral behavior as any other Warped audio files.

e Any devices with random parameters (e.g., the Chance control in the Beat Repeat
device) will no longer exhibit random behavior after freezing. This is because, as with
time-based effects, the random values that were in place at the moment of freezing will
be rendered as part of the new file, and will thus no longer be calculated in real-time.

Please note that the Flatten command replaces any original clips and devices with the
audio files created by freezing. When using this command, it is important to keep in mind
the special cases above — what you hear after freezing is exactly what you will get when
flattening, so if the results are not to your liking, be sure to unfreeze and make any necessary
changes to device parameters before invoking the Flatten command.

This procedure is tested by rendering the output of an audio track and comparing it to the
frozen audio from the same track via phase cancellation to ensure that the files are identical.
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30.2.8 Bypassed Effects

Bypassed effects in Live are removed from the signal flow. This is true for both Live’s built-in
effects devices and third-party VST and AU plug-ins. Consequently, audio at the output
of a bypassed effect is identical to the audio at the input. Please note, however, that
effects devices with parameters that inherently require delay (e.g., the Look Ahead settings
in Compressor) will still introduce this delay when bypassed, in order to maintain automatic
delay compensation with the rest of the project. In most cases, the effects of this behavior
will be completely inaudible.

The neutrality of bypassed effects is tested by loading one instance of each of Live’s effects
devices into an audio track, deactivating them, and then rendering the output of the track.
The rendered file is then compared to the rendered output of the same track with no loaded
devices. Phase cancellation testing of the two files confirms that they are identical.

30.2.9 Routing

The routing of signals within Live is a neutral operation. The signal at the routing destination
will be identical to the signal at the routing source. It is important to note that Live's flexible
routing architecture allows for a variety of scenarios, including routing from before or after
any track’s effects or mixer and tapping the output of individual sample slots within the
Impulse instrument. In these cases, it is likely that the signal heard at the output point
will be different from the signal heard prior to routing, because it has been tapped before
reaching the end of its original signal chain.

30.2.10 Splitting Clips

Clips which are already neutral will remain neutral after splitting. Splitting only affects
playback position within the sample, and has no effect on the sample data itself. Playback
across a split boundary is seamless and sample-accurate.

The neutrality of clip splitting is tested under a variety of conditions:
e splitting unwarped clips with loop on and off;

e splitting warped but unstretched clips with loop on and off;



CHAPTER 30. AUDIO FACT SHEET 495

In all cases, output is rendered and compared with the output of an unsplit version of the
same source. Phase cancellation testing of the two files confirms that they are identical.

30.3 Non-Neutral Operations

Procedures in Live that will cause a change in audio quality are referred to as non-neutral
operations. Users can be guaranteed that using these operations will cause at least some
change to the signal. Applying non-neutral operations to files imported into Live ensures
that the imported audio will differ from the files saved on disk. Applying non-neutral
operations to files being exported from Live ensures that what you hear during realtime
playback will be different from what will end up in your new file.

Non-neutral operations include:

30.3.1 Playback in Complex and Complex Pro Mode

The algorithms used in the Complex and Complex Pro Warp modes use an entirely different
technology from the algorithms behind Beats, Tones and Texture modes. Although the
Complex modes may sound better, particularly when used with mixed sound files containing
many different kinds of audio material, they are never neutral — not even at the original
tempo. Because of this, and because of the increased CPU demands of these algorithms,
we recommend using them only in cases where the other Warp modes don’t produce
sufficient results.

30.3.2 Sample rate conversion/transposition

Sample rate conversion (during both real-time playback and rendering) is a non-neutral
operation. Playback of audio files at a sample rate that is different from the rate set in
Live's Preferences window will cause signal degradation. Transposition is also a form of
sample-rate conversion, and thus also results in non-neutral behavior.

To minimize potential negative results, it is recommended to do sample rate conversion as
an offline process in another application. Once the samples have been converted to the
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sample rate that you plan to use in Live, the files can be imported without any loss of quality.
P you p p y q Y.

Rendering audio from Live with a sampling rate other than the one that was used while
working on the project is also a non-neutral operation, and may result in a loss of sound
quality. It is recommended to always render using the original sampling rate, and then
convert the rendered file using a dedicated mastering application that is optimized for
these kinds of CPU-intensive, offline tasks.

While we recommend that you use a high-quality offline tool for sample rate conversion,
we recognize that one of Live’s core features is its ability to pitch-shift and warp audio in
real time. For this situation, it is necessary to make a trade-off between CPU performance
and precision. We recommend the use of the Hi-Q button for any clips which undergo
transposition in a given Set. The algorithm behind the Hi-Q switch was rewritten for Live 7,
and now results in considerably lower distortion than in previous versions.

30.3.3 Volume Automation

Automation of volume level results in a change in gain, which is necessarily a non-neutral
operation. But certain implementations of automation envelopes can result in audible
artifacts, particularly if the envelopes are not calculated at a fast enough rate. Since Live 7,
volume automation curves are updated for each audio sample, resulting in extremely low
levels of distortion.

30.3.4 Dithering

Whenever rendering audio to a lower bit depth, it is a good idea to apply dithering in order
to minimize artifacts. Dithering (a kind of very low-level noise) is inherently a non-neutral
procedure, but it is a necessary evil when lowering the bit resolution.

Please note that Live’s internal signal processing is all 32-bit, so applying even a single gain
change makes the resulting audio 32-bit as well — even if the original audio is 16- or 24-bit.
Dither should never be applied more than once to any given audio file, so unless you are
mastering and finalizing in Live, it is best to always render at 32-bit and avoid dithering
altogether.
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30.3.5 Recording external signals (bit depth < A/D converter)

Recording audio signals into Live is a non-neutral operation if the bit depth set in Live’s
Preferences window is lower than that of the A/D converters used for the recording. This is
not recommended.

30.3.6 Recording internal sources below 32 bit

Audio that is recorded via internal routing will lose quality if the recording is made at
a bit depth below 32 bits. To ensure neutral recordings of plug-in instruments and any
audio signals that are being processed by effects plug-ins, internal recording at 32 bits is
recommended. Please note, however, that if the source audio is already at a lower bit depth,
internal recording at that bit depth will also be neutral (assuming that no effects are used);
internally recording an unprocessed 16 bit audio file at 32 bits will not increase the sound

quality.

30.3.7 Consolidate

Consolidating clips in the Arrangement View creates new audio files, which are non-neutral
in comparison to the original audio data. Specifically, the new files will be normalized, with
their clip volumes adjusted to play back at the same volume as heard prior to consolidation.
Normalization is a gain change, which is a non-neutral operation. Also, the new files will be
created at the sample rate and bit depth set in Live’s Preferences window, which may differ
from those in the original audio files.

30.3.8 Clip fades

When Create Fades on Clip Edges is enabled in the Record/Warp/Launch Preferences, a
short (up to 4 ms) fade is applied to the clip start and end to avoid clicks at the clip edges.
These “declicking” fades can also be applied to Session View clips via the Clip Fade button.
Additionally, Arrangement View clips have editable fades and crossfades. Applying any of
these fade options is a non-neutral operation.
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30.3.9 Panning

Live uses constant power panning with sinusoidal gain curves. Output is O dB at the
center position and signals panned fully left or right will be increased by +3 dB. In order to
minimize this volume change, it may be helpful to narrow the overall stereo width before
doing extreme panning. This can be done via the Width control in the Utility device.

30.3.10 Grooves

Under most conditions, playback of a warped clip that is at the same tempo as the Set is
a neutral operation. However, if a groove is applied, playback will be non-neutral at any
tempo.

30.4 Tips for Achieving Optimal Sound Quality in Live

For users looking to achieve optimal audio quality in Live, we have provided a list of
recommended practices and program settings.

¢ Decide which sample rate to use for a project prior to beginning work, rather than
changing the sample rate while working on the project.

e Record audio into Live using high-quality hardware components (audio interface, ca-
bles, etc.) and at the highest sample rate and bit depth your interface and computer
will support.

¢ Avoid using samples that are at different sample rates within the same project. If you
want to work with such files, we recommend that you first convert them to the sample
rate set for your audio interface in an offline application that is optimized for this task.

e For all audio clips, disable both the Warp and Fade options in the Clip View.
¢ Do not adjust the Transpose and Detune controls for any clips.

e Always render at 32-bit and at the sample rate set for your audio interface. If you
need audio files at a different sample rate and/or bit depth, we recommend that you
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convert your rendered files in an offline application that is optimized for these tasks,
rather than in Live.

Please note that these practices, while ensuring optimal audio quality, disable some of Live’s
functionality — in particular, stretching and synchronization.

30.5 Summary and Conclusions

Ableton wrote this paper in order to help users understand exactly how audio is affected
when performing various procedures in Live. Our focus has been on functions that have
proven over the years to cause confusion or uncertainty, and the list of both neutral and
non-neutral operations presented here is necessarily incomplete.

We encourage you to refer to this paper if you have any questions about the functions
discussed, but we also encourage you to contact us' if you have additional questions that
we haven't answered. Live is a product, but it is also an ongoing process, and one that
benefits greatly from user input.

Tcontact@ableton.com
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Chapter 31

MIDI Fact Sheet

In conjunction with our work on the audio engine, Ableton has spent additional effort an-
alyzing Live’s MIDI timing and making improvements where necessary. We wrote this fact
sheet to help users understand the problems involved in creating a reliable and accurate
computer-based MIDI environment, and to explain Live's approach to solving these prob-
lems.

Note: the MIDI timing issues discussed in this paper are generally not applicable to users
with high-quality audio and MIDI hardware. If you have already invested time and money
into optimizing these factors in your studio, and are not experiencing problems with MIDI
timing, you probably do not need this information.

31.1 Ideal MIDI Behavior

To understand how MIDI works within a digital audio workstation (DAW), it is helpful to
introduce some common terms and concepts. A DAW must be able to accommodate three
distinct MIDI-related scenarios:

1) Recording refers to sending MIDI note and controller information from a hard-
ware device (such as a MIDI keyboard) into a DAW for storage. An ideal recording
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environment would capture this incoming information with perfect timing accu-
racy in relation to the timeline of the song — as accurately as an audio recording.

2) Playback refers to two related scenarios when dealing with DAWSs. The first in-
volves sending MIDI note and controller information from the DAW to a hardware
device such as a synthesizer. The second involves converting stored MIDI infor-
mation into audio data within the computer, as played back by a plug-in device
such as the Operator synthesizer. In both cases, an ideal playback environment
would output a perfect reproduction of the stored information.

3) Playthrough involves sending MIDI note and controller information from a hard-
ware device (such as a MIDI keyboard) into the DAW and then, in real-time, back
out to a hardware synthesizer or to a plug-in device within the DAW. An ideal
playthrough environment would “feel” as accurate and responsive as a physical
instrument such as a piano.

31.2 MIDI Timing Problems

The realities of computer-based MIDI are complex, and involve so many variables that
the ideal systems described above are impossible to achieve. There are two fundamental
issues:

1) Latency refers to inherent and consistent delay in a system. This is a particular
problem in a DAW because digital audio cannot be transferred into or out of an
audio interface in real time, and must instead be buffered. But even acoustic
instruments exhibit a certain degree of latency; in a piano, for example, there is
some amount of delay between the time a key is depressed and the time the
hammer mechanism actually activates the string. From a performance perspec-
tive, small latency times are generally not a problem because players are usually
able to adapt the timing of their playing to compensate for delays — as long as
the delays remain consistent.

2) Jitter refers to inconsistent or random delay in a system. Within a DAW, this
can be a particular problem because different functions within the system (e.g.,
MIDI, audio and the user interface) are processed separately. Information often
needs to be moved from one such process to another — when converting MIDI
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data into a plug-in's playback, for example. Jitter-free MIDI timing involves
accurate conversion between different clocks within the system’s components —
the MIDI interface, audio interface, and the DAW itself. The accuracy of this
conversion depends on a variety of factors, including the operating system and
driver architecture used. Jitter, much more so than latency, creates the feeling
that MIDI timing is “sloppy” or “loose.”

31.3 Live's MIDI Solutions

Ableton’s approach to MIDI timing is based on two key assumptions:

1. In all cases, latency is preferable to jitter. Because latency is consistent and
predictable, it can be dealt with much more easily by both computers and people.

2. If you are using playthrough while recording, you will want to record what you
hear — even if, because of latency, this occurs slightly later than what you play.

Live addresses the problems inherent in recording, playback and playthrough so that MIDI
timing will be responsive, accurate and consistently reliable. In order to record incoming
events to the correct positions in the timeline of a Live Set, Live needs to know exactly when
those events were received from the MIDI keyboard. But Live cannot receive them directly
— they must first be processed by the MIDI interface’s drivers and the operating system. To
solve this problem, the interface drivers give each MIDI event a timestamp as they receive
it, and those are passed to Live along with the event so that Live knows exactly when the
events should be added to the clip.

During playthrough, a DAW must constantly deal with events that should be heard as soon
as possible, but which inevitably occurred in the past due to inherent latency and system
delays. So a choice must be made: should events be played at the moment they are
received (which can result in jitter if that moment happens to occur when the system is busy)
or should they be delayed (which adds latency)? Ableton’s choice is to add latency, as we
believe that it is easier for users to adjust to consistent latency than to random jitter.

When monitoring is enabled during recording, Live adds an additional delay to the times-
tamp of the event based on the buffer size of your audio hardware. This added latency
makes it possible to record events to the clip at the time you hear them — not the time you
play them.
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For playback of hardware devices, Live also generates timestamps that it attempts to com-
municate to the MIDI interface drivers for scheduling of outgoing MIDI events. Windows
MME drivers cannot process timestamps, however, and for devices that use these drivers,
Live schedules outgoing events internally.

Even during high system loads that cause audio dropouts, Live will continue to receive
incoming MIDI events. In the event of audio dropouts, there may be timing errors and
audio distortion during playthrough, but Live should still correctly record MIDI events into
clips. Later, when the system has recovered from the dropouts, playback of these recorded
events should be accurate.

31.4 Variables Outside of Live's Control

In general, timestamps are an extremely reliable mechanism for dealing with MIDI event
timing. But timestamps are only applicable to data within the computer itself. MIDI data
outside of the computer can make no use of this information, and so timing information
coming from or going to external hardware is processed by the hardware as soon as it
arrives, rather than according to a schedule. Additionally, MIDI cables are serial, meaning
they can only send one piece of information at a time. In practice, this means that multiple
notes played simultaneously cannot be transmitted simultaneously through MIDI cables, but
instead must be sent one after the other. Depending on the density of the events, this can
cause MIDI timing problems.

Another issue that can arise, particularly when working with hardware synthesizers from the
early days of MIDI, is that the scan time of the device may occur at a relatively slow rate.
Scan time refers to how often the synthesizer checks its own keyboard for input. If this rate
is too slow, jitter may be introduced.

Of course, any such timing problems present at the hardware level may be multiplied as
additional pieces of gear are added to the chain.

Even within the computer, the accuracy of timestamps can vary widely, depending on the
quality of the MIDI hardware, errors in driver programming, etc. Live must assume that any
timestamps attached to incoming MIDI events are accurate, and that outgoing events will
be dealt with appropriately by any external hardware. But both situations are impossible for
Live to verify.
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31.5 Tests and Results

Our procedure for testing the timing of incoming MIDI events is represented in the following
diagram:

Live
MIDI Clip
MIDI
MIDI Source ~{splitter
MIDI-to-Audio —
Converter Audio Clip

The output of a MIDI Source (a keyboard or other DAW playing long sequences of random
MIDI events) is fed to a zero-latency hardware MIDI Splitter. One portion of the splitter’s
output is recorded into a new MIDI clip in Live. The other portion is fed to a MIDI-to-Audio
Converter. This device converts the electrical signal from the MIDI source into simple audio
noise. Because the device does not interpret the MIDI data, it performs this conversion with
zero-latency. The converter’s output is then recorded into a new audio clip in Live. In an
ideal system, each event in the MIDI clip would occur simultaneously with the corresponding
event in the audio clip. Thus the difference in timing between the MIDI and audio events in
the two clips can be measured to determine Live's accuracy.

In order to assess MIDI performance under a variety of conditions, we ran the tests with
three different audio/MIDI combo interfaces at different price points, all from well-known
manufacturers. We will refer to these interfaces as A, B and C. All tests were performed with
a CPU load of approximately 50% on both OS X and Windows machines, at both 44.1 and
96 kHz and at three different audio buffer sizes, for a total of 36 discrete test configurations.

Windows:

e Interface A: The maximum jitter was +/- 4 ms, with the majority of the jitter occurring
at +/- 1 ms.

e Interface B: For most of the tests, the maximum jitter was +/- 3 or 4 ms. At 96 kHz
and 1024 sample buffer, there were a small number of events with +/- 5 ms of jitter.

MIDI Input Test
Configuration.
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At 44.1 kHz and 512 sample buffer, occasional events with +/- 6 ms occurred. In all
cases, the majority of the jitter occurred at +/- 1 ms.

e Interface C: For most of the tests, the maximum jitter was +/- 5 ms. At 96 kHz and 512
sample buffer, there were a small number of events with between +/- 6 and 8 ms of
jitter. At 44.1 kHz and 1024 sample buffer, there were a small number of events with
jitter as high as +/- 10 ms. In all cases, the majority of the jitter occurred at +/- 1 ms.

oS X:

o Interface A: At 44.1 kHz and 1152 sample buffer, jitter was fairly evenly distributed
between +/- 4 and 11 ms. For all other tests, the maximum jitter was +/- 5 ms. In all
tests, the majority of the jitter occured at +/- 1 ms.

e Interface B: For most of the tests, the maximum jitter was +/- 4 or 5 ms. At 44.1 kHz
and 1152 sample buffer, there was a fairly even distribution of jitter between +/- 2 and
11 ms. In all cases, the majority of the jitter occurred at +/- 1 ms.

e Interface C: In all tests, the maximum jitter was +/- 1 ms, with most events occurring
with no jitter.

We also performed a similar procedure for testing the timing of outgoing MIDI events, as
represented in the following diagram:

Live

MIDI Clip _ |MIDI-to-Audio -
Converter Audio Recording

(another instance of Live)
Audio Clip -

In all cases, the output tests showed comparable results to the input tests.

MIDI Output Test
Configuration.
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31.6 Tips for Achieving Optimal MIDI Performance

In order to help users achieve optimal MIDI performance with Live, we have provided a list
of recommended practices and program settings.

o Use the lowest possible buffer sizes available on your audio hardware, thereby keeping
latency to a minimum. Audio buffer controls are found in the Audio tab of Live's
Preferences, and vary depending on the type of hardware you're using. For more
information, see the Lesson “Setting Up Audio I/0.”

e Use a high quality MIDI interface with the most current drivers in order to ensure that
MIDI timestamps are generated and processed as accurately as possible.

e Do not enable track monitoring if you are recording MIDI while listening directly to
a hardware device such as an external synthesizer (as opposed to listening to the
device's audio through Live via the External Instrument device). Likewise, disable track
monitoring when recording MIDI data that is generated by another MIDI device (such
as a drum machine). When monitoring is enabled, Live adds latency to compensate for
playthrough jitter. Therefore, it is important to only enable monitoring when actually
playing through.

e The DirectMusic architecture on Windows allows outgoing MIDI events to be sched-
uled by the operating system rather than scheduled by Live alone, so performance
may differ depending on whether or not you're using MME or DirectMusic mode. If
you experience timing issues, we recommend switching to the other mode. This is set
in the MIDI Ports list in the MIDI/Sync Preferences.

MIDI Ports rack Sync Remote

Selecting the MIDI Port
Type (Windows).
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31.7 Summary and Conclusions

Ableton wrote this paper in order to help users understand a variety of related topics:
e the inherent problems in computer-based MIDI systems;
e our approach to solving these problems in Live;
e additional variables that we cannot account for.

As mentioned before, the best way to solve MIDI timing issues in your studio is to use the
highest-quality hardware components available. For users of such components, all software
MIDI systems should perform with no noticeable issues. For users with less-than-optimal
hardware, however, Live still offers an additional degree of accuracy by minimizing jitter, but
at the expense of a small amount of additional latency.

We encourage you to refer to this paper if you have any questions about Live's approach to
MIDI timing, but we also encourage you to contact us' if you have additional questions or
concerns that we haven’t addressed.

Tcontact@ableton.com
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Chapter 32

Live Keyboard Shortcuts

32.1 Showing and Hiding Views
Windows Macintosh
Toggle Full Screen Mode F11
Toggle Session/Arrangement View
Toggle Track/Clip View & s ) or | & = ] or
Hide/Show Detail View or or
(Cul )@ _JF12 )
Hide/Show Info View 2]
Hide/Show Browser (ctrl J(At  ](B] (G A JB]
Hide/Show Overview (Cul @Al (0] (& ®AL —)0)
Hide/Show In/Out Cul J@Aat () G ®EAE 1)
Hide/Show Sends
Hide/Show Mixer
Open the Preferences (Cul ][] [CHES]
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Windows Macintosh
Close Window/Dialog Esc Esc

32.2 Accessing Menus

Under Windows, you can access each menu by pressing and the first letter of the
menu (At J[F] for “File,” for instance). While a menu is open, you can use:

. to navigate the menu items;
. to open the neighboring menu;
. to choose a menu item.

32.3 Adjusting Values

Windows Macintosh
Increment/Decrement 3L
Finer Resolution for Dragging
Return to Default [Delete) L=
Type in Value 0] .. (9] 0] .. (@]
Go to Next Field (Bar.beat.16th) (0] 1
Abort Value Entry Esc Esc
Confirm Value Entry
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32.4 Browsing

In addition to the shortcuts shown here, editing shortcuts can also be used in the Browser.

Windows Macintosh
Scroll Up/Down ¥4
Open/Close Folders >
Set Selected Folder as Browser Root
Load Selected Item from Browser Return] or Double- | Retun] or Double-
Click Click
Preview Selected File
Activate Browser Search Mode
Jump to Search Results
32.5 Transport
Windows Macintosh
Play from Start Marker/Stop
Continue Play from Stop Point (£ )[Space) (£ )(Space)
Play Arrangement View Selection
Record
Back to Arrangement F10 F10
Activate/Deactivate Track 1..8 (FL ). (F8 ) F1 ) .. (F8 )
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32.6 Editing

Windows Macintosh

Cut

Copy [Crl)(c) @ ®c)

Paste
Duplicate SN © %0
Delete

Undo

Redo (Crl ](v) G B )Z)
Rename (Crl ][R G _BR)
Select Al

By holding down an additional modifier key, some of the above commands can also be
applied to:

Windows Macintosh
Clips and Slots Across all Tracks
Time Across all Tracks
The Selected Part of the Envelope Alt

can be used to move from one track or scene to another while renaming.
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32.7 Loop Brace and Start/End Markers

The loop brace and start/end markers must first be selected before any of the following

commands will apply to them.

Windows Macintosh
Move Start Marker to Position Click Click
Nudge Loop Left/Right «“
Move Loop By Loop Length (v)(4] (v](4]
Double/Halve Loop Length G B[4
Shorten/Lengthen Loop [Cul )«
Select Material in Loop Click Loop Brace or | Click Loop Brace or
[Crl )& L) © ® L]
32.8 Session View Commands
See also the editing commands.
Windows Macintosh
Launch Selected Clip/Slot
Select Neighbouring Clip/Slot Arrow Keys Arrow Keys
Select all Clips/Slots
Copy Clips Drag Drag
Add/Remove Stop Button
Insert MIDI clip Cr )& JM  or| G @& IM  or
Double-Click Slot Double-Click Slot
Insert Scene (cul ) G #0 ]
Insert Captured Scene (Cl J@& ) c_#L I
Move Nonadjacent Scenes Without
Collapsing
Drop Browser Clips as a Scene
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32.9 Arrangement View Commands

The shortcuts for zooming, snapping/drawing and loop/region settings also work in the
Arrangement View. See also the editing commands.

Windows Macintosh
Split Clip at Selection
Consolidate Selection into Clip
Create Fade/Crossfade Cul )@ J(F) G ®AL IJF)
Loop Selection
Insert Silence (Cul (1) ©_ B0
Pan Left/Right of Selection
Unfold all Tracks (At ) Unfold button | (At -5 Unfold button
Scroll Display to Follow Playback




CHAPTER 32. LIVE KEYBOARD SHORTCUTS

514

32.10 Commands for Tracks

See also the editing commands.

Windows Macintosh
Insert Audio Track
Insert MIDI Track
Insert Return Track
Rename Selected Track (crl JR] S BR)
While Renaming, Go to next Track
Group Selected Tracks
Ungroup Tracks
Show Grouped Tracks +) (+]
Hide Grouped Tracks ) =)
Move Nonadjacent Tracks Without + arrow keys + arrow keys
Collapsing
Arm/Solo Multiple Tracks Click Click
Add Device from Browser Double-Click Double-Click

32.11

Commands for Breakpoint Envelopes

The shortcuts for zooming, snapping/drawing and loop/region settings also work in the
Envelope Editor and Arrangement View. See also the editing commands.

Windows Macintosh
Finer Resolution for Dragging
Enable Dragging Over Breakpoints
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32.12 Key/MIDI Map Mode and the Computer MIDI

Keyboard
Windows Macintosh
Toggle MIDI Map Mode cul ] S %M
Toggle Key Map Mode
Computer MIDI Keyboard

32.13 Zooming, Display and Selections

Zoom In

Zoom Out

Drag/Click to Append to a Selection

Click to Add Adjacent
Clips/Tracks/Scenes to Multi-Selection

Click to Add Nonadjacent
Clips/Tracks/Scenes to a
Multi-Selection

= =]
Q.
[¢]
g
w0

| iigﬂ%
0

% 5
[e]

(7]

>

Follow (Auto-Scroll)

Ctrl

Pan Left/Right of Selection

2 |(™

Ctrl

ﬁi
%)/ 138
)M

i
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32.14 Clip View Sample Display

The shortcuts for zooming and loop/region settings also work in the Sample Display.

Windows Macintosh
Quantize
Quantize Settings...
Move Selected Warp Marker =
Select Warp Marker (Crl )« © ®H
Scroll Display to Follow Playback
Move Clip Region with Start Marker

32.15 Clip View MIDI Editor

The shortcuts for zooming, snapping/drawing and loop/region settings also work in the

MIDI Editor.
Windows Macintosh

Quantize (Cul (U] (S
Quantize Settings...
Scroll Editor Vertically
Scroll Editor Horizontally (Ctl ) Page) (* Page) (& %) Page)(f Page
Copy Note (crl ) Drag (At <) Drag
Change Velocity From Note Editor Drag Drag
Add/Delete Note in Edit Mode Double-Click Double-Click
Move Insert Mark to Beginning Home home
Move Insert Mark to End End end
Scroll Display to Follow Playback (Cul JF) S $F)
Move Clip Region with Start Marker
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32.16 Grid Snapping and Drawing

Windows Macintosh
Toggle Draw Mode
Narrow Grid (Ctl J1] (@ ®)[1)
Widen Grid
Triplet Grid
Snap to Grid
Fixed/Zoom-Adaptive Grid
Bypass Snapping While Dragging Alt

32.17 Global Quantization

Windows Macintosh
Sixteenth-Note Quantization (Cul 6] S *B6)
Eighth-Note Quantization
Quarter-Note Quantization (Cul ](8) S ®)B6)
1-Bar Quantization (Cl (o) [HE3]CY)
Quantization Off (Cul_ o] & $0]
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32.18 Working with Sets and the Program

Windows Macintosh
New Live Set
Open Live Set (cul )[o] & %))
Close Live Set
Save Live Set
Save Live Set As...
Quit Live (ctrl_][Q) [2:3]()
Hide Live (3]G
Export Audio/Video i )& IR © ¥ IR
Export MIDI file

32.19 Working with Plug-Ins and Devices

Windows Macintosh
Show/Hide Plug-In Windows Cul ) J(P] & ®¥AL JP)
Open Second/Multiple Windows with (Cul ]
Plug-In Edit Button
Open Mac Keystroke Plug-In Window
with Plug-In Edit Button
Group/Ungroup Devices

Activate/Deactivate All Devices in
Group

Device Activa-

tor

Device Activa-

tor

Click to Append Devices to a Selected

Device

Load Selected Device From Browser Return) or Double- | Return] or Double-
Click Click
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32.20 Using the Context Menu

A context menu is available in Live for quick access to many commonly used menu items.
To access the context menu, 3 (PC) / 8 (Mac) on the part of the interface where
you would like to execute a particular command. It is worth noting that Live's context menu
may sometimes contain applicable settings from the Preferences. You should change these
options with care, as they will affect not only the currently selected item but the general
settings of the program.

Some commands only appear in the context menu. Among these are: the Create Folder,
Analyze Audio, Search In Folder, Close All Folders and Refresh commands from the Browser;
the special grid marker commands for directing Auto-Warp; detailed options for zoom-
adaptive and fixed grid line width; and copying and pasting for Operator’s envelopes and
oscillators.
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